SIMATIC HMI

WinCC V7.5
WinCC Basic Options
(WebNavigator, DataMonitor, WebUX)

System Manual

Printout of the online help
Legal information

Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are graded according to the degree of danger.

**DANGER**

indicates that death or severe personal injury **will** result if proper precautions are not taken.

**WARNING**

indicates that death or severe personal injury **may** result if proper precautions are not taken.

**CAUTION**

indicates that minor personal injury can result if proper precautions are not taken.

**NOTICE**

indicates that property damage can result if proper precautions are not taken.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property damage.

Qualified Personnel

The product/system described in this documentation may be operated only by **personnel qualified** for the specific task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified personnel are those who, based on their training and experience, are capable of identifying risks and avoiding potential hazards when working with these products/systems.

Proper use of Siemens products

Note the following:

**WARNING**

Siemens products may only be used for the applications described in the catalog and in the relevant technical documentation. If products and components from other manufacturers are used, these must be recommended or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and maintenance are required to ensure that the products operate safely and without any problems. The permissible ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks

All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the information in this publication is reviewed regularly and any necessary corrections are included in subsequent editions.
# Table of contents

1 WinCC V7.5 Installation / Release Notes .........................................................................................................................9

1.1 WinCC Installation Notes .........................................................................................................................................................9
1.1.1 WinCC installation instructions ........................................................................................................................................9
1.1.2 Scope of delivery ...............................................................................................................................................................9
1.1.3 SIMATIC WinCC: Product compatibility and supported functions .......................................................................................11
1.1.4 Licenses and Licensing .....................................................................................................................................................11
1.1.5 Activating and testing ASIA licenses ................................................................................................................................14
1.1.6 WinCC installation requirements .......................................................................................................................................16
1.1.6.1 WinCC Installation Requirements ..................................................................................................................................16
1.1.6.2 Hardware requirements for installing WinCC ......................................................................................................................17
1.1.6.3 Software requirements for installing WinCC ......................................................................................................................19
1.1.6.4 Microsoft SQL Server for WinCC ..................................................................................................................................24
1.1.6.5 Notes on Data and System Security .................................................................................................................................25
1.1.6.6 Access rights in the operating system .....................................................................................................................................27
1.1.6.7 How to Adapt the Windows Security Policies ....................................................................................................................33
1.1.7 Installing WinCC ................................................................................................................................................................33
1.1.7.1 Installing WinCC .............................................................................................................................................................33
1.1.7.2 How to Install MS Message Queuing ................................................................................................................................34
1.1.7.3 How to Install WinCC .......................................................................................................................................................36
1.1.7.4 How to Install Supplementary Components Later ...........................................................................................................40
1.1.7.5 How to Install Supplementary Languages .........................................................................................................................41
1.1.7.6 Configure automatic installation of WinCC ...........................................................................................................................42
1.1.8 Uninstalling WinCC ..............................................................................................................................................................44
1.1.9 Upgrading WinCC .................................................................................................................................................................46
1.1.9.1 Upgrading WinCC .............................................................................................................................................................46
1.1.9.2 How to Perform an Upgrade Installation ...............................................................................................................................47
1.1.10 Overview: Notes on operation ..........................................................................................................................................49
1.2 WinCC Release Notes ............................................................................................................................................................50
1.2.1 Release Notes ......................................................................................................................................................................50
1.2.2 Notes on operation ...............................................................................................................................................................50
1.2.2.1 Notes on operation .............................................................................................................................................................50
1.2.2.2 Information on the Windows operating system ...................................................................................................................52
1.2.2.3 Information on the database system .....................................................................................................................................55
1.2.2.4 Information on network technology and UPS ....................................................................................................................56
1.2.3 Notes on WinCC ...................................................................................................................................................................61
1.2.3.1 General information on WinCC and configurations .........................................................................................................61
1.2.3.2 Information on WinCC CS ...................................................................................................................................................65
1.2.3.3 Information on WinCC runtime ...........................................................................................................................................67
1.2.3.4 Information on Smart tools .................................................................................................................................................69
1.2.3.5 Information on process communication ...............................................................................................................................70
1.2.3.6 Remote access and Remote Desktop Protocol (RDP) .......................................................................................................72
1.2.4 Notes on WinCC Redundancy ...............................................................................................................................................74
1.2.5 Notes on Process Control Options ......................................................................................................................................75
1.3 WinCC/Connectivity Pack Installation Notes ..........................................................................................................................78
1.3.1 Connectivity Pack licensing ..................................................................................................................................................78
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.3.2 How to Install MS Message Queuing</td>
<td>78</td>
</tr>
<tr>
<td>1.3.3 Installation of the Connectivity Pack Server</td>
<td>79</td>
</tr>
<tr>
<td>1.3.4 Installation of the Connectivity Pack Client</td>
<td>81</td>
</tr>
<tr>
<td>1.4 WinCC/Connectivity Pack Release Notes</td>
<td>82</td>
</tr>
<tr>
<td>1.4.1 Information on the Connectivity Pack</td>
<td>82</td>
</tr>
<tr>
<td>1.5 WinCC/DataMonitor Installation Notes</td>
<td>83</td>
</tr>
<tr>
<td>1.5.1 Requirements of installing DataMonitor</td>
<td>83</td>
</tr>
<tr>
<td>1.5.2 User rights for installing the DataMonitor client</td>
<td>85</td>
</tr>
<tr>
<td>1.5.3 Installing the Internet Information Service (IIS)</td>
<td>86</td>
</tr>
<tr>
<td>1.5.4 Installing DataMonitor</td>
<td>88</td>
</tr>
<tr>
<td>1.5.5 DataMonitor licensing</td>
<td>90</td>
</tr>
<tr>
<td>1.6 WinCC/DataMonitor Release Notes</td>
<td>93</td>
</tr>
<tr>
<td>1.6.1 Notes about DataMonitor</td>
<td>93</td>
</tr>
<tr>
<td>1.7 WinCC/WebNavigator Installation Notes</td>
<td>96</td>
</tr>
<tr>
<td>1.7.1 General information on the WebNavigator installation</td>
<td>96</td>
</tr>
<tr>
<td>1.7.2 WebNavigator installation requirements</td>
<td>96</td>
</tr>
<tr>
<td>1.7.2.1 Hardware and software requirements for WebNavigator</td>
<td>96</td>
</tr>
<tr>
<td>1.7.2.2 Licensing WebNavigator</td>
<td>99</td>
</tr>
<tr>
<td>1.7.2.3 Requirements for the Use of Terminal Services</td>
<td>101</td>
</tr>
<tr>
<td>1.7.3 Installing a WebNavigator server</td>
<td>102</td>
</tr>
<tr>
<td>1.7.3.1 Overview: Installing the WebNavigator server</td>
<td>102</td>
</tr>
<tr>
<td>1.7.3.2 Installing the Internet Information Server (IIS)</td>
<td>103</td>
</tr>
<tr>
<td>1.7.3.3 Installing the WebNavigator server</td>
<td>105</td>
</tr>
<tr>
<td>1.7.4 Installing the WebNavigator client</td>
<td>106</td>
</tr>
<tr>
<td>1.7.4.1 Installing the WebNavigator client</td>
<td>106</td>
</tr>
<tr>
<td>1.7.4.2 User rights and user groups for WebNavigator clients</td>
<td>109</td>
</tr>
<tr>
<td>1.7.4.3 Internet Explorer settings (WebNavigator client)</td>
<td>110</td>
</tr>
<tr>
<td>1.7.4.4 Installation from the DVD (WebNavigator client)</td>
<td>111</td>
</tr>
<tr>
<td>1.7.4.5 Installation via the Intranet/Internet (WebNavigator client)</td>
<td>112</td>
</tr>
<tr>
<td>1.7.5 Installing the WebNavigator diagnostics client</td>
<td>113</td>
</tr>
<tr>
<td>1.7.6 WebNavigator Demo Project</td>
<td>114</td>
</tr>
<tr>
<td>1.7.7 Uninstalling the WebNavigator</td>
<td>115</td>
</tr>
<tr>
<td>1.8 WinCC/WebNavigator Release Notes</td>
<td>116</td>
</tr>
<tr>
<td>1.8.1 Information about WebNavigator</td>
<td>116</td>
</tr>
<tr>
<td>1.9 WinCC/WebUX</td>
<td>121</td>
</tr>
<tr>
<td>1.9.1 WebUX licensing</td>
<td>121</td>
</tr>
<tr>
<td>1.9.2 Communication: SSL certificate for HTTPS connections</td>
<td>122</td>
</tr>
<tr>
<td>1.9.3 Installation of WebUX</td>
<td>123</td>
</tr>
<tr>
<td>1.9.4 Configuring the WebUX website</td>
<td>125</td>
</tr>
<tr>
<td>1.10 Service and Support</td>
<td>128</td>
</tr>
<tr>
<td>1.10.1 Warnings</td>
<td>128</td>
</tr>
<tr>
<td>1.10.2 Customer support</td>
<td>130</td>
</tr>
<tr>
<td>1.10.3 Support request</td>
<td>133</td>
</tr>
<tr>
<td>2 WinCC/WebNavigator</td>
<td>137</td>
</tr>
<tr>
<td>2.1 WinCC/WebNavigator Getting Started</td>
<td>137</td>
</tr>
<tr>
<td>2.1.1 First Web Project</td>
<td>137</td>
</tr>
<tr>
<td>2.1.2 Configuring the WinCC project</td>
<td>139</td>
</tr>
<tr>
<td>2.1.2.1 Publishing process pictures</td>
<td>139</td>
</tr>
</tbody>
</table>
3 WinCC/DataMonitor ..................................................................................................................................245

3.1 WinCC/DataMonitor Getting Started ...........................................................................................................245
3.1.1 DataMonitor .................................................................................................................................................245
3.1.2 Preparations ....................................................................................................................................................246
3.1.3 Configuring the DataMonitor system ............................................................................................................247
3.1.3.1 Defining users in Windows........................................................................................................................247
Table of contents

3.1.3.2 Administering users for DataMonitor ................................................................. 249
3.1.3.3 Configuring the DataMonitor web page ......................................................... 251
3.1.3.4 Configuring the firewall ................................................................................ 252
3.1.3.5 How to publish WinCC process pictures using Web View Publisher ............. 254
3.1.4 Working with the DataMonitor client ................................................................. 261
3.1.4.1 Configuring security settings in Internet Explorer ........................................ 261
3.1.4.2 DataMonitor start page on the DataMonitor client ....................................... 263
3.1.5 Working with WinCCViewerRT ........................................................................ 265
3.1.5.1 Configuring WinCCViewerRT ......................................................................... 265
3.1.5.2 Displaying pictures ....................................................................................... 269
3.1.6 Use of DataMonitor ......................................................................................... 270
3.1.6.1 Create connection and set up language ....................................................... 270
3.1.6.2 Displaying process values and messages via "Trends and Alarms" ................. 272
3.1.6.3 Displaying process values in an Excel workbook ......................................... 279
3.1.6.4 Outputting data using "Reports" ................................................................. 301
3.1.6.5 Creating Webcenter pages in "Webcenter" ................................................... 310
3.1.7 Working with WinCCViewerRT ........................................................................ 299
3.1.8 Administration ............................................................................................... 322
3.2 WinCC/DataMonitor Documentation ................................................................ 321
3.2.1 Basic principles ............................................................................................ 321
3.2.1.1 DataMonitor ............................................................................................... 321
3.2.1.2 WinCCViewerRT ....................................................................................... 322
3.2.1.3 Web center .............................................................................................. 322
3.2.1.4 Overview of Web Parts ............................................................................... 323
3.2.1.5 Trends and Alarms ................................................................................... 324
3.2.1.6 Excel workbook ....................................................................................... 325
3.2.1.7 Reports .................................................................................................... 326
3.2.2 Configuring the DataMonitor system ............................................................ 327
3.2.2.1 Overview of the configuration steps ......................................................... 327
3.2.2.2 Configure the WinCC project .................................................................... 328
3.2.2.3 Configuring the DataMonitor system ...................................................... 342
3.2.2.4 Working with the DataMonitor client ....................................................... 348
3.2.2.5 Working with WinCCViewerRT ................................................................. 351
3.2.2.6 Configuring web parts within Webcenter pages ........................................ 382
3.2.2.7 Deleting Webcenter pages and layout templates ....................................... 384
3.2.2.8 Working with trends and alarms ............................................................. 386
3.2.2.9 Displaying process values in a table ....................................................... 386
3.2.2.10 Displaying process values in a diagram ................................................ 387
3.2.2.11 Displaying messages in the alarm table ............................................... 389
3.2.2.12 Alarm Log Column Names .................................................................... 391
3.2.2.13 Displaying the hit list of messages ....................................................... 393
3.2.2.14 Displaying statistics function for process values ..................................... 395
3.2.2.15 Working with Excel Workbook ............................................................. 396
3.2.2.16 Configuring the Excel workbook ............................................................ 396
3.2.2.17 Displaying process data in an Excel workbook ....................................... 415
3.2.2.18 Alarm Attributes ..................................................................................... 417
3.2.3 Configuring the DataMonitor system ............................................................ 327
3.2.3.1 Configuring WinCCViewerRT .................................................................... 328
3.2.3.2 Configuring WinCCViewerRT .................................................................... 351
3.2.3.3 Administering users for DataMonitor ....................................................... 249
3.2.3.4 Administering users for DataMonitor ....................................................... 249
3.2.3.5 Administering users for DataMonitor ....................................................... 249
3.2.3.6 Administering users for DataMonitor ....................................................... 249
3.2.4 Working with the Webcenter .......................................................................... 336
3.2.4.1 Administration ....................................................................................... 356
3.2.4.2 Creating static process pictures for the Webcenter .................................... 372
3.2.4.3 Creating layout template for Webcenter pages ......................................... 374
3.2.4.4 Creating Webcenter page ........................................................................ 376
3.2.4.5 Inserting web parts to the Webcenter page ............................................. 379
3.2.4.6 Deleting Webcenter pages and layout templates ....................................... 384
3.2.4.7 Deleting Webcenter pages and layout templates ....................................... 384
3.2.4.8 Deleting Webcenter pages and layout templates ....................................... 384
3.2.4.9 Deleting Webcenter pages and layout templates ....................................... 384
3.2.4.10 Deleting Webcenter pages and layout templates ..................................... 384
3.2.5 Configuring the DataMonitor system ............................................................ 327
3.2.5.1 Configuring the DataMonitor system ....................................................... 327
3.2.5.2 Configuring the DataMonitor system ....................................................... 327
3.2.5.3 Configuring the DataMonitor system ....................................................... 327
3.2.5.4 Configuring the DataMonitor system ....................................................... 327
3.2.5.5 Configuring the DataMonitor system ....................................................... 327
3.2.5.6 Configuring the DataMonitor system ....................................................... 327
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.2.6.4</td>
<td>VBA Functions of the Excel Workbook</td>
<td>418</td>
</tr>
<tr>
<td>3.2.7</td>
<td>Working with reports</td>
<td>419</td>
</tr>
<tr>
<td>3.2.7.1</td>
<td>Making an Excel workbook available as template</td>
<td>419</td>
</tr>
<tr>
<td>3.2.7.2</td>
<td>Making an Excel workbook available as a report tool</td>
<td>420</td>
</tr>
<tr>
<td>3.2.7.3</td>
<td>Making Settings for Reports</td>
<td>422</td>
</tr>
<tr>
<td>3.2.7.4</td>
<td>Displaying a report with an Excel Workbook</td>
<td>423</td>
</tr>
<tr>
<td>3.2.7.5</td>
<td>Creating a report with a print job</td>
<td>426</td>
</tr>
<tr>
<td>4</td>
<td>WinCC/WebUX</td>
<td>429</td>
</tr>
<tr>
<td>4.1</td>
<td>WinCC/WebUX - Documentation</td>
<td>429</td>
</tr>
<tr>
<td>4.1.1</td>
<td>WebUX - Overview</td>
<td>429</td>
</tr>
<tr>
<td>4.1.2</td>
<td>WebUX licensing</td>
<td>431</td>
</tr>
<tr>
<td>4.1.3</td>
<td>Communication: SSL certificate for HTTPS connections</td>
<td>433</td>
</tr>
<tr>
<td>4.1.4</td>
<td>Installation of WebUX</td>
<td>434</td>
</tr>
<tr>
<td>4.1.5</td>
<td>Configuring the WebUX website</td>
<td>436</td>
</tr>
<tr>
<td>4.1.6</td>
<td>Functions supported in WebUX</td>
<td>438</td>
</tr>
<tr>
<td>4.1.6.1</td>
<td>Functions supported in WebUX</td>
<td>438</td>
</tr>
<tr>
<td>4.1.6.2</td>
<td>Supported functions: Graphic objects</td>
<td>438</td>
</tr>
<tr>
<td>4.1.6.3</td>
<td>Supported functions: WinCC Controls</td>
<td>441</td>
</tr>
<tr>
<td>4.1.6.4</td>
<td>Supported functions: Dynamization</td>
<td>445</td>
</tr>
<tr>
<td>4.1.7</td>
<td>Configuring a WinCC project for WebUX</td>
<td>448</td>
</tr>
<tr>
<td>4.1.8</td>
<td>How to use WebUX</td>
<td>450</td>
</tr>
<tr>
<td>4.1.9</td>
<td>Appendix</td>
<td>451</td>
</tr>
<tr>
<td>4.1.9.1</td>
<td>Dynamics dialog Restrictions on expressions / formulas</td>
<td>451</td>
</tr>
</tbody>
</table>

Index | 453 |
1.1 WinCC Installation Notes

1.1.1 WinCC installation instructions

Contents

This documentation contains important information on the scope of delivery, as well as on the installation and operation of WinCC.

The information contained here takes precedence over the information contained in the manual and online help.

1.1.2 Scope of delivery

Components supplied

WinCC V7.5 is available as a basic package or upgrade package and as a download package "OSD" (Online Software Delivery).

You will receive the following components:

<table>
<thead>
<tr>
<th>Components ¹</th>
<th>Basic / Upgrade / Download Package</th>
</tr>
</thead>
<tbody>
<tr>
<td>WinCC V7.5 DVD:</td>
<td>X</td>
</tr>
<tr>
<td>• WinCC V7.5</td>
<td></td>
</tr>
<tr>
<td>• WinCC/WebUX V7.5</td>
<td></td>
</tr>
<tr>
<td>• WinCC/WebNavigator V7.5</td>
<td></td>
</tr>
<tr>
<td>• WinCC/DataMonitor V7.5</td>
<td></td>
</tr>
<tr>
<td>• WinCC/Connectivity Pack V7.5</td>
<td></td>
</tr>
<tr>
<td>• WinCC/Connectivity Station V7.5</td>
<td></td>
</tr>
<tr>
<td>• SQL Server 2016 SP2 for WinCC V7.5</td>
<td></td>
</tr>
<tr>
<td>• SIMATIC Logon V1.6 ²</td>
<td></td>
</tr>
<tr>
<td>• Automation License Manager V6.0 SP1</td>
<td></td>
</tr>
<tr>
<td>• AS-OS-Engineering V8.2</td>
<td></td>
</tr>
<tr>
<td>SIMATIC NET DVD:</td>
<td>X</td>
</tr>
<tr>
<td>• Simatic Net V15</td>
<td></td>
</tr>
</tbody>
</table>
Components

<table>
<thead>
<tr>
<th>DVD Additional Content:</th>
<th>Basic / Upgrade / Download Package</th>
</tr>
</thead>
<tbody>
<tr>
<td>• SQL Server Management Studio</td>
<td>X</td>
</tr>
<tr>
<td>Required licenses</td>
<td>X</td>
</tr>
<tr>
<td>Certificate of License</td>
<td>X</td>
</tr>
</tbody>
</table>

1) Refer to the software requirements in the installation notes and release notes.
2) When you install SIMATIC Logon, a computer restart may be necessary.

Note

Print Installation Notes

The installation notes for the respective products are also provided as a PDF file.

You can find the installation notes and release notes on the WinCC DVD in the "Install_and_Release-Notes" directory.

You need at least Adobe Acrobat Reader V5.0. You can download the Adobe Acrobat Reader free of charge from the following URL:

• http://www.adobe.com/products/acrobat

Communication drivers

The communication drivers included in the package don't need an additional license:

• Allen Bradley - Ethernet IP
• Mitsubishi Ethernet
• Modbus TCP/IP
• OPC
• OPC UA ¹)
• PROFIBUS DP
• SIMATIC 505 TCPIP
• SIMATIC S5 Ethernet Layer 4
• SIMATIC S5 Profibus FDL
• SIMATIC S5 Programmers Port AS511
• SIMATIC S5 Serial 3964R
• SIMATIC S7 Protocol Suite
• SIMATIC S7-1200, S7-1500
• SIMATIC TI Ethernet Layer 4
• SIMATIC TI Serial
• SIMOTION
• System Info

¹) You need a Connectivity Pack license for the WinCC OPC UA server.
1.1.3 SIMATIC WinCC: Product compatibility and supported functions

To use the software with other SIMATIC products you must ensure that the product versions match and support the required functions.

- You determine the version compatibility with the compatibility tool.
- Note the additional information on the products and functions

SIMATIC Process Historian

Note which functionality is supported by the SIMATIC Process Historian version that is used in each case. For additional information, refer to the documentation for the SIMATIC Process Historian.

Installing PH-Ready / IS-Ready

You install “PH-Ready” and “IS-Ready” from the “Process Historian / Information Server” DVD.

Compatibility tool

With the compatibility tool, Industry Online Support gives you a function you can use to put together a compatible selection of software products or to check existing configurations for compatibility.

In the following entry you can call the compatibility tool and find additional information on the operation of the tool:


1.1.4 Licenses and Licensing

Introduction

The WinCC software is protected and can only be used in its full measure with a valid license. Each installed software and option used requires a valid license for unrestricted operation of WinCC. The licenses for optional packages must be ordered separately.

You will receive the necessary license keys for the installation of licenses as follows:

- As storage medium with license keys
- Via the Internet (online software delivery)
Licenses which are installed for use in WinCC are transferred from the storage medium to a local drive and are unregistered on the storage medium.

**Note**

Furthermore, the licensee confirms that the software (SW) contains licensed software by Microsoft Corporation or its subsidiaries. Thereby, licensee agrees to be bound by the terms and conditions of the appended license agreement between Microsoft SQL Server and end user, and to fulfill same.

**Notes on license conditions**

Please observe the enclosed license conditions, which are also displayed during the installation. You need V7.5 licenses for WinCC V7.5.

The SIMATIC WinCC software is copy-protected against unlicensed use. You can find additional information on licenses and license types under “Licensing” in the WinCC Information System.

Installed licenses are required to enable proper operation of WinCC. If WinCC is installed without licenses, the program will switch to demo mode at start-up.

**Note**

It is not allowed to run WinCC in process mode without a valid license.

**Cumulating licenses**

The cumulation of more than one license per component subject to a license is only possible for the following licenses or licenses of the following options:

- WinCC Archive licenses
- WinCC/DataMonitor
- WinCC/WebNavigator
- WinCC/WebUX
- WinCC/IndustrialDataBridge
- WinCC/PerformanceMonitor
- SIMATIC Information Server

Other licenses cannot be cumulated.

**Demo Mode**

If a license is missing for one or several components, WinCC will run in demo mode. WinCC also switches to demo mode when the maximum authorized number of process tags or archive tags is exceeded in a project.

In Demo mode, you can use the WinCC software fully for a maximum of one hour. After this period, the operation of WinCC violates the license agreements.
After one hour, the WinCC Explorer and the editors will be closed.

In runtime, the system will request the acquisition of a valid license. This dialog will appear every 10 minutes.

To exit WinCC demo mode, install the required licenses.

Details on demo mode may be found in WinCC Information System under "Licensing".

**Microsoft SQL Server 2016**

A license is necessary to use the Microsoft SQL Server database. This license is readily available in a licensed and proper installation of WinCC.

The licensed SQL server installed with WinCC may only be used in connection with WinCC. Its use for other purposes requires an additional license. These include, e.g.:

- Use for internal databases
- Use in third-party applications
- Use of SQL access mechanisms that are not provided by WinCC

**Uninstalling**

After uninstalling WinCC, you also need to remove the "WinCC" SQL server instance:

Select "Control Panel" > "Software" and then select the "Microsoft SQL Server 2016" item for removal.

**Installation of Licenses**

You may use the Automation License Manager for installation of licenses.

Licenses may be installed during installation of WinCC or after the fact. You will find the Automation License Manager in the Windows start menu in the "Siemens Automation" program group. An after-the-fact installation of a license will take effect upon restart of your computer.

For the installation of licenses, the following requirements must be met:

- The storage medium containing the licenses must not be write protected.
- You can install the RC licenses on a license server for the configuration. You do not have to install the licenses on the local drive.
- Licenses may only be installed on a non-compressed drive.

**Note**

After uninstalling WinCC, the licenses remain installed on the system.
1.1.5 Activating and testing ASIA licenses

Overview

The license keys for WinCC Runtime and WinCC RC (Runtime and Configuration) are provided on the supplied license storage medium "License Key USB Hardlock".

The licensed ASIA version is executable in parallel to the European version by switching to Unicode.

The "License Key USB Hardlock" (dongle) checks the following conditions:

- WinCC GUI language
- Runtime language
- The Text Library contains an Asian language.
- Asian characters are used in the WinCC project.
- Operating system settings

You can find more information about installing the license under "Licenses and licensing".

Note

It is not allowed to run WinCC in process mode without a valid license.

Installed Languages

A newly created project receives all installed WinCC languages as project languages.

Testing the validity of the licenses

If you start a correctly licensed WinCC version without a connected dongle, the following error message appears:

WinCC Information

WinCC Runtime License [IN20]

For this version of WinCC, the license data carrier must be available at the USB interface.

Connect the license data carrier with the USB interface or check your hardware.

The same error message appears after a few minutes if you disconnect the dongle from the computer with a correctly licensed WinCC version.

If this error message does not appear, a non-licensed WinCC version is installed.

No right of usage for WinCC is available in this case. Remove this WinCC version and obtain a legal, licensed version of WinCC V7.
If necessary, contact WinCC Support and provide the serial number of your software version:


You can find the serial number on the "Certificate of License" (CoL).

**Working with the "License Key USB Hardlock"

Please note the following:

- Do not edit data on the "License Key USB Hardlock".
  The actions not allowed include:
  - Rename data
  - Delete data
  - Copy data to the "License Key USB Hardlock"

- Do not format the "License Key USB Hardlock".

- Do not remove the "License Key USB Hardlock" from the PC while WinCC is running.

---

**NOTICE**

**Do not remove the "License Key USB Hardlock" dongle**

If you remove the dongle from the computer, an error message is generated and WinCC switches to Demo mode.

If you re-connect the dongle to the computer, the error message disappears and Demo mode is disabled. WinCC works once again in licensed mode.

---

**See also**

1.1.6 WinCC installation requirements

1.1.6.1 WinCC Installation Requirements

Introduction

You will need special hardware and software for the installation of WinCC. The requirements are described in the chapters "Hardware Requirements for Installation" and "Software Requirements for Installation".

Note

Windows operating system: Avoid changes in system

Windows settings deviating from default can have an effect on operation of WinCC.

Observe this note particularly for the following changes:
- Change of processes and services in Control Panel.
- Changes in Windows Task Manager.
- Changes in Windows registry.
- Changes in Windows security policies.

The first check if certain conditions are met is already executed during the installation of WinCC. The following conditions are checked:

- Operating system
- User Rights
- Graphic Resolution
- Internet Explorer
- MS Message Queuing
- Due Complete Restart (Cold Restart)

Error Messages

If one of these conditions is not met, the WinCC installation will be aborted and an error message will be displayed. For details about the error messages displayed see the table below.

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>To execute installation properly, restart the computer</td>
<td>The software installed on your computer requires a restart. Before WinCC can be installed, the computer should be restarted once.</td>
</tr>
<tr>
<td>This application requires VGA or any higher resolution</td>
<td>Check the settings of the connected monitor and upgrade the graphic card, if necessary.</td>
</tr>
<tr>
<td>You do not have administrator rights. Log on as administrator.</td>
<td>Administrator rights are required for the installation. Please log in to Windows again as a user with administrator rights.</td>
</tr>
<tr>
<td>Error Message</td>
<td>Explanation</td>
</tr>
<tr>
<td>------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Setup has detected that unInstallShield is active. Please close unInstallShield and restart Setup.</td>
<td>Close unInstallShield. This message may also indicate that you are lacking administrator rights for this installation. In this case, log on to Windows again as user with administrator rights.</td>
</tr>
<tr>
<td>The Microsoft Message Queuing services are not installed.</td>
<td>Install the Microsoft Message Queuing services. To do this, you will need the Windows installation CD. You can find detailed information in the section &quot;Installing Microsoft Message Queuing&quot;.</td>
</tr>
</tbody>
</table>

See also

- Defining Access Rights in the Operating System (Page 27)
- How to Adapt the Windows Security Policies (Page 33)
- How to Install MS Message Queuing (Page 34)
- Notes on Data and System Security (Page 25)
- Software requirements for installing WinCC (Page 19)
- Hardware requirements for installing WinCC (Page 17)
- Microsoft SQL Server for WinCC (Page 24)

1.1.6.2 Hardware requirements for installing WinCC

Introduction

Certain hardware configuration conditions must be fulfilled for installation.

Hardware requirements

WinCC supports all common IBM/AT-compatible PC platforms.

To efficiently work with WinCC, select a system with the recommended specifications.

Note

Unless noted to the contrary, the same requirements as for servers are applicable to single-user systems.
## Minimum Recommended CPU

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Dual core CPU</td>
<td></td>
<td>Dual core CPU</td>
</tr>
<tr>
<td>Client / single-user system 2.5 GHz</td>
<td>Client / single-user system / server: 2.5 GHz</td>
<td></td>
</tr>
<tr>
<td>Multi core CPU</td>
<td></td>
<td>Multi core CPU</td>
</tr>
<tr>
<td>Client: 3 GHz</td>
<td></td>
<td>Client: 3 GHz</td>
</tr>
<tr>
<td>Single-user system: 3.5 GHz</td>
<td>Single-user system / server: 3.5 GHz</td>
<td></td>
</tr>
</tbody>
</table>

## Minimum Recommended Work memory

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Client: 2 GB</td>
<td></td>
<td>4 GB</td>
</tr>
<tr>
<td>Single-user system: 4 GB</td>
<td></td>
<td>8 GB</td>
</tr>
</tbody>
</table>

## Minimum Recommended Free storage space on the hard disk

- for the installation of WinCC
- for working with WinCC

<table>
<thead>
<tr>
<th></th>
<th>Installation:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client: 1.5 GB</td>
<td></td>
</tr>
<tr>
<td>Server: &gt; 1.5 GB</td>
<td></td>
</tr>
<tr>
<td>Working with WinCC:</td>
<td>Client: 1.5 GB</td>
</tr>
<tr>
<td></td>
<td>Server: 2 GB</td>
</tr>
</tbody>
</table>

## Minimum Recommended Virtual work memory

<table>
<thead>
<tr>
<th></th>
<th>1.5 x RAM</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client: 1.5 GB</td>
<td></td>
</tr>
<tr>
<td>Server: 2 GB</td>
<td></td>
</tr>
</tbody>
</table>

## Minimum Recommended Color depth / Color quality

<table>
<thead>
<tr>
<th></th>
<th>256</th>
<th>Highest (32 Bit)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution</td>
<td>800 * 600</td>
<td>1920 * 1080 (Full HD)</td>
</tr>
</tbody>
</table>

1) Depending on project size and on the size of archives and packages.

2) WinCC projects should not be stored on compressed drives or directories.

3) Use the recommended value in the area “Total size of swap file for all drives” for “Size of swap file for a specific drive”. Enter the recommended value in both the "Start size" field as well as in the "Maximum size" field.

### Note

In the case of online configuration, the recommended requirements are valid as the minimum requirement.

### Virtualization

The following virtualization systems are tested:

- Microsoft Hyper-V 2012 R2 / 2016
- VMware ESXi 6.5 / 6.7

### Requirement

The performance data of the virtual computers must meet the minimum requirements for WinCC clients.
You can find additional information about virtual environments with WinCC at the following URL (entry ID=49368181):


See also

- Defining Access Rights in the Operating System (Page 27)
- Notes on Data and System Security (Page 25)
- Software requirements for installing WinCC (Page 19)

1.1.6.3 Software requirements for installing WinCC

Introduction

Certain requirements concerning operating system and software configuration must be met for the installation.

Note

WinCC is enabled for operation within a domain or workgroup.

Note however that domain group policies and restrictions in the domains may prevent installation. In this case, remove the computer from the domain before installing Microsoft Message Queuing, Microsoft SQL Server and WinCC. Log on to the computer concerned locally with administrator rights. Carry out the installation. Following successful installation, the WinCC computer can be registered in the domain again. If the domain-group policies and domain restrictions do not impair the installation, the computer must not be removed from the domain during installation.

Note however that domain group policies and restrictions in the domain may also hinder operation. If these restrictions cannot be overcome, operate the WinCC computer in a work group. If necessary, contact the domain administrator.

Operating systems

Operating system languages

WinCC is released for the following operating system languages only:

- German
- English
- French
- Italian
- Spanish
- Chinese (Simplified, PR China)
Configurations
When using more than one server, all servers must be operated with a uniform operating system:
Windows Server 2012 R2 or 2016 uniformly Standard or Datacenter edition in each case.

Single-user systems and clients

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Configuration</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 10 ¹)</td>
<td>Pro</td>
<td>Standard installation 64-bit</td>
</tr>
<tr>
<td></td>
<td>Enterprise</td>
<td>If you are using Simatic Net, observe the information in the Simatic Net &quot;readme&quot; file.</td>
</tr>
<tr>
<td>Windows 10 ¹)</td>
<td>Enterprise LTSB (Long-Term Servicing Branch)</td>
<td>Standard installation 64-bit</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If you are using Simatic Net, observe the information in the Simatic Net &quot;readme&quot; file.</td>
</tr>
</tbody>
</table>

¹) The currently released build versions of Windows 10 are listed in the Compatibility Tool.

You can also run single-user systems and clients in WinCC multi-user systems on Windows Server 2012 R2 / 2016.

WinCC Server

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Configuration</th>
<th>Comments</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Server 2012 R2</td>
<td>Standard Datacenter</td>
<td>64-bit</td>
<td></td>
</tr>
<tr>
<td>Windows Server 2016</td>
<td>Standard Datacenter</td>
<td>64-bit</td>
<td></td>
</tr>
</tbody>
</table>

WinCC server with up to three WinCC clients

It is also possible to operate a WinCC Runtime server on Windows 10 if you are not running more than three clients.

WinCC ServiceMode is not released for this configuration.

Note

Only enable the terminal server for WinCC/WebNavigator

WinCC is not suitable for use on a Microsoft terminal server.

You can use the Microsoft terminal server only in connection with the WinCC Web client. Note the installation instructions of the WinCC/WebNavigator.
Virus scanner
You can find information on the use of virus scanners as well as approved virus scanner versions in the WinCC Release Notes under "Notes on operation (Page 50)."

Microsoft Windows Patches / Updates: Compatibility with SIMATIC products
Note the latest information on compatibility of SIMATIC products with Microsoft patches and updates:

- FAQ 18752994 [https://support.industry.siemens.com/cs/ww/en/view/18752994]

Windows computer name
Do not change the computer name
Do not change the Windows computer name after installing WinCC installation.

Illegal characters
The following characters are not permitted in the computer name:

- . , ; : ! ? " ' ^ ` ~ _
- + = / \ @ * # $ % & § °
- ( ) [ ] { } < >
- Space character

Note the following:
- Only uppercase relevant
- The first character must be a letter.

Microsoft Message Queuing services
WinCC requires Microsoft Message Queuing services. You can find detailed information in the section "Installing Microsoft Message Queuing".

Microsoft .NET Framework
Before installing WinCC ensure that .NET Framework is activated.

<table>
<thead>
<tr>
<th>As of Windows 10</th>
<th>This version may be required for the installation of the SQL Management Studio:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Server 2012 R2</td>
<td>Microsoft .NET Framework 3.5</td>
</tr>
<tr>
<td>Windows 10 / Windows Server 2016</td>
<td>Microsoft .NET Framework 4.6.1 ¹</td>
</tr>
</tbody>
</table>

¹) If necessary, install the .NET Framework version subsequently.
Internet Explorer - requirements

You can find the browser requirements for WinCC options in the respective installation notes for the option.

You need Microsoft Internet Explorer to open the WinCC online help. Recommended versions:

- Microsoft Internet Explorer V11.0 (32-bit)

If you wish to fully use WinCC’s HTML Help, you must permit the use of JavaScript under "Internet Options" in Internet Explorer.

**Note**

Do not disable Internet Explorer.

Operation with multiple network adapters

When a server is used with several network adapters, read the notes in the WinCC Information System under "Configurations > Distributed Systems > System behavior in Runtime > Special features of communication using a server with several network adapters".

Adapting security policies

The operating system must permit the installation of unsigned drivers and files. Detailed information is available in the section "Adapting Security Policies under Windows".

**Note**

An update of the operating system is not permitted if WinCC is started. Start the computer again after updating the operating system.

Checking the "Path" environment variable

Before starting WinCC, you should check the entries in the "Path" environment variable.

A few programs insert paths containing quotation marks in the environment variable. These paths can prevent WinCC from starting or limit its functionality. The paths with quotation marks can also interfere with the software of other manufacturers.

Open the "System properties" dialog in the Control Panel. Open the "Environment variables" dialog using the "Environment variables" button on the "Advanced" tab, and display the value of the "Path" system tag.

If the "Path" system tag contains paths with quotation marks, reorder the entries so that these paths are called last.
Microsoft Internet Information Service (IIS)

Before installing the following components or options, you must first install the Microsoft Internet Information Service (IIS):

- WinCC OPC XML DA Server
- WinCC/DataMonitor
- WinCC/WebNavigator
- WinCC/WebUX

The IIS settings for the WinCC/DataMonitor, WinCC/WebNavigator and WinCC/WebUX options can be found in the respective installation notes.

**WinCC OPC XML DA Server: Configuring the settings**

In Windows Server 2012 R2 / 2016, configure the settings in the Server Manager using the "Web server (IIS)" role in the associated role services.

Select the following settings:

- Web Management Tools:
  - IIS Management Service
  - IIS Management Console
  - IIS Management Scripts and Tools
  - Compatibility with IIS Metabasis and IIS 6 configuration
  - Compatibility with WMI for IIS 6
- WWW Services > Common HTTP Features or Shared HTTP Features:
  - Standard document
  - Static content
- WWW Services > Application Development Features:
  - .NET extendibility
  - ASP
  - ASP.NET
  - ISAPI Extensions
  - ISAPI Filters
- WWW Services > Security:
  - Request Filtering
  - Basic Authentication
  - Windows Authentication
Note
Always install Microsoft Internet Information Service (IIS) with ASP.NET and ASP
Always install ASP.NET and ASP when you install the Microsoft Internet Information Service (IIS).

WinCC OPC XML DA Server: Firewall settings
The web service of the WinCC OPC XML DA server communicates over port: 80 (HTTP).
Make sure that the firewall rule "WWW services (HTTP)" is selected and activated for the required network areas.

See also
Microsoft SQL Server for WinCC (Page 24)

1.1.6.4 Microsoft SQL Server for WinCC
WinCC requires Microsoft SQL Server 2016 SP2 in the 64-bit version:
- Microsoft SQL Server 2016 SP2 64-bit Standard Edition
- Microsoft SQL Server 2016 SP2 64-bit Express Edition
SQL Server is included automatically in the WinCC installation.

Microsoft SQL Server 2016 SP2
The corresponding user rights must be set up for accessing the SQL Server data. Read the notes in the section "Defining access rights in the operating system (Page 27)".
Note the information on licensing of the SQL Server under "Licenses and licensing".
When you install WinCC/Connectivity Pack, the required connectivity components are installed along with the Microsoft SQL Server.

SQL server instance "WinCC"
During installation, a new "WinCC" instance with the required settings is created with Microsoft SQL Server.
This instance is always installed in English. The language in which existing SQL server instances have been installed has no effect on this. Existing instances are not affected by the Service Pack.

"WinCC" instance after removing WinCC
When WinCC is removed, the "WinCC" SQL server instance remains installed and must be removed manually for licensing reasons.
Installation of SQL Server Express

SQL-Express is installed in the following cases:

- Installation of "WinCC client"
- Installation of the WinCC V7 demo version

Requirement for the installation of SQL-Express
The Windows user name of the user performing the installation must not contain any space characters.

SQL Server Management Studio

The SQL Server Management Studio is no longer part of the SQL Server installation. If you want to install SQL Server Management Studio, use the provided "Additional Content" DVD.

See also

- Defining Access Rights in the Operating System (Page 27)
- Software requirements for installing WinCC (Page 19)
- Access rights in the operating system (Page 27)

1.1.6.5 Notes on Data and System Security

Introduction

System security when using WinCC can be increased by implementing simple measures. You can find additional information in the "WinCC Release Notes > Notes on Operation > AUTOHOTSPOT".

You can find information on the remote access under "WinCC Release Notes > Notes on WinCC > Remote access and Remote Desktop Protocol (RDP) (Page 72)".

Information on write access for WinCC project folders can be found under "Access rights in the operating system > Defining Access Rights in the Operating System (Page 27)".

Activating WinCC remote communication

On WinCC systems remote communication is disabled by default after the installation. For the following scenarios you must activate the remote communication of the participating computers:

- Client-server communication
- Redundant system
To enable remote access, proceed as follows:
1. Open the communication settings using the shortcut menu of SIMATIC Shell in Windows Explorer.
2. Select the "Remote Communication" option.
3. Configure the encrypted communication in the network: Select the PSK key and the port.
4. Select the network adapter and, if required, the Multicast settings.

**Firewall settings**

To limit the incoming rule for the CCAgent, you can change the parameter "Remote address" from "Any" to "Local subnet".

You can edit the firewall rules in the "Windows Firewall with Advanced Security" dialog.

**Preventing Access to the Operating System Layer in Runtime**

If the Windows Selection dialog is opened in an activated WinCC project, access to the Windows operating system is possible using this function. A Windows Selection dialog is opened, for example, when data is imported or files are selected.

Protect the corresponding function by executing a Permission Check via the User Administrator to prevent unauthorized access to the operating system.

**Preventing access to the Windows toolbar**

You can use the computer properties to prevent the Windows taskbar from being displayed in Runtime. Open the "Parameters" tab in the "Computer properties" dialog and deactivate all the shortcut keys in the "Disable Keys" area.

In addition, deactivate the "Keep the taskbar on top of other windows" setting in Windows.

**Disabling shortcut keys**

If you would like to disable shortcut keys, you must adapt the group policies in the operating system management.

A detailed description of this can be found in the FAQ with entry ID "44027453" in the SIMATIC Customer Online Support:


**Shortcut key <Ctrl+Esc>**

If you disable the <Ctrl+Esc> shortcut key, the following shortcut keys are also disabled in Runtime:

<table>
<thead>
<tr>
<th>Keyboard shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Windows key+U&gt;</td>
<td>System utility program manager</td>
</tr>
<tr>
<td>Press &lt;Shift&gt; five times</td>
<td>Locking function</td>
</tr>
<tr>
<td>Press &lt;Shift right&gt; for eight seconds</td>
<td>Impact delay</td>
</tr>
<tr>
<td>&lt;Alt left+Shift left+Num&gt;</td>
<td>Keyboard mouse</td>
</tr>
<tr>
<td>&lt;Alt left+Shift left+Print&gt;</td>
<td>High contrast</td>
</tr>
</tbody>
</table>
Note

The functions can be configured using the Windows Control Panel.

If the functions are activated in the Windows Control Panel before activating WinCC Runtime, they are no longer locked in runtime.

Checklist for technical implementation

You can find additional information on configuring your system in the following document in the "Industry Online Support":


See also

- Defining Access Rights in the Operating System (Page 27)
- How to Adapt the Windows Security Policies (Page 33)
- How to Install WinCC (Page 36)
- Notes on operation (Page 50)
- Remote access and Remote Desktop Protocol (RDP) (Page 72)

1.1.6.6 Access rights in the operating system

Defining Access Rights in the Operating System

Introduction

To support you in protecting your system, WinCC offers a structured user management:

- Protect your system against unauthorized access.
- Assign each user the required rights.

In order to work with WinCC, certain folders can be enabled for access via the network. For security reasons, you should only assign access rights to these folders to authorized users. You manage access rights via the Windows Standard user groups and user groups created by WinCC.
Access rights specified in WinCC

Following WinCC installation, WinCC automatically establishes the following local groups in Windows User and Group Administration:

- "SIMATIC HMI"
  All users must be members of the "SIMATIC HMI" user group. These members may create local projects, and may process, start, and access these projects remotely. Access to the WinCC database is limited to the minimum rights necessary (read/write). By default, the user who carries out the WinCC installation and the local administrator are members of this group. Additional members must be added manually by an administrator.

- "SIMATIC HMI Viewer"
  These members have read access only to configuration and runtime data in the WinCC database. This group is primarily used for accounts for Web publication services, e.g., IIS (Internet Information Services) account for operation of WinCC WebNavigator.

- Access to folder "<Installation Directory>/WinCC/aplib"
  Following installation, the directory "Installation Directory/WinCC/aplib" named "SCRIPTFCT" is unlocked for the "SIMATIC HMI" user group. This directory contains central libraries for project script functions.

WinCC folder share

With access via folder shares, the folders of a WinCC project are generally read-only. Access to the WinCC project folders and project data from the network via Windows is read-only.

Release project folder for write access

The "SIMATIC HMI" user group needs full access to the project folders of a server in the following cases:

- Access via scripts or open interfaces, e.g. when using WinCC/ODK
- Access via multiuser engineering
- Access of clients with own project
- Integrated projects (SIMATIC Manager)

To enable full access to the WinCC project folders, disable the following option in the "Project properties" dialog:

- The project directory is only released for read access.

Make sure that full access is restricted to the necessary user groups or users.

You can change the option while runtime is activated.

The change is applied immediately.

User Groups and User Rights

The following overview contains the tasks of the different user groups with the access rights and instructions required to assign these access rights.
WinCC Installation

- Task: WinCC Installation
- Role: Configuration engineer, Administrator
- Authorization: Windows Administrator rights
- Procedure:
  Prior to installation, ensure that you have local administrator rights on the computer.
- Explanation:
  You need local administrator rights to install WinCC.

Preparation for operation

- Task: Access to WinCC
- Role: Configuration engineer, Administrator
- Authorization: Power user rights, Administrator rights
- Procedure:
  After installation, set up the administrative settings as administrator or power user.
- Explanation:
  Power user rights are the minimum requirements for administrative settings, e.g. the authorization of file rights or printer driver settings.
  To delete a WinCC project completely, you must have power user rights, at a minimum.

Local user rights when operating WinCC

- Task: Operator input in Runtime, configuration
- Role: WinCC user (operator, configuration engineer)
- Authorization:
  - Windows group "User"
  - User group "SIMATIC HMI"
- Procedure:
  Add the user to the "SIMATIC HMI" user group and, at a minimum, to the Windows "User" user group.
- Explanation:
  In order to operate WinCC or for remote access to a WinCC project on the client and server, the user must be a member of the "SIMATIC HMI" user group.

Access to distributed systems

- Task: Access to distributed systems
- Role: WinCC user (operator, configuration engineer)
- Authorization: Uniform user groups on all computers
• Procedure:
Enter the WinCC users on all computers in the same group.
Assign the same password to all the users.

• Explanation:
For access to distributed systems, the same user groups must be created on clients and servers.

Access rights for local projects
• Task: Access to projects which were created as follows:
  - Manual copy
  - Duplicate
  - Retrieval
  - Migration

• Role: WinCC user (operator, configuration engineer)

• Authorization: SIMATIC HMI, SIMATIC HMI Viewer

• Procedure:
Assign full access rights to the project folder for the "SIMATIC HMI" group.
To do so, open the project following its creation once as administrator or power user.
Alternatively, you can specify access rights in the Windows Computer Management.
Even if you want to copy projects with the Project Duplicator you will need the appropriate authorizations. You will either have to grant access to the used folders or duplicate them as main user.

• Explanation:
When a local project is newly created, the members of user groups "SIMATIC HMI" and "SIMATIC HMI Viewer" automatically receive the necessary access rights to the project directory.
However, when projects are copied, logged, or migrated, the local authorizations are not transferred but must be reassigned.

Access rights to system information
• Task: Access to system information via the WinCC channel "System Info"

• Role: Operator

• Authorization: System monitor user

• Procedure:
Into the Windows group "System monitor user", accept all users who require the following system information of the WinCC channel "System Info":
  – CPU load
  – Status of the export file

• Explanation:
Users with Windows standard user rights do not have access to certain system information.
Including users in the "SIMATIC HMI" user group

Introduction

Include those local users in the "SIMATIC HMI" group whose login permits access to WinCC. You must first create local users to do so. Users of a domain may be directly included in the user group "SIMATIC HMI".

WinCC/WebNavigator: Users of the Web client

When you install the WebNavigator client on the WinCC PC, you must also include the users of the Web client in the user group "SIMATIC HMI" or "SIMATIC HMI VIEWER".

Procedure

1. Open the workstation administration under Windows.
2. Select the entry "Local Users and Groups > Users" in the navigation window. All local users are displayed in the data window.
3. Open the "New User" dialog via the shortcut menu. Create a user account with the same login for each user who is to have access to WinCC.
4. Select the entry "Local Users and Groups > Groups" in the navigation window. All groups are displayed in the data window. Select the "SIMATIC HMI" group.
5. Using the shortcut menu, open the "Add Member" dialog and include those users as members of the "SIMATIC HMI" user group.

Including domain-global user group in the "SIMATIC HMI" user group

Introduction

During operation of a domain, an additional domain-global user group may be created and included as a member of the "SIMATIC HMI" user group.
Requirements

- The domain administrator creates a domain-global user group.
- Within the domain, the domain administrator includes those users in the domain whose login permits access to WinCC.

Procedure

1. Open the workstation administration under Windows.
2. In the navigation window, select the "Local Users and Groups > Groups" entry. The data window displays all groups. Select the group "SIMATIC HMI".
3. Using the pop-up menu, open the "Add Member" dialog and include domain-global user group as members of the "SIMATIC HMI" user group.

Release existing project for "SIMATIC HMI" user group

Introduction

You must first remove the existing release of the project directory if the user group "SIMATIC HMI" has to access an existing user group. Then the project is released again while opening WinCC Explorer.

Procedure

1. Open the workstation administration under Windows.
2. In the navigation window, select the entry "Shared Folders > Shares". The data window displays all unlocked directories.
3. Select the respective project directory and remove the enable through the "Cancel Share" pop-up menu.
4. If you now open the project in WinCC, the project directory is automatically unlocked for the "SIMATIC HMI" user group, and all members of the user group are granted access to the project directory.

Note

The enable name of the directory unlocked by WinCC must not be modified.
1.1.6.7 How to Adapt the Windows Security Policies

Introduction

Before you install WinCC, you must check the operating system settings:

- The system must permit the installation of unsigned drivers and files.

Procedure

1. To open the Windows entry field, select the entry "Run" in the "Windows System" program group.
2. Enter "gpedit.msc" in the input box. The "Local Group Policy Editor" dialog box opens.
3. In the left section of the window under "Policy for local computer", select "Computer Configuration > Administrative Templates > System > Device Installation > Device Installation Restrictions".
4. Check the settings of the security policies below:
   - "Display a custom message when installation is prevented by policy (balloon text)"
   - "Display a custom message when installation is prevented by policy (balloon title)"
   "Not configured" must be set for the policy.

See also

- Notes on Data and System Security (Page 25)
- Defining Access Rights in the Operating System (Page 27)
- Software requirements for installing WinCC (Page 19)
- WinCC Installation Requirements (Page 16)

1.1.7 Installing WinCC

1.1.7.1 Installing WinCC

Introduction

This section describes the installation of WinCC.

Install MS Message Queuing before you install WinCC.
Installation of a WinCC file server

If a WinCC server is set up which is to be used for project data archiving only, only the WinCC file server needs to be installed. You can find more information in the WinCC Information System, in the section "Configurations > Fileserver".

Note

Usage only with administrator rights

If you want to use the Fileserver, you need administrator rights.

Fileserver installation requirements

WinCC V7 and WinCC Fileserver V7 cannot be installed at the same time on one computer.

Installation of WinCC Options

The WinCC DVD contains the following options:

- WinCC/Connectivity Pack / Connectivity Station
- WinCC/DataMonitor
- WinCC/WebNavigator
- WinCC/WebUX

These options require their own licenses.

If you purchase a WinCC option at a later date, you will receive the necessary licenses on a license data carrier. An installation DVD is not supplied. Use the WinCC DVD for installation.

See also

Upgrading WinCC (Page 46)
How to Install Supplementary Components Later (Page 40)
How to Install WinCC (Page 36)
How to Install MS Message Queuing (Page 34)
Hardware requirements for installing WinCC (Page 17)

1.1.7.2 How to Install MS Message Queuing

Introduction

WinCC implements the Message Queuing services from Microsoft. It is a component part of the operating system.
MS Message Queuing is however not included in the standard Windows installation and must be installed separately if required.

---

**Note**

WinCC is enabled for operation within a domain or workgroup.

Note however that domain group policies and restrictions in the domains may prevent installation. In this case, remove the computer from the domain before installing Microsoft Message Queuing, Microsoft SQL Server 2016 and WinCC. Log on to the computer concerned locally with administrator rights. Carry out the installation. Following successful installation, the WinCC computer can be registered in the domain again. If the domain-group policies and domain restrictions do not impair the installation, the computer must not be removed from the domain during installation.

Note however that domain group policies and restrictions in the domain may also hinder operation. If these restrictions cannot be overcome, operate the WinCC computer in a workgroup.

If necessary, contact the domain administrator.

---

**Procedure - Windows 10**

1. Go to "Control Panel > Programs and Features".
2. Click the "Turn Windows features on or off" button on the left menu bar. The "Windows Features" dialog opens.
3. Activate the "Microsoft Message Queue (MSMQ) server" component. The "Microsoft Message Queue (MSMQ) Server Core" entry is selected. The subcomponents remain disabled.
4. Confirm with "OK".

---

**Procedure - Windows Server 2012 R2 / Windows Server 2016**

1. Start the Server Manager.
2. Click on "Add roles and features". The "Add Roles and Features Wizard" window opens.
3. Click "Server selection" in the navigation area. Ensure that the current computer is selected.
4. Click "Features" in the navigation area.
5. Select the following options:
   - "Message queuing"
   - The "Message Queuing Services" option below
   - The "Message Queuing Server" option below
6. Click "Install".
1.1 WinCC Installation Notes

See also

How to Install WinCC (Page 36)
WinCC Installation Requirements (Page 16)

1.1.7.3 How to Install WinCC

Introduction

This section describes how to install and run WinCC. The components already installed are displayed during setup. The following symbols are used:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️</td>
<td>Current version of program is installed.</td>
</tr>
<tr>
<td>⬆️</td>
<td>Program is being updated.</td>
</tr>
<tr>
<td>⚠️</td>
<td>Program setup conditions are not met. Click the symbol for more detailed information.</td>
</tr>
<tr>
<td>□</td>
<td>Program can be selected.</td>
</tr>
<tr>
<td>✔️</td>
<td>Program selected for installation.</td>
</tr>
<tr>
<td>□</td>
<td>Program cannot be selected (due to dependence on other programs).</td>
</tr>
<tr>
<td>✔️</td>
<td>Program selected for installation (cannot be deselected).</td>
</tr>
</tbody>
</table>

Scope of Installation

During custom installation of WinCC, you can choose between the following variants:

<table>
<thead>
<tr>
<th>Typical</th>
<th>• WinCC Runtime</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• WinCC CS</td>
</tr>
<tr>
<td></td>
<td>• Basic Process Control</td>
</tr>
<tr>
<td></td>
<td>• SQL Server</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Complete</th>
<th>&quot;Typical&quot;, including:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• OPC servers</td>
</tr>
<tr>
<td></td>
<td>• SmartTools</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Expert mode</th>
<th>Custom installation:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>You can select or deselect individual components in &quot;WinCC Expert&quot;.</td>
</tr>
</tbody>
</table>
1) When installing the "WinCC Client", you need an "RT Client" or "RC Client" client license.

You can also install or remove components and languages at a later time. Read the sections "How to perform a supplementary installation" and "How to perform a supplementary installation of languages" for more on this.

The required drive space depends upon the installed components. An estimated value is shown in the status bar.

**WinCC remote communication**

Remote access is disabled by default after the installation.

If you use a redundant system or a client-server system, for example, activate the remote communication in the SIMATIC Shell settings.

You can find additional information under "Notes on Data and System Security (Page 25)".

**Installation of WinCC Options**

You can installed the desired options during the installation of WinCC itself.

The documentation for some of the options will be available only if the concerned option package is installed.

**Automatic Migration when a WinCC Project of a Previous Version is Opened**

When you open a project that was created with a version older than WinCC V7.5, the configuration data and Runtime data are automatically migrated. Convert the pictures and libraries with the Project Migrator or manually via the WinCC Explorer.

You can find detailed information about migration in the WinCC Information System under "First Steps > Migration".

**Requirements**

- Make sure that no other setup is running on the computer at the same time, for example, a Windows update.
- You need local administrator rights to install WinCC.
- Information on user rights, which is necessary for the operation of WinCC, is located in section "Instructions for Security of Data and System".
- The computer name may only contain permissible characters.
- The Windows component "MS Message Queueing" services must have been installed.
- The security policies must be adapted under Windows.
- No manually created SQL server entity with the name "WinCC" may be installed.
• The storage medium with the licenses is still not to be connected with the installation computer.

• If you want to use the OPC-XML-DA-Server from WinCC, the Microsoft Internet Information Service (IIS) must be installed before installing the OPC-XML-DA-Server.

WinCC is released for the following operating system languages: English, German, French, Italian, Spanish, Chinese simplified (PRC), Chinese traditional (Taiwan), Japanese, Korean and multi-lingual operating system.

---

**Note**

**Unfulfilled requirements**

An error message is output if you run WinCC Setup without having the administrator rights, or if other setup conditions are not met.

You can find additional information on error messages under "WinCC Installation Requirements (Page 16)".

---

**Procedure**

1. Start the WinCC product DVD.
   - The DVD starts automatically if Autorun is enabled in the operating system.
   - If the Autorun function is not activated, start the program Setup.exe on the DVD.

2. Follow the on-screen instructions.
   Read the License Agreement and the Open Source License Agreement.

3. Select the languages you want to install.
   You may install other languages at a later time.

4. Select "Install" as the setup type.
   If an older WinCC version is found, you can also activate the "Update" setup type. However, this does not allow you to install any additional products.

5. Select the setup mode.

6. In Package installation, select the Program package "WinCC Installation".
   - If you also want to install WinCC options, select the corresponding program packages.
   - Select "WinCC Client Installation" if you only want to install the WinCC client.
   - Select the scope of your installation in User-defined installation.
   The components to be installed are highlighted in Setup.
   Click on "Help" for a description of the displayed symbols. Click on "Readme" to open the Information System.

7. Read the license agreement for the Microsoft SQL Server.

8. Before the installation, the security settings that are adapted for WinCC are displayed in the "System Settings" dialog. The firewall is configured automatically.
   Confirm the changes to the system settings.
9. Start the installation.
   You can track the status of the installation in the displayed dialog. Select "Cancel" to cancel
   the installation of the current component.

10. You can transfer the product License Keys after having installed the components.
    To do so, click on "Transfer License Key".
    Select "Next" if you have already transferred the license keys or want to install them at a
    later time.

   **Note**
   **Transferring the licenses**
   The license keys will not be transferred automatically. You will have to transfer missing
   license keys during or after installation with Automation License Manager.

11. Restart the computer to conclude the installation.

**Entries in the "Siemens Automation" program group**

After the installation of WinCC, you will find the new entries in the "Siemens Automation"
program group.

- **Starting WinCC Explorer:**
  - WinCC Explorer

- **Editors and tools for working with WinCC:**
  - Autostart
  - Channel Diagnosis
  - Cross Reference Assistant
  - Dynamic Wizard Editor
  - Project Duplicator
  - Project Migrator
  - Tag Export Import
  - WinCC Documentation Viewer
  - WinCC Tag Simulator

- **Documentation on WinCC:**
  - Documentation > Manuals

To open the online help of WinCC and the installed WinCC options, select the "WinCC
Information System" link in the language folder.
Print versions of the WinCC Information System:
  - PDF files in the installation path under "WinCC > Documents"

- **Management of the licenses:**
  - Automation License Manager
  - License Analysis
- Security Controller for display of the customized security settings:
  - Security Controller
- Overview of the installed SIMATIC software and the components:
  - Inst. Software

See also
- Upgrading WinCC (Page 46)
- Notes on Data and System Security (Page 25)
- Defining Access Rights in the Operating System (Page 27)
- How to Install MS Message Queueing (Page 34)
- How to Adapt the Windows Security Policies (Page 33)
- How to Install Supplementary Components Later (Page 40)
- WinCC Installation Requirements (Page 16)

1.1.7.4 How to Install Supplementary Components Later

Introduction
Once you have installed WinCC, you can then install further components or options at a later date.

Installation of WinCC Options
The WinCC DVD contains the following WinCC Options:
- WinCC/Connectivity Pack / Connectivity Station
- WinCC/DataMonitor
- WinCC/WebNavigator
- WinCC/WebUX

These options require their own licenses.
If you purchase a WinCC option at a later date, you will receive the necessary licenses on a license data carrier. An installation DVD is not supplied.
Use the WinCC DVD for installation.
Procedure

1. Start the WinCC product DVD. If the Autorun function is not activated, start the program Setup.exe on the DVD.
2. Specify whether you wish to install individual components or options. The already installed components will be displayed.
3. Follow the on-screen instructions.

Installation path of SmartTools

Run the SmartTools setup from the following path on your WinCC DVD:

- “Instdata\Smarttools\Setup\Setup.exe”

See also

WinCC Installation Requirements (Page 16)
How to Install WinCC (Page 36)

1.1.7.5 How to Install Supplementary Languages

Introduction

Once you have installed WinCC, you can later install additional languages.

Procedure

1. Open the “Programs and Features” entry in the Control Panel.
2. Select “SIMATIC WinCC Runtime V7.5” and click the “Change” button. The WinCC Setup program opens.
3. Select the desired languages.
4. When prompted, insert the WinCC product DVD in the DVD drive. Once the start page of the DVD is opened via Autorun function, close the window with “Exit”.
5. Follow the instructions on the screen.
6. If you have installed WinCC CS, select “SIMATIC WinCC Configuration V7.5” and click the “Change” button. Repeat steps 3 to 5 for WinCC CS. Repeat this procedure for any additionally installed components and options.
1.1.7.6 Configure automatic installation of WinCC

The "Central installation" function

Configuring automatic installation
To install WinCC on multiple PCs, use a central installation.

Central setup storage: Note the path length
When you store the setup at a central location and launch it from a network drive, use the shortest possible folder names.

The path length of the drive name, file folder and setup files may be no longer than 255 characters.

Record function
The Record function supports multiple installation on different computers with identical options.

During setup, the Record function records the settings and creates a "Ra_Auto.ini" installation file which supports you during installation.

While in the past you had to navigate through all setup dialogs for each installation, all you have to do now is start setup with the "Ra_Auto.ini" control file.

Conditions for using the record function
- Central installation is only possible for the respective setup version that is available at the time.
  A central installation of WinCC has no effect on the subsequent installation of updates or options.
- The "Expert mode" scope of installation cannot be used for automatic installation.
  In Expert mode, the installation dialog is opened for each product even when you have saved the installation settings with the Record function.

Overview of the procedure
The following steps are required for a central installation:

1. Call the Record function and create the "Ra_Auto.ini" control file.
2. Start central installation.

Calling the Record function of the central installation
You use the Record function to create the "Ra_Auto.ini" control file which includes all information for the central installation.

Dependency on operating system
Run the central installation for each operating system version separately.
The control file can only be executed on PCs on which the same operating system version is running. During installation of WinCC, Microsoft updates are installed, for example, which depend on the installed operating system.

Scope of installation for automatic installation

The "Expert mode" scope of installation cannot be used for automatic installation.

Select one of the other available installation methods, e.g. "Typical" or "WinCC Client".

Requirement

- You need administrator rights on your PC.

Procedure

1. To open the Windows entry field, select the entry "Run" in the "Windows System" program group.
2. Enter the following command line:
   
   - <Path for the installation data>\setup.exe /record

   Select the DVD drive or a central PC to which the installation data were copied as path for the installation files.
   
   Setup is started.
3. Select the desired language and click "OK".
   
   The "Record function" dialog is displayed.
4. Activate the Record function.
5. Select the path in which you want to create the "Ra_Auto.ini" control file and confirm with "Next".
6. Select the required components and settings for the installation.
   
   Once you have made the settings, the message "Recording completed" is displayed.

Result

The control file "Ra_Auto.ini" is created and saved in the selected path.

The same setup version must be used for central installation and for creation of the "Ra_Auto.ini" file.

Start central installation

For central installation on the PC of your WinCC system, start an automatic installation.

The settings of the "Ra_Auto.ini" control file are applied in the process.
WinCC V7.5 Installation / Release Notes

1.1 WinCC Installation Notes

Requirement

- You have created the "Ra_Auto.ini" file using the Record function.
  The file "Ra_Auto.ini" must be created with the existing setup version.
- The same operating system version is installed on the PC.

Procedure

1. If required, copy the setup to a central server or PC.
2. Copy the file "Ra_Auto.ini" to the folder "C:\Windows" on the PC to be installed.
3. Start central installation by calling automatic installation:
   - `<Path for the installation data>\setup.exe /silent`
     You may receive a message when the central installation was completed successfully.

Note

If an error or inconsistency occurs during installation, you will receive messages that require your acknowledgement.

4. Repeat this process for each required computer.

Alternative procedure

If the file "Ra_Auto.ini" is not located in the "C:\Windows" folder, start central installation with the following call:

- `<Path for the installation data>\setup.exe /silent=<storage path>\Ra_Auto.ini`

1.1.8 Uninstalling WinCC

Introduction

On your computer, you can remove WinCC completely or simply remove individual components. You cannot remove individual languages.

You can execute the removal via the WinCC product DVD or via the control panel of the operating system.

Procedure: Uninstalling via the WinCC Product DVD

1. Start the WinCC product DVD.
   The DVD starts automatically if Autorun is enabled in the operating system.
   If the Autorun function is not activated, start the program Setup.exe on the DVD.
2. Follow the on-screen instructions.
3. Select "Remove" as the setup type.
4. Select the components that you want to remove.

**Alternative procedure: Uninstalling via the Control Panel**

1. Open the "Uninstall or change a program" dialog in the Windows Control Panel.
2. Select the desired entry.
   - The installed WinCC components always start with "SIMATIC WinCC".
3. Choose the "Uninstall" or "Change" option from the shortcut menu.
   - Remove any WinCC options that may have been installed before you remove the WinCC version.

**Microsoft SQL Server 2016**

After uninstalling WinCC, you also need to remove the "WinCC" SQL server instance:

Choose the "Microsoft SQL Server 2016" entry for removal in the "Uninstall or change a program" dialog.

The use of the Microsoft SQL Server 2016 is only permitted when you have a valid license.

**Automation License Manager / MS Update**

When WinCC is removed, the following programs remain installed, as they may be needed by other SIMATIC products:

- Automation License Manager
- MS Update V1.0 SP1

If, after removing WinCC, you want to install an earlier version of WinCC, you need to remove both of these programs:

Select the respective entry for removal in the "Uninstall or change a program" dialog.

**Removal when the WebNavigator client is installed**

If you remove WinCC from a computer on which the WebNavigator client is installed, you must then reinstall the WebNavigator client.

**Changing the settings in the Windows Event Viewer**

When WinCC is installed, the WinCC Setup program changes the settings of the Event Viewer.

- Maximum Log Size (System Log/User Log): 1028 KB
- Log Continuation (System Log/User Log):
  - "Overwrite events" (Default setting: Overwrite events that are older than 7 days)

After removing WinCC, these settings are not reset.
You can adapt these settings in the Windows Event Viewer yourself.

1.1.9 Upgrading WinCC

1.1.9.1 Upgrading WinCC

Introduction

You can upgrade to WinCC V7.5 as of version WinCC V6.2 SP3 through an upgrade installation.

Proceed as described in "Upgrading an installation" section.

Note

Restart PC before installing the update

Restart the PC before commencing installation of the update to WinCC V7.5.

Requirements for the upgrade

If you are upgrading WinCC versions prior to V7.0 SP3, observe the operating system requirements and hardware requirements.

Additional information on migration of WinCC versions V4 or higher is available under the following URL (entry ID=44029132):


Information on migrating projects

When you open a project of a previous version in WinCC V7.5, you are prompted to migrate it. However, you may also use WinCC Project Migrator to migrate several WinCC projects in a single step.

You still have to make some project settings after migration.

For more information about the migration of projects see section "Migration".

Note

WinCC user no longer needs to be a member of the "SQLServerMSSQLUser$<COMPUTER NAME>$WINCC" user group

When you migrate projects created prior to WinCC V7.2, you remove the WinCC users from this group.

In WinCC projects prior to V7.2, you will find the user group under the name "SQLServer2005MSSQLUser$<COMPUTER NAME>$WINCC".
Notes on licensing

You need to upgrade licenses of WinCC prior to V7.5 to the current version.
You can update the licensing retroactively. Detailed information is available in the WinCC Information System under the topic "Licensing".

See also

How to Perform an Upgrade Installation (Page 47)


1.1.9.2 How to Perform an Upgrade Installation

Introduction

If you currently have WinCC V6.2 SP3 or higher installed on your system, you can perform an upgrade installation.

Before beginning an upgrade installation, the transfer of existing projects must be prepared.

Requirement

The hardware configuration of previous versions is sufficient in most cases to install an upgrade to WinCC V7.5.

However, performance is reduced if the amount of data is increased too much. If it is expected that the data volume will increase, upgrade the hardware in good time.

Note

Restart PC before installing the update

Restart the PC before commencing installation of the update to WinCC V7.5.

Requirements for the upgrade

If you are upgrading WinCC versions prior to V7.0 SP3, observe the operating system requirements and hardware requirements.

Additional information on migration of WinCC versions V4 or higher is available under the following URL (entry ID=44029132):

Upgrade preparation

Note

Backing up a WinCC project
Make a backup copy of your project before upgrading WinCC.

Restart PC before installing the update
Restart the PC before commencing installation of the update to WinCC V7.5.

Additional steps and adjusting settings
Also read the notes in the WinCC Information System under "Migration".

Check the special characters
Before performing an upgrade installation of WinCC, check the existing projects with regard to special characters used in the archive names, archive tag names, trend names, trend window names, column names and table window names. You will find a table with the permitted special characters in the section "Working with WinCC > Working with Projects > References".

It is possible that you must use Tag Logging in WinCC V6.2 SP3 or V7.0 to remove certain special characters from the names.

NOTICE

Transferring archives with impermissible special characters
When transferring archives, if they contain impermissible special characters, the Runtime archive may be lost.

Modified standard functions (ANSI-C)
If modified standard functions (ANSI-C) are used, make backup copies of the functions prior to the upgrade installation.

During the WinCC installation process, these functions are overwritten by the standard functions supplied.

Procedure

1. Prepare existing WinCC projects for migration.
   Check the used names for impermissible special characters.

2. Install WinCC V7.5. Proceed as described in the section "How to install WinCC".
   You need the storage medium that contains the licenses for WinCC V7.5. Upgraded licenses of previous WinCC versions will be lost.

3. Migrate your existing WinCC projects.
   Note the corresponding "First Information > Migration" section in the WinCC Information System.
See also

How to Install WinCC (Page 36)

1.1.10 Overview: Notes on operation

Introduction

For trouble-free operation and optimal performance of WinCC, observe the notes on operation under Windows and the notes on configuration.

You can find this information in the following sections of the WinCC Information System:

- "Release Notes > Notes on operation"
  This section includes information on compatibility and on use of virus scanners.
- "Release Notes > Notes on WinCC > Remote access and Remote Desktop Protocol (RDP)"
  The section contains information about remote communication.
- "Working with WinCC > Working with Projects > Making Settings for Runtime > Effect of External Applications on Runtime"
  This section contains information on applications that can affect system resources.
- "Working with WinCC > Working with Projects > Making Settings for Runtime > System Diagnostics with Performance Tags"
  The section contains information on system tags with which, for example, the time behavior during reading or writing of tags is analyzed.
- "Working with WinCC > Dynamize process pictures > Dynamization: Configuration recommendations"
  The section contains information on optimal dynamization of picture objects and controls.
- "Configurations > Multi-User Systems > Quantity Structures and Performance"
  The notes on configuration in this section apply to all project types.
1.2 WinCC Release Notes

1.2.1 Release Notes

Content

These Release Notes contain important information.

The information in these Release Notes has priority over that in the manuals and online help with regard to legal validity.

Please read these Release Notes carefully since it contains information which may prove helpful.

1.2.2 Notes on operation

1.2.2.1 Notes on operation

General information

Avoiding loads from external applications
If several programs are run simultaneously on the same computer, the computer may be exposed to high load levels.

To ensure trouble-free WinCC operations do not run any other applications that can lead to a resource crunch on the PC. Therefore, close any unnecessary programs before starting WinCC. Additional information is available in the section "Working with Projects > Making Runtime Settings > Impact of External Applications on Runtime".

System diagnostics with performance tags
You can analyze the time behavior, e.g. during reading and writing of data, with the system tags of the "Performance" tag group.

Compatibility

You can find information on compatibility on the Internet in FAQ No. 64847781:

Use of virus scanners

The following virus scanners have been released for use as of WinCC V7.5:

- Trend Micro "OfficeScan" Client-Server Suite V12.0
- Symantec Endpoint Protection V14 (Norton Antivirus)
- McAfee VirusScan Enterprise V8.8
- McAfee Endpoint Protection V10.5
- McAfee Application Control V8.1 (Whitelisting)
- Kaspersky Anti-Virus 2018
- Windows Defender (version contained in the operating system)

Updated information on the approved virus scanners is available in the compatibility tool under "Further products > Virus scanners".

Fundamental principle

The use of a virus scanner should not hamper the runtime process in a plant.

Rules for local virus scanners (virus scan clients)

- Integrated firewall of the virus scanners
  In WinCC V7.x, the local Windows firewall can be programmed with SIMATIC Security Control. You may not install or activate the integrated Firewall of the virus scanners.

- Manual scan
  You are not permitted to run a manual scan in runtime. Run this scan at regular intervals on all the system PCs, for e.g. during a maintenance interval.

- Automatic scan
  During automatic scan it is enough to just scan the incoming data traffic.

- Scheduled Scan
  You are not permitted to run a scheduled scan in runtime.

- Pattern update
  Pattern update of virus scan clients (system PCs being checked for viruses) is done by the higher-level virus scan servers (the system PC that centrally manages the virus scan clients).

- Dialogs
  To avoid interfering with process mode, no dialog messages should be displayed on the virus scan clients.

- Drives
  Only the local drives are scanned to prevent overlapping scans on network drives.

- You can deactivate e-mail scan except on the WinCC engineering station that receives e-mail.

Accept all other default settings.
What does this ensure?
The incoming data traffic is checked for viruses. The effect on process mode is kept to a minimum.

Note
When using a virus scanner, make sure that the computer has sufficient system resources.

Screen savers

Using a screen saver costs processor time and can lead to a system overload. Screensavers which no longer release parts of the working memory, continuously reduce the usable working memory.

The Windows "Logon screen saver" can be used.

See also

Software requirements for installing WinCC (Page 19)
Compatibility tool for automation and drive technology:

1.2.2.2 Information on the Windows operating system

Microsoft security updates and patches

Make sure that all current patches and security updates from Microsoft are installed on your computer.

For further information, refer to the FAQs in the SIMATIC Customer Online Support:

General information

WinCC interface and 64-bit operating system

The public interface of WinCC offer no native 64-bit support. This primarily affects ODK, VBS and the WinCC OLEDB provider. To use the interface of WinCC under a 64-bit operating system, you must adhere to the following:

- You cannot launch VB scripts simply with a double-click. You must explicitly use the 32-bit version under "syswow64\wscript.exe".
- .NET applications that use the WinCC API must be explicitly compiled as 32-bit applications. With "x86" and not with "AnyCPU".
- C++ applications cannot be compiled as 64-bit applications.

Preventing access to Windows in runtime

Displaying the online help in runtime

If you wish to ensure that operators have no access to the operating system level of a plant, deactivate online help in all controls. This prevents the Windows selection dialog from opening.

To do so, deactivate the "Help available in Runtime" option in the "Project properties" dialog in the "Options" tab.

Displaying the Windows taskbar in runtime

You can use the computer properties to prevent the Windows taskbar from being displayed in runtime:

- Open the "Parameters" tab in the "Computer properties" dialog and disable the option "Disable shortcut keys for operating system access" in the "Disable Keys" area.
- In addition, deactivate the "Keep the taskbar on top of other windows" setting in Windows.

If you disable the <CTRL+ESC> shortcut key, the following shortcut keys are also disabled in runtime:

<table>
<thead>
<tr>
<th>Keyboard shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Windows key+U&gt;</td>
<td>System utility program manager</td>
</tr>
<tr>
<td>Press &lt;SHIFT&gt; five times</td>
<td>Locking function</td>
</tr>
<tr>
<td>Press &lt;SHIFT right&gt; for eight seconds</td>
<td>Impact delay</td>
</tr>
<tr>
<td>&lt;ALT left+SHIFT left+NUM&gt;</td>
<td>Keyboard mouse</td>
</tr>
<tr>
<td>&lt;ALT left+SHIFT left+PRINT&gt;</td>
<td>High contrast</td>
</tr>
</tbody>
</table>

The functions can be configured using the Windows Control Panel.

If the functions are activated in the Windows Control Panel before activating WinCC Runtime, they are no longer locked in runtime.

By activating the option "Disable shortcut keys for operating system access", you are also disabling the shortcut keys for easier operation.
Do not use the "On-screen Keyboard" enabled by Windows
Use the on-screen keyboard offered by WinCC instead of the "On-Screen Keyboard" enabled by Windows to prevent the display of the Windows taskbar in runtime.

Do not specify print to file as standard printing
Do not set the print to file as standard printing procedure in the Windows operating system. This prevents the Windows dialog for saving the file from opening when printing from WinCC.

WinCC WebBrowser Control: Disabling the shortcut menu
You can restrict the shortcut menu of the WinCC WebBrowser Control in runtime:

- To reduce the shortcut menu to "Forward" and "Backward" navigation, activate the object property "UseSimpleContextMenu" in the Graphics Designer.
- To suppress the shortcut menu completely, deactivate the Windows group guideline:
  To open the Microsoft "Group Policy Object Editor", enter "Gpedit.msc" in the search field. Deactivate the shortcut menu in the Group Policy "User configuration\Administrative templates\Windows components\Internet Explorer\Browser menus".

Warnings with the DCOM configuration
When the "Dcomcnfg.exe" program starts, there may be warnings about unregistered ApplIDs of WinCC components.
This reaction has no effect on the functional capability of the software. The warnings can be ignored.

Changing the screen settings

Changing the color palette
If you change the color palette via the Windows Control Panel, you should expect color changes and poorer legibility of the text.
When creating the project, therefore, be sure use the same color palette that will be used in runtime.

Changing the resolution
In order to use a different resolution in the destination system, use the "Adapt Picture" or "Adapt Size" functions for pictures and windows.
These settings can lead to blurred displays in runtime and increased system loads.

Operating system with multilanguage installation: wrong language in message boxes
In message boxes in which the user must respond with Yes/No, OK/Cancel, etc., the buttons are always labeled in English in both CS and RT.
This characteristic is independent of both the operating system language set and the WinCC language.
Novell Netware clients

WinCC should not be installed on a system together with the Novell client software. The installation of WinCC can have the effect that it is no longer possible to log on to the Novell system or the lock the keyboard during runtime. We recommend you not use the Netware client software or use the Microsoft client for Netware.

Notes on Internet Explorer

Web client: Display of ActiveX controls in Internet Explorer

ActiveX controls are disabled in Internet Explorer by default. For this reason, the WinCC controls are not displayed correctly in Internet Explorer on a Web client.

To display the WinCC controls correctly, add the Web server as a trusted website and enable the ActiveX controls only for the "Trusted sites" zone.

To continue protecting Internet Explorer from foreign ActiveX controls, check that the restricted security settings still apply to the other zones after making the changes.

For more information, refer to the following documentation:

- WinCC/WebNavigator: "WinCC/WebNavigator Installation Notes > Installation of WebNavigator Client > Settings in Internet Explorer"
- WinCC/DataMonitor: "WinCC/DataMonitor Documentation > Configuring the DataMonitor System > Working with the DataMonitor Client > Configuring Security Settings in Internet Explorer"

Internet Explorer: Setting for WinCC without Internet connection

Disable the option "Check for publisher's certificate revocation" on the "Advanced" tab in the Internet Options if you operate WinCC on computers that do not have an Internet connection.

See also


1.2.2.3 Information on the database system

Information on DB.dll

DB.dll is an ODK component for accessing databases via C API functions. The functionality is no longer supported for use with WinCC. Do not develop new applications with the database access layer DB.dll from WinCC.
Instead, use the following functions offered by Microsoft:

- Use ADO.NET for .NET-based applications. The database interface of the .NET Framework is object-oriented and designed for scalable applications. The interface is also well suited for data communication through firewalls.

- You can use OLE DB for C++ based applications. Microsoft provides templates with Visual Studio for this. They make it easier to use the OLE DB database technology with classes, which implements many commonly used OLE DB interfaces.

- You can also use ODBC C++ based applications. Microsoft provides classes for this, which facilitate programming.

You can find more detailed information and examples on the Microsoft website.

Notes on Microsoft SQL server

Error accessing the SQL master database after switching off the server while the system is running

If a server fails unexpectedly in runtime (power failure, disconnection of power plug), the WinCC installation may be corrupted as a result and the SQL server will no longer be able to access the SQL master database following a restart. Access is only possible after reinstalling the WinCC instance.

In order to reinstall the WinCC instance, both WinCC and the SQL server must be removed and installed again.

Improved access protection for the WinCC databases

For the purposes of improved access protection, the user names "WinCCAdmin" and "WinCCConnect" have been removed from the WinCC database. Access to the WinCC database is no longer possible using these user names. Applications which use their own SQL user names with password are not affected.

The user "SA" (system administrator) of the SQL server is deactivated during installation.

Manual detachment of WinCC project databases

A system property in Microsoft SQL server can bring about changes to the NTFS authorizations when you detach the WinCC project database.

If a WinCC database remains attached after you have closed a WinCC project or if you have manually attached the WinCC database, you always need to use the CCCleaner to detach the database. The "CCCleaner" program is located in the "bin" folder of the WinCC installation directory and must be started as administrator.

1.2.2.4 Information on network technology and UPS

Information on networks

WinCC only supports the TCP/IP network protocol on the terminal bus.
Operation on network servers

It is not permitted to operate WinCC on network servers (e.g. domain controllers, file and name utility servers, routers, software firewalls, media servers, exchange servers, etc.).

Operation on systems with Windows cluster technology

WinCC cannot be used on systems implementing Windows cluster technology.

Use of redundant servers

When redundant pairs of servers are implemented, the master and standby server must be operated in the same IP/subnet band.

Network adapters with energy-saving mode

When using network adapters provided with energy-saving mode, the energy-saving mode must not be activated.

Operation with multiple network adapters

If WinCC is used on a PC with more than one network adapter, observe the following:

Select the IP addresses which WinCC should use for communication with other WinCC stations. In Windows Explorer, select the "Simatic Shell" directory. Click into the navigation window of the dialog "Simatic Shell" and select "Settings..." in the shortcut menu. In the "Settings" dialog that follows, select the IP address to be used.

If problems occur with the configuration and project management despite this setting, it could be due to the assignment of the IP address by the DHCP server to the WinCC station being too slow. In this case, the network administrator must define the IP address for each network adapter on the WinCC station causing the problem.

To do this, press the Windows "Start" button and select "Settings" > "Control Panel". Open the "Network Connections" folder and then the "LAN Connection" dialog. Click "Properties" in the "General" tab. Open the "LAN Connection Properties" dialog and select the "Internet Protocol (TCP/IP)" element from the list in the "General" tab by double-clicking it. Use the "Use the following IP address" option button in the properties of Internet Protocol (TCP/IP) to define the IP addresses.

Observe the information in the following chapter: "Special features for communication with a server with multiple network adapters”

Network environment and network drives

Ensure that there are no unnecessary network drive connections.

In order to prevent delays following a restart of a distributed system, start the multi-user projects first. The reason for this is the reaction of the master browser service (responsible for displaying the network environment in the operating system) and administration of the domains and working groups.
Operation with TCP/IP protocol

If the TCP/IP protocol is installed, the IP address must be valid and must not change in runtime operation.

Observe the following here:

1. The IP address becomes invalid when the network adapter is removed or deactivated after installation of the TCP/IP protocol.

2. The IP address may not be initialized yet. This occurs, for example, when the TCP/IP protocol is installed with the IP address derived from a DHCP server. When the computer is connected to the network, the computer undergoes a basic initialization during which an IP address is transferred. This IP address then remains valid even after the computer is disconnected from the network. After the period of the lease has expired, however, it can become invalid or changed in another way.

If the computer is not connected to the network, the user must log on via a user configured locally on this computer. This user should have local power user rights for runtime operation and for the configuration.

Leading zeros in IP addresses

When multi-user mode is used with name derivation via "hosts" and "lmhosts", no preceding zeros may be entered in the "hosts" file. IP addresses with leading zeros are interpreted as OCTAL instead of DECIMAL.

Example:

- Computer_1 199.99.99.020 is interpreted as 199.99.99.16 (decimal)
- Computer_2 199.99.99.026 is interpreted as 199.99.99.22 (decimal)

The specification can also be made hexadecimal:

- 199.99.99.0x10 for Computer_1

Using WinCC in multiple domains

The correct functioning of WinCC can only be guaranteed when all the computers in a multi-user system are located in a common domain or working group. When WinCC is used in different domains or working groups, complications may arise if the access rights and/or name utility are configured incorrectly.

When the user administration is realized in a working group, all the WinCC users must be set up on all the computers in the multi-user system and have the necessary access authorization.

Use of WinCC within a domain

If problems occur accessing the Windows domains, it cannot be guaranteed that WinCC functions correctly. Therefore, in addition to a "server-stored user profile", a local user profile and local user with necessary rights for WinCC must be set up. If access problems occur with a domain logon, exit WinCC and log on again using the local user profile.
Information for using routers and firewalls

Using routers

WinCC V7 can also be used to connect WinCC clients to WinCC servers via routers. WinCC clients without their own project cannot be used for configuration with the routers, only for WinCC Runtime. There are no restrictions for WinCC clients with their own project.

The following is required when using routers:

- WinCC must use the correct IP address of the WinCC stations.
- The WinCC stations must be capable of resolving the physical computer name (NETBIOS name) of the other computers in the WinCC project.
- The WinCC stations must be capable of reaching each other via TCP/IP and ICMP without any problems. When testing the connection using Ping, it must be possible to access the computers immediately.
- Activate multicast forwarding to the network routers between the servers and the clients.

Speed of the network connections

For slow network connections, we recommend:

- Restricting the quantity of data to be transferred, for example, by avoiding complicated graphics.
- Using the local pdl cache of the WinCC client.
- Using the ISDN router for a WinCC client in multi-link mode (channel bundling). Bandwidths below 128 Kbps have proved insufficient.
- Integrate only one WinCC client for each additional ISDN channel.
- The operation of WinCC via ISDN routers depends on the stability and availability of the ISDN network.
- Reserve the maximum bandwidth of the connection for WinCC.

Note

Connection via ISDN and operation using slow connections has not been approved for clients without a local project.

Connecting to an office network with a central firewall

Some network configurations can increase the load on the firewall. You can avoid the described reaction by assigning unique IP addresses to all WinCC stations.

Basic system characteristics

- With a standard installation of Windows, the computer is assigned a random IP address from the DHCP server.
Requirements
The following conditions can lead to undesirable reactions when operating WinCC:

- The IP address band used in the terminal network is higher than the APIPA address band (169.254.x.x).
- IP addresses are routed via the default gateway.
- IP addresses from the APIPA band are routed to the firewall.

Cause of the increased load at the firewall
Following a system startup, each WinCC station sends its IP address once to all the other WinCC stations in the network. The WinCC stations define the WinCC station with the lowest IP address as the server that coordinates availability of the project.

If a WinCC station does not receive an address from the DHCP server and is therefore missing in the APIPA process, this station becomes the coordinating server. As a result, all the other WinCC stations attempt to access this server cyclically to publish the project.

The coordinating server, however, cannot be addressed because the IP address from the APIPA band is automatically transferred to the firewall. This also causes an increased network load at the central firewall.

Solution
This reaction can be avoided by assigning a unique IP address to each WinCC station.
Information on uninterruptible power system

Prevent damaged files during power outages
If a power failure occurs while using Windows systems when the WinCC system is active, files can be corrupted or lost. Operation using the NTFS file system offers more security.

Secure continuous operation can only be guaranteed when an uninterruptible power system (UPS) is used.

Uninterruptible power system for client-server systems
If the server in a client-server system should be buffered by an UPS system, it must be capable of bridging a power failure for up to 30 minutes. This value depends on the configuration and number of computers, especially in a multi-user system. A great deal of time is required for the configuration.

1.2.3 Notes on WinCC

1.2.3.1 General information on WinCC and configurations

General information

WinCC Demo project
The WinCC demo project for WinCC V7.5 can be downloaded as a self-extracting ZIP file at:


WinCC passwords: Migration of WinCC projects
As of version V7.2, WinCC offers improved encryption of passwords.

Note for migrated project that were created with WinCC prior to V7.2:

- You must re-enter the user name and the password for "WinCC Service Mode" operating mode.
- To increase security of WinCC through improved encryption, you have the re-enter the passwords in the User Administrator.

Increasing password security
Make sure that the WinCC passwords meet the usual security guidelines, for example, mandatory use of capital letters and special characters, minimum number of characters.
Migrate WinCC projects remotely only with UNC paths

Use only UNC paths to migrate WinCC projects remotely. Release the project path or the folder above it. Use this UNC path as project directory for the WinCC Project Migrator.

No update of the operating system with WinCC started

An update of the operating system is not permitted if WinCC is started. Start the computer again after updating the operating system.

WinCC documentation: WinCC Information System

The information in the online help is more up-to-date than the information in the printable PDF files.

Openness and system stability

WinCC enables high performance programming of actions on individual graphic objects up to complete functions and global action scripts that are independent of the individual components.

C scripting

WinCC and Windows API functions can be called in the action scripts. In addition, the integrated script programming contains a C interpreter with a large number of standard functions complying to ANSI-C.

Please note that, due to the openness of the system, it is possible to write actions that block the system and lead to system crashes in runtime due to continuous loops, incorrectly initialized pointers, etc. Pay attention to the availability of allocated memory.

VB scripting

VBScript (VBS) enables access to tags and objects of the graphical runtime system during runtime. In addition to VBS standard functions and constants, the Windows Scripting Host and the MS Automation interface can also be used to make the Windows environment dynamic.

There is no guarantee nor WinCC support for the VBS functionality with regard to its adaptation to the Windows environment.

You can find additional information in the following sections of the WinCC Information System:

- "ANSI-C for Creating Functions and Actions"
- "VBS for Creating Procedures and Actions"
- "Process Picture Dynamics"

Time synchronization

Time synchronization between the servers and automation systems is essential for the correct functioning of:

- Redundancy synchronization
- Chronological messaging
• Search and sorting criteria using the time code
• Operating multi-user projects in one domain

You can find additional information in the following sections of the WinCC Information System:
• "Redundant systems"
• "Chronological reporting"
• "Multi-user systems"
• "Time synchronization"

**Complete download of redundant systems**

Do not perform a complete download to the redundant systems in SIMATIC Manager using the "Target system / Compile and Download Objects..." function, as this can create inconsistent data on the target system.

Instead, select the "Download" option in the SIMATIC manager in the shortcut menu of the operating system.

**Installation of the examples projects**

The supplied example projects are located on the WinCC DVD in the directory "Samples \WinCC".

**Installing OPC XML DA Server on a WinCC system**

Use the WinCC Product DVD if you want to add an OPC XML DA Server installation to a WinCC system. Do not install the application by means of Windows Control Panel.

**Information on multi-user systems**

**Clients without their own project in multi-user systems**

In multi-user systems, there may be a delay in the selection of the first picture following a redundancy switchover for clients without their own project.

If you are changing the runtime language of a client without its own project in a multi-user system, you will have to close WinCC on the client and exit the WinCC project on the server. Only then will the language be altered.

**Remote access from a client without its own project**

The server data editor is not available in the WinCC Explorer on a client without its own project. The "Archive Configuration" entry is not available in Tag Logging and Alarm Logging.
Notes on integration into SIMATIC Manager

Symbolic data block name: Maximum of 16 characters long

If you want to transfer tags from a data block to WinCC, the symbolic name must not exceed 16 characters.

Creating a DCF file

If the DCF file cannot be read after migration, a message regarding the defective file is written to the migration log file.

In order to create another DCF file, proceed as follows. The sequence must be adhered to in all cases:
1. Open the project in the configuration mode.
2. Remember your own symbolic computer name (server prefix) needed for later export.
3. Remember the storage location of the imported server data.
4. Remember the preferred server and the default server.
5. Delete your own and imported server data.
6. Close the project.
7. Delete the DCF file in project directory (typically ProjectName.dcf).
8. Reopen the project in the configuration mode.
9. Create your own server data, making sure to maintain the original symbolic computer name (server prefix) (see step 2).
10. Import all imported packages again (see step 3).
11. Reconfigure the preferred server and default server (see step 4).
12. Close the project.

CPU load

If data, transferred from a server to a client, cannot be processed at the same speed, the client rejects the data frames from a specified threshold value.

The following process control messages are issued in conjunction with this:

- 1000200: "WCCRT:Status"

You will find the following additional information in the comment of this message or in the log file "WinCC_Sys_<x>.log":

- 1000200,4,,<Computer name>, DataManager Runtime, RPC call took longer than 5000 msec
  (Client requires a very long time to process the data)
- 1000200,4,,<Computer name>, DataManager Runtime, Update data for Client '<client name>' lost,
  (message frames for the client are discarded on the server)
Data may be lost on the client.

See also

Internet: WinCC demo projects (https://support.industry.siemens.com/cs/products?search=demo&dtp=ExampleOfUse&o=DefaultRankingDesc&pnid=14867&lc=en-WW)

1.2.3.2 Information on WinCC CS

General information

Using several WinCC editors

Do not use multiple WinCC editors at the same time because the editors can access the same WinCC components. For example, use of the "Text Distributor" and "Cross Reference" editors or automatic update of the Cross Reference when the Graphics Designer is being accessed simultaneously via interfaces.

If you would like to work in several WinCC editors in parallel, activate the function "Multi-User-Engineering" in the WinCC project.

Information on the Graphics Designer

Custom ActiveX controls (SIMATIC WinCC/ODK)

You must verify compatibility of custom ActiveX controls (SIMATIC WinCC/ODK) with the WinCC Basic System, WebNavigator Server, and WebNavigator Client.

This applies to both a direct installation of ActiveX control on the computer with WinCC, Web server or Web client and the installation using a plug-in, such as on a Web client.

- With a direct installation, the ActiveX control should therefore be installed prior to WinCC Basic System, Web Server or Web Client.
  If the custom ActiveX controls do not function without error after this step, there is no compatibility.
- If the custom ActiveX Control was packaged in a plug-in and installed via download, an upgrade of WinCC Basic System, Web Server or Web Client will also require generation of a new plug-in using this ActiveX Control.
  When creating the plug-in, care should be taken to use compatible binaries (DLL, OCX, etc.).

Do not change the folder "GraCS/SVGLibrary"

Do not save any process pictures or faceplate types in the project folder under "GraCS/SVGLibrary".
The folder "SVGLibrary" is only used for SVG libraries.

**Editor "Text and graphics lists" Limited release of text lists**

Contrary to the information in the WinCC documentation, the centrally configured text list is only enabled for the object "Text list".

The function is not enabled for the following objects:

- Combo box
- List box
- Check box
- Option group
- Faceplate types

**The "Date/Time" data format is not available for I/O fields copied from WinCC < V7.3**

When you copy an I/O field created in WinCC < V7.3, the "Date/Time" data format is not available for the pasted I/O field.

**Pictures with transparent areas: Using file formats with alpha channel**

If you want to use a graphic for Direct2D display which contains transparent areas, use only graphic formats with an alpha channel, e.g. BMP or PNG.

**Information on user administration**

**Electronic signature: WebUX not enabled**

The electronic signature as protection against critical operations cannot be used with WinCC/WebUX.

**Information on the logging system**

**Print barcode: "Code 39 Logitogo" font**

The "Code 39 Logitogo" font is language-dependent.

If you are using this font in a layout, not all languages may be printed correctly.

**Solution**

To print the barcode, use the "Version for MS Dynamics German + English" font.

This font is language-independent. The barcodes are printed even if the computers have different language settings.
Information on VBA

VBA updates

The user is solely responsible for the installation of updates for VBA. The corresponding updates for VBA are made available by Microsoft on the download pages. Siemens does not supply any updates from Microsoft. Install the updates for VBA after installing WinCC.

Notes on the channels

Name of a channel with national characters

When you enter a name with national characters in the "SIMATIC S7 Protocol Suite" channel and especially in the "Named Connections" channel unit, you must have set the corresponding code page in the language options of the operating system.

See also


1.2.3.3 Information on WinCC runtime

Information on multi-user systems

Copying large amounts of data via the terminal bus

Copying larger amounts of data on a computer connected to a terminal bus can effect communication in a multi-user system. One of the possible causes is the use of hubs with a low data throughput.

Information on Tag Logging / Alarm Logging

Editing archive data already saved

Archived measured values/messages of previously saved archives cannot and should not be changed due to reasons of data security and consistency.
Information on OPC

SIMATIC WinCC OPC Server: Automatic assignment of DCOM rights
The DCOM rights required for operation of the OPC server are assigned automatically. The settings are performed during the installation. Depending on the WinCC operating mode, further configurations are performed.
You must not edit these settings manually.

No deinstallation of SIMATIC WinCC OPC Server when the OPC channel is used
When you use the OPC channel, you must not remove the SIMATIC WinCC OPC DA Server.

OPC tags: Time stamp for Alarm Logging and Tag Logging
If messages are triggered by OPC tags, the message time stamp is used by the OPC server, comparably to chronological reporting.
For Tag Logging the time stamp is generated by the Tag Logging server.

OPC Data Access
During operation of the OPC DA server on the WinCC client:
While the connection of the OPC client is being established, the WinCC server with which the OPC client exchanges data must be in Runtime.
If the WinCC server is deactivated, not all properties of the items will be provided.
Since the display of data types in OPC Item Manager requires a lot of time, the display should be turned off if it is not needed.

OPC XML Data Access
Display of newly created tags
When you create new tag folders with new tags in Runtime in the WinCC project, the tag folders and the tags will not become visible on the OPC client until you have restarted WinCC Runtime on the OPC client system.
Make sure that "OPCTags" are no longer open on the OPC client.

Add Tags
If you want to add tags with the OPC Item Manager, then WinCC Runtime will have to be enabled on the OPC server.

Authentication method
XML DA Web service is installed using WinCC Setup with the "Integrated Windows Authentication" authentication method. The WinCC OPC XML client supports this method. For this, the user account under which the OPC Client runs must be known to the XML server computer.
Upgrade installation: Setting up a WinCC OPC XML server
After an upgrade installation, in Computer Management, for the "Internet Information Services (IIS) Manager", under "Application Pools" for "WinCC-OPC-XML" you have to change the Microsoft .Net Framework version from V2.0 to V4.0.

OPC Historical Data Access

Return value "OPC_E_MAXEXCEEDED" for archive access
If the OPC client demands data from more than 2000 values during synchronous or asynchronous reading, the call is rejected with a return message OPC_E_MAXEXCEEDED.
This limit serves to limit the computer load and duration of the call.
This restriction does not apply if the entire time range is read.

OPC Alarm&Event

Avoid bounding values
Avoid using bounding values when reading historical alarms via the WinCC-OPC-A&E-server.
Otherwise, processing read access requests can take a long time, depending on the size of the archive.

Filtering messages when using format instructions in the user text block
The OPC source of a message is shown in an user text block. This is user text block 2 with the default setting.
If you use format instructions in this user text block, you need to use wild cards for the filter setting.
This ensures correct filtering when the OPC sources are generated dynamically in Runtime.

1.2.3.4 Information on Smart tools

Notes on WinCC ConfigurationTool and WinCC Archive ConfigurationTool

WinCC ConfigurationTool / WinCC Archive ConfigurationTool: Replacement
As of WinCC V7.3 you import and export the WinCC data via the WinCC Configuration Studio.
To import already existing files from the WinCC Configuration Tool/WinCC Archive ConfigurationTool into the WinCC Configuration Studio, use the menu command "Import" in the WinCC Configuration Studio.
In addition to the file name, select the "ConfigTool file (*.xlsx)" or "Archive Config Tool file (*.xlsx)" entry in the file selection dialog.
If you have configured the colors of message types in the WinCC Configuration Tool, the colors are not imported into the WinCC Configuration Studio from the Configuration Tool. You either need to create the message colors in the WinCC project before migrating the WinCC project.
to WinCC V7.3 and higher or, alternatively, manually configure the message colors later after the import in the WinCC Configuration Studio.

WinCC Configuration Studio replaces the functionality of "Tag Export/Import"
To export tags from a WinCC project or import them into a WinCC project, use the WinCC Configuration Studio.

Information on the Dynamic Wizard Editor

Opening the Dynamic Wizard Editor
The Dynamic Wizard Editor and the Graphics Designer should not be opened at the same time.

Information on the Tag Simulator

General information
The update time for tag values is one second. Any change will only become active when you are activating the functions.
A maximum of 300 tags can be configured.

1.2.3.5 Information on process communication

Information on the WinCC "SIMATIC S7 Protocol Suite" channel

S7DOS configuration: Activate IPv4 protocol
If you are using S7DOS, you require the IPv4 protocol as of version "S7DOS V9". Therefore, leave the IPv4 protocol activated in the Ethernet properties for the network adapter or the SIMATIC Ethernet CPs.
In this way, you ensure that the module detection of S7DOS works for the TCP, RFC1006 and ISO protocols.

Time change on an S7 automation system when using AR_SEND
Archive data transferred from the S7-AS to WinCC with AR_SEND is ignored if the time is reset on the AS, e.g. following time synchronization. The archive already contains the reset time period.
Information on the WinCC "WinCC-OPC-UA" channel

OPC UA: Displaying imported OPC UA tags
Tags created with a WinCC version older than V7.4 are shown as imported in the "Symbols" view of the Configuration Studio.

However, in this case the tags of the type "Raw data" are not shown as imported. The column "Access" is not available, although these tags have been correctly created in the Tag Management.

Reimport these tags and delete the incorrectly displayed tags in the Configuration Studio.

Filters for the OPC UA alarms: Extended operators for "Severity"
Contrary to the status described in the documentation, the operators for the filter criterion "Severity" have been extended.

For the criterion "Severity", you can use the following operators:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>=</td>
<td>Is equal to</td>
</tr>
<tr>
<td>!=</td>
<td>Is not equal to</td>
</tr>
<tr>
<td>&gt;</td>
<td>Is greater than</td>
</tr>
<tr>
<td>&lt;</td>
<td>Is less than</td>
</tr>
<tr>
<td>&gt;=</td>
<td>Is greater than or equal to</td>
</tr>
<tr>
<td>&lt;=</td>
<td>Is less than or equal to</td>
</tr>
<tr>
<td>between</td>
<td>Range from, to</td>
</tr>
<tr>
<td></td>
<td>Example:</td>
</tr>
<tr>
<td></td>
<td>• 100, 200</td>
</tr>
<tr>
<td></td>
<td>Corresponds to Severity from 100 to 200 (Including the specified value respectively)</td>
</tr>
</tbody>
</table>

Information on the WinCC "Mitsubishi Ethernet" channel

Bit addressing with incorrect data type
Ensure that the bit addressing has the correct data type.
Incorrect addressing can result in the incorrect data type being written and as a result the adjacent bits being influenced.
The addressing of, for example a BOOL address with the data type WORD can result in the adjacent bits of the addressed bit being overwritten.
Information on the WinCC "SIMATIC S5 PROFIBUS DP" channel

PROFIBUS DP and SIMATIC Net V14

In order to use the "PROFIBUS DP" channel with SIMATIC Net V14, you must disable the "OPC UA" property for the "DP" protocol in the communication settings of SIMATIC Net V14.

Information on the WinCC "SIMATIC 505 TCPIP" channel

LMode and LStatus data types

The channel has been extended by the data types LMode and LStatus.

- LMode (Loop Mode): 16-bit value (bit array) without sign; access: write and read
- LStatus (loop status): 16-bit value (bit array) without sign; access: Read ONLY

The offset to be specified during the addressing identifies the loop whose mode or status should be requested.

1.2.3.6 Remote access and Remote Desktop Protocol (RDP)

Remote access to WinCC stations

You can find current instructions for remote access in the following FAQ:


Also observe the information on remote configuration in the WinCC Information System under "Configurations > Multi-User Systems > Remote Configuration".

Approved scenarios

The following scenarios have been tested:

- WinCC as single-user system
- WinCC as distributed system
- WinCC in redundant mode
- WinCC/WebUX server

You can also use communication via OPC in the approved scenarios.

Use of RealVNC

Information on the use of "RealVNC" is available on the Internet on the Customer Support pages:

No keyboard lock with RealVNC
Note that the keyboard lock is not supported with "RealVNC". The keyboard lock is only in effect with a Remote Desktop Protocol connection.

Remote maintenance of WinCC systems via RDP
Use of the Remote Desktop Protocol (RDP) is only permitted when the WinCC server or the single-user system is running in WinCC ServiceMode.

Restrictions when using RDP
Observe the following restrictions:

- Start the WinCC project via the local user on the PC.
  If you do not start via the local user, not all the services are started during operation via the remote console.
  Further information is available under "Configurations > WinCC ServiceMode"
- The use in integrated operation in SIMATIC Manager has not been approved.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Data loss after interruption of the remote desktop connection</strong></td>
</tr>
</tbody>
</table>
When the remote desktop connection is interrupted, for example, because the network cable was removed from the computer of the Remote Desktop Client, the archives and the OPC server, among others things, will no longer receive values from the data manager.
This status will persist until the connection has been restored, or the timeout of approximately 35 seconds has expired.

Starting the Remote Desktop
You can access WinCC systems with a Remote Desktop client via a console session.
Access via the Remote Desktop Protocol may only be gained by means of console takeover with the same user, or initial login.

User groups and access rights
All "Remote Desktop" users must be members of the "SIMATIC HMI" user group on the target PC.
Procedure
1. To start a console session, open the "Run" dialog, for example, with <Windows button+R>.
2. Enter the following command:
   - mstsc /v:<Server> /admin

   Enter the computer name or the IP address as server.

For information on additional parameters, enter the following command:
   - mstsc /?

Migration: Migrate WinCC projects remotely only with UNC paths
Use only UNC paths to migrate WinCC projects remotely.
Release the project path or the folder above it.
Use this UNC path as project directory for the WinCC Project Migrator.

See also

1.2.4 Notes on WinCC Redundancy

Notes on redundant systems

Redundancy behavior in case of double failure
Double failures are not covered by redundancy.
A double failure occurs, for example, when the terminal bus was pulled on server 1 while server 2 was deactivated.
Delay in swapping out archives

The swapping of archives will be delayed if a redundant partner is not available or deactivated. Swapping of archives will not start or continue until the partner is available once again and after archive synchronization.

An extended failure of the redundant partner may result in data loss, because the memory capacity of the circular buffer for Tag Logging and Alarm Logging is limited.

No reloading of messages after network failure

The reloading of messages after network failure is not permitted for redundant systems.

Configuring used standard gateway

For redundancy, it is recommended to configure a standard gateway for the correct detection of failure scenarios. The standard gateway must be properly configured on both redundancy servers for this. This can be done manually or via DHCP.

For a configured standard gateway, ensure that this gateway cannot only be reached but is also accessible using a “ping”.

Use of DHCP: Starting computer only with active network connection

If you are using DHCP on the terminal bus network card, note the following in a redundant system:

The computer must obtain a valid IP address from the DHCP server during startup.

Otherwise, the redundancy status is always indicated as "fault". This status can only be reset by restarting the computer.

Message sequence report in a redundant system

If you output a message sequence report on a client, you may encounter problems during logging when switching to the redundant partner.

1.2.5 Notes on Process Control Options

Creating a New Project

If you create a new project manually, you must first run the OS Project Editor.

While creating an OS using PCS7 Engineering Station, the project is automatically called in the background and initialized using the default settings.

Removing unneeded "@*.PDL" pictures before migration

If the OS Project Editor has processed a WinCC project, the "@*.PDL" pictures of Basic Process Control will have been installed in the Graphics Designer.
If you do not need these pictures following the migration, you not only have to remove the "@.PDL" pictures prior to migration, but also the "PAS" files and "SSM.cfg". After the migration, the files from Basic Process Control are no longer added.

**Multiple languages**

Online documentation in the WinCC Information System is available only in English, French, German and Chinese (Simplified, PR China).

If you work with a French, English or German version of Windows computer software and install a different language, it is possible that terms in WinCC appear in this language even if WinCC is operated with the same language as Windows.

Different buttons have English labels especially in the multi-lingual versions of Windows independent of the language setting and independent of the WinCC language. This affects dialog boxes in particular which the user must respond with Yes/No, OK/Cancel etc.

**Tags with @ prefix**

The project engineer my not create any tags with @ prefix. Only the WinCC PCS7 software can do this.

You are not allowed to manipulate these system tags.

The system tags are required so that the product works properly.

While configuring AS and OS monitoring using Lifebeat Monitoring, device names should not be identical to area names in Picture Tree or internal tags with the "@" name prefix.

**Smart card: Disabling the Plug&Play service**

If the Plug&Play service is enabled, an operating system message may occur in WinCC Runtime when scanning for drivers. This allows the access to the operating system.

Since WinCC does not require a separate smart card driver, the "Plug&Play" service for smart cards is disabled.

**Area names in Alarm Logging and in the Picture Tree**

Area names in Alarm Logging and in Picture Tree must not contain any spaces at the beginning or end.

**Area names in distributed systems**

With distributed systems, the area names in the projects of the various WinCC servers must be unique in order to ensure correct filtering and display of the messages according to the area.

**Process picture in the plant view: Level 16 is hidden**

Level 16 is always hidden when you create a new process picture in SIMATIC Manager in the plant view or with the WinCC Explorer.
Do not change this setting if you are using PCS 7 ASSET. The hidden level contains an "@RTBehaviourParams" object that is used for diagnostic purposes.

**Image painting time**

To optimize the image painting time, set the "WinCC Classic" design in the WinCC project properties.

**User authorization "No. 8 Controlling archives"**

User authorization "No. 8 Controlling archives" in User Administrator is no longer used by the system.

**Authorization check in WinCC ServiceMode**

There are three possible scenarios for WinCC in ServiceMode that influence the Runtime behavior through the authorization check:

- No Windows user logged on. A user is defined as "User in service context" in WinCC User Administrator. The authorizations of this user in the service context will be checked in Runtime. This setting will influence the trigger authorization for the signaling device.

- No Windows user logged on. No user is defined as "User in service context" in WinCC User Administrator. The signaling device will always be activated in Runtime.

- A Windows user is logged on. Interactive user inputs are possible. If a user is defined in the service context does not have an effect in Runtime. The authorizations of the logged on WinCC user will be checked in Runtime.
1.3 WinCC/Connectivity Pack Installation Notes

1.3.1 Connectivity Pack licensing

Introduction
The WinCC/Connectivity Pack enables licensed access to online and archive data of WinCC. The Connectivity Pack includes licenses for access using:

- WinCC OPC XML DA Server
- WinCC OPC-DA Server
- WinCC OPC HDA Server
- WinCC OPC A&E Server
- WinCC OPC UA Server

Starting from WinCC/Connectivity Pack V7.0, a WinCC Client Access License (WinCC/CAL) is no longer required.

1.3.2 How to Install MS Message Queuing

Introduction
WinCC implements the Message Queuing services from Microsoft. It is a component part of the operating system.

MS Message Queuing is however not included in the standard Windows installation and must be installed separately if required.

Note
WinCC is enabled for operation within a domain or workgroup.

Note however that domain group policies and restrictions in the domains may prevent installation. In this case, remove the computer from the domain before installing Microsoft Message Queuing, Microsoft SQL Server 2016 and WinCC. Log on to the computer concerned locally with administrator rights. Carry out the installation. Following successful installation, the WinCC computer can be registered in the domain again. If the domain-group policies and domain restrictions do not impair the installation, the computer must not be removed from the domain during installation.

Note however that domain group policies and restrictions in the domain may also hinder operation. If these restrictions cannot be overcome, operate the WinCC computer in a work group.

If necessary, contact the domain administrator.
Procedure - Windows 10

1. Go to "Control Panel > Programs and Features".
2. Click the "Turn Windows features on or off" button on the left menu bar.
   The "Windows Features" dialog opens.
3. Activate the "Microsoft Message Queue (MSMQ) server" component.
   The "Microsoft Message Queue (MSMQ) Server Core" entry is selected.
   The subcomponents remain disabled.
4. Confirm with "OK".


1. Start the Server Manager.
2. Click on "Add roles and features".
   The "Add Roles and Features Wizard" window opens.
3. Click "Server selection" in the navigation area.
   Ensure that the current computer is selected.
4. Click "Features" in the navigation area.
5. Select the following options:
   − "Message queuing"
   − The "Message Queuing Services" option below
   − The "Message Queuing Server" option below
6. Click "Install".

1.3.3 Installation of the Connectivity Pack Server

Introduction

The installation of the Connectivity Pack Server includes the following components:

- WinCC OLE DB Provider
- SQL Server 2016 SP2 64-bit
- "Automation License Manager" for Management of WinCC Licenses
- WinCC Archive Connector
- WinCC DataConnector
- WinCC DataConnector
- WinCC Basic Components
- Documentation
- Examples
Requirement

- Hardware requirement:
  Observe the hardware requirements of WinCC V7.5 for WinCC servers.

- Operating system:
  - Windows 10 Pro / Enterprise / Enterprise LTSB (max. 3 clients) 64-bit
  - Windows Server 2012 R2 Standard / Datacenter 64-bit
  - Windows Server 2016 Standard / Datacenter 64-bit

- Microsoft Message Queuing must be installed.

- Microsoft Internet Explorer as of V11.0 (32-bit)

- For access to WinCC RT archives, WinCC V7.5 must be installed.

Note

To use more than three clients, you must install the server version.

With the workstation version, you can use max. three clients.

Procedure

1. In order to configure a computer as Connectivity Pack Server, run the Connectivity Pack Server setup on the computer.


Licensing

For operation of the Connectivity Pack Server, the license for the WinCC Connectivity Pack option is required.

Access rights

All the users of the WinCC/Connectivity Pack have to be included in the Windows user group "SIMATIC HMI".

The user has to be a member of the user group "SIMATIC HMI" on the Connectivity Pack server for remote access of a Connectivity Pack client.
1.3.4 Installation of the Connectivity Pack Client

Introduction

The installation of the Connectivity Pack Client includes the following components:

- WinCC OLE DB Provider
- WinCC DataConnector
- SQL Connectivity Tools
- Documentation

Note

In order to install the SQL Connectivity Tools, you will need administrator rights on the computer.

Requirement

- Operating system:
  - Windows 10 Pro / Enterprise / Enterprise LTSB 64-bit
  - Windows Server 2012 R2 Standard / Datacenter 64-bit
  - Windows Server 2016 Standard / Datacenter 64-bit
- Microsoft Message Queuing must be installed.
- Microsoft Internet Explorer as of V11.0 (32-bit)

Procedure

1. In order to configure a computer as Connectivity Pack Client, run the Connectivity Pack Client setup on the computer.
2. Select the "ConnectivityPack-Client" entry on the WinCC Product DVD in the "Program Packages" dialog.
3. If WinCC V7.5 is already installed on the client, an additional installation of the Connectivity Pack Client is not required.

Access rights

All the users of the WinCC/Connectivity Pack have to be included in the Windows user group "SIMATIC HMI".

The user has to be a member of the user group "SIMATIC HMI" on the Connectivity Pack server for remote access of a Connectivity Pack client.
1.4 WinCC/Connectivity Pack Release Notes

1.4.1 Information on the Connectivity Pack

Content

These release notes contain important information.

The statements in these release notes take precedence over information provided in the manuals and in the online help.

Please read these release notes carefully as they contain useful information.

Exchange of data between OPC client and Connectivity Station via OPC UA

A OPC UA server is implemented in the Connectivity Station which is available at the address "opc.tcp://[HostName]:[Port]".

<table>
<thead>
<tr>
<th>HostName</th>
<th>Placeholder for the computer name; is inserted automatically.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port</td>
<td>Port number. The default is &quot;4864&quot;.</td>
</tr>
</tbody>
</table>

Limitation for use of WinCC OLEDB Provider

As of WinCC V7.2, the function "Import" via the interface "WinCC OLEDB Provider" does not run in MS Office Excel.

Saving examples prior to uninstallation

When uninstalling the Connectivity Pack, the included examples are also uninstalled from the path "Installation Directory\SAMPLES". If you want to save the examples, you need to copy the files from this path to a different directory.
1.5 WinCC/DataMonitor Installation Notes

1.5.1 Requirements of installing DataMonitor

Introduction

Certain hardware and software configuration requirements must be fulfilled for installation.

Note

A DataMonitor server cannot be operated on a WinCC client without a project of its own. Only use a DataMonitor server on a computer which is not operated in WinCC ServiceMode.

Hardware requirements

To work with WinCC/DataMonitor efficiently, select a system that meets the recommended specifications for an optimum configuration.

<table>
<thead>
<tr>
<th>DataMonitor server</th>
<th>Minimum</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td>DataMonitor server on WinCC server for more than 10 clients</td>
<td>CPU: Dual core CPU; 2.5 GHz</td>
<td>Multi core CPU; 3.5 GHz</td>
</tr>
<tr>
<td></td>
<td>Work memory: 4 GB</td>
<td>8 GB</td>
</tr>
<tr>
<td>DataMonitor server on WinCC server with WinCC project in Runtime</td>
<td>CPU: Dual core CPU; 2.5 GHz</td>
<td>Multi core CPU; 3.5 GHz</td>
</tr>
<tr>
<td></td>
<td>Work memory: 4 GB</td>
<td>8 GB</td>
</tr>
<tr>
<td>DataMonitor server on WinCC server</td>
<td>CPU: Dual core CPU; 2.5 GHz</td>
<td>Multi core CPU; 3.5 GHz</td>
</tr>
<tr>
<td></td>
<td>Work memory: 4 GB</td>
<td>&gt; 4 GB</td>
</tr>
<tr>
<td>DataMonitor server on WinCC single-user system or WinCC client with its own project</td>
<td>CPU: Dual core CPU; 2.5 GHz</td>
<td>Multi core CPU; 3.5 GHz</td>
</tr>
<tr>
<td></td>
<td>Work memory: 4 GB</td>
<td>&gt; 4 GB</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>DataMonitor client</th>
<th>Minimum</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Dual core CPU; 2 GHz</td>
<td>Multi core CPU; 3 GHz</td>
</tr>
<tr>
<td>Work memory</td>
<td>1 GB</td>
<td>2 GB</td>
</tr>
</tbody>
</table>

Software requirements

Certain requirements concerning operating system and software configuration must be met for the installation.

Microsoft Internet Information Service (IIS)

Before installing the DataMonitor server, you must first install the Internet Information Service (IIS).
DataMonitor server on WinCC server

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Software</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Server 2012 R2 Standard / Datacenter 64-bit</td>
<td>Internet Explorer as of V11.0 (32-bit)</td>
</tr>
<tr>
<td>Windows Server 2016 Standard / Datacenter 64-bit</td>
<td>WinCC Basic System V7.5 or WinCC File Server V7.5</td>
</tr>
</tbody>
</table>

If you want to publish Intranet information, the following is required:

- A network-capable computer with a LAN connection
- A system that converts computer names into IP addresses. This step allows users to use "alias names" instead of IP addresses when connecting to your server.

If you want to publish information in the Internet, the following is required:

- An Internet connection and an IP address from your Internet service provider (ISP). You can only publish information in the Internet, if you have a connection to the Internet provided by the ISP.
- A network adapter that is suitable for connecting to the Internet.
- A DNS registration for your IP address. This step allows users to use "alias names" instead of IP addresses when connecting to your server.

DataMonitor server on WinCC single-user system or WinCC client with its own project

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Software</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 10 Pro / Enterprise / Enterprise LTSB 64-bit (max. 3 clients)</td>
<td>Internet Explorer as of V11.0 (32-bit)</td>
</tr>
<tr>
<td>Windows Server 2012 R2 Standard / Datacenter 64-bit</td>
<td>WinCC Basic System V7.5 or WinCC File Server V7.5</td>
</tr>
</tbody>
</table>
| Windows Server 2016 Standard / Datacenter 64-bit | For the components "Excel Workbook Wizard" and "Excel Workbook":
  - Microsoft Office 2013 SP1 32-bit version
  - Microsoft Office 2016 32-bit version |

You also need access to the Intranet/Internet or a TCP/IP connection to the Web server.

DataMonitor client

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Software</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 7 SP1 Professional / Enterprise / Ultimate 32-bit / 64-bit</td>
<td>Internet Explorer as of V11.0 (32-bit)</td>
</tr>
<tr>
<td>Windows 8.1 Pro / Enterprise / 32-bit / 64-bit</td>
<td>WinCC Basic System V7.5 or WinCC File Server V7.5</td>
</tr>
</tbody>
</table>
| Windows 10 Pro / Enterprise / Enterprise LTSB 64-bit | For the components "Excel Workbook Wizard" and "Excel Workbook":
  - Microsoft Office 2013 SP1 32-bit version
  - Microsoft Office 2016 32-bit version |
| Also other operating systems via MS Terminal Services | Also other operating systems via MS Terminal Services |

You also need access to the Intranet / Internet or a TCP/IP connection to the Web server.
1.5.2 User rights for installing the DataMonitor client

Introduction

You can install the DataMonitor client as follows:

- Installation from the product DVD
  In this case, certain Windows user rights are necessary, depending on the operating system.

- Installation via the Intranet/Internet
  In this case, certain Windows user rights are necessary, depending on the operating system.

- Installation using the group policy-based software distribution in networks
  This can be done without any user interaction and using the Windows user permissions of the current user.

Windows user permissions required for installation and initial logon of the client

Depending on the operating system, specific minimum user rights are required to install the DataMonitor client via Intranet/Internet.

After installation, the client must log in with the following user identification for initial registration on the DataMonitor server:

- Under a user identification with Windows user rights higher or equal to those defined by the user identification that was given for the installation.

The connections must be established successfully. The subsequent logins can then be performed under a different Windows user authorization with possibly limited rights.

Minimum required user rights:

- Administrator

Installing the DataMonitor client with limited Windows user rights

Using Microsoft Windows Installer technology (MSI), DataMonitor clients can also be installed with limited Windows user permissions, i.e. permissions other than "Power user" or "Administrator".

This procedure can be set during the installation using the group policy based software distribution in networks.

Even the add-ins and plug-ins for the DataMonitor client can be installed in this way. The minimum user permissions described above are also required to install plug-ins created with WinCC Plug-In Builder.

Using MSI technology, it is also possible to install the DataMonitor client for a configured group of users or computers.

Installation for a configured group of users or computers
The following is possible with the Microsoft Systems Management Server or a group policy on a Domain Controller:

- The installation for a group of users or computers configured by the administrator
  - To do this, the "WinCCDataMonitorClient.msi" MSI file is published on the domain controller and then released for a user group. The installation is then performed according to the configuration of the group policy based software distribution either during login of the defined users or when the computer is started.
  - When using a Microsoft Systems Management Server, the installation is configured by the administrator, triggered and executed when the relevant computer boots. Additional information on Microsoft Systems Management Server is available in the Internet on the Microsoft Homepage.

**Group policy based software distribution**

The software installation is normally executed with the access rights of the current Windows user. When using MSI technology, the installation is performed by an operating system service with a higher level of rights. This enables installations to be performed for which the Windows user has no permission. Applications which require installations with a higher permission are referred to as "privileged installations" in MSI technology. Installation of these applications is possible when a Windows user is assigned the "Always install with elevated privileges" permission.

In order to use the group policy-based software distribution, a group policy is created on the domain controller and assigned to the distributing software or published using Active Directory.

- Assignment: The software distribution can be assigned to a user or a computer. In this case, the software to be distributed is automatically installed when the user logs in or the computer is started.
- Publication: The software distribution can be published for single users. In this case, when the user logs onto the client computer, the software to be distributed appears in a dialog and can be selected for installation.

### 1.5.3 Installing the Internet Information Service (IIS)

**Settings**

Before installing the DataMonitor server, you must first install the Internet Information Service (IIS). You specify the settings for the DataMonitor server during installation.
Select the following settings:

- **Web management tools:**
  - IIS management service
  - IIS management console
  - IIS management scripts and tools
  - Compatibility with IIS Metabasis and IIS 6 configuration
  - Compatibility with WMI for IIS 6

- **WWW Services > Common HTTP Features or Shared HTTP Features:**
  - Standard document
  - Static content
  - HTTP error

- **WWW services > Application development features:**
  - .NET extendibility
  - ASP
  - ASP.NET
  - ISAPI extensions
  - ISAPI filters

- **WWW Services > security:**
  - Request filtering
  - Basic Authentication
  - Windows authentication

**Note**

If the logging functions are active with IIS, the log files must be monitored and deleted, if necessary. The event views should be configured so that the log files do not become too large.

**Requirements**

- To do this, you must have administrator rights.

**Procedure**

1. Select “Programs and Features” from the Control Panel.
2. Click "Turn Windows features on or off" or "Add/Remove Windows Components".
3. Activate the settings specified above.
   You can also use the command line "Start > Run > cmd" to install the IIS components:
   pkgmgr.exe /iu:IIS-WebServerRole;IIS-WebServer;IIS-CommonHttpFeatures;IIS-
   StaticContent;IIS-DefaultDocument;IIS-HttpErrors;IIS-ASPNET;IIS-ASP;IIS-
   ISAPIExtensions;IIS-ISAPIFilter;IIS-BasicAuthentication;IIS-WindowsAuthentication;IIS-
   ManagementConsole;IIS-ManagementService;IIS-IIS6ManagementCompatibility;IIS-
   Metabase;IIS-WMICompatibility

4. Click "OK" to close the dialog. The required data is transferred and the IIS is configured
   accordingly.


Configure the settings in the Server Manager using the "Webserver (IIS)" role in the associated
role services.

1.5.4 Installing DataMonitor

Introduction

This chapter describes the installation of the DataMonitor server and DataMonitor client.
Installation on the DataMonitor client depends on the DataMonitor tool used.

DataMonitor server scope of installation

A DataMonitor server is installed and set up as the web server to enable WinCC/DataMonitor
to be used.

This installation allows you to access the WinCC runtime archive using "Trends & Alarms".
Only "Webcenter" and "Trends & Alarms" are installed on a computer with WinCC file server,
for example, used as a archive server, because the other components require WinCC Runtime.
"Webcenter" and "Trends & Alarms" install all necessary components in the process.

Microsoft Internet Information Service (IIS)

Before installing the DataMonitor server, you must first install the Internet Information Service
(IIS).

DataMonitor client installation conditions

You need not install the DataMonitor client if you only want to use "Webcenter" and "Trends
and Alarms".

You can install the Excel add-ins "ExcelWorkbook Wizard" and "Excel Workbook" individually
under "Reports/Download area" on the DataMonitor start page for the "Reports".
"Microsoft Excel" is needed for "Excel Workbook". The following Office versions are approved:

- Microsoft Office 2013 SP1
- Microsoft Office 2016
Depending on the operating system, specific user rights may be required for installing the DataMonitor client. For additional information on this, see "User rights for installing the DataMonitor client".

---

**Note**

**Downloading the client setup**

To save the client setup on the client computer, select the "Save" option when downloading the client software from the DataMonitor server. It is recommended to save the Setup file because, in the event of a restart of the client computer being necessary, the Setup need not be downloaded again.

If the DataMonitor client has already been installed from DVD and you want to install an updated version of the client via the Intranet/Internet, you must save the client setup on the target computer.

If the DataMonitor client is a 64-bit computer, an additional link is displayed during installation over Intranet/Internet to install "Visual C++ 2010 Redistributable". You must first perform this installation because it is required for the DataMonitor client. In addition, "Visual C++ 2010 Redistributable" must be available as an "msi" packet. If the DataMonitor clients on the 64-bit computers are integrated in domain group policies, the users of the clients must install "DataMonitorClient_x64_AddOn.msi" themselves.

**Excel Workbook Wizard requires Microsoft .Net Framework**

In order to use Excel Workbook Wizard make sure that the .Net Framework is installed on the DataMonitor client.

**Client installation on a DataMonitor server**

Proceed as follows if you also wish to install the DataMonitor client or WebNavigator client on a DataMonitor server:

1. Use the Services Manager in Windows to set the start type of the "CCArchiveConnMon" service to manual.
2. Restart the computer.
3. Install the client.
   Ensure that no WebNavigator clients or DataMonitor clients access the server during installation.
4. Switch the start type of the "CCArchiveConnMon" service back to automatic.

---

**Requirement**

- The DataMonitor server requires the [Internet Information Services (IIS)](Page 86).
- The DataMonitor server requires the WinCC configuration data.
- You need Windows "Administrator" rights to install the DataMonitor server.
Procedure

1. Insert the WinCC DVD into the DVD drive.
2. If the automatic execution of an autorun file is activated, after a few seconds the setup program starts automatically. The setup can also be started manually in case the installation is performed from a network drive or the autorun function has been disabled. The setup program is started.
3. To install, click the text "Install Software".
4. In the following dialog, select the component "DataMonitor Server" or "DataMonitor Client".
5. Follow the instructions of the setup program.

See also

Installing the Internet Information Service (IIS) (Page 86)

1.5.5 DataMonitor licensing

DataMonitor client

No license is required for the DataMonitor client on the computer.
The DataMonitor clients are licensed on the DataMonitor server. Install the license keys for the client access to the server on the DataMonitor server.

DataMonitor server

As a prerequisite for the WinCC basic system, the WinCC RT basic license is required.
Licenses are available for 1 / 3 / 10 / 30 clients that can simultaneously access the DataMonitor server. The licenses are cumulative.
A message will appear if the number of licensed clients is exceeded during a login attempt by a DataMonitor client. No further logins will be possible.

Note

The connection to the DataMonitor server is maintained if the user closes the DataMonitor start page without logging off with the "Log off" button.
The license remains allocated and is only released after approximately 20 minutes.
License count

DataMonitor distinguishes between the following function groups:

- **Excel Workbooks**
  A "WinCC DataMonitor" license is required on the server computer for each DataMonitor client.

- **Webcenter, Trends & Alarms, Reports**
  It is not the number of clients but the number of connections that is relevant for the license count for the Webcenter function group.

The following table shows the maximum number of clients or connections per license based on the function group. The values are valid only within a function group.

<table>
<thead>
<tr>
<th>License</th>
<th>Excel Workbooks</th>
<th>Webcenter, Trends &amp; Alarms, Reports</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Client</td>
<td>1</td>
<td>3</td>
</tr>
<tr>
<td>3 Clients</td>
<td>3</td>
<td>6</td>
</tr>
<tr>
<td>10 clients</td>
<td>10</td>
<td>20</td>
</tr>
<tr>
<td>30 Clients</td>
<td>30</td>
<td>60</td>
</tr>
</tbody>
</table>

1) The same values apply even if you cumulate licenses.

In the following example, two licenses are installed on the DataMonitor server: "1 Client" a"3 Clients".

The following cumulative values apply depending on the selected function group:

**Example: Excel Workbooks**

<table>
<thead>
<tr>
<th>Installed licenses</th>
<th>Function group</th>
<th>Maximum logged on users</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;1 Client&quot; + &quot;3 Clients&quot;</td>
<td>Excel Workbooks</td>
<td>4</td>
</tr>
</tbody>
</table>

**Example: Webcenter, Trends & Alarms, Reports**

<table>
<thead>
<tr>
<th>Installed licenses</th>
<th>Function group</th>
<th>Maximum logged on users</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;1 Client&quot; + &quot;3 Clients&quot;</td>
<td>Webcenter, Trends &amp; Alarms, Reports</td>
<td>8</td>
</tr>
</tbody>
</table>

No operation without a valid license

If no license is available, DataMonitor displays a page reporting the missing license.

Check the existing licenses. If necessary, install the required licenses.

Using DataMonitor versions prior to V7.4

DataMonitor versions up to V7.3 do not recognize licenses from DataMonitor V7.4 and higher.

Once you install the current DataMonitor licenses on a computer, a DataMonitor installation of a version prior to V7.4 is no longer licensed.

This also applies if you upgrade to the new cumulative licenses through an upgrade license. The upgraded licenses are no longer recognized by DataMonitor V7.3 or earlier versions.
The upgrade to DataMonitor V7.4 or higher cannot be reversed.
1.6 WinCC/DataMonitor Release Notes

1.6.1 Notes about DataMonitor

These release notes contain important information.

The statements in these release notes take precedence over information provided in the manuals and in the online help.

Please read these release notes carefully as they contain useful information.

Using a secure connection over HTTPS

To improve the security of your communication, configure the DataMonitor server in such a way that only HTTPS connections are supported.

You need a digital certificate for the DataMonitor server for this purpose. Also use SSL certificates on the DataMonitor clients.

Detailed information is available in the Microsoft Support under "How To Set Up an HTTPS Service in IIS" (http://support.microsoft.com/kb/324069/EN-US (http://support.microsoft.com/kb/324069)).

System load through large amounts of data

Note that SQL queries returning large amounts of data can affect system functionality.

Select filter criteria which limit the amount of data in a useful manner.

Opening Excel workbooks on a computer not connected to the Internet

If you want to use the DataMonitor client on a computer not connected to the Internet, you must deactivate certificate checking. To do this, follow these steps:

● Open Internet Explorer.
● Select the "Internet Options" command from the "Tools" menu.
● Click "Advanced".
● In the "Security" section, deactivate the setting "Check for publisher's certificate revocation".

Excel workbook functions and print jobs after deactivating and activating WinCC Runtime

If you deactivate WinCC Runtime and then reactivate it, you also need to restart the Web application.
Excel workbook: volume of requested data for archived values

Although you can limit the requested data volume with the "Data resolution" property, all data of the defined time period is initially used internally. This may have the result that the internal system limit is reached. Use compression archives to limit the data volume.

Web Client: Display of ActiveX controls in Internet Explorer

ActiveX controls are disabled in Internet Explorer by default. For this reason, the WinCC controls are not displayed correctly in Internet Explorer on a Web client.

To display the WinCC controls correctly, add the Web server as a trusted website and enable the ActiveX controls only for the "Trusted sites" zone.

To continue protecting Internet Explorer from foreign ActiveX controls, check that the restricted security settings still apply to the other zones after making the changes.

For more information, refer to the following documentation:

- WinCC/DataMonitor: "WinCC/DataMonitor Documentation > Configuring the DataMonitor System > Working with the DataMonitor Client > Configuring Security Settings in Internet Explorer"

DataMonitor server: Remote access to WinCC file server

Remove access from one DataMonitor server to a WinCC file server is possible only if the firewall is disabled on the WinCC file server.

Excel workbook: Local times on DataMonitor client and DataMonitor server

Note when requesting archive data that the local times on the server and client may differ if they have not been sufficiently synchronized, for example because automatic synchronization is not possible.

The DataMonitor client attempts to establish the current time of the DataMonitor server when archive data is requested. If it succeeds, the query will be based on the server time. For the display of data in the Excel table, the time stamp represents the server time but in the local time zone of the client.

If the query of the server time is unsuccessful, the DataMonitor client will base the time period of the query on its local time. An entry will also be made in the Windows event display on the DataMonitor client. For the display of data in the Excel table, the time stamp represents the client time.

Excel workbook: Client on terminal server

In the case of operation on a terminal server, an Excel Workbook client will run in a session of the terminal services. A maximum of only 10 Excel workbook clients can be operated; otherwise, MS Excel will overload the computer.
Trends & Alarms: Display of archive data after copying a project

To copy a WinCC project between computers and then display the archive data of the project on the target computer in "Trends & Alarms", you will first need to copy the project using the WinCC Project Duplicator.

If you use Windows Explorer rather than the Project Duplicator to copy the project, the runtime data will not be adapted to the target computer. The computer name of the source computer and not that of the target computer is displayed in the archive selection in "Trends and Alarms". The computer name of the target computer is displayed in the selection field only after the archive has been reset in Alarm Logging and Tag Logging.

See also

http://support.microsoft.com/kb/324069 (http://support.microsoft.com/kb/324069)
1.7 WinCC/WebNavigator Installation Notes

1.7.1 General information on the WebNavigator installation

Scope of delivery

You can find the following components for WinCC/WebNavigator on the WinCC DVD:

- WebNavigator server
- WebNavigator client
- WinCCViewerRT
- WebNavigator diagnostics client
- Web View Publisher
- WebNavigator Plug-In Builder
- Documentation
- Release notes

Note

Installation of WinCC/WebNavigator V7.5 is only released on the basis of WinCC V7.5

You cannot install the WebNavigator server/client of V7.5 on a computer with WinCC versions earlier than V7.5. Nor can a WebNavigator server/client version older than V7.5 be installed on a computer with WinCC V7.5.

Note that mixed use of European and Asian versions of WinCC and WebNavigator is not permitted in the configuration.

1.7.2 WebNavigator installation requirements

1.7.2.1 Hardware and software requirements for WebNavigator

Introduction

This section describes the hardware and operating system requirements for WinCC/WebNavigator.
Notes on the software requirements

**Microsoft Internet Information Service (IIS)**
Before installing the WebNavigator Server, you must first install the Internet Information Service (IIS).

**Note**
A WebNavigator server cannot be operated on a WinCC client without a project of its own.

**Internet Explorer 11**
If you are using Internet Explorer 11, adjust the following settings:
1. Select the "Tools > Manage Add-ons" menu command.
These add-ons can have an adverse effect on the stability of Internet Explorer 11.

**WebNavigator client**

**Hardware**

<table>
<thead>
<tr>
<th></th>
<th>Minimum</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Dual core CPU; 2 GHz</td>
<td>Multi core CPU; 3 GHz</td>
</tr>
<tr>
<td>Work memory</td>
<td>1 GB</td>
<td>2 GB</td>
</tr>
</tbody>
</table>

**Software**

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Windows 7 SP1 Professional / Enterprise / Ultimate 32-bit / 64-bit</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Windows 8.1 Pro / Enterprise 32-bit / 64-bit</td>
</tr>
<tr>
<td></td>
<td>Windows 10 Pro / Enterprise 64-bit</td>
</tr>
<tr>
<td></td>
<td>Windows 10 Enterprise LTSE 64-bit</td>
</tr>
<tr>
<td></td>
<td>Windows Server 2012 R2 Standard / Datacenter 64-bit</td>
</tr>
<tr>
<td></td>
<td>Windows Server 2016 Standard / Datacenter 64-bit</td>
</tr>
<tr>
<td></td>
<td>Also other operating systems via MS Terminal Services</td>
</tr>
<tr>
<td></td>
<td>Windows Embedded Standard 7 including SP1 in combination with SIMATIC IPC 4x7D and SIMATIC IPC 4x7E</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Software</th>
<th>Internet Explorer as of V11.0 (32-bit)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>WebNavigator client: For installation via Intranet/Internet, the latest cumulative security update for Internet Explorer must be installed. Additional information is available in the Microsoft Update KB3072449.</td>
</tr>
</tbody>
</table>

| Other          | Access to the intranet/Internet or a TCP/ IP connection to the WebNavigator server |
WebNavigator server on a WinCC single-user system

Hardware

<table>
<thead>
<tr>
<th></th>
<th>Minimum</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Dual core CPU; 2.5 GHz</td>
<td>Multi core CPU; 3.5 GHz</td>
</tr>
<tr>
<td>Work memory</td>
<td>2 GB</td>
<td>&gt; 4 GB</td>
</tr>
</tbody>
</table>

Software

Operating system
- Windows 10 Pro / Enterprise 64-bit
- Windows 10 Enterprise LTSG 64-bit
- Windows Server 2012 R2 Standard / Datacenter 64-bit
- Windows Server 2016 Standard / Datacenter 64-bit

Software
- Internet Explorer as of V11.0 (32-bit)
- WinCC Basic System V7.5

Other
- Access to the intranet/Internet
- or a TCP/IP connection to the WebNavigator client

WebNavigator server on WinCC server or WinCC client with its own project

Hardware

<table>
<thead>
<tr>
<th></th>
<th>Minimum</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Dual core CPU; 2.5 GHz</td>
<td>Multi core CPU; 3.5 GHz</td>
</tr>
<tr>
<td>Work memory</td>
<td>4 GB</td>
<td>8 GB</td>
</tr>
</tbody>
</table>

Software

Operating system
- Windows Server 2012 R2 Standard / Datacenter 64-bit
- Windows Server 2016 Standard / Datacenter 64-bit

Software
- Internet Explorer as of V11.0 (32-bit)
- WinCC Basic System V7.5

Other
- Access to Intranet/Internet
- If you wish to publish on the Intranet, you will need a system that converts computer names into IP addresses. This step allows users to use alias names instead of IP addresses when connecting to the server.
- You will need DNS registration for your IP address if you wish to publish on the Internet. This step allows users to use alias names instead of IP addresses when connecting to the server.
WebNavigator diagnostics client

Software

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Windows 7 SP1 Professional / Enterprise / Ultimate 32-bit / 64-bit</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Windows 8.1 Pro / Enterprise 32-bit / 64-bit</td>
</tr>
<tr>
<td></td>
<td>Windows 10 Pro / Enterprise 64-bit</td>
</tr>
<tr>
<td></td>
<td>Windows 10 Enterprise LTBS 64-bit</td>
</tr>
<tr>
<td></td>
<td>Windows Server 2012 R2 Standard / Datacenter 64-bit</td>
</tr>
<tr>
<td></td>
<td>Windows Server 2016 Standard / Datacenter 64-bit</td>
</tr>
<tr>
<td>Software</td>
<td>Internet Explorer as of V11.0 (32-bit)</td>
</tr>
<tr>
<td>Other</td>
<td>Access to Intranet/Internet</td>
</tr>
</tbody>
</table>

See also

[Installing the Internet Information Server (IIS) (Page 103)]

1.7.2.2 Licensing WebNavigator

WebNavigator client

No license is required for the PC on which the WebNavigator client is running, as server licenses are available on the WebNavigator server.

WebNavigator server

As a prerequisite for the WinCC basic system, the WinCC RT basic license is required. No WinCC server license is required if no local WinCC clients are to be operated. Even when operating a WinCC client as a dedicated web server, you do not require a WinCC server license for the WinCC client.

Licenses are available for 1 / 3 / 10 / 30 / 100 clients. If you have upgraded a WebNavigator version prior to V7.4, there may also be licenses for 5 / 25 / 50 / 150 clients.

The packages are version-independent and can be combined. Up to 150 clients can access the WebNavigator server simultaneously.

A message will appear if the number of licensed clients is exceeded during a login attempt by a WebNavigator client. No further logins will be possible.

WinCC/WebUX clients

If the WinCC/WebUX option is also used in the WinCC system, a WebUX client can also occupy a WebNavigator license. This reduces the number of available WebNavigator licenses.

You can find more information in the documentation for WinCC/WebUX.

Test mode

If there is no WebNavigator license or if the license has been removed, the WebNavigator server runs in Test mode.
Test mode runs for a maximum of 30 days from the date of installation. Once 30 days have expired after the installation, the WebNavigator server can only be started with an installed license.

**WebNavigator diagnostics client**

A "Diagnostics client" license is required on the client computer for the diagnostics client. The diagnostics client can access on the WebNavigator server in the following cases:

- When the maximum number of simultaneous accesses has been reached on WebNavigator server.
- When no WebNavigator license is installed on the WebNavigator server.

**Diagnostics client without corresponding license**

If the diagnostics client is installed without the corresponding license, a message will appear about one hour after each start-up of the computer.

Install the diagnostics client license or remove the diagnostics client software.

**No access via RDP**

Access via Remote Desktop Protocol (RDP) is not enabled for the diagnostics client.

---

**Note**

**Computer with WinCC basic system and diagnostics client**

If you install a diagnostics client on a computer with the WinCC basic system, you will have to reinstall the diagnostics client after removing WinCC.

---

**Overview of licenses for WebNavigator server and client**

You can combine WebNavigator and diagnostics licenses.

<table>
<thead>
<tr>
<th>Server</th>
<th>Client has no license ¹)</th>
<th>Client has diagnostics client license ³)</th>
</tr>
</thead>
<tbody>
<tr>
<td>No WinCC license</td>
<td>Client in test mode</td>
<td>Client in test mode</td>
</tr>
<tr>
<td>No WebNavigator license</td>
<td>Unlimited number</td>
<td>Unlimited number</td>
</tr>
<tr>
<td>WinCC license</td>
<td>Client in test mode</td>
<td>Diagnostics client</td>
</tr>
<tr>
<td>No WebNavigator license</td>
<td>Unlimited number</td>
<td>One license per diagnostics client</td>
</tr>
<tr>
<td>WebNavigator license</td>
<td>Client in test mode</td>
<td>Client in test mode</td>
</tr>
<tr>
<td>No WinCC license</td>
<td>Unlimited number</td>
<td>Unlimited number</td>
</tr>
<tr>
<td>WebNavigator license  + WinCC license</td>
<td>WebNavigator client</td>
<td>Diagnostics client</td>
</tr>
<tr>
<td></td>
<td>Number up to maximum of</td>
<td>One license per diagnostics client</td>
</tr>
<tr>
<td></td>
<td>the server license</td>
<td></td>
</tr>
</tbody>
</table>

¹) ¹st

²) ²nd

³) ³rd
### Server

<table>
<thead>
<tr>
<th>Server</th>
<th>Client has no license ¹</th>
<th>Client has diagnostics client license ¹</th>
</tr>
</thead>
<tbody>
<tr>
<td>WebNavigator license</td>
<td>WebNavigator client</td>
<td>Diagnostics client</td>
</tr>
<tr>
<td>+ WinCC license</td>
<td>Number up to maximum of server license</td>
<td>One license per diagnostics client</td>
</tr>
<tr>
<td>+ &quot;Load Balancing&quot; license</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WebNavigator license</td>
<td>WebNavigator client</td>
<td>Diagnostics client</td>
</tr>
<tr>
<td>+ WinCC license</td>
<td>Number up to maximum of server license</td>
<td>One license per diagnostics client</td>
</tr>
<tr>
<td>+ WinCC Redundancy license</td>
<td></td>
<td></td>
</tr>
<tr>
<td>+ &quot;Load Balancing Step-Up&quot; license</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

¹) Note the behavior in test mode. Test mode runs for a maximum of 30 days from the date of installation.

### Restarting the WebNavigator client after license modification

If the WebNavigator licenses on the WebNavigator server are modified, e.g. to a different number of clients, Internet Explorer must be restarted on each connected WebNavigator client, and the WebNavigator client must log in again. Otherwise, the WebNavigator client will switch to demo mode. This also applies to automatic reconnection of the WebNavigator client.

### Using WebNavigator versions prior to V7.4

WebNavigator versions up to V7.3 do not recognize licenses from WebNavigator V7.4 and higher.

Once you install the current WebNavigator licenses on a computer, a WebNavigator installation of a version prior to V7.4 is no longer licensed.

This also applies if you upgrade to the new cumulative licenses through an upgrade license. The upgraded licenses are no longer recognized by WebNavigator V7.3 or earlier versions.

It is not possible to undo the upgrade to WebNavigator V7.4 or higher.

### 1.7.2.3 Requirements for the Use of Terminal Services

The WebNavigator client is released for Windows Terminal Services.

A maximum of 150 sessions per terminal server are permitted.

### Terminal server

**Hardware**

<table>
<thead>
<tr>
<th></th>
<th>Minimum</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Dual core CPU; 2 GHz</td>
<td>Multi core CPU; 3 GHz</td>
</tr>
<tr>
<td>Work memory</td>
<td>1 GB</td>
<td>2 GB</td>
</tr>
</tbody>
</table>

**Note**

Each terminal client will increase the memory requirements and the processor load. You must therefore ensure that the terminal server has adequate memory and processor load capacity.
### Software

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Windows Server 2012 R2 Standard / Datacenter 64-bit</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Windows Server 2016 Standard / Datacenter 64-bit</td>
</tr>
<tr>
<td>It must be possible to repeatedly call and execute applications that are to be executed on the clients.</td>
<td></td>
</tr>
<tr>
<td>Miscellaneous:</td>
<td>If many users want to access the server, you will need to use a high-performance network card.</td>
</tr>
</tbody>
</table>

### Terminal client

<table>
<thead>
<tr>
<th>Minimum requirement:</th>
<th>Network card with TCP/IP</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Terminal client RDP 5.0</td>
</tr>
<tr>
<td></td>
<td>Display or monitor</td>
</tr>
<tr>
<td></td>
<td>Pointing device</td>
</tr>
</tbody>
</table>

### Note

As with Windows Server CAL, there are two different CAL terminal services:
- The TS device CAL enables a device to run user-independent Windows sessions on a Windows Server.
- The TS user CAL enables a user to run device-independent Windows sessions on a Windows Server.

A Windows Server Terminal Server CAL “TS CAL” is required for every user or every device. Please go to “http://www.microsoft.com/resources/sam/lic_cal.mspx” for more information.

---

**See also**


### 1.7.3 Installing a WebNavigator server

#### 1.7.3.1 Overview: Installing the WebNavigator server

**Requirements**

- The software requirements for the Windows operating system have been met.
- Local administrator rights.
- The WinCC basic system is installed.
NOTICE

WebNavigator server: Using a secure connection over HTTPS

To increase the security of your communication, configure the WebNavigator server in such a way that only HTTPS connections are supported. You need a digital certificate for your WebNavigator server for this. For more information, refer to "How to Set Up an HTTPS Service in IIS" in Microsoft Support:

- http://support.microsoft.com/kb/324069

Installation Overview

1. Installation of the Internet Information Server (IIS).
2. Installation of the WebNavigator server.

Note

WinCC options previously installed

If you have already installed other WinCC options prior to the installation of WinCC/WebNavigator, you may have to re-install these options.

See also

- Installing the Internet Information Server (IIS) (Page 103)
- Installing the WebNavigator server (Page 105)
- http://support.microsoft.com/kb/324069

1.7.3.2 Installing the Internet Information Server (IIS)

Settings

Before installing the WebNavigator server, you must first install the Internet Information Service (IIS). You specify the settings for the WebNavigator server during installation.
Select the following settings:

- Web management tools:
  - IIS management service
  - IIS management console
  - IIS management scripts and tools
  - Compatibility with IIS Metabasis and IIS 6 configuration
  - Compatibility with WMI for IIS 6

- WWW Services > Common HTTP Features or Shared HTTP Features:
  - Standard document
  - Static content

- WWW services > Application development features:
  - .NET extendibility
  - ASP
  - ASP.NET
  - ISAPI extensions
  - ISAPI filters

- WWW Services > security:
  - Request filtering
  - Basic Authentication
  - Windows authentication

**Note**

If the logging functions are active with IIS, the log files must be monitored and deleted, if necessary. The event views should be configured so that the log files do not become too large.

**Requirements**

- Administrator rights
- Write access for the registration database

**Procedure**

1. Select "Programs and Features" from the Control Panel.
2. Click "Turn Windows features on or off" or "Add/Remove Windows Components".
3. Activate the settings specified above.
4. Click "OK" to close the dialog. The required data is transferred and the IIS is configured accordingly.
Alternative procedure

Alternatively, you can use the command line "Start > Run > cmd" to install the IIS components located on the installation data medium:

pkgmgr.exe /iu:IIS-WebServerRole;IIS-WebServer;IIS-CommonHttpFeatures;IIS-StaticContent;IIS-DefaultDocument;IIS-HttpErrors;IIS-ASPNET;IIS-ASP;IIS-ISAPIExtensions;IIS-ISAPIFilter;IIS-BasicAuthentication;IIS-WindowsAuthentication;IIS-ManagementConsole;IIS-ManagementService;IIS-IIS6ManagementCompatibility;IIS-Metabase;IIS-WMICompatibility


Configure the settings in the Server Manager using the "Webserver (IIS)" role in the associated role services.

See also

Hardware and software requirements for WebNavigator (Page 96)

1.7.3.3 Installing the WebNavigator server

Requirements

- Local administrator rights
- The Internet Information Server is installed.

Procedure

1. Insert the WinCC DVD in the drive.
   The DVD starts automatically if Autorun is enabled in the operating system. If the autorun function is not activated, start the program Setup.exe on the DVD.
2. In the "Installation Type" dialog, select "Package Installation".
3. Select the "WebNavigator Server" installation.
4. Before the installation, the security settings that are adapted for WinCC are displayed in the "System Settings" dialog.
   The firewall is configured automatically.
   Confirm the changes to the system settings.
5. Start the installation.
   You can track the status of the installation in the displayed dialog.
   Select "Cancel" to cancel the installation.
6. You can transfer the license key for the product after installation of the WebNavigator server. To do so, click on "Transfer License Key". Select "Next" if you have already transferred the license key or want to install it at a later time.

**Note**

License keys will not be transferred automatically. You will have to transfer missing license keys during or after installation with "Automation License Manager".

7. Restart the computer when prompted to do so by setup.

**Result**

The WebNavigator server is installed and is displayed in the navigation window of the WinCC Explorer.

### 1.7.4 Installing the WebNavigator client

#### 1.7.4.1 Installing the WebNavigator client

**Introduction**

You can install the WebNavigator client as follows:

- Installation from the WinCC product DVD.
  In this case, certain Windows user rights are necessary, depending on the operating system.
- Installation via the Intranet/Internet.
  In this case, certain Windows user rights are necessary, depending on the operating system.
- Installation without user interaction:
  - Using the Windows user rights of the current user
  - Or in networks, using group policy-based software distribution

In addition, you can also install the WebNavigator client on the WebNavigator server. This is useful, for example, if you want to check the WinCC project locally on the server in Internet Explorer.

**Note**

**.Net controls on the WebNavigator client**

If you wish to use .Net controls on the WebNavigator client, you need to install the .Net Framework 4.0 or higher on the client from the WinCC product DVD.
WinCCViewerRT

The web viewer "WinCCViewerRT" is installed upon installation of the WebNavigator client.

Procedure

1. Entry and check of the settings of the client computer in Internet Explorer.
2. Installation of the WebNavigator client.

Note

If you are installing from the DVD or using software distribution based on group policy, you can directly upgrade an older version of the WebNavigator client without having to remove the older client first.

If you install the WebNavigator server on a PC after the WebNavigator client, you will have to install the client again.

Plug-in reinstallation

The plug-ins "User Archive Control", "FunctionTrend Control", "Hardcopy" and "Web Client" are already integrated in the WebNavigator client as of version V7.0 upon installation.

If a WebNavigator client as of V7.0 is connected to a WebNavigator server older than V7.0 (e.g. V6.2 SP3), you will be offered these plug-ins for installation in the download area of the Web navigation user interface.

The plug-ins are already installed. Do not reinstall these plug-ins.

Information on the setup and installation of the WebNavigator client:

- Before downloading and installing a new version on the WebNavigator client, check the languages installed on the client and connected server. Only the languages of the connected server will be available on the client computer following client installation by download.

- WebNavigator client setup will be interrupted with the error message "WinCC Active" if the local WinCC project is open or has been opened since the PC was last restarted. Restart the computer. Check whether WinCC has been included in the Autostart directory. Remove the entry if necessary and then restart the computer to execute WebNavigator client installation.

- You will need at least 70 MB of free memory space on the local hard disk to install the WebNavigator client. Otherwise, the MSI setup will cancel installation with a corresponding error message.

- When installing the WebNavigator client by downloading it from the Intranet/Internet, you can select to either "Open" or "Save" the setup file. The procedure you select upon initial installation of the WebNavigator client must also be selected for the subsequent installation of plug-ins or ActiveX controls. Otherwise, the "MSI Installer" service will output the error message "Error 1316".
• Prior to installation via download, the latest cumulative security update for Internet Explorer must be installed. Additional information is available in the Microsoft Update KB3072449 (https://support.microsoft.com/en-us/kb/3072449).

• Microsoft Visual C++ 2010 Redistributable must be installed on the WebNavigator client with a 64-bit computer before the connection to the WebNavigator server is established. If the client is a 64-bit computer, an additional link is displayed during installation over the Intranet/Internet to install "Visual C++ 2010 Redistributable". You must first perform this installation because it is required for the Web client.

Note
Installation of Microsoft Visual C++ 2010 Redistributable in domain environments
In addition, "Visual C++ 2010 Redistributable" must be available as an "msi" packet:
• If the WebNavigator client on the 64-bit computer is not upgraded to the latest version via the DVD, "Webnavigatorclient.msi" and "WebNavigatorClient_x64_AddOn.msi" can be made available to the user via the domain controller.
• If the WebNavigator clients on the 64-bit computers are integrated in domain group policies, the users of the clients must install "WebNavigatorClient_x64_AddOn.msi" themselves.

• In the download area of the Web Navigation user interface, the Plug-Ins which can be installed are displayed. The same minimum user rights are required for installing these plug-ins as for installation of the WebNavigator client.
  If you select a plug-in in the Web Navigation user interface, WebNavigator client setup will start. You will have to confirm the selected plug-in again.

Upgrading the WebNavigator client from a previous version
You can download and install the demo project from the "WinCC/WebNavigator and WinCC/DataMonitor Demo Access" page at "www.wincc.de".
The system checks whether the latest version of WebNavigator client is installed.
  If an older version is present, the WebNavigator client is also upgraded when you access the demo project.

Upgrade from WinCC V6.2 SP3
Perform a repair installation after upgrading from WinCC V6.2 SP3.
  Start the WinCC/WebNavigator client installation in the Control Panel via "Uninstall or change a program" and select "Repair".
  Otherwise, controls may be reinstalled during operation.
  Restart the computer.

Installing the WebNavigator client under Windows Server
Installation of the WebNavigator client under Windows Server with a lower user authorization than "Administrator" is not possible in the default setting of group policies.
Enable the installation of the WebNavigator client in the group policy by

- Assigning and making the software public
- Or activating the setting "Always install with elevated privileges" under "Administrative Templates / Windows Components / Windows Installer".
  You must activate "Never" for the "Deactivate Windows Installer" option.

See also

https://support.microsoft.com/en-us/kb/3072449

1.7.4.2 User rights and user groups for WebNavigator clients

**Windows user rights required for installation and initial registration of the WebNavigator client**

"Administrator" rights are required for installing the WebNavigator client via Intranet/Internet or using the product DVD. The initial registration of the client on the WebNavigator server must take place with the user identification used during installation and the same or higher Windows user rights. The connections must be established successfully. All subsequent logins can then be performed by users with different Windows user rights, which may be more restricted.

**Windows user groups "SIMATIC HMI" / "SIMATIC HMI VIEWER"**

Following WinCC installation, WinCC automatically establishes the following local groups in Windows User and Group Administration:

<table>
<thead>
<tr>
<th>Group</th>
<th>Rights Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIMATIC HMI</td>
<td>These members may create local projects, and may process, start, and access these projects remotely. Access to the WinCC database is limited to the minimum rights necessary (read/write).</td>
</tr>
<tr>
<td>SIMATIC HMI Viewer</td>
<td>These members have read access only to configuration and runtime data in the WinCC database.</td>
</tr>
</tbody>
</table>

In the following cases you must add users of the WebNavigator client to a Windows user group:

- The WebNavigator client is installed on a PC on which WinCC is already installed:
  Users of the Web client must be members of the user group "SIMATIC HMI VIEWER" or "SIMATIC HMI".
- The WebNavigator client accesses the WebNavigator server as "Remote Desktop" user:
  Users of the Web client must be members of the user group "SIMATIC HMI VIEWER".

**Installing the WebNavigator client with limited Windows user rights**

The MSI technology used allows you to install the WebNavigator client even with limited Windows user rights. This procedure can be set during the installation using the group policy based software distribution in networks.

Even the add-ins and plug-ins for the WebNavigator client can be installed. "Administrator" rights are required for the installation of plug-ins that were created with the WinCC Plug-In Builder.
Installation for a configured group of users or computers

Using the Microsoft Systems Management server or group policy on a Domain Controller, it is possible to install a group of users or computers configured by the Administrator.

- For this the MSI file "WinCCWebNavigatorClient.msi" is published at the Domain Controller and enabled for a user group. Installation is then performed either during login of the defined users or when the computer is started, depending on the configuration of the group policy-based software distribution.
- When using a Microsoft Systems Management Server, the installation is configured by the administrator, triggered and executed when the relevant computer boots.

Group policy-based software distribution

Software is normally installed with the access rights of the current Windows user. When using MSI technology, the installation is performed by an operating system service with a higher level of rights. This enables installations for which the Windows user does not have the necessary rights. Applications which require higher rights for installation are referred to as "privileged installations" in MSI technology. Installation of these applications is possible when a Windows user is assigned the "Always install with elevated privileges" permission.

A group policy is created in the domain controller for use of group policy-based software distribution. The software to be distributed is then assigned or made public using Active Directory.

- Assignment: Software distribution can be assigned to a user or a computer. The software to be distributed is automatically installed when the user logs in or the computer is started.
- Publication: The software distribution can be published for individual users. When the user logs on to the client computer, the software to be distributed appears in a dialog and can be selected for installation.

1.7.4.3 Internet Explorer settings (WebNavigator client)

Introduction

You have to adapt the Internet Explorer security settings in order to utilize full functionality of the WebNavigator Client.

Procedure

1. Click "Tools > Internet Options" in Internet Explorer.
2. Select the "Security" tab.
   Select the corresponding zone, for example, "Local Intranet" or "Internet".
3. Click "Custom Level...".
4. Enable the "Script ActiveX controls marked safe for scripting" and "Download signed ActiveX controls" options.
5. Enable "Active Scripting" under "Scripting".
6. Click "OK". Carry out the modifications in the subsequent dialog.
7. Click the “Trusted Sites” icon.
   Click the "Sites..." button to open the "Trusted sites" dialog.

8. Enter the address of the WebNavigator Server in the "Add this website to the zone" field.
   Possible formats and wildcards include "*://157.54.100 - 200", "ftp://157.54.23.41", or "http:// *.microsoft.com".
   Deactivate the "Require server verification (https:) for all sites in this zone" option.
   Click "Add". Click "OK".

9. Click the “Trusted Sites” icon.
   Click the "Standard level" button and then the "Custom Level" button.
   Enable "Initialize and script ActiveX controls not marked as safe". Click "OK".

10. Click on the "General" tab.
    Click in the "Settings" area on the "Temporary Internet Files" button.
    Enable the "Automatic" option under "Check for newer versions of stored pages:"
    Click "OK".

11. Close the "Internet Options" dialog by clicking "OK".

See also
    Hardware and software requirements for WebNavigator (Page 96)

1.7.4.4 Installation from the DVD (WebNavigator client)

Requirements

- For the installation and use of the WebNavigator client, the information in Internet Explorer settings (WebNavigator client) (Page 110) applies.

- Depending on the operating system, specific minimum user rights are required to install the WebNavigator client; see User rights and user groups for WebNavigator clients (Page 109).

Procedure

1. Insert the WinCC DVD in the drive.
   The DVD starts automatically if Autorun is enabled in the operating system. If the Autorun function is not activated, start the program Setup.exe on the DVD.

2. In the "Installation Type" dialog, select "Package Installation".

3. Select the "WebNavigator Client" program package.

4. Before the installation, the security settings that are adapted for WinCC are displayed in the "System Settings" dialog. The firewall is configured automatically. Confirm the changes to the system settings.

5. Start the installation. You can track the status of the installation in the displayed dialog. Select "Cancel" to cancel the installation.

6. Restart the computer when prompted to do so by setup.
The WebNavigator client is now installed and has been added as a function to the navigation window of the WinCC Explorer.

### 1.7.4.5 Installation via the Intranet/Internet (WebNavigator client)

#### Requirements

- For the installation and use of the WebNavigator client, the information in [Internet Explorer settings (WebNavigator client)](Page 110) applies.

- Depending on the operating system, specific minimum user rights are required to install the WebNavigator client; see [User rights and user groups for WebNavigator clients](Page 109).

- The WebNavigator server must be installed on a computer. The Internet Information Server must be configured with the WinCC Web Configurator. The users must be registered in the WinCC User Administrator. The WinCC project must be in runtime.

- The latest cumulative security update for Internet Explorer must be installed. This applies to all installed versions of Internet Explorer. See the following Microsoft article:
  - [https://support.microsoft.com/en-us/kb/3072449](https://support.microsoft.com/en-us/kb/3072449)

- Microsoft Visual C++ 2010 Redistributable must be installed on the WebNavigator client with a 64-bit computer before the connection to the WebNavigator server is established.

#### Procedure

1. Go to the address bar of Internet Explorer and enter the URL "http://www.servername" of the WebNavigator server. For installation in a virtual directory, the address can be as follows: "http://www.servername/WebNavigator/".

2. Type in the user name and password.

3. The first time you access the WebNavigator server, you will be prompted to install the WebNavigator client.
   If the client is a 64-bit computer, an additional link is displayed in order to install "Visual C++ 2010 Redistributable". You must first perform this installation because it is required for the Web client.
4. Click on the link "Click here to install WebNavigator Client". Click the "Save" button in the "File Download" dialog to store the client setup on the target computer. It is recommended to save the Setup file because, in the event of a restart of the client computer being necessary, the Setup need not be downloaded again.

**Note**

If you have installed the WebNavigator client without installing "Visual C++ 2010 Redistributable", you can also install the software later via the "Web Navigator and System Updates" menu in the "download area" of the Navigation user interface of "MainControl.asp".

If you have already installed the WebNavigator client and wish to install a more recent version via the Intranet/Internet, open the client setup straight away. You do not need to save the installation file on the target computer. Remove the old installation file first if you wish to save the new one. Alternatively, you can save the new version of the file in a different directory.

5. Leave the Internet Explorer open and open Windows Explorer. Navigate to the directory in which you saved the setup file. Start setup by double-clicking on the file.

6. Follow the instructions on the screen and enter the information and settings necessary. The client-side controls of the WebNavigator will be installed. Close the Setup dialog.

**Result**

Following successful installation, the WebNavigator client connects to the WinCC project currently in runtime.

**Note**

If you want to use the on-screen keyboard, you also have to install .net 4.0 or higher. If you install the WebNavigator client from the WinCC DVD, .net 4.0 is already included.

**See also**

https://support.microsoft.com/en-us/kb/3072449

**1.7.5 Installing the WebNavigator diagnostics client**

**Introduction**

The software for the WebNavigator diagnostics client is installed on the client computer from the DVD.
Requirements

- To do this, you must have administrator rights.
- Access via Remote Desktop Protocol (RDP) is not enabled for the diagnostics client.

Procedure

1. Insert the WinCC DVD in the drive.
   The DVD starts automatically if Autorun is enabled in the operating system.
   If the Autorun function is not activated, start the program Setup.exe on the DVD.
2. In the "Installation Type" dialog, select "Custom Installation".
3. Select the "Diagnose Client" program in the "Web Navigator" program group.
4. Before the installation, the security settings that are adapted for WinCC are displayed in
   the "System Settings" dialog. The firewall is configured automatically.
   Confirm the changes to the system settings.
5. Start the installation.
   You can track the status of the installation in the displayed dialog.
   Select "Cancel" to cancel the installation.
6. Restart the computer when prompted to do so by setup.

Result

The WebNavigator diagnostics client is now installed.

1.7.6 WebNavigator Demo Project

Introduction

The WinCC Demo Project can be downloaded as a self-extracting ZIP file from:

Installation

To install the project, copy the file in a local target directory and start the decompressing
process by double-clicking the file.

The following logins are already configured in the demo project:

<table>
<thead>
<tr>
<th>WinCC</th>
<th>Login</th>
<th>Password</th>
</tr>
</thead>
<tbody>
<tr>
<td>WebNavigator German</td>
<td>winccd</td>
<td>winccpass</td>
</tr>
<tr>
<td>WebNavigator English</td>
<td>wincce</td>
<td>winccpass</td>
</tr>
<tr>
<td>WebNavigator French</td>
<td>winccf</td>
<td>winccpass</td>
</tr>
<tr>
<td>WebNavigator Italian</td>
<td>wincci</td>
<td>winccpass</td>
</tr>
</tbody>
</table>
1.7.7 Uninstalling the WebNavigator

Introduction
You can remove the WebNavigator server and WebNavigator client in the usual way, as in Windows.

Procedure: Uninstalling via the WinCC Product DVD
1. Start the WinCC product DVD.
   The DVD starts automatically if Autorun is enabled in the operating system. If the Autorun function is not activated, start the program Setup.exe on the DVD.
2. Follow the on-screen instructions.
3. Select "Remove" as the setup type.
4. Select the components that you want to remove.

Alternative procedure: Uninstalling via the Control Panel
1. Open the "Uninstall or change a program" dialog in the Windows Control Panel.
2. Select the WebNavigator server or client and click "Remove". Follow the instructions on the screen.

Result
The WebNavigator Server or WebNavigator client has now been removed from the computer.
1.8 WinCC/WebNavigator Release Notes

1.8.1 Information about WebNavigator

Introduction

These release notes contain important information.

The statements in these release notes take precedence over information provided in the manuals and in the online help.

Please read these release notes carefully as they contain useful information.

Notes on the security of the system

For the secure operation of Siemens products and solutions, it is necessary to take suitable preventive action (e.g. cell protection concept) and integrate each component into a holistic, state-of-the-art industrial security concept. Third-party products that may be in use should also be considered. You will find more information about industrial security under http://www.siemens.com/industrialsecurity.

Security restrictions with the WebNavigator client

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security restrictions and response times in Internet Explorer</td>
</tr>
</tbody>
</table>

Please note the Internet-specific security restrictions when using the WebNavigator client. The WebNavigator client may take significantly longer (>20 seconds) than a regular WinCC client to recognize that the WebNavigator server is down or that the communication is faulty.

Using a secure connection over HTTPS

To increase the security of your communication, configure the WebNavigator server in such a way that only HTTPS connections are supported.

You need a digital certificate for the WebNavigator server for this. Also use the SSL certificate on the WebNavigator client.

Detailed information is available in the Microsoft Support under “How To Set Up an HTTPS Service in IIS” (http://support.microsoft.com/kb/324069).
Communication via proxy server

Please note the following for communication using a proxy server:

- The WebNavigator client must be a member of the server domain.
- If the users registered on the WebNavigator client have no access to the proxy server, logon to the proxy server with NTLM authentication is as follows:
  1. The logon dialog for the proxy server appears.
  2. The logon dialog for the WinCC user appears.
  3. The logon dialog for the proxy server appears again.

Avoid cross-site request forgery for the WebNavigator

Cross-site request forgery is similar to the vulnerability caused by cross-site scripting (XSS, Cross Site Scripting).

The attack is triggered when an authenticated user clicks on a malicious link. This vulnerability exists even if scripting is deactivated in the browser.

Siemens recommends:

- Do not work with other applications or services that have anything to do with the Internet.
- Log off when you do not need the WebNavigator any longer

Defense in depth

See the notes on "Industrial Security" on the Siemens website:


General information about WebNavigator

Uninstalling WinCC: WebNavigator client must be installed later

If you uninstall WinCC, you will need to post-install the WebNavigator client.

Security settings in Internet Explorer: Installation via SSL connection

If you want to download the WebNavigator from an ASP portal via an SSL connection, note that the download is not possible under certain conditions. You can correct this with one of the following settings:

- Deactivate the "Do not save encrypted pages to disk" option in the "Advanced" tab for the Internet options of the Internet Explorer.
- Deactivate the "Internet Explorer Enhanced Security Configuration" option in the "Control Panel/Add/Remove Programs/Windows Components".
Message after installation of a plug-in

The Program Compatibility Wizard may possibly output an message during installation of a plug-in. The plug-in is installed correctly. You may therefore acknowledge this message with "The program was installed correctly."

Project Change

Following a change of projects, a sporadic inoperable period of the Internet Information Services (IIS) may occur. The computer must then be restarted.

WebNavigator server: Configure a port other than the standard port "80"

When configuring the port in the WinCC Web Configurator, use "8080", for example, rather than the standard port "80".

WebNavigator client: Internet Explorer setting with Windows Server 2012

To allow the start screen to be loaded on Windows Server 2012 with the WebNavigator client, you need to disable the setting "Do not save encrypted pages to disk" in Internet Explorer under "Tools > Internet Options > Advanced".

WebNavigator client: Display of ActiveX controls in Internet Explorer

ActiveX controls are disabled in Internet Explorer by default. For this reason, the WinCC controls are not displayed correctly in Internet Explorer on a WebNavigator client.

To display the WinCC controls correctly, add the Web server as a trusted website and enable the ActiveX controls only for the "Trusted sites" zone.

To continue protecting Internet Explorer from foreign ActiveX controls, check that the restricted security settings still apply to the other zones after making the changes.

For more information, refer to the following documentation:

- WinCC/WebNavigator: "WinCC/WebNavigator Installation Notes > Installation of WebNavigator Client > Settings in Internet Explorer"

WebNavigator client: Firewall settings for printing from WinCC controls

To be able to print out on the client, you need to define the following Firewall settings for the profiles used:

1. Open "Control Panel > System and Security > Windows Firewall".
2. In the navigation bar, click "Allow a program or feature through Windows Firewall".
3. In the "Allowed programs and features:" list, activate the entry "File and printer sharing" for the relevant profile.
4. Return to the Windows Firewall start page.
5. In the navigation bar, click "Turn Windows Firewall on or off".
6. If the Firewall is enabled, disable the setting "Block all incoming connections, including those in the list of allowed programs".

WebNavigator client: WinCC Computer with "Basic Process Control"

The plug-in "WinCC Basic Process Control" must be installed on the WebNavigator client if the client is connected to a computer with WinCC Basic Process Control. Without the plug-in, the functionality of WinCC Basic Process Control will not be available on the WebNavigator client. For example, the relevant ActiveX controls and the group display will not be available.

The plug-in is on the WebNavigator server in the "\<wincc_installationpath>\WebNavigator \Server\Web\Install\Custom" directory. You can download the plug-in via the WebNavigator navigation user interface from the download area.

A description of supported and non-supported functions may be found in WinCC Information System under "Options for Process Control > System Overview Process Control Options > Configuration in PCS 7 Environment > Web Client".

If the WebNavigator client is to be installed on a dedicated web server with WinCC Basic Process Control, the plug-in "WinCC Basic Process Control" must be installed immediately after installation of the WebNavigator client. The download page for the plug-in is displayed. You will only be able to exit this page after installation of the plug-in for displaying the process pictures.

For more information on the supported functionalities of the WebNavigator client when connected to a PCS7 OS, please refer to the PCS7 documentation.

WebNavigator client: Updating pictures with faceplates

To enable updating of changes to pictures with faceplates, you must enable the setting "Every time I visit the webpage" in the settings for temporary Internet files in Internet Explorer.

WebNavigator client: ODK function "PWRTCheckPermissionOnPicture"

In order to use the ODK function "PWRTCheckPermissionOnPicture" on a WebNavigator client, install the plug-in "WinCC Basic Process Control" and "Advanced Process Control".

WebNavigator client: WinCC Alarm Control on a WebNavigator server in WinCC ServiceMode

Initial Situation
The WebNavigator client is connected with a WebNavigator server operated in WinCC ServiceMode.

Behavior
If you are using WinCC Alarm Control prior to WinCC V7 that is connected via a server prefix, you will not be able to open the selection dialog.

Solution
Use the WinCC AlarmControl that is offered as of WinCC V7.
WebNavigator client: Diagnostics file "WebNavReconnect.log"

After installation of the WebNavigator client, the diagnostics file "WebNavReconnect.log" is saved in the "<User>\Application Data\LocalLow\Siemens\SIMATIC.WinCC\WebNavigator \Client" directory.

The diagnostics file will be saved into the respective user profile so that this user no longer requires administrator rights.

WebNavigator client: "FLAG_COMMENT_DIALOG" of the "GCreateMyOperationMsg" function

The WebNavigator client does not support the parameter "FLAG_COMMENT_DIALOG" for the "GCreateMyOperationMsg" function.

Custom ActiveX controls (Industrial X)

Compatibility with WinCC and WebNavigator server or WebNavigator client must be ensured if custom ActiveX controls (Industrial X) are used:

- Direct installation of the ActiveX control on the computer with WinCC and WebNavigator server or client. You must install the ActiveX control before installing WinCC and the WebNavigator server or client. If the ActiveX control does not function without errors after this step, there is no compatibility.

- Installation as a plug-in via the Web Navigation user interface on the WebNavigator client. If the ActiveX Control is packaged in a plug-in and installed via download, an upgrade of WinCC and the WebNavigator server or client will also require the generation of a new plug-in using this ActiveX control. Ensure compatible binaries (DLL, OCX, etc.) are used when creating the plug-in.

See also

http://support.microsoft.com/kb/959658
http://support.microsoft.com/kb/324069
http://www.siemens.com/industrialsecurity
1.9 WinCC/WebUX

1.9.1 WebUX licensing

The WinCC/WebUX basic package with an integrated WinCC WebUX Monitor license is included in WinCC.

WebUX client

The WebUX clients are licensed on the WebUX server.
No license is required for the WebUX client on the computer.

WebUX server

The WebUX server is installed on a WinCC system. The WinCC basic system requires at least the WinCC basic RT license.

The license keys are differentiated as described below and run in parallel on the WinCC/WebUX server:

<table>
<thead>
<tr>
<th>License</th>
<th>Function</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>WinCC WebUX Monitor</td>
<td>The user has only read access.</td>
<td>The authorization level 1002 &quot;Web access - monitoring only&quot; is configured for the user in the User Administrator.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If the available &quot;Monitor&quot; licenses have been allocated, an &quot;Operate&quot; license or a WebNavigator license can also be allocated to a WebUX client for read access.</td>
</tr>
<tr>
<td>WinCC WebUX Operate</td>
<td>User has read and write access</td>
<td>If the available &quot;Operate&quot; licenses have been allocated, a WebNavigator license can also be allocated to a WebUX client for read or write access.</td>
</tr>
<tr>
<td>WinCC/WebNavigator</td>
<td>The user's authorizations determine whether write access is possible in addition to read access.</td>
<td>If a WinCC/WebNavigator license is also installed in the WinCC system, the WebNavigator license can also be allocated to a WebUX client. First, however, all available WebUX licenses are used.</td>
</tr>
</tbody>
</table>

License packages

The license packages are available with 1, 3, 10, 30 and 100 clients.
If you have upgraded from WebUX V7.3, there may also be licenses for 5 / 25 / 50 / 150 clients.
If the number of licensed clients is exceeded during the logon attempt by a WebUX client, no further logon is permitted.
The packages are version-independent and can be combined.

Reserved license

A reserved WebUX license always gives the user guaranteed access to the WebUX server.
A connection remains reserved for the user. The number of freely available WebUX licenses is reduced by each configured reserved license.

Applications
Possible applications include:

- Remote operator access:
  If the connections to the WebUX server are occupied by read-only access, a connection remains reserved for operation.

- Central display:
  Central client stations are always connected, for example, to display the status of the WinCC system.

Reserve WebUX license
In the User Administrator, you assign one of the available licenses to a WebUX user as a reserve license.

To do this, enable the "Reserve WebUX license" option for the user. The field "WebUX Number of reserved licenses" shows how many WebUX licenses are assigned through reservation.

Reserved licenses cannot be configured for user groups, only for individual users.

If more reserved licenses are configured than those available on the WebUX server, the licenses of the first users logged on are used.

1.9.2 Communication: SSL certificate for HTTPS connections

To improve the security of your communication, WebUX only supports HTTPS connections.

You need a digital SSL certificate for the WebUX server.

You can find more information in the Microsoft Support under "How to Set Up an HTTPS Service in IIS":

- http://support.microsoft.com/kb/324069

NOTICE
Protecting the infrastructure
Setting up a Web server may enable access to your plant infrastructure.

Therefore, protect the computer on which the Web server is installed. Make sure that the following rules are followed:

- The computer is only accessible via secure connections.
- The check mechanisms provided by software vendors are activated and cannot be bypassed under any circumstances.
**Install a SSL certificate**

You have the following options when setting up the WebUX website:

- Select an existing certificate
- Create self-signed certificates:
- Install a certificate after setting it up

**Creating a new certificate**

1. Activate the "Create a new certificate" option.
2. Enter a name of your choice.

When the configuration is completed, a self-signed certificate is created. The certificate is valid for one year.

---

**Note**

**Restricted authentication**

The certificates that you create when you configure the WebUX website itself are not verified by an official certification body. Depending on your browser settings, a warning message is displayed when you access the website.

To better secure the server authentication, install the certificate of an official certification body.

**Display of secure data sources only**

For display of websites and external files, one of the following conditions must be met:

- Call via the HTTPS connection
- Call of a trusted site

---

**See also**

[http://support.microsoft.com/kb/324069](http://support.microsoft.com/kb/324069)

---

**1.9.3 Installation of WebUX**

**Software requirements**

Certain requirements concerning operating system and software configuration must be met for the installation.
**WebUX server: Operating system**

<table>
<thead>
<tr>
<th>Software</th>
<th>Configuration</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 10</td>
<td>Pro</td>
<td>Standard installation 64-bit Only a limited number of connections is possible. A maximum of three WebUX clients can connect to the WebUX server.</td>
</tr>
<tr>
<td>Windows 10</td>
<td>Enterprise</td>
<td>Standard installation 64-bit Only a limited number of connections is possible. A maximum of three WebUX clients can connect to the WebUX server.</td>
</tr>
<tr>
<td>Windows Server 2012 R2</td>
<td>Standard</td>
<td>64-bit</td>
</tr>
<tr>
<td>Windows Server 2016</td>
<td>Standard</td>
<td>64-bit</td>
</tr>
</tbody>
</table>

**Additional software requirements**

<table>
<thead>
<tr>
<th></th>
<th>Version / setting</th>
<th>Relevant for</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web browser</td>
<td>The browser must support HTML5.</td>
<td>WebUX client / terminal</td>
<td>WebUX can be used with any browser.</td>
</tr>
<tr>
<td>WinCC version</td>
<td>WinCC V7.5</td>
<td>WebUX server</td>
<td>The WebUX server is installed on a WinCC system.</td>
</tr>
<tr>
<td>SIMATIC Logon version (optional)</td>
<td>SIMATIC Logon V1.6</td>
<td>WebUX server</td>
<td>Only relevant if you are using SIMATIC Logon for central user administration.</td>
</tr>
</tbody>
</table>
WebUX client (terminal)

You only need a HTML5-enabled Web browser such as Chrome, Firefox, Internet Explorer or Safari on a terminal that accesses the WebUX server.

Installation of the WebUX server

You can install WinCC/WebUX together with WinCC.

When you install the server WebUX at a later time, proceed as follows:

1. Start the WinCC installation DVD.
2. Select the installation type "Custom Installation".
3. In the "WinCC" group of the "Program" dialog, select the entry "WinCC WebUX".
4. Transfer the WebUX license. You can find additional information under:

   - WebUX licensing (Page 121)

After the installation and restarting the PC, the WinCC WebUX Configurator opens.

You can find information about configuring WebUX under:

- Configuring the WebUX website (Page 125)

See also

WebUX licensing (Page 121)
Configuring the WebUX website (Page 125)

1.9.4 Configuring the WebUX website

Configure the WebUX website on the WebUX server and the connection via HTTPS to communicate with the WebUX clients.

WinCC WebUX Configurator

After WinCC and WinCC/WebUX are installed, the WinCC WebUX Configurator opens.

To make changes later, you can find the WinCC WebUX Configurator in the "Siemens Automation" program group.

You use the WebUX Configurator to set up the standard configuration for the use of WebUX.

- Configuration of the Microsoft Internet Information Service
- Settings of the Web server
- SSL certificate for HTTPS connections
- Virtual folder

Read the information about digital certificates at:

- Communication: SSL certificate for HTTPS connections (Page 122)
Creating virtual folders

During the course of initial configuration, you specify whether you wish to create a new default website or a new virtual directory.

If you would like to set up the website as a virtual directory, at least one website with activated SSL encryption must be present on the PC. The websites that meet this criterion are shown in the “Select the higher level website” selection list.

Procedure: Use virtual folders

1. Configuration
   Select a higher-level website.
   The WebUX Configurator takes the port number and the SSL settings from the IIS settings.

2. Access from the terminal (WebUX client):
   To access the website, add the name of the virtual directory to the URL in the browser.

Requirement

- Microsoft Internet Information Service (IIS) is installed.
- The WinCC basic system is installed.
- The "WinCC WebUX" program package is installed.
- The "WinCC WebUX" license is installed.

Procedure

After installing WinCC/WebUX and restarting the PC, the WinCC WebUX Configurator opens.

1. Click "Apply configuration".
   The standard configuration is set up.
   The "IIS configuration" dialog opens.

2. Enter a name for the website.

3. If you only operate the WebUX web page on the server, select the "Create a new website" option.
   If you work with virtual folders, proceed to step 6.

4. Enter the number of the port used for access in the "Port" field.
   The HTTPS standard port "443" is set by default.
   If you select a different port number, the address must be adapted on the WebUX client:
   When logging on to the terminal, this number is added into the browser address bar after
   the server name.

5. Select the settings for the digital certificate of the server.

6. If you set up the website as a virtual directory, select a higher level website.
   The WebUX Configurator takes the port number and the SSL settings from the IIS settings.

7. Confirm with "OK".

8. When the configuration has been set up, click "Exit".

9. Restart the computer.
Result

The WebUX server has been configured and the WebUX website set up.
The WinCC project must be activated in Runtime in order to access the WebUX server.

See also

Communication: SSL certificate for HTTPS connections (Page 122)
http://support.microsoft.com/kb/324069 (http://support.microsoft.com/kb/324069)
1.10 Service and Support

1.10.1 Warnings

Safety information

Warning notice system

This manual contains notices you must observe to ensure your personal safety and to prevent damage to property. Notices referring to your personal safety are highlighted in the manual by a safety alert symbol; notices referring to property damage only have no safety alert symbol. The warning notices shown below are graded according to the degree of danger.

<table>
<thead>
<tr>
<th>Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>DANGER</strong></td>
<td>indicates that death or severe personal injury will result if proper precautions are not taken.</td>
</tr>
<tr>
<td><strong>WARNING</strong></td>
<td>indicates that death or severe personal injury may result if proper precautions are not taken.</td>
</tr>
<tr>
<td><strong>CAUTION</strong></td>
<td>indicates that minor personal injury may result if proper precautions are not taken.</td>
</tr>
<tr>
<td><strong>NOTICE</strong></td>
<td>indicates that property damage may result if proper precautions are not taken.</td>
</tr>
</tbody>
</table>

Note

indicates important information about the product and its use or a specific section of the documentation to which you should pay particular attention.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will be used. A warning notice of injury to persons with a safety alert symbol may also include a warning relating to property damage.

Qualified personnel

The product/system described in this documentation may be operated only by personnel qualified for the specific task in accordance with the relevant documentation, in particular its warning notices and safety information. Qualified personnel are those who, based on their training and experience, are capable of identifying risks and avoiding potential hazards when working with these products/systems.
Proper use

Note the following:

⚠️ WARNING

Proper use of Siemens products

Siemens products may only be used for the applications described in the catalog and in the relevant technical documentation. If products and components from other manufacturers are used, these must be recommended or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and maintenance are required to ensure that the products operate safely and without any problems. The permissible ambient conditions must be adhered to. The information in the relevant documentation must be observed.

Trademarks

All names identified by ® are registered trademarks of Siemens AG. The remaining names in this publication may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Security information

Siemens provides products and solutions with industrial security functions that support the secure operation of plants, systems, machines and networks.

In order to protect plants, systems, machines and networks against cyber threats, it is necessary to implement - and continuously maintain - a holistic, state-of-the-art industrial security concept. Siemens' products and solutions only form one element of such a concept.

Customer is responsible to prevent unauthorized access to its plants, systems, machines and networks. Systems, machines and components should only be connected to the enterprise network or the internet if and to the extent necessary and with appropriate security measures (e.g. use of firewalls and network segmentation) in place.

Additionally, Siemens' guidance on appropriate security measures should be taken into account. For more information about Industrial Security, please visit:

- https://www.siemens.com/industrialsecurity

Siemens' products and solutions undergo continuous development to make them more secure. Siemens strongly recommends to apply product updates as soon as available and to always use the latest product versions. Use of product versions that are no longer supported, and failure to apply latest updates may increase customer’s exposure to cyber threats.

To stay informed about product updates, subscribe to the Siemens Industrial Security RSS Feed under:

- https://www.siemens.com/industrialsecurity
Disclaimer of liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software described. Since discrepancies cannot be precluded entirely, we cannot guarantee full agreement. However, the information in this publication is reviewed regularly and any necessary corrections are included in subsequent editions. Suggestions for improvement are welcomed.

Information in the online documentation is more binding than that in the manuals and PDF files. Observe the Release Notes and Installation Notes. Information in the Release Notes and Installation Notes is more binding than that in the manuals and online help.

Copyright © Siemens AG 2018

All rights reserved

The reproduction, transmission or use of this document or its contents is not permitted without express written authorization. Offenders will be held liable for payment of damages. All rights, including rights created by patent grant or registration of a utility or design, are reserved.

Siemens AG
Division Digital Factory
SIMATIC Human Machine Interfaces
P.O. Box 4848
D-90026 Nuremberg, Germany

See also


1.10.2 Customer support

Customer Support, Technical Support

You can reach the SIMATIC hotlines at the times specified in the following table. The SIMATIC hotline employees speak German and English. The Authorization hotline offers French, Italian or Spanish customer support in addition to German and English.

Technical support

Nuremberg (GMT +1:00)
Service Hours Monday - Friday, 8:00 to 17:00 (CET/CEST)
Phone +49 911 895 7222
An overview of the Technical Support is available at the following URL:


**Automation Value Card (AVC)**

The Automation Value Card (AVC) gives you access to extended Technical Support, e.g. 24/7 accessibility. Information on the AVC can be found at the following URL:


**SIMATIC Customer Online Support**

**Service and Support**

An overview of the support offering for our products is available at the following URL:

- https://support.industry.siemens.com/

In Product Support, for example, you will find downloads of firmware updates, service packs and useful applications.

Online Help is available so that you can successfully use the Support offering. Open the Online Help using the button on the Internet page or using the following URL:


The app is available for mobile Siemens Support:

- https://support.industry.siemens.com/cs/sc/2067

**WinCC FAQs**

WinCC Online Support with information on FAQs (Frequently Asked Questions) may also be found at the following URL:


**Technical Forum**

The Technical Forum supports exchange with other SIMATIC users. It is available at the following URL:

- https://support.industry.siemens.com/tf/
WinCC V7.5 Installation / Release Notes
1.10 Service and Support

Technical documentation for SIMATIC products
You can find a guide to the technical documentation provided for individual SIMATIC products and systems at the following URL:


Local partners database
To contact your local partner, search our local partners database at the following URL:


Product Information

SIMATIC WinCC
Go to the following URL for general information about WinCC:


SIMATIC Products
Go to the following URL for general information about SIMATIC products:


See also

Internet: Support Request (https://support.industry.siemens.com/My/ww/en/requests)
Internet: Service and Support (https://support.industry.siemens.com/cs/ww/en/)
Internet: Technical documentation for SIMATIC products (http://www.siemens.com/simatic-tech-doku-portal)
Internet: Contact person database (http://w3.siemens.com/aspa_app/?lang=en)
Internet: Information about WinCC (http://www.siemens.com/wincc)
Internet: SIMATIC Products (http://www.siemens.com/simatic)
1.10.3 Support request

Dear customer

In order to provide you with fast and effective support, please complete the "Support Request" form online on the Internet. Describe the problem in as much detail as possible. We would appreciate if you would provide us with all project data so that we can reproduce the error situation or shorten the turn-around time.

Before filling out the support request, check whether your configured quantity structure is within the range of tested quantity structures (see topic "Performance Data").

Support Request form

The Support Request form is available at the following URL:

- https://support.industry.siemens.com/my/WW/en/requests

When filling out the report, you will be guided through several steps. The data required by the Technical Support are described in the FAQ 16607894:


A detailed description of the Support Request can be found at the following URL:


Procedure

1. Open the "Support Request" form using the link on the Internet. Step 1 "Select product" is displayed:

2. Enter the project name in the "Product/Order number" box. Upper/lower case is not relevant. Search for parts of the product name or enter the full product name in the correct order. You can e. g. search for the following terms:
   - "WinCC Runtime V7"
   - "wincc editor"
   - "WinCC DataMonitor"
   - "wincc webnav"
   - "Connectivity"

   The found products are offered in the "Product selection" field. If you have questions about licensing, activate the "Problem with SIMATIC authorization/license" in the product selection field.

3. Select the desired product and click on "Next" to switch to step 2 "Select your situation". Select a use case.
4. Press "Next" to switch to step 3 "Our solutions". Suggested solutions and FAQs for the selected key words are listed. Once you have found a suggested solution for your problem, you can close the form in the browser. If you did not find any applicable suggested solutions, press "Next" to switch to step 4 "Describe a problem".


6. Describe your problem as exactly as possible in the "Details" field. Pay particular attention to the following questions and comments. Please also check the WinCC installation and configuration with regard to the following references.
   If you have any idea what has caused the error, please let us know. No detail should be omitted, even if you consider it unimportant.
   – Was the configuration data created with older WinCC versions?
   – How can the error be reproduced?
   – Are other programs running simultaneously with WinCC?
   – Have you deactivated the screen saver, virus checker and power management function?
   – Search your computer for log files (WinCC\Diagnose\*.log, drwatson.log, drwtsn32.log). The log files are needed for error analysis. Thus, be sure to send the log files as well.
   – To assemble diagnostic and system information from computers and other devices, use the "SIMATIC Assessment Suite - Data Collector" (SAS-DC) diagnostics tool.

7. Use the "Search" button to upload your affected project and the log files (e. g. as a Zip file) to the Support Request.
   Press "Next" to switch to step 5 "Specify contact data".

8. Enter your contact information.
   Press "Next" to switch to step 6 "Summary & Send".

9. Press the "Print" button if you would like to print the support request. To receive a copy of your request as email, activate this option in the summary.
   You close the support request by clicking the "Send" button.
   Your data will be transmitted to Customer Support and processed there.

Thank you for your cooperation. We hope that we can be of assistance in solving your problems.

Your WinCC Team

See also


2.1 WinCC/WebNavigator Getting Started

2.1.1 First Web Project

Introduction

WinCC/WebNavigator provides a solution for operator control and monitoring of the automation system via the Intranet and Internet.

WinCC/WebNavigator offers you an easy and efficient way of implementing the operator control and monitoring functions of the WinCC project.

WinCC/WebNavigator components

The optional "WinCC/WebNavigator" package consists of server components that you install on the WebNavigator server.

You need the WebNavigator client components on the computer that you are using to control and monitor the process pictures that are displayed as in the WinCC basic system. For this purpose, use Internet Explorer or the "WinCCViewerRT" Web Viewer on the client.

WebNavigator Diagnostics Client

WinCC/WebNavigator also contains the "WebNavigator Diagnostics Client" component. The functionality of this Diagnostics Client is no different from that of a WebNavigator client.

The Diagnostics Client provides cost-effective and reliable access to one or several WebNavigator Servers for diagnostics purposes.

Overview

This Getting Started is based on the WinCC demo project. For this example project, WinCC, WebNavigator Server and WebNavigator Client are installed on the same computer.

Edit the WinCC project on the WebNavigator Server. Use the WebNavigator Client if you access the project with Internet Explorer or "WinCCViewerRT".
Requirements

- The WinCC basic system is installed.
- You have installed the WinCC demo project.
  You can find additional information in the WinCC/WebNavigator installation notes under
  "WebNavigator demo project (Page 114)".
- WebNavigator Server is installed.
  You can find additional information in the WinCC/WebNavigator Installation Notes under
  "Overview: Installing the WebNavigator Server (Page 102)"

Procedure

Perform the following steps for the first Web project:

- Configure the WinCC project
  – Publish the WinCC process pictures for web access
  – Administer the users for WebNavigator Client

- Configuring the WebNavigator Server
  – Configure the WebNavigator web page
  – Configure the firewall
  – Check the activated web page

- Operating the WinCC project
  – Configure the Internet Explorer settings
  – Install the WebNavigator Client and operate the WinCC project using Internet Explorer
  – Set up WinCCViewerRT and operate the WinCC project using WinCCViewerRT

- Creating a new process picture and displaying it on the WebNavigator client

See also

- Creating a new process picture (Page 158)
- Installing the WebNavigator Client (Page 153)
- Administering the users for WebNavigator Client (Page 145)
- Starting the demo project (Page 147)
- WebNavigator Demo Project (Page 114)
- Overview: Installing the WebNavigator server (Page 102)
2.1.2 Configuring the WinCC project

2.1.2.1 Publishing process pictures

Introduction

If you wish to display WinCC process pictures on the WebNavigator Client, you must publish them first. For publishing the pictures, use the Web View Publisher, which automatically makes the necessary adjustments to the project data.
**Procedure**

1. Select "WebNavigator" in the navigation window of WinCC Explorer. Select the "Web View Publisher" command from the shortcut menu. The WinCC Web Publishing Wizard is now launched.

2. Click "Next".
3. Select the WinCC project folder under "Path to your WinCC project".  
Select the target folder for the published pictures under "Publishing folder of the WinCC Web".  
Accept the proposed folder within the WinCC project folder.  
Click "Next".
4. Move the pictures that you wish to publish to the "Selected files" list.

Click "Next".
5. Move the necessary C project functions to the "Selected files" list.

Click "Next".
6. Move the graphics used in the process pictures to the "Selected files" list. The referenced files are in the "GraCS" folder or in subfolders of "GraCS".

Click "Next".

7. To start publishing the pictures, click "Finish".
The results list displays the status of all published objects. You can click an object to view additional object information.

You have successfully published the pictures and functions.

2.1.2.2 Administering the users for WebNavigator Client

Introduction

In order to enable a user to access a WinCC project via a WebNavigator Client, you must assign the appropriate authorizations to the user in the WinCC User Administrator. You can select a different start picture and runtime language for each user.
Procedure

1. Right-click "User Administrator" in the navigation window of the WinCC Explorer. Select the "Open" command from the shortcut menu.

2. You can use an existing user for the Web project. Select the user named "winccd" who has been assigned the login "winccd" and password "winccpass", for example, or create a new user based on this template.

3. If you want to create a new user, select the "New User" command in the shortcut menu of a group in the navigation area.

4. Specify the password for the new user in the "Password" column.

5. Select the new user in the table window of the User Administrator.

6. Select the "WebNavigator" check box in the data window.

7. Select the start picture for the user, e.g. "winccPic.pd_", in "Web start picture" via the dropdown list. You can only select published pictures as start pictures.

8. Select the Runtime language for the user in "Web language" via the dropdown list. The languages created in the Text Library are available for selection.

9. Select the new user in the navigation window of the User Administrator. Select the required user rights by clicking in the "Authorization" column of the table window. If system authorization "Web access - monitoring only" has been enabled, the user is only allowed to monitor the WinCC project when acting as WebNavigator Client.

10. Close the User Administrator.
2.1.3 Configuring the WebNavigator Server

2.1.3.1 Starting the demo project

Introduction
You have copied the WinCC demo project to the computer.
In this step, you set up the Web project for the computer that acts as both WebNavigator Server
and WebNavigator Client.

Procedure
1. Start the WinCC Explorer in the “Siemens Automation” program group.
2. Open the WinCC demo project.
3. Click “Start server locally” in the next dialog.
   The WinCC project can only be activated if your computer has been entered as an available
   server in the computer list.
4. Right-click “Computer” in the navigation window of WinCC Explorer and select
   “Properties...”.
5. Click the “Properties” button in the dialog.
6. Enter the computer name in the “Computer name” field.
7. Click "OK". Restart the project to activate your changes.
8. Close the project by selecting "File > Exit".
9. Reopen the demo project to configure the WebNavigator Server.

See also
Configuring the WebNavigator web page (Page 147)
First Web Project (Page 137)

2.1.3.2 Configuring the WebNavigator web page

Introduction
The WinCC Web Configurator is used to set up and manage the Microsoft Internet Information
Service (IIS). You will be creating a default web page in this step.

Requirement
- The WebNavigator Server is installed.
- The Windows "Internet Information Service" component is installed.
Procedure

1. Select "WebNavigator" in the navigation window of WinCC Explorer. Click the "Web Configurator" command in the shortcut menu. Click "Next" on the start page.

2. Enable the "Create a new standard web page (standalone)" option and then click "Next".
3. Enter the name "WebNavigator" for the web page.

4. Select the default port "80" in the "Port" field.

5. Select an "IP address". Use only the addresses that are available in the selection list. Select "All not assigned" to enable Intranet and Internet access to the computer.


7. Click "Finish" if you have not activated a Firewall.
   Click "Next" if you have installed a Firewall.

Result

You have created the Web folder and activated the web page.

2.1.3.3 Configuring the firewall

Introduction

This section describes how to activate "HTTP" and "HTTPS" services using Windows Server 2016 as an example.

Consult your network administrator if you want to set up the Windows Firewall with advanced security or for a different port.
Requirement

- You have created a default web page with Web Configurator.
- The Firewall is activated.
- The user who is logged has Windows administrator rights.
- You have to set up the HTTPS service in IIS if you are using it for WebNavigator.
  For more information, refer to “Setting up an HTTPS service in IIS (http://support.microsoft.com/kb/324069)”.

Procedure for the default port

1. Click the "Windows Firewall" button in the "WinCC Web Configurator".

The "Windows Firewall" dialog opens.

2. Click "Allow an app or feature through Windows Firewall".

3. Activate "Secure WWW services (HTTPS)" or "WWW services (HTTP)".

4. Close all Windows dialogs with "OK".

5. Click "Finish" in the Web Configurator.

The server configuration is completed.
2.1.3.4 Check the activated web page

Procedure

1. In the "Administrative Tools" program group, select the entry "Internet Information Services (IIS) Manager".

2. Click the computer name in the "Connections" field.

3. Click "Default Web Site".

4. Check the view of the web pages.
   If the status "Stopped" is displayed next to the required web page, for example, "WebNavigator", start the web page.
   Select the "Start" command from the shortcut menu to launch the web page.

5. Close the "Internet Information Services (IIS) Manager". The web page is activated.
2.1.4 Operating the WinCC project

2.1.4.1 Operating the WinCC project with Internet Explorer

Internet Explorer settings (WebNavigator client)

Introduction

You have to adapt the Internet Explorer security settings in order to utilize full functionality of the WebNavigator Client.

Procedure

1. Click "Tools > Internet Options" in Internet Explorer.
2. Select the "Security" tab.
   Select the corresponding zone, for example, "Local Intranet" or "Internet".
3. Click "Custom Level...".
4. Enable the "Script ActiveX controls marked safe for scripting" and "Download signed ActiveX controls" options.
5. Enable "Active Scripting" under "Scripting".
6. Click "OK". Carry out the modifications in the subsequent dialog.
7. Click the "Trusted Sites" icon.
   Click the "Sites..." button to open the "Trusted sites" dialog.
8. Enter the address of the WebNavigator Server in the "Add this website to the zone" field. Possible formats and wildcards include "*:157.54.100 - 200", "ftp://157.54.23.41", or "http://*.microsoft.com". Deactivate the "Require server verification (https:) for all sites in this zone" option. Click "Add". Click "OK".
9. Click the "Trusted Sites" icon.
   Click the "Standard level" button and then the "Custom Level" button. Enable "Initialize and script ActiveX controls not marked as safe". Click "OK".
10. Click on the "General" tab.
    Click in the "Settings" area on the "Temporary Internet Files" button. Enable the "Automatic" option under "Check for newer versions of stored pages:". Click "OK".
11. Close the "Internet Options" dialog by clicking "OK".
Installing the WebNavigator Client

Introduction
This chapter describes how to install the WebNavigator Client on the WebNavigator Server via Intranet/Internet.

Requirement
- The WebNavigator Server is installed.
- The "WinCC WebNavigator" license is installed.
- The WinCC project is in Runtime.
- The WinCC pictures are configured and published for web access.
- A user for the WebNavigator Client has been created in WinCC.
- Internet Explorer

Procedure
1. Go to the address bar of Internet Explorer and enter the URL "http://www.<servername>" of the WebNavigator Server.
2. Type in the user name and password, for example, "winccd".
   The first time you access the WebNavigator Server, you are prompted to install the WebNavigator Client. Click on the link "Click here to install".
3. Click "Save" in the "File Download" dialog to save the client setup to the target computer.
   Saving the client setup to the client computer saves you from having to download the data once again if you have to restart the client computer.
4. Select the destination folder for the setup file of the WebNavigator Client in the next dialog.
5. Without closing Internet Explorer, open Windows Explorer. Navigate to the folder in which you saved the Setup file. Start the setup by double-clicking on setup.exe.
6. Follow the instructions on the screen and make the necessary entries and settings.
7. Select the "Complete" option in the "Setup type" dialog to install all components of the Client. Click "Next".
8. Click "Install" in the next dialog.
9. Click "Finish" in the "Install Wizard completed" dialog.

Result
On successful installation, the WebNavigator Client connects to the WinCC project currently in Runtime. The standard web page is displayed with the picture that you specified for the user in the User Administrator.
During installation of the WebNavigator client, the "WinCCViewerRT" Web viewer is also installed. "WinCCViewerRT" is a viewing program that you can use in place of Internet Explorer to visualize the WinCC project.

2.1.4.2 Operating the WinCC project using WinCCViewerRT

Configuring WinCCViewerRT

Introduction

WinCCViewerRT is a program for visualizing WinCC projects. You can configure WinCCViewerRT for operation with the WebNavigator Server and Graphics Runtime.

Use project settings

If you select the "Use project settings" option, the following settings are applied by the WebNavigator server:

- User Administrator:
  - Automatic logoff
- Computer properties:
  - Runtime language
  - Runtime Default Language
  - Start Picture
  - Start configuration of Menu and Toolbars
  - Hardware accelerated graphics representation (Direct2D):

Requirement

- On the server
  - The WebNavigator Server is installed.
  - A WinCC/WebNavigator license is installed.
  - The WinCC project is in Runtime.
  - The WinCC pictures are configured and published for web access.
- On the client
  - The WebNavigator Client is installed.
Procedure

1. Double-click the link "WinCCViewerRT.exe" in the "Webnavigator\Client\bin" installation folder.
   The configuration dialog opens if you reconfigure WinCCViewerRT.
   WinCCViewerRT opens if WinCCViewerRT has already been set up.
   Use the <Ctrl+Alt+P> key combination to open the configuration dialog of WinCCViewerRT.

2. Enter the login data in the "General" tab:
   - Server address: "http://<Servername>" or "http://<IP-Adresse>"
   - Use project settings: Apply settings of the WebNavigator server
   - User name and password, if you want to specify a default user for the login dialog.

3. Specify the Runtime language in the "Parameters" tab.
   If necessary, disable any key combinations with which the user switches to other programs.
   If required, you can modify the preset <Ctrl+Alt+P> key combination that is used to open
   the WinCCViewerRT configuration dialog.
   Define a key combination with which a user can log off and a new user can log on.
   The key combination can only be used if no default user has been set in the "General" tab.
4. Specify the WinCC Runtime properties in the "Graphics Runtime" tab:
   - Start Picture
   - Configuration file for user-defined menus and toolbars
   - Window Attributes
   - Impermissible user actions

5. Specify additional user actions in the "Runtime" tab:
   - Activating the screen keyboard
   - <Ctrl+Alt+Del> key combination to allow switching to the Task Manager or operating system via the screen keyboard.
   - Auto-logoff settings
   - Activating Direct2D to accelerate graphics representation.
   - Specification of the printer with which you can print from the WinCC Controls using the configured print job. Alternatively, you can print the print job with the "RPTJobPrint" function. A preview via "RPTJobPreview" is not possible on the web client.

6. Click "OK" to close the dialog.

Result

WinCCViewerRT is configured.
The connection to the WebNavigator Server is set up after you close the dialog.
The settings are saved to the "WinCCViewerRT.xml" configuration file. The configuration file settings are used at the next start of WinCCViewerRT.
WinCCViewerRT applies the user interface language from WinCC.

The configuration file is stored in the following folder based on the operating system:

- `<User>\AppData\LocalLow\Siemens\SIMATIC.WinCC\WebNavigator\Client`

You can rename the file, for example, to "User1.xml".

You can also start WinCCViewerRT by means of the command line with the user-specific configuration file, e.g. "WinCCViewerRT.exe User1.xml". This procedure allows for different configurations, depending on the logged-on user.

The WinCCViewerRT configuration dialog opens at the start if you rename or delete "WinCCViewerRT.xml". Reconfigure WinCCViewerRT or select a different configuration file.

---

**Note**

WinCCViewerRT can only be closed by means of script function if you disable a key shortcut or hide the "Close" button.

Function in the C-Scan: DeactivateRTProject; function in the VBScript: HMI.Foundation.Stop.

---

### Operating the WinCC project

#### Requirement

- **On the server**
  - The WebNavigator Server is installed.
  - The "WinCC WebNavigator" license is installed.
  - The WinCC project is in Runtime.
  - The WinCC pictures are configured and published for web access.
  - The user is created in WinCC.

- **On the client**
  - WinCCViewerRT is configured.
Procedure

1. In the "Siemens Automation" program group, select the entry "WinCCViewerRT".

2. Log on to the WebNavigator Server:
   - A login dialog is not displayed if the user name and password is preset in the "WinCCViewerRT" configuration dialog. You are logged on automatically with the stored login data.
   - The login dialog is displayed if a user name and password is not set in the "WinCCViewerRT" configuration dialog. Enter the user name and password of the WinCC user. Passwords are case-sensitive. Click "OK".

3. To change the user, use the specified key combination for "WinCCViewerRT" login/logoff. The previous user is logged off. Enter the user name and password of the new WinCC user in the login dialog. Passwords are case-sensitive. Click "OK". The key combination can only be used if no default user has been set.

Result

WinCCViewerRT automatically connects to the activated WinCC project. The start picture that is configured for the user is displayed.

The user may operate or monitor the project, depending on authorizations. Users assigned system authorization No. 1002 "Web access - monitoring only" in the User Administration are only allowed to monitor the WinCC project.

The "View Only Cursor" indicates that process-related operations are not possible.

Certain operations, such as opening the properties dialog of a WinCC OnlineTrendControl, are still possible.

You can also use your own cursor icon as a "View Only Cursor", if required. For more information, refer to "Configuring Runtime settings" (Page 184).

The <F5> key triggers a reselection of WinCCViewerRT.

2.1.5 Creating a new process picture and displaying it on the client

2.1.5.1 Creating a new process picture

Introduction

Configure a new process picture for the web project on the server. Create a trend window that displays the measured values from the archive of the WinCC demo project.
Requirement

- The WinCC demo project is open.

Procedure

1. Click "Graphics Designer" in the navigation window of WinCC Explorer. Right-click in the data window and select the "New picture" menu command.

2. In the object palette of Graphics Designer, double-click "WinCC OnlineTrendControl" on the "Controls" tab. The control is inserted into the picture and the configuration dialog opens.
3. Click the "Trends" tab. Click at the tag name in the "Data connection" field. Select the "Measured values" archive and "T01" tag in the "Archive/tag selection" dialog.

![Image of WinCC/WebNavigator Trend Settings]

4. Click "OK". The measured values from "T01" are linked to the trend.

5. If required, configure additional properties of the trend or control.

6. Save the control under the name "NewTrend.pdl" and close Graphics Designer.
2.1 WinCC/WebNavigator Getting Started

2.1.5.2 Configuring a new process picture for the web

Introduction

In order to display the trend window on the WebNavigator Client, you must publish the picture and assign it to a user as start picture.

Requirement

- The WinCC demo project is open.
- You have successfully created a trend window in a picture on the WebNavigator Server.

Procedure

1. Right-click "WebNavigator" in the navigation window of the WinCC Explorer. Select the "Web View Publisher" command from the shortcut menu.
2. Select the new "NewTrend.pdl" picture in the "Files" field of the "Select pictures" dialog of the Publishing Wizard. Move the file to the "Selected files" list.
3. Follow the further instructions of the Publishing Wizard. The picture is published after you have completed the Wizard.
4. Right-click "User Administrator" in the navigation window of WinCC Explorer and select the "Open" command from the shortcut menu.
5. Select the user with whom you wish to display the new trend window from the navigation window of the User Administrator.
6. Select the "WebNavigator" check box in the table window. The "Web Options" area is displayed.
7. Click "..." to select the "NewTrend.pd_" start picture.
8. Close the User Administrator.

Result

You have successfully configured the picture that contains the trend window for visualization on the WebNavigator Client.
2.1.5.3 Displaying the process picture on the WebNavigator Client

Introduction
You want to display the new process picture on the WebNavigator Client. Use the "WinCCViewerRT" Web Viewer for this example.

Requirements
- The WebNavigator Server and the "WinCC WebNavigator" license are installed.
- The user is created in WinCC.
- A process picture is created in WinCC.
- The process picture is published and assigned to the user as start picture.
- The WinCC project is in Runtime.
- WinCCViewerRT is configured.

Procedure
1. In the "Siemens Automation" program group, select the entry "WinCCViewerRT".
2. Log on to the WebNavigator Server:
   - A login dialog is not displayed if the user name and password are set in the "WinCCViewerRT" configuration dialog. You are logged on automatically with the stored login data.
   - The login dialog is displayed if a user name and password is not set in the "WinCCViewerRT" configuration dialog.
     Enter the user name and password in the "General" tab. Click "OK".
3. You can use the preset <Ctrl+Alt+P> key combination to change the user. The "WinCCViewerRT" configuration dialog opens.
   Enter the user name and password in the "General" tab. Click "OK".
Result

The trend window is displayed in the "WinCCViewerRT" Web Viewer. The trend values are loaded from the archive.

See also

- Configuring WinCCViewerRT (Page 154)
- Operating the WinCC project (Page 157)
2.2 WinCC/WebNavigator Documentation

2.2.1 Function overview

Introduction

WinCC/WebNavigator provides a solution for operator control and monitoring of the automation system via the Intranet and Internet. WinCC/WebNavigator offers you an easy and efficient way of implementing the operator control and monitoring functions of the WinCC project.

Current Internet security methods are supported. Use SSL encryption to increase Internet security.

The optional "WinCC/WebNavigator" package consists of the following components:

- WebNavigator server
- WebNavigator client
- WebNavigator diagnostics client

WebNavigator server

All necessary WinCC pictures and functions that are displayed on the WebNavigator Client are stored on the WebNavigator Server. The Web View Publisher automatically makes the required adaptations to the project data that is necessary for the web. This ensures the best possible performance.

The WebNavigator Server needs Microsoft Internet Information Service (IIS) for communication with the WebNavigator Clients. The IIS is set up and managed using the WinCC Web Configurator.

The "Load Balancing" function allows you to automatically distribute the WebNavigator Clients evenly to different WebNavigator Servers, in accordance with the respective server license.

WebNavigator client

The WebNavigator Client is started in Internet Explorer with enabled ActiveX controls. You can operate and monitor a current WinCC project without the entire WinCC basic system having to be installed on the computer.

You control access of the WebNavigator Clients in the user administration. A different start picture and language can be selected for each user. You can enable scalable access to different project areas and functions for individual users by assigning user authorizations.

The "WinCCViewerRT" Web Viewer program is used for visualization of web projects only. The program can be used in place of Internet Explorer to visualize the WinCC project.
WebNavigator diagnostics client

The WebNavigator Diagnostics Client is particularly useful for the following activities:

- Remote diagnostics and operator control of multiple unmanned WinCC stations.
- Central remote maintenance using a Diagnostics Client to monitor several WebNavigator Servers.
- For Power Users who need guaranteed server access at all times.

The functionality of this Diagnostics Client is no different from that of a WebNavigator client. However, the Diagnostics Client provides guaranteed access to the WebNavigator Servers at all times. Access is independent of the number of users already logged on to the WebNavigator Server.

The Diagnostics Client licensing provides you with a cost-effective solution for accessing many WebNavigator Servers using one or a few WebNavigator Clients. You can combine WebNavigator and diagnostics licenses.

2.2 Possible applications of WinCC/WebNavigator

2.2.2 WebNavigator Server on the WinCC Server

Linking WebNavigator Clients and WinCC projects via Intranet/LAN

The WinCC Server and the server component of the Web Navigator are installed on the same computer. The WebNavigator Clients operate and/or monitor the current server project via Intranet/LAN in an isolated solution.

This cost-effective solution allows you to set up computer stations, for example, for the purpose of monitoring or maintenance. It is not necessary to install the complete WinCC system on these computers.

Linking the WebNavigator Clients and WinCC projects via Internet and Intranet

The WinCC Server and the server component of the Web Navigator are installed on the same computer. The WebNavigator Clients are able to operate and/or monitor the current server project via Internet and Intranet.

Two Firewalls are employed to protect against malicious attacks from the Internet. The first firewall protects the WebNavigator Server against an attack from the Internet. The second Firewall provides additional security for the Intranet.
2.2.2 Separation of the WinCC and WebNavigator servers

Communication via a channel

A group of automation systems is assigned to the WinCC Server. The project includes all data such as programs, configuration data and miscellaneous settings. On the computer that contains the WinCC and WinCC WebNavigator servers, the WinCC project is mirrored 1:1 and not networked with the automation systems.

Data is synchronized via the OPC channel. For this purpose, the WinCC WebNavigator Server needs a license for the number of OPC tags.

Two firewalls are employed to protect the system against unauthorized access. The first firewall protects the WebNavigator Server against an attack from the Internet. The second firewall provides additional security for the intranet.
Communication via the process bus

On the computer that contains the WinCC and WinCC WebNavigator servers, the WinCC project is mirrored 1:1. Data is synchronized via the process bus. Two firewalls are employed to protect the system against unauthorized access.

2.2.2.3 Dedicated Web Server

Introduction

Installation of a dedicated web server is advantageous in larger-scale systems for the central data supply to the WebNavigator Clients. The dedicated web server processes and optimizes client access and is available to the clients as a proxy of the WinCC servers.

The functionality of the dedicated web server is provided by the installation of the WebNavigator server on a WinCC client.
Advantages of using a dedicated web server

- The load can be distributed over several dedicated web servers in order to enhance the performance of the complete system.
- The physical separation of the dedicated web server and the WinCC server on different computers increases security.
- Operation of the servers on different stations also permits the separation of operational functions, for example, plant support and the IT department.
- The dedicated web server is able to provide simultaneous access to several subordinate WinCC servers. Users logged on to the dedicated web server can access several WinCC projects, without having to log on separately for each project.
- The dedicated web server supports redundancy switchover between two subordinate WinCC servers with WinCC Redundancy.
2.2.4 WinCCViewerRT

Overview
You run the "WinCCViewerRT.exe" application instead of Internet Explorer on the WebNavigator Client. WinCCViewerRT is installed with the WebNavigator Client.

The example of WinCCViewerRT is that you do not need the browser. You therefore protect the system against virus or Trojan attacks.

The viewer only displays the pictures that you configured for web access and published on the WebNavigator Server. The user may operate or monitor the project, depending on authorizations. Users assigned authorization 1002 "Web access - monitoring only" in WinCC are only allowed to monitor the project. The WebNavigator Client is therefore a so-called "View Only Client".

The "View Only Cursor" indicates that process-related operations are not possible. Certain operations, such as opening the properties dialog of the WinCC OnlineTrendControl, are still possible.

You can also use WinCCViewerRT as terminal services application. For more information, refer to "Configuring terminal services for WebNavigator Server".

See also
Configuring terminal services for WebNavigator (Page 228)

2.2.5 WebNavigator Diagnostics Client

Overview
The WebNavigator Diagnostics Client provides cost-effective access to several WebNavigator Servers.

Several Diagnostics Clients and standard clients can be used simultaneously.

Licensing
This process does not demand an additional license for WebNavigator Server. Licensing is handled on the Diagnostics Client.

The diagnostics client can always access the WebNavigator server, regardless of whether or not the maximum number of simultaneous logins to the WebNavigator server has been reached.

Diagnostics Client access to the WebNavigator Server is always guaranteed.

No access via RDP
Access via Remote Desktop Protocol (RDP) is not enabled for the diagnostics client.
Applications

Possible applications include:

- Remote maintenance:
The Diagnostics Client is used for consecutive access to different WinCC systems for the purpose of service and maintenance.

- Central maintenance:
The Diagnostics Client is used for simultaneous access to several servers.

2.2.2.6 Terminal services and WebNavigator

Introduction

The terminal services of Windows server operating systems provide access to the desktop of a Windows server. The Terminal Client provides screen output while the application, for example, WinCCViewerRT, is active on the Terminal Server.

The Terminal Services only transfer the user interface of the application to the clients. Each client's keyboard inputs and mouse operations are returned back to the server.

For information on redundant system configurations with the Terminal Services, refer to the corresponding Microsoft documentation.

Advantages of the Terminal Services

- Use of robust hardware with low memory requirements for the clients, for example, without fans and hard disk in a dusty environment.

- Use of mobile clients with limited power consumption, e.g. handhelds, Palmtops, or PDAs.

- All applications are located on the server in a secure environment.

- Simple, central administration and system maintenance.

- Support of different operating systems, e.g. Windows CE, Windows 95.
2.2.3 Configuring the WebNavigator system

2.2.3.1 Overview of the configuration steps

Requirement

- The server and client are interconnected via TCP/IP.
- On the server
  - Internet Information Service is installed.
  - The WebNavigator Server is installed.
  - A license key is installed.
  - WinCC is installed.
- On the client
  - Internet Explorer is installed.
  - or
  - WinCCViewerRT is installed.

Basic procedure

It is necessary to complete the following configurations in order to set up the WebNavigator system:

1. Configuration of the WinCC project.
   - Publish the WinCC process pictures for web access
   - Configure web settings
   - Create and administer users for access of the WebNavigator Client.

2. Configuration of the WebNavigator Server.
   - Configure the WebNavigator web page.
   - Configure the "Load Balancing" function, if necessary.

3. Consideration of the differences compared to the WinCC basic system and of restrictions.
2.2.3.2 Configuring the WinCC project

Publishing WinCC process pictures

Introduction
If you wish to display WinCC process pictures on the WebNavigator Client or DataMonitor Client, you have to publish the pictures. For publishing, you use the Web View Publisher, which automatically makes the necessary adaptations to the project data.

Overview
The Web View Publisher enables the following types of publishing:

- Publishing on the local computer.
  The current WinCC project folder is the source folder.
  The target folder is a subfolder, for example, "Projectname/WebNavigator/Pictures".

- Publishing on a dedicated web server with a server prefix.
  The source folder is the WinCC project folder on another WinCC computer that is defined by the server prefix.
  The target folder is located in subfolder ".../WebNavigator/Pictures" of the WinCC project on the WinCC Client. The pictures of your own project are saved with the name "<picturename>.PD_", while the pictures of other projects are saved with the name "<serverprefix>_<picturename>.PD_".

- Remote publishing.
  The source and target folders can be located on the same or different web servers.
  You can start the Web View Publisher on the web server with the source and target folder or on a third web server.

- Remote publishing on a dedicated web server or WinCC Client from a different remote station.
  The project folder of the WinCC project must be released in Windows on the dedicated web server/WinCC Client. You can start the Web View Publisher remotely by opening the WinCC project of the web server/WinCC Client on the remote computer. On the remote station, you publish the WinCC pictures from other WinCC Servers to the dedicated web server.

The Web View Publisher performs the following adjustments:

- Compression of the data for optimizing performance on the Internet.
- Removal of project-specific data that is not required for the operation.
- Conversion of picture windows into an ActiveX component.
- Conversion of scripts so that they can be run on the Client.
Opening a published picture in Internet Explorer

In order to open a published picture directly, a website must already be set up.

1. In WinCC Explorer, select a published picture in the table area of the WebNavigator.
2. Select the "Copy URL to clipboard" command from the shortcut menu.
3. Paste the link from the clipboard in the address bar of Internet Explorer.

The file with the picture opens in Internet Explorer.

Publication of pictures with faulty scripts

If warnings or errors are generated during publishing, the process pictures affected are marked in the output field of the Web Publishing Wizard. The pictures with errors in the scripts are nonetheless published. However, errors can still occur in Runtime and are reported by the WebNavigator Client.

The "PdlPad" tool can be started directly in the Web View Publisher in order to check and, if necessary, correct the scripts used in the published pictures.

Publishing Without Project Functions

Publishing without project functions can be an additional source of error. When publishing with the Web View Publisher, the selected project functions are always published. When published without project functions, the pictures no longer contain any project functions. The project functions of the last publishing process are always available in the published pictures and, therefore, on the client.

The selection of project functions in the Publisher is independent of the pictures published in the same process. If, for example, you modify selected project functions but not their interfaces, you need to publish all necessary project functions. In this case, you do not have to publish the picture.

Changing the process picture in Graphics Designer

Process pictures that you edit in runtime in Graphics Designer on the WebNavigator Server must be published once again. This is required for the process picture to be displayed on the WebNavigator Client.

When using a dedicated web server, open the WinCC project on that server from a remote station in order to transfer the changes to the WebNavigator Client. On completion, open and save the modified picture in Graphics Designer. Publish the picture in the next step using Web View Publisher on the dedicated web server.

If you have modified a large number of pictures, you can simplify this process. For this purpose, call the "Convert pictures" function in the shortcut menu of Graphics Designer. On completion, you once again have to publish the pictures.

See also

How to publish WinCC process pictures using Web View Publisher (Page 176)
Requirements for publishing pictures (Page 175)
Requirements for publishing pictures

General requirements

- The picture names may not contain double underscores, e.g. "__furnace_overview.pdl". The string before the double underscore will be interpreted as server prefix.
- The package names and/or symbolic computer names may not contain any double underscores.
- The package names and/or symbolic computer names may not end in an underscore.
- Moreover, the name cannot begin with a single underscore if you are using Basic Process Control. When using Picture Tree, the name string of higher-level pictures will have a "@PTN_" prefix. With the leading underscore, the picture name will then have a double underscore.
- If two header files of the same name exist in the project path and in the installation path of WinCC, Web View Publisher will use the header file from the installation path.

Requirements for publishing on a dedicated web server

- The Web Navigator Server is installed on the WinCC Client.
- The C and VB scripts of all WinCC servers to which the WinCC Client has access have been copied to the WinCC Client.
- The WinCC server packages that the WinCC Client can access are loaded on the WinCC Client.
- If you wish to publish projects on other computers, these computers must be linked by means of network drive before you start Web View Publisher. This procedure enables the display of your projects in the selection dialog of the Publisher. You cannot enter the path directly.

Requirements for remote publishing

- Access to the target and source folders is enabled for Web View Publisher. WinCC configures these Windows enables by default. Verify that these enables are not restricted, for example, valid for specific users only.
- If you wish to publish projects on other computers, these computers must be linked by means of network drive before you start Web View Publisher. This procedure enables the display of your projects in the selection dialog of the Publisher. You cannot enter the path directly.

See also

- Publishing WinCC Process Pictures (Page 173)
- How to publish WinCC process pictures using Web View Publisher (Page 176)
How to publish WinCC process pictures using Web View Publisher

Introduction

Use Web View Publisher to publish the process pictures that you created in Graphics Designer. The WinCC Web Publishing Wizard supports you during publishing.
Procedure

1. Select "Web Navigator" in the navigation window of WinCC Explorer. Select the "Web View Publisher" command in the shortcut menu. The WinCC Web Publishing Wizard is now launched.

2. Click "Next".
3. Activate the "Server prefix" option if you want to publish the pictures on a dedicated web server.
   Select the prefix of the WinCC Server that contains the WinCC project from the selection list. The list displays the prefixes of the servers whose packages are loaded on the WinCC Client.
   Deleting a prefix from the selection changes the paths displayed in the fields below.

4. Under "Path to your WinCC project", select the WinCC project folder containing the pictures you want to publish.
   The folder has the following format for publication on a dedicated web server:
   
   "\<servername>\<serverprefix>_\<projectname>".
   If you want to publish from a remote station, select the source project containing the pictures. The source project is displayed by its enable name on the other WinCC Server.
   The folder has the following format:
   
   "\<computer name>\<enable name>".

5. Select the target folder for the published pictures under "Publishing folder of the WinCC web".
   Accept the proposed folder within the WinCC project folder.
   Do not change the path specification unless you want to transfer pictures to a different project, for example. In this case, the prefix selection list will be expanded accordingly.
   Verify the specified target project to which the published pictures are saved during remote publishing.
   The path definition will be updated when you select the source project.
   Should the target project be located on another WinCC server, select the corresponding project.
6. Select the "Display hidden objects" option to show hidden objects that are published automatically in the results list.

7. Click "Next". Move the pictures that you wish to publish to the "Selected files" list.
8. Click "Next". Move the C project functions which you use in the published pictures to the "Selected files" list. You cannot publish individual VB scripts.

Click "Next".
9. Move the referenced graphics that you wish to publish to the "Selected files" list. The referenced files are in the "GraCS" folder or in subfolders of "GraCS".

![WinCC Web Publishing Wizard](image)

Click "Next".

10. Click "Exit" to start publishing the pictures.
Result

You have successfully published the pictures and functions. The results list displays the status of all published objects. You can click an object to view additional object information.

You can trace publishing using the "<projectfolder>\WebNavigator\WizardLog.txt" file.
Checking the scripts using "PdlPad"

The "WizardLog.txt" log file contains information about errors in the scripts used. You can also find errors using the "PdlPad" debugger.

1. Open "PdlPad" by double-clicking on the affected object in the results list of Web View Publisher. The script of the published picture is displayed.

2. Click \(\text{CheckScript}^{\text{\normalfont \small ?}}\) in order to check the script.

3. You can temporarily correct and save the scripts. These corrections are only saved to the published pictures, not in the process picture of the WinCC project.

Alternatively, open "PdlPad" in the "Siemens Automation" program group.

See also

- Publishing WinCC Process Pictures (Page 173)
- Requirements for publishing pictures (Page 175)
### Configuring web settings

### Configuring runtime settings

#### Introduction

You can configure the behavior in Runtime in the "WinCC web settings" dialog.

#### Procedure

1. Select "WebNavigator" in the navigation window of WinCC Explorer. Select the "Web settings" command from the shortcut menu.

2. Change to the "Runtime" tab in the "WinCC web settings" dialog. Select the required settings. Close the dialog with "OK".
Use "WinCC Classic" design
Select this option to improve the performance of the WebNavigator Client. The original style of WinCC V6 is now used.

"Monitoring only" cursor
A default cursor shows that the user of the WebNavigator Client is not allowed to operate Runtime. The user has been assigned system authorization no. 1002 - "Web access - monitoring only" in the WinCC User Administrator.

If you want to use your own cursor, enter its path and file name. You can also use the "..." button to navigate to the file of the selected cursor.

Maximum number of simultaneous connections
Specify the maximum load on the WebNavigator Server. Specify the maximum number of connections for simultaneous access to the server. The number of configured gadgets is included in the count.

The number of simultaneous connections can exceed the number of WebNavigator licenses if, for example, several tabs are opened in the browser window. A limitation of "50" is necessary, since the server guarantees a maximum of 50 connections in normal operation without additional loads. The value must not be less than the actual number of WebNavigator licenses.

Maximum number of tabs per browser
Specify the maximum number of tabs per browser window. Multiple tabs in a browser window are counted as one WebNavigator license.

Activate WinCC system messages
The system messages "No. 1012400" or "No. 1012401" are output and archived at the login/logoff of a WebNavigator Client.

Enable event log messages
A successful session login or logoff is recorded in the Windows event viewer.

Disable local groups of SIMATIC Logon
The WebNavigator Server can only be accessed by groups in the same domain.

Hardware accelerated graphics representation
The Direct2D representation is activated for the entire project on the WebNavigator clients.

WinCC pictures as gadget

Overview
Gadgets are mini applications for the Windows Sidebar. On a WebNavigator Client, you can display published WinCC process pictures in a gadget.

Specify the WinCC pictures for the gadget. In Runtime, the WebNavigator Server successively generates a cyclic snapshot image "pdlImage.jpg" of each picture. The file is saved to the "\WinCC\Webnavigator\Server\Web\Image\_gadget" folder. The gadget accesses the file at cyclic intervals and displays the currently generated picture.
The following objects are not displayed in a gadget:

- Global Script Diagnostics Window
- WinCC Media Control
- WinCC Controls from migrated projects that have been installed with versions before WinCC V7.0

**Note**

The pictures displayed cannot contain any user interaction. This includes calling login dialogs or notice dialogs by means of functions, for instance.

You cannot operate the picture that is displayed in the gadget.

**NOTICE**

**Short update cycles place a high load on the WebNavigator system**

Set a sufficiently long update cycle rate when an AlarmControl is displayed or a large number of process values for trend views are updated in the gadget.

If a process value has not yet been read from the controller at the time of the snapshot, the gadget displays the start value instead of the actual process value.

**Requirement**

- The Windows operating system must support the use of gadgets.
- The WebNavigator Client must be installed on the WebNavigator Server to enable configuration of the gadgets.
Configuring the gadget on the WebNavigator Server

1. Select "WebNavigator" in the navigation window of WinCC Explorer. Select the "Web settings" command from the shortcut menu.

2. Change to the "Gadget" tab in the "WinCC web settings" dialog.

3. Use the "..." button to select a published picture under "Name".

4. Specify the Runtime language for the selected picture.

5. Define the clipping of the selected picture that is displayed in the Gadget. As a rule, the process picture is too large for display in the Gadget. Ensure that the clipping has the same width and height as the gadget, or at least the same width/height ratio. Otherwise, the picture will be distorted in the gadget or displayed with a black frame.

6. Click "Add". The picture is inserted into the "Pictures" list. Repeat steps 3 to 6 for additional pictures.
7. Select pictures for which you want to change the language or clipping from the list. Edit the settings and click "Change".

8. In the "Update cycle" field, specify the time interval that is to be used by the server for the cyclic update of the picture that is displayed in "pdlImage.jpg". The new picture is accessed at the start of the time interval. The current process values are read from the controller. At the end of the interval the snapshot is created and stored in "pdlImage.jpg". The following example shows two process pictures with an update cycle of "10 s".

<table>
<thead>
<tr>
<th>Time [s]</th>
<th>Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>Process_Picture_1 -&gt; pdlImage.jpg</td>
</tr>
<tr>
<td>20</td>
<td>Process_Picture_2 -&gt; pdlImage.jpg</td>
</tr>
<tr>
<td>30</td>
<td>Process_Picture_1 -&gt; pdlImage.jpg</td>
</tr>
<tr>
<td>40</td>
<td>Process_Picture_2 -&gt; pdlImage.jpg</td>
</tr>
</tbody>
</table>

1. Select the "Time stamp" option if you want the gadget to display the date and time of generation of the picture.

2. Close the dialog with "OK".

Displaying gadgets on the WebNavigator Client

A pre-configured gadget for displaying WinCC pictures is available in the installation folder at "\WinCC\Webnavigator\GADGET" on the WebNavigator Client.

To access the gadget with the WebNavigator Client, proceed as follows:

1. Double-click "WebNavigator.gadget" in the installation folder at "\WinCC\Webnavigator \GADGET". The gadget is installed in the Windows Sidebar.
2. Specify the update cycle in which the gadget loads a picture from the WebNavigator Server.
3. Enter the address of the WebNavigator Server. The Gadget establishes a connection to the WebNavigator Server.
4. If necessary, drag-and-drop the Gadget onto the desktop.

Web settings for compatibility

Working with migrated projects

The following restriction existed for C scripts in WinCC/Web Navigator prior to V6.2. Instead of the complete path and picture name, the following parameters and functions returned only the picture name on the WebNavigator Client:

- Parameter "lpszPictureName"
- Function "GetParentPicture"
- Function "GetParentPictureWindow"

As of WinCC/WebNavigator V6.2, you can enable absolute addressing and therefore revoke this restriction for the WebNavigator Client, if required.
Select the desired response for the execution of C scripts:

- **Picture name**: Absolute addressing is disabled by default. The functions or parameters only return the picture name. Compatibility with older versions of WebNavigator Client and the C scripts created for these is maintained.

- **Picture name and path**: The absolute picture name is returned with the complete path. This response corresponds with the WinCC basic system. There is no need to modify the C-Scripts used on the WinCC basic system for execution on the WebNavigator Client.

**Procedure**

1. Select "WebNavigator" in the navigation window of WinCC Explorer. Select the "Web settings" command from the shortcut menu.

2. Change to the "Compatibility" tab in the "WinCC web settings" dialog.

3. Activate the desired response of the C-Scripts.

4. Close the dialog with "OK".

**Administering the users for WebNavigator Client**

**Introduction**

Assign authorizations to the user for operator control and monitoring for access to a WinCC project as WebNavigator Client.

You can select a start picture and Runtime language for each user.

Use the "Automatic Logout" function to specify the timeout for access of the WebNavigator Client to the WinCC project. The user will then be logged off automatically.

**Automatic logout**

The automatic logout provides the following advantages on a WebNavigator system:

- **Access from the WebNavigator client to the WinCC project is subject to timeout.** This enhances system security, particularly when using unattended clients that access the WebNavigator Server.

- **The license used by the client is released again after the automatic logout.**

- **The current load on the WebNavigator Server is reduced after the automatic logout.**
Manual logout using the ODK function "PWRTLogout"

You can also log off users from the WebNavigator client with the ODK function "PWRTLogout()".

You will find a description of this function in the ODK documentation under "ODK User Administrator > Functions of the RT > Functions for logging in/out".

WinCCViewerRT / Internet Explorer: Different behavior

After the manual logoff, the WebNavigator changes to a page with the "Logon" and "Close" options.

When the "Log on" button is clicked, the browsers react differently:

- WinCCViewerRT:
  If user name and password are configured in WinCCViewerRT, the stored user is automatically logged on.

- Internet Explorer:
  The logon dialog for entering the user name and password opens.

Requirement

- The WinCC process pictures were published using Web View Publisher.
- WinCC User Administrator is open.
- A user is created.
- System authorizations of the user are specified.
- The domain-specific authorizations are specified if the WinCC option "Basic Process Control" is used.
Procedure

1. Select the desired user in the navigation window.

2. The user's operating authorizations are displayed in the table window.
   If system authorization "Web access - monitoring only" has been enabled, the user is only allowed to monitor the WinCC project when acting as WebNavigator Client. If this system authorization is disabled, the other operating authorizations assigned to the user are valid. For this reason, check the settings of the other authorizations.

3. If applicable, specify the time until automatic logout in the "Logout" field in the user properties.
   To get to the properties, select the user group in the navigation window, and then select the user in the table window.
   - If "None" is entered, automatic logout is disabled.
   - The time configured for automatic logout starts at the time of logon if you select the "Absolute" option.
     The time expires independent of user actions.
   - If you select the "Inactive" option, the configured time starts with the last keyboard or mouse operation by the user.
     The user is automatically logged out after this period of inactivity.

   The "Automatic logout: disconnected from server" message is displayed after the automatic logout. You can refresh the page by pressing "F5" and reconnect with the WebNavigator Server.

4. In the properties of the user, activate the "WebNavigator" option.

5. Select the start picture for the user in "Web start picture" via the dropdown list.
   You can only select published pictures as start pictures.
6. Select the Runtime language for the user in "Web language" via the dropdown list. The languages created in the Text Library are available for selection.

7. Close the User Administrator.

Restrictions when using SIMATIC Logon

The WebNavigator Server supports SIMATIC Logon. However, the following restrictions apply:

- If the user is a member of several user groups, a random group in which a start picture is configured will be selected. You cannot configure which group should be selected. The authorizations of all groups in which the user is a member are taken into account.

- You must add the domain prefix to the user name in the logon dialog of Internet Explorer: "<domain>\<username>".

- Password expiration during a client session has no influence on the operability of the WebNavigator Client.

- You can only change the password on the WebNavigator Server.

- The WebNavigator Client does not support the following functions when SIMATIC Logon is used on the WebNavigator Server:
  - ODK functions
  - User Administrator

2.2.3.3 Configuring the WebNavigator Server

Configuring the WebNavigator web page

WinCC Web Configurator

Introduction

The WinCC Web Configurator is used to set up and manage the Microsoft Internet Information Service (IIS).

Requirement

- The WebNavigator Server is installed.
- The Windows "Internet Information Service" component is installed.

Starting WinCC Web Configurator

- Select "WebNavigator" in the navigation window of WinCC Explorer. Click the "Web Configurator" command in the shortcut menu.
- You can also click the "Web Configurator" shortcut on your desktop.
Initial configuration using WinCC Web Configurator

During the course of initial configuration, you specify whether you wish to create a new default web page or a new virtual folder.

If you only operate the Web Navigator web page on the server, select the "Create a new standard web page (standalone)" option.

To add the WebNavigator web page as subfolder to an existing web page, select the "Add to existing web page (virtual folder)" check option. This option may be necessary if the current default web page must remain active or if the operating system only supports operation of one web page.

Note
Default Web Page on a 64-Bit Operating System

If you operate the default web page on a 64-bit operating system, you must allow 32-bit applications in the "DefaultAppPool" application pool in the advanced settings of the "Default Web Site" of IIS Manager.

Managing the configuration in WinCC Web Configurator

If IIS has already been configured, edit the settings of the existing web server or the virtual folder using the Web Configurator.
The Web Configurator automatically detects whether a configuration already exists. The dialog for editing the configuration opens if an existing configuration is found.

**Note**

**Web folder was modified or deleted**

If you have deleted the web folder, restart the computer before you create a new web folder with Web Configurator.

Note the following:

- If web communication fails after you have changed the web folder, the Web Configurator attempts to adjust the settings.
- If this action is unsuccessful, proceed as follows:
  1. Exit the IIS console.
  2. To delete the WebNavigator web page, enter the following command line in the window "Run":
     
     ```
     <wincc_installationpath>\WebNavigator\Server\bin\WinCCWebConfigurator.exe deinstall="yes".
     ```
  3. Start the desired web page from the IIS console, for example, the standard web page.

---

### Creating a new default web page

#### Introduction

You can create the standard web page using the WinCC Web Configurator.

#### Requirement

- The WebNavigator Server is installed.
- The Windows "Internet Information Service" component is installed.
- WinCC Web Configurator is started.
1. Select the "Create a new standard web page (standalone)" option and then click "Next".

2. Select "Name of the web page" and enter the name.

3. Enter the number of the port used for access in the "Port" field. HTTP port "80" is set by default. If you select a different port number, that number has to be appended to the server name in the address bar of Internet Explorer when a WebNavigator Client logs on, e.g. "http://<servername>:<portnumber>".

4. At "IP address", specify whether the computer is to be available on the Intranet or Internet or on both networks. Use only the addresses that are available in the selection list. Select "All not assigned" to enable Intranet and Internet access to the computer.

5. Select the default web page to be displayed on the WebNavigator Client after selection of the web server.
   - MainControl.asp
     Opens the WinCC Web Navigation interface and the start picture specified in the User Administration. You need the Web Navigation interface to download plug-ins, for example.
   - WebClient.asp
     Opens the start picture you specified in the User Administration.

6. Specify the time interval for automatic connection setup after a connection failure. A time setting of "0" disables the "Automatic reconnection" function.
7. Specify whether the web page is started once the configuration is completed.
8. Click "Finish" if you have not activated a Firewall. Click "Next" if you have installed a Firewall.

Result

You have successfully created the web folder and activated the web page.

Creating a virtual folder

Introduction

You can create a virtual folder using the WinCC Web Configurator.

Requirement

- The WebNavigator Server is installed.
- The Windows "Internet Information Service" component is installed.
- WinCC Web Configurator is started.

Procedure

1. Enable "Add to existing web (virtual folder)". Click "Next".
2. Select the active web page to which you want to add the virtual folder.
3. Click "OK" to close the dialog.
   Click "Next" in the next dialog.

4. Select "Name of the web page" and enter the name.

5. Web Configurator applies the IIS settings as port number and IP address.

6. Select the default web page to be displayed on the WebNavigator Client after selection of the web server.
   - MainControl.asp
     Opens the WinCC Web Navigation interface and the start picture specified in the User Administration. You need the Web Navigation interface to download plug-ins, for example.
   - WebClient.asp
     Opens the start picture you specified in the User Administration.

7. Specify the time interval for automatic connection setup after a connection failure.
   A time setting of "0" disables the "Automatic reconnection" function.

8. Specify whether the web page is started once the configuration is completed.

9. Click "Finish" to complete the configuration.

**Result**

You have created the virtual web folder and the web page is activated.

On the WebNavigator Client, add the name of the virtual web folder to the URL to enable access to the web page, e.g. "http://WebServer/WebNavigator".
No active web page

If no active web page is found, the Web Configurator terminates with a message. Activate a web page before you restart the Web Configurator. For more information, refer to "Checking the activated web page".

See also

Check the activated web page (Page 200)

Configuring the firewall

Introduction

This section describes how to activate "HTTP" and "HTTPS" services using Windows Server 2016 as an example.

Consult your network administrator if you want to set up the Windows Firewall with advanced security or for a different port.

Requirement

- You have created a default web page with Web Configurator.
- The Firewall is activated.
- The user who is logged has Windows administrator rights.
- You have to set up the HTTPS service in IIS if you are using it for WebNavigator. For more information, refer to "Setting up an HTTPS service in IIS (http://support.microsoft.com/kb/324069)".
Procedure for the default port

1. Click the "Windows Firewall" button in the "WinCC Web Configurator".

The "Windows Firewall" dialog opens.

2. Click "Allow an app or feature through Windows Firewall".

3. Activate "Secure WWW services (HTTPS)" or "WWW services (HTTP)".

4. Close all Windows dialogs with "OK".

5. Click "Finish" in the Web Configurator.

The server configuration is completed.
Check the activated web page

Procedure

1. In the "Administrative Tools" program group, select the entry "Internet Information Services (IIS) Manager".

2. Click the computer name in the "Connections" field.

3. Click "Default Web Site".

4. Check the view of the web pages.
   If the status "Stopped" is displayed next to the required web page, for example, "WebNavigator", start the web page.
   Select the "Start" command from the shortcut menu to launch the web page.

5. Close the "Internet Information Services (IIS) Manager". The web page is activated.

Load Distribution Using the "Load Balancing" Function

Load balancing on WebNavigator Servers

Overview

The "Load balancing" function allows you to automatically distribute the WebNavigator Clients evenly to different Web Navigator servers. All WebNavigator Servers can participate in load balancing using their respective server license.
A WebNavigator Server can act either as Load Balancing Server or only as participating WebNavigator Server.

The respective WebNavigator Server is then configured as follows in the "Load Balancing Configuration" dialog:

- The WebNavigator server is only a participating WebNavigator Server.

- The WebNavigator server is a load balancing server.

A Load Balancing Server is automatically a participating WebNavigator Server, too.
Several Load Balancing Servers can be configured in a group of participating WebNavigator Servers.

**Load balancing sequence**

Following the login of a WebNavigator Client, the Load Balancing Server transfers the client to the participating WebNavigator Server with the lowest load.

The clients are allocated using the "LBConfig.xml" file. The file is available in the "Project folder/ WebNavigator".

If the fewest clients are logged on to the Load Balancing Server, the new client remains connected to that server.

If a participating WebNavigator Server fails, the clients logged on to it remain in the Reconnect Screen until this Webserver is available again.

The address of a WebNavigator Server does not depend on whether it is activated as a Load Balancing Server.

**Licensing**

The "Load balancing" function supports a maximum of 32 interconnected WebNavigator Servers.
All participating WebNavigator Servers and Load Balancing Servers need a "Load balancing" license.

No license is necessary on the WebNavigator Clients.

When using WinCC computers with WinCC Redundancy, you can operate a Load Balancing Server or participating WebNavigator Server using the "WinCC Redundancy" and "Load Balancing Step-Up" licenses.

Example
In the figure, WebNavigator Servers 1 to 3 participate in "Load Balancing". A "Load Balancing" license is installed on the WebNavigator Servers.

WebNavigator Servers 1 and 2 are configured as Load Balancing Server.

When WebNavigator Client 1 logs on to WebNavigator Server 1 or 2, it is routed automatically to the server that is with the lowest load.

If the WebNavigator Server to which it is connected fails, Client 1 is re-routed to one of the remaining WebNavigator Servers.

WebNavigator Server 3 participates in "Load Balancing", but it is not configured as Load Balancing Server.

In the case of a high load or on the failure of Server 1 or Server 2, the WebNavigator Clients can be re-routed to Server 3. If WebNavigator Server 3 fails, the client cannot be re-routed to Server 1 or 2, irrespective of any active connection.

WebNavigator Server 4 does not participate in "Load Balancing". A logon of WebNavigator Client 2 to this server will possibly fail because load limits are exceeded on the server. On failure of WebNavigator Server 4, the client cannot be re-routed to one of the WebNavigator Servers 1 to 3, irrespective of any active connection.

Settings for the use of a proxy server

The use of a proxy server may have the effect that the target address "http://<servername>" of the participating WebNavigator Server or Load Balancing Server is replaced with "http://<servername.proxyname>".

The addressed WebNavigator Server will not be found. For this reason, you must enter the target addresses on the servers involved of all other participating servers in Internet Explorer. Enter the addresses in "Tools > Internet Options > Connections > LAN Settings > Advanced", "Exceptions" field.

See also

Configuring the "Load Balancing" Function (Page 203)

Configuring the "Load Balancing" Function

Introduction

You need a license on each participating WebNavigator Server and Load Balancing Server.

All Load Balancing Servers and participating WebNavigator Servers are included in the list of Load Balancing Servers.

The order of all listed participating servers must be identical on all Load Balancing Servers.

Set up the query interval and activate the "Load Balancing" function.
A configuration is not necessary on the WebNavigator Clients.

---

**Note**

**Identical lists of participating WebNavigator Servers**

The lists on the Load Balancing Servers and all participating WebNavigator Servers must be identical to ensure uniform functionality in the case of the failure of a WebNavigator Server.

**Settings for a migrated project**

The “Load Balancing” settings are saved for each specific project. You need to save the settings once again in order to activate these for a migrated project. Start the configuration dialog and confirm the settings with “OK”.

---

**Requirement**

- The WinCC basic system, WebNavigator Server and a "Load Balancing" license are installed.
- The same users are configured on all participating WebNavigator Servers and Load Balancing Servers.
- The default web page for WebNavigator must have been created as "standalone" on the WebNavigator Server.
Procedure

1. In WinCC Explorer, select the "Load Balancing" command from the "WebNavigator" shortcut menu. The "Load Balancing Configuration" dialog is opened.

2. In the top field, enter the address of a WebNavigator Server that participates in "Load Balancing". Click "Add" to include the address in the list of servers. Repeat the process for each WebNavigator Server that participates in "Load Balancing". Supplement the name of the Load Balancing Server in the list. You can always remove a server name from the list. Select a name from the list and click "Remove".

3. Select the "Enable Load Balancing" check box to activate the local WebNavigator Server as Load Balancing Server. The check box remains deactivated on the participating WebNavigator Servers. The list of servers is retained even when you clear the check box.

4. In the "Polling Interval" field, select the time interval for polling the other participating WebNavigator Servers. The time interval is only relevant on a Load Balancing Server.

5. Click "Save".
6. Close the dialog with "OK".
7. Repeat the procedure on all participating WebNavigator Servers and Load Balancing servers.
   The modifications take effect when WinCC Runtime is restarted.

2.2.3.4 Differences to the WinCC Basic System

Functional restrictions

Introduction

The WebNavigator has certain functional restrictions compared to the WinCC basic system. You should therefore check your WinCC projects for these restrictions and adjust the project settings as required.

Overview

When you use functions that are not supported in a project, corresponding messages are generated in Runtime to draw your attention to the fact.

The following restrictions apply to the WebNavigator Client:

- The client provides only a view of the running WinCC project. It is not possible to configure the WinCC Server projects.
- You can only use WinCC options and WinCC add-ons if specified explicitly in the documentation.
- Not all "Runtime API functions" are supported. A list of supported functions is available at "Supported functions (Page 233)".
- For information on restrictions in combination with Basic Process Control, refer to "Options for Process Control > Overview of process control system options > Configuring in the PCS 7 environment > Web Client in the WinCC Information System.
- The message archive and message system can only be operated and monitored.
- WinCC Controls before WinCC V7: You cannot modify the selection of archives and tags for the visualization of the process values. The button for selection is deactivated.
- WinCC AlarmControl: The "Triggers an action" property for a message is not supported. For the correct display of message blocks, the "Apply project settings" option cannot be activated. You can find this option on the "Message blocks" tab of the "WinCC AlarmControl" properties dialog.
- WinCC Alarm Control: When a user-defined selection is created, the "Authorizations for selection editing" selection is not supported.
- The hotkeys configured in WinCC are not supported. Operator control using the tab key is supported.
• The following objects contained in the "Global library/Operation/Operating panels" folder of the WinCC shared library are not supported:
  – 1_Slider
  – 2_Slider
  – 4_Slider
• National special characters in names of process pictures or referenced graphics are not supported on the Internet.
• The overlap lock in process pictures is not supported.
• The advanced zoom functions cannot be disabled. If you do not want to employ the zoom functions, do not use a wheel mouse with “auto-scroll” setting on the client.
• The redundancy switch is only supported on the dedicated web server.

See also

Using the “Hardcopy” function (Page 223)

Using Scripts

Scripts running exclusively for the WebNavigator

In order to execute scripts only for the WebNavigator, use the pre-processor definition “RUN_ON_WEBNAVIGATOR” in the script. For example:

```c
void OnOpenPicture (char* lpszPictureName, char* lpszObjectName, char* lpszPropertyName)
{
  #ifdef RUN_ON_WEBNAVIGATOR
  // here you enter the code that is to be executed only in the
  WebNavigator
  #else
  // here you enter the code that is executed only in the WinCC basic
  system
  #endif
}
```

Visual Basic Script

There are only slight restrictions imposed by unsupported functions when VBS is used. A list of these functions is available at “Unsupported functions (Page 243)”.

Global Script

You configure the scripts on the WinCC Server in the server project.

Global scripts cannot be executed on the WebNavigator Client. Global Scripts on the server are supported.
The scripts generated using the Dynamic Wizard cannot contain unsupported functions and, therefore, cannot be executed on the WebNavigator Client. Check and correct the scripts, if necessary. Add the following condition, for example: "#ifdef RUN_ON_WEBNAVIGATOR".

**Script with trigger tags**

The WebNavigator queries tags at cyclic intervals of "1 second". The update cycle of trigger tag "upon change" is also one second.

This may lead to an increased communication load between the AS and WinCC Server. Take increased loads into account if communication between the AS and WinCC Server is operated at load limits.

If tag-triggered scripts request additional tags having a name that is generated using a string function, for example, unknown tags can only be read synchronously. Enter the tag names you are using in the trigger list in order to avoid extended selection times.

**Script for picture selection and deselection**

In contrast to the basic system, a picture is downloaded in asynchronous mode when WebNavigator is used. Account for this fact when using scripts that contain picture changes.

If a picture selection for a picture window is initiated within a script, you cannot access the objects of the new picture within the same script afterwards. The picture is not yet loaded at this time. A time delay, e.g. "Sleep(2000)" is of no help since the script and Internet Explorer are waiting. You should then execute the next script elements in the "OpenPicture" function that is triggered after the picture is loaded.

Other functions called in the script following a picture deselection will be executed with errors or not at all. The picture context is lost due to the picture deselection.

**Synchronous script functions**

Synchronous script functions impose a heavy load on the system.

You should therefore refrain from using the "SetTagxxx" function in cyclic scripts. The server will be overloaded when many clients call the "SetTagxxx" functions in a fast cycle, e.g. 1 sec or less.

Note that the following script functions and calls are transferred synchronously to the server:

- Functions that write a tag in synchronous mode and then wait for the result, e.g. "xxxWait"
- C-API calls

The frequent use of these scripting functions and calls has a negative effect on the performance of the WebNavigator Client. In the case of an Internet connection, the duration of these calls may even be in the seconds range.

Script functions that manipulate the objects in the displayed picture are of no concern since no data traffic takes place between the client and server.
**Picture in picture method and cyclic scripts**

Many synchronous calls in a picture may reduce performance, for example, in the following cases:

- More than ten windows are configured in a picture window.
- Cyclic scripts with synchronous calls, for example, "SetTagxxx", are used in the windows.

Execution of certain scripts may fail due to timeout.

The following elements are supported in a window:

- 16 windows with cyclic scripts.
- 31 windows without cyclic scripts.

**Using tags**

**Computer-local tags**

The WebNavigator Client supports computer-local tags with the following restrictions:

- When a dedicated web server is used, only the computer-local tags of that server are available on the client. The tags on the client cannot assume their own values.
- Computer-local tags of the subordinate WinCC servers cannot have their own values on the client.
- The start value of computer-local text tags can only contain characters that are allowed in tag names. If the start value of a text tag contains a colon, for example, the tag is not recognized on the client.
- Computer-local tags are not supported on the client when User Archives are used, because User Archives can only identify the local tags of the server, but not the tags of the WebNavigator Client.

**Defining picture-local script tags**

Do not use WinCC tags for WebNavigator if picture-specific data is stored in scripts.

The reading or writing of data in scripts always generates data traffic to the server. This places a load on the communication.

You can save picture-specific data as follows:

- Configure "hidden" graphic objects so that you can use their properties as picture-specific tags. Actions are executed at the object properties upon changes to the stored values.
- You have created the hidden "static text" object, for example. The "Text" property is used to store any texts, while the color properties are used to store any colors. The properties are read and/or written using scripts and influence the picture status without requiring a roundtrip to the server.
2.2.4 Operating the WinCC project

2.2.4.1 General properties of the WebNavigator Client

Automatic connection setup after connection interruption

If communication between the WebNavigator client and WebNavigator Server goes down, a message is output to the user on the client.

The client performs an automatic connection establishment. Upon successful connection setup, the start page of the WinCC project is selected. Specify the time interval between attempts to set up a connection in the Web Configurator.

If a firewall or proxy server is used in client/server communication, the client logon may be successful, but automatic reconnection does not work. When attempting to reconnect, the client uses "ICMP Ping", which may be blocked by the firewall or proxy server. In this case, deactivate the use of "ICMP-Ping" by the client for reconnection. The "Reconnect > Deactivate ICMP Ping" setting is available under "Settings > WebClient Properties" in the Web Navigation interface or via the "ClientConfig.asp" page.

Contents of the address bar

Character strings which cannot be interpreted and are not relevant to the user are displayed on the address bar of Internet Explorer. For example, the "loadbalancing=no" entry may appear, but it does not represent a status indication for the servers participating in Load Balancing.

Enter characters in the address bar when logging on and check the server name and port.

Login by means of direct input in Internet Explorer

The Microsoft Security Patches for Internet Explorer now prevent the WebNavigator client login by input of the user name and password in the address bar.

"AutoComplete" entries and links in the progress bar

The entries in the address bar of Internet Explorer are displayed as a link in the progress bar or suggested as "AutoComplete" entries for subsequent input. However, you cannot use these functions without verification when a WebNavigator client logs on to a WebNavigator Server with Load Balancing.

At its initial login on a server with Load Balancing, the client is re-routed to a second server. Internet Explorer displays the address of the second server in the progress bar or as an "AutoComplete" entry. The link in the progress bar or the "AutoComplete" is applied without verification at the next client login. The client is then logged on to the second server.

WebNavigator client with several power users

Once a power user has installed a new WebNavigator client version on a computer, all other power users of this computer must upgrade to the new version.
Inconsistency of the versions employed by power users may lead to problems. This also applies when a power user connects to a server that hosts an older version of WebNavigator.

Persistency in Runtime

The persistency data for pictures and objects is stored in each case on the WebNavigator client. Observe the following points when working on the server with several projects that contain pictures or objects of the same name:

If you create a persistency for a project picture in Runtime, that persistency is also applied to the picture of the same name in other projects.

The persistency settings you defined once for a server picture on the dedicated web server is applied to the respective WebNavigator client.

Persistency for WinCC controls

In controls for WinCC V7 or later, reset the settings in the control properties in the "Online Configuration" tab.

The persistency files for controls prior to WinCC V7 are located in the folder "Documents and Settings/User/Application Data/Siemens/SIEMENS.WINCC/WebNavigator/Client" on the WebNavigator client.

You have the following options of undoing the settings in the controls in which Runtime persistency was activated:

- Resetting individual settings in the control.
- Deleting the file.

Text changes in the text library

If you change a text from the text library in Runtime, the WebNavigator client does not automatically detect this. In order to refresh the displayed pictures, reload the picture in Internet Explorer using the "Refresh" icon or the "F5" key.

Language-dependent texts as text references

Language-dependent texts via text references are displayed on the WebNavigator client in the language currently set for the client in the "User Administrator" editor.

WinCC Slider control

Set the "Continuous_Update" property to "No" when using the WinCC Slider control. If you set this property to "Yes", the slightest change to the position generates an event trigger. This setting causes a heavy communication load on the WebNavigator client.
Removing the ProTool/Pro software

The controls of the HMI Symbol Library are deregistered if you remove the ProTool/Pro software on a WebNavigator client. Reinstall the WebNavigator client in order to recover access to the controls.

Access of the WebNavigator client to a WinCC flexible Sm@rt Server

A WebNavigator client can call the "Change server" function using the Web Navigation interface to access a WinCC flexible Sm@rt Server.

2.2.4.2 Process pictures on the WebNavigator Client

Picture change on dedicated web server

If a picture with a server prefix was loaded on the dedicated web server, no picture of the local WinCC project can subsequently be displayed without server prefix.

To display a picture of the local client project, use the server prefix "@local" for addressing, e.g. "@local::picture123.pdl".

When executed, the OpenPicture() function opens the higher-level picture of the executing object on the dedicated web server.

Project functions in pictures

The project functions are loaded when a project is initially selected after the start picture has been loaded.

For this reason, a delay may be generated between the initial display of the start picture and execution of operator actions. Although the picture is displayed, it cannot be operated until a delay of approximately 1 second has expired.

Picture window on the WebNavigator client

After you rename a picture in a picture window, the "Object change" event of the picture window is executed several times on the WebNavigator client.

The event is executed only once in the WinCC basic system.

This response on the client is system-related, because the asynchronous operating principle of the Internet connection may trigger multiple updates of the picture window object. This response has no implications in terms of functionality.
WinCC web browser OCX on the WebNavigator client

- The "Allow ActiveX controls" check box has to be activated in the "Security" tab in the Internet options of Internet Explorer.
- If you select a link in a process picture on the WebNavigator client using the WinCC web browser, the "Back" button does not work during the initial display of the linked page. The function is not properly executed until the page is called a second time. The incorrect behavior persists after a change of the process picture.
- The WinCC web browser serves to display static web contents or CHM documents in process pictures. Contents with scripting functionality are not supported.
- If you want to disable the right mouse button in the WinCC web browser to prevent the WinCC client from accessing the shortcut menu, proceed as follows:
  - Use Microsoft "Group Policy Object Editor" (Gpedit.msc).
  - Select the path "\Windows Components\Internet Explorer\Browser menus" and set the shortcut menu to "Disabled".

Performance when using WinCC UserArchiveControl

Changes to a user archive trigger the update of the WinCC UserArchiveControl that is displayed. The following factors affect the performance of the process pictures with WinCC UserArchiveControls on the WebNavigator client:

- Reduce the number of WinCC UserArchiveControls that simultaneously access a user archive to the minimum.
- Do not configure more than the necessary number of cyclic changes in the user archive.

2.2.4.3 Operating the WinCC project with Internet Explorer

Operating the WinCC project with Internet Explorer

Requirement

- On the server
  - The WebNavigator Server is installed.
  - The "WinCC WebNavigator" license is installed.
  - The WinCC pictures are configured and published for web access.
  - A user for the WebNavigator Client was created in WinCC User Administrator.
  - A start picture was specified for the user in the User Administrator.
  - The WinCC project is in Runtime.
- On the client
  - The WebNavigator Client is installed.
  - Internet Explorer is installed.
Procedure

1. Go to the address bar of Internet Explorer and enter the address "http://www.<servername>" of the WebNavigator Server.
2. Confirm your entries.
3. Type in the user name and password. Confirm your entries.

Note

Passwords are case-sensitive.

Result

The default web page is displayed. The view depends on the configuration:

- With "WebClient.asp" setting for the default web page, the WebNavigator Client starts with the start picture that is specified for the user.
- With "MainControl.asp" setting for the default web page, the WebNavigator Client starts with the start picture that is specified for the user plus the WinCC Web Navigation interface.

See also

Administering the users for WebNavigator Client (Page 189)
Working with the WinCC Web Navigation interface

Menu of the WinCC Web Navigation interface

In addition to the start picture, the WebNavigator Client displays the WinCC Web Navigation interface when "MainControl.asp" is configured as the default web page.

The Web Navigation interface provides a compilation of different web functions in its menus:

- "Change server": Changes to a different WebNavigator Server.
- "Used servers": Navigates to the web servers used previously.
Expanding the WinCC Web Navigation interface

Introduction

The menu of the Web Navigation interface may be expanded by additional entries and functions.

Configure the expansion in an XML file. This file is saved to the "_custom_data" subfolder on the WebNavigator Server. You can give the file any name you choose, since all files with "XML" extension are processed in this folder.

Example

The following example adds the "My Private Menu" submenu to the "Server" menu. The submenu consists of three entries, namely "My Link", "Relative Link" and "Run Script".

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;?xml version=&quot;1.0&quot;?&gt;</td>
<td>Version information</td>
</tr>
<tr>
<td>&lt;menu hook-on=&quot;server&quot;&gt;</td>
<td>The &quot;menu hook-on&quot; command is used to reference the name &quot;server&quot; that defines the &quot;Current Server&quot; menu on the Web Navigation interface.</td>
</tr>
<tr>
<td>&lt;caption&gt;&lt;lng&gt;My Private Menu&lt;/lng&gt;&lt;/caption&gt;</td>
<td>Defines an empty entry.</td>
</tr>
</tbody>
</table>
Diagnosis of the Connections with "Status.html"

Introduction

The "Status.html" page is used to diagnose the WinCC WebNavigator Server and its connected active clients.

Overview

Call the diagnostics page as follows:

- Type in the address "http://<servername>/status.html" in Internet Explorer if WebNavigator is configured as the default web page.
- Type in the address "http://<servername>/<foldername>/status.html" in Internet Explorer if WebNavigator is configured as virtual web page.
- Select the "Status" command from the "Diagnostics" menu if the Navigation interface is available via "MainControl.asp".

Access to this page is restricted to the users created in the User Administrator.
### Structure of diagnostics information related to the WebNavigator Server

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server version</td>
<td>WebNavigator Server version</td>
</tr>
<tr>
<td>Server file date</td>
<td>Date of the server version</td>
</tr>
<tr>
<td>License count</td>
<td>Number of licenses on the WebNavigator Server</td>
</tr>
<tr>
<td>Runtime mode</td>
<td>Status of WinCC Runtime</td>
</tr>
<tr>
<td>Last update</td>
<td>Date and time of the last display refresh</td>
</tr>
<tr>
<td>Connected WebNavigator Clients</td>
<td>Number of connected WebNavigator Clients</td>
</tr>
<tr>
<td>Connected Diagnostics Clients</td>
<td>Number of connected Diagnostics Clients</td>
</tr>
<tr>
<td>Connected DataMonitor Clients</td>
<td>Number of connected DataMonitor Clients</td>
</tr>
</tbody>
</table>

#### Table

<table>
<thead>
<tr>
<th>Login</th>
<th>Type</th>
<th>PID</th>
</tr>
</thead>
<tbody>
<tr>
<td>nie1</td>
<td>Diagnose [Gadget]</td>
<td>6584</td>
</tr>
<tr>
<td>nie2</td>
<td>Diagnose [Gadget]</td>
<td>6584</td>
</tr>
<tr>
<td>nie3</td>
<td>Standard</td>
<td>6584</td>
</tr>
<tr>
<td>nie4</td>
<td>DataMonitor [ViewOnly]</td>
<td>6584</td>
</tr>
</tbody>
</table>
Structure of diagnostics information related to the connected clients

The diagnostics information starts with the name of the relevant client.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logged on users</td>
<td>Number of connected clients</td>
</tr>
<tr>
<td>Login</td>
<td>Login name of the current user</td>
</tr>
<tr>
<td>Time</td>
<td>Login time of the current user or time of the most recent automatic connection setup.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of client, e.g. standard, DataMonitor</td>
</tr>
<tr>
<td>PID</td>
<td>Process ID of the instance of WebNavigatorRT.exe on the web server communicating with the client.</td>
</tr>
</tbody>
</table>

**Note**

You can save the status information that is displayed. To do this, use the "Save as" function in Internet Explorer and select the "(*.txt)" file type. If "(*.htm, *.html)" are selected, the contents displayed are not saved.

2.2.4.4 Operating the WinCC project using WinCCViewerRT

Configuring WinCCViewerRT

Introduction

WinCCViewerRT is a program for visualizing WinCC projects.

You can configure WinCCViewerRT for operation with the WebNavigator Server and Graphics Runtime.

Use project settings

If you select the "Use project settings" option, the following settings are applied by the WebNavigator server:

- User Administrator:
  - Automatic logoff
- Computer properties:
  - Runtime language
  - Runtime Default Language
  - Start Picture
  - Start configuration of Menu and Toolbars
  - Hardware accelerated graphics representation (Direct2D):
Requirement

- On the server
  - The WebNavigator Server is installed.
  - A WinCC/WebNavigator license is installed.
  - The WinCC project is in Runtime.
  - The WinCC pictures are configured and published for web access.
- On the client
  - The WebNavigator Client is installed.

Procedure

1. Double-click the link "WinCCViewerRT.exe" in the "Webnavigator\Client\bin" installation folder.
   The configuration dialog opens if you reconfigure WinCCViewerRT.
   WinCCViewerRT opens if WinCCViewerRT has already been set up.
   Use the <Ctrl+Alt+P> key combination to open the configuration dialog of WinCCViewerRT.

2. Enter the login data in the "General" tab:
   - Server address: "http://<Servername>" or "http://<IP-Adresse>"
   - Use project settings: Apply settings of the WebNavigator server
   - User name and password, if you want to specify a default user for the login dialog.

3. Specify the Runtime language in the "Parameters" tab.
   If necessary, disable any key combinations with which the user switches to other programs.
   If required, you can modify the preset <Ctrl+Alt+P> key combination that is used to open
   the WinCCViewerRT configuration dialog.
   Define a key combination with which a user can log off and a new user can log on.
   The key combination can only be used if no default user has been set in the "General" tab.
4. Specify the WinCC Runtime properties in the "Graphics Runtime" tab:
   - Start Picture
   - Configuration file for user-defined menus and toolbars
   - Window Attributes
   - Impermissible user actions

5. Specify additional user actions in the "Runtime" tab:
   - Activating the screen keyboard
   - <Ctrl+Alt+Del> key combination to allow switching to the Task Manager or operating system via the screen keyboard.
   - Auto-logoff settings
   - Activating Direct2D to accelerate graphics representation.
   - Specification of the printer with which you can print from the WinCC Controls using the configured print job.
     Alternatively, you can print the print job with the "RPTJobPrint" function. A preview via "RPTJobPreview" is not possible on the web client.

6. Click "OK" to close the dialog.

Result

WinCCViewerRT is configured.

The connection to the WebNavigator Server is set up after you close the dialog.

The settings are saved to the "WinCCViewerRT.xml" configuration file. The configuration file settings are used at the next start of WinCCViewerRT.
WinCCViewerRT applies the user interface language from WinCC.

The configuration file is stored in the following folder based on the operating system:

- `<User>\AppData\LocalLow\Siemens\SIMATIC.WinCC\WebNavigator\Client`

You can rename the file, for example, to "User1.xml".

You can also start WinCCViewerRT by means of the command line with the user-specific configuration file, e.g. "WinCCViewerRT.exe User1.xml". This procedure allows for different configurations, depending on the logged-on user.

The WinCCViewerRT configuration dialog opens at the start if you rename or delete "WinCCViewerRT.xml". Reconfigure WinCCViewerRT or select a different configuration file.

**Note**

WinCCViewerRT can only be closed by means of script function if you disable a key shortcut or hide the "Close" button.

Function in the C-Script: DeactivateRTProject; function in the VBScript: HMIRuntime.Stop.

### Operating the WinCC project

#### Requirement

- **On the server**
  - The WebNavigator Server is installed.
  - The "WinCC WebNavigator" license is installed.
  - The WinCC project is in Runtime.
  - The WinCC pictures are configured and published for web access.
  - The user is created in WinCC.

- **On the client**
  - WinCCViewerRT is configured.
Procedure

1. In the "Siemens Automation" program group, select the entry "WinCCViewerRT".

2. Log on to the WebNavigator Server:
   - A login dialog is not displayed if the user name and password is preset in the "WinCCViewerRT" configuration dialog. You are logged on automatically with the stored login data.
   - The login dialog is displayed if a user name and password is not set in the "WinCCViewerRT" configuration dialog. Enter the user name and password of the WinCC user. Passwords are case-sensitive. Click "OK".

3. To change the user, use the specified key combination for "WinCCViewerRT" login/logoff. The previous user is logged off. Enter the user name and password of the new WinCC user in the login dialog. Passwords are case-sensitive. Click "OK".
   The key combination can only be used if no default user has been set.

Result

WinCCViewerRT automatically connects to the activated WinCC project. The start picture that is configured for the user is displayed.

The user may operate or monitor the project, depending on authorizations. Users assigned system authorization No. 1002 "Web access - monitoring only" in the User Administration are only allowed to monitor the WinCC project.

The "View Only Cursor" indicates that process-related operations are not possible.

Certain operations, such as opening the properties dialog of a WinCC OnlineTrendControl, are still possible.

You can also use your own cursor icon as a "View Only Cursor", if required. For more information, refer to "Configuring Runtime settings (Page 184)".

The <F5> key triggers a reselection of WinCCViewerRT.

2.2.4.5 Using the "Hardcopy" function

Introduction

On the WebNavigator Client, the current view can be output to the default printer.

You can generate a screenshot using a configurable key combination or a script. You can enter the definition of the key combination or the screen area to be printed via the command line, for example.

To print out Runtime data with a print job, use the buttons of the WinCC controls or the "RPTJobPrint" function.
Starting the hardcopy application

Start the "PrtScr.exe" application on the WebNavigator Client, for example, by means of the command line input or a user-defined function. The application is stored in the "...\Common Files\Siemens\BIN" folder.

The parameters are transferred once only at the start. Separate the parameters with a space. Observe case sensitivity.

Close the application before you edit the parameters. Edit the parameters and restart the application.

The following parameters specify the procedure for printing a screenshot:

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Without parameters</td>
<td>Not allowed on the WebNavigator Client. Use &quot;-infinit&quot; as a substitute. Example: PrtScr.exe -infinit -hotkey=&quot;&lt;ALT&gt;+p&quot;</td>
</tr>
<tr>
<td>-end</td>
<td>Terminates an active instance of PrtScr.exe.</td>
</tr>
<tr>
<td>-hardcopy</td>
<td>Starts PrtScr.exe. Creates a screenshot of the current view. The hardcopy function then waits for the key combination for output to the printer. Use this on the WebNavigator Client only in combination with the &quot;infinit&quot; and &quot;hotkey&quot; parameters.</td>
</tr>
<tr>
<td>-nomcp</td>
<td>Starts PrtScr.exe. Creates a screenshot and prints the current view. PrtScr.exe is then closed.</td>
</tr>
<tr>
<td>-C= left;top;right;bottom</td>
<td>Starts PrtScr.exe. Creates a screenshot of the screen section that is specified in pixels and prints the current view. PrtScr.exe is then closed. &quot;-C=&quot; is always followed by a space. Example: PrtScr.exe -C= 50;50;100;100</td>
</tr>
<tr>
<td>-l</td>
<td>Prints in landscape format. You can add the parameter to any parameter combination.</td>
</tr>
<tr>
<td>-infinit</td>
<td>Serves as parameter for starting PrtScr.exe on a system without WinCC. Always use the parameter in combination with &quot;hotkey&quot;.</td>
</tr>
<tr>
<td>-hotkey=&quot;x&quot;</td>
<td>Specifies the key combination that starts output to the printer. The following characters and combinations are allowed: &lt;ALT&gt;, &lt;SHIFT&gt;, &lt;CTRL&gt; + {0-9, A-Z, 0xXX} Write the parameters in uppercase letters. Combinations of the &lt;ALT&gt;, &lt;SHIFT&gt;, and &lt;CTRL&gt; keys are allowed but not mandatory. You can specify the &quot;Virtual Key Code&quot; with &quot;XX&quot; using the hexadecimal input &quot;0xXX&quot;. For more information about &quot;Virtual Key Codes&quot;, refer to the MSDN Library. Examples: Key combination &quot;CTRL&quot; and P: -hotkey=&quot;&lt;CTRL&gt;+P&quot; Print button (&quot;Print-Screen&quot;): -hotkey=&quot;0x2C&quot; Key combination &quot;ALT&quot; and &quot;Print-Screen&quot;: -hotkey=&quot;&lt;ALT&gt;+0x2C&quot;</td>
</tr>
</tbody>
</table>

Examples of parameter combinations

<table>
<thead>
<tr>
<th>Starting the hardcopy function by means of a key combination</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>PrtScr.exe -infinit -hotkey=&quot;&lt;ALT&gt;+p&quot;</td>
<td>Starts PrtScr.exe and waits for input of the &quot;&lt;ALT&gt;+p&quot; key combination. The current screen view is printed as screenshot when you hit the key combination.</td>
</tr>
<tr>
<td>Enter the following string in the command line:</td>
<td></td>
</tr>
<tr>
<td>&quot;C:\Program Files\Common Files\Siemens\BIN\PrtScr.exe&quot; -infinit -hotkey=&quot;&lt;ALT&gt;+p&quot;</td>
<td></td>
</tr>
<tr>
<td>PrtScr.exe -infinit -hotkey=&quot;&lt;ALT&gt;+p&quot; -C= 10;10;100;100</td>
<td>Starts PrtScr.exe and waits for input of the &quot;&lt;ALT&gt;+p&quot; key combination. Only the screen section that is defined in pixels will be printed as screenshot when you hit the key combination.</td>
</tr>
</tbody>
</table>
Starting the hardcopy function by means of script

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PrtScr.exe –nomcp</td>
<td>Starts PrtScr.exe. Creates a screenshot and prints the current view. PrtScr.exe is then closed.</td>
</tr>
<tr>
<td>PrtScr.exe –C= 10;10;100;100</td>
<td>Starts PrtScr.exe. Creates a screenshot of the section that is specified in pixels and prints the current view. PrtScr.exe is then closed.</td>
</tr>
</tbody>
</table>

### 2.2.5 Installation of the WinCC Plug-In Builder

#### 2.2.5.1 Overview of the WinCC Plug-In Builder

**Introduction**

You use the WebNavigator Plug-In Builder to create MSI setup programs for downloading additional components to the WebNavigator-Clients, e.g., custom-created ActiveX-Controls. The Plug-Ins can be downloaded by the user, e.g., via the Web Navigator interface and can only be used in the WebNavigator environment.

No knowledge of the setup technology is required for using the Plug-In Builder. You only have to know which files are installed and registered by the setup program.

The created Plug-In setup takes the form of a self-extracting "EXE" file. The file is made available in a folder on the WebNavigator-Server for download to the clients.

A WebNavigator Plug-In is integrated in a previously installed WebNavigator-Client and is also uninstalled again with this Client.

**User interface of WinCC Plug-in Builder**

You install the WebNavigator Plug-In Builder from the WinCC-DVD.

To open the Plug-In Builder, select the entry "Web Navigator Plug-In Builder" in the "Siemens Automation" program group.

The Plug-In Builder shows an overview and the status of the existing Plug-In projects. Older Plug-Ins may have to be generated again.
The functions for creating a Plug-In are available via the navigation area, the menu commands and the toolbar.

All open PlugIn projects are listed in the project explorer.

In the "Information" area, you see the project status of the selected PlugIn project.

In the "Installed Software" area, you see the WebNavigator components that are installed or still needed on the computer. The functions for testing and publishing a Plug-In are only available with certain WebNavigator components.

### 2.2.5.2 How to publish a plug-in

**Introduction**

You can publish the Plug-In on the local WebNavigator-Server. As a result, the Plug-In is available to all Clients for installation.

If WebNavigator-Server and Plug-In Builder are located on the same computer, you can export the Plug-In directly to the WebNavigator-Server. If the Plug-In Builder is on another computer, you must transfer the Plug-In manually to the WebNavigator-Server.
Requirement

- The Plug-In has been generated successfully.
- Publishing requires the WebNavigator-Server.

Procedure

1. In the navigation area, click "Publish", or get to this dialog from "Test" with "Next".

2. Click or on the "Publish" button. The created Plug-In is stored on the WebNavigator-Server in the following installation folder: "WebNavigator/Server/Web/Install/Custom".

3. You receive information on the status of the publishing in the "Publish Plugin" results window. You go directly to the storage location by clicking the link.

4. Click the menu command "File > Close" to close the project or close the Plug-In Builder with .
Installing a plug-in on the WebNavigator client

In order to install plug-ins created with the Plug-In Builder on the WebNavigator-Client, you must have Windows administrator rights. The versions of the Plug-In Builders and WebNavigator-Clients used must be identical.

You use the Web Navigator interface to install the Plug-In. In the "Download Area/Download plugins" menu, select the desired Plug-In.

### 2.2.6 Configuring terminal services for WebNavigator

#### 2.2.6.1 Communication Using Terminal Services

Access from WebNavigator client and WinCC clients to the WebNavigator server

When a WebNavigator Client via the terminal service and WinCC Clients access the WebNavigator Server, the WebNavigator Client operating as Terminal Client must not open a Windows Desktop in the session.

You have the following options of preventing the WebNavigator Client from opening the Windows Desktop at the beginning of a session:

- Enter all users directly in the Terminal Service configuration.
- In the Computer Management, enter Internet Explorer as start program for individual users.

#### 2.2.6.2 Terminal Services Setup

*Introduction*

The following chapters show you how to set up the terminal services with regard to the WebNavigator Client.
Requirement

- The WinCC basic system and WebNavigator Server do not run under the terminal services.
- The WinCC basic system and WebNavigator Server must be installed on the server before you activate the terminal services for the following configuration steps.

Configuration steps

1. Activate the terminal services on the Terminal Server
2. Install the application on the Terminal Server, e.g. the WebNavigator Client. Information pertaining to the installation can be found in the corresponding documentation and the Online Help.
3. On the Terminal Server, create the users for access via the terminal services.
4. Run the application on the Terminal Client.

For more information, refer to "Terminal services" in the Microsoft Online Help.

2.2.6.3 Activating terminal services on the Windows Server

Introduction

Activate the Terminal Services on the server before you install the actual applications, e.g. WebNavigator Client.

Install the application on the server using the "Add or Remove Programs" dialog in the Control Panel. This makes it possible for all users to configure the applications. If the application is installed in any other way, only the user who actually installed the application can use it.

Requirement

- Windows administrator rights
- Windows server

Procedure

1. Open the Control Panel and double-click "Software".
2. Click "Add/Remove Windows Components" in the "Software" dialog. The "Windows Components Wizard" opens.
3. Activate "Terminal Server" and "Terminal Server Licensing".
4. Click "Next". Follow the instructions.
2.2.6.4 Creating users for access to the Terminal Server

Requirement

- Terminal Server is installed.
- A Windows user is created.

Procedure

1. Open Computer Management via the Control Panel. Select "Local Users and Groups".
2. Double-click the "Users" folder.
3. Double-click the user to be granted access to the Terminal Service.
4. Click on the "Membership" tab. Click "Add". The "Select Group" dialog opens.
5. Add the "Remote Desktop Users" group. Click "OK" to close all open dialogs.
6. Check the membership of the users in other groups. If required, add the user to other groups in order to assign the necessary user authorizations.

2.2.6.5 Starting the Terminal Server on the Terminal Client

Requirement

- The Terminal Service is started on the Windows Server
- On the Terminal Server, you created a user for access.

Procedure

1. On the Terminal Client, select the entry "Remote Desktop Connection" in the "Windows Accessories" program group. The "Remote Desktop Connection" dialog opens.
2. Enter the name of the Terminal Server.
3. Click "Connect". Log on with the user that you created for access to the Terminal Server.

Result

The connection is established. The desktop of the Terminal Server is displayed. Start an application on the Terminal Server, for example, WebNavigator Client via Internet Explorer.
2.2.7 Appendix

2.2.7.1 Troubleshooting

Communication between the WebNavigator Server and WebNavigator Client is down

If a provider (participating proxy, Firewall) has set Content Filtering for an Internet connection, WebNavigator communication is no longer possible. With content filtering, only certain contents of HTML pages are permitted. Communication is routed via a defined port to an IP address, e.g. the address of the WinCC Server.

Disable Smart Filtering of the IP address on the WebNavigator Server. Because there is no HTML content on the WinCC server, filtering is not particularly useful in any case.

The data is transferred in encrypted form if you are using SSL technology. In this case, Smart Filtering of contents is not possible.

Connection abort

In the Internet environment, connection failures, delays, and fluctuation in communication can occur.

If communication between the WebNavigator Client and WebNavigator Server goes down, a message is output to the user on the WebNavigator Client. The WebNavigator Client then attempts to perform an automatic connection setup in order to restore the connection.

Set the waiting times between connection attempts with the "Web Configurator". If the value "0" is set, the WebNavigator Client does not attempt to reconnect automatically. In this case, a message is output on the WebNavigator Client querying whether you wish to re-establish the connection.

No pictures are displayed.

Check that the correct web page is activated on the WebNavigator Server.

Multiple tab browsing

You need the "ControlHost.exe" process to enable multiple tab browsing in Internet Explorer.
When you append "?inplacecontrol=no" to the server name in the address bar, the WebNavigator Client is no longer hosted in the ControlHost, but instead in Internet Explorer. This means that multiple tab browsing is no longer possible and that the "Multiple viewer instance disabled" message is output.

Demo mode

If a required license is missing on the WebNavigator Server, a message is displayed informing you of this and the WebNavigator Client runs in demo mode. In this mode, the WebNavigator Client is fully operational for a period of 30 days. After 30 days, the error message "Still no License on Server, Demo mode expired" is shown. The WebNavigator Client can no longer connect to the WebNavigator Server.

Security levels as of Internet Explorer 8

Protected mode is activated by default for Internet Explorer 8 in Windows 7. While protective mode is activated, you cannot connect to the WebNavigator Server. The error message "Low integrity level is not supported:. Please deactivate protected mode" is displayed. Disable the mode in "Tools > Internet Options > Security".

No connection to WebNavigator Server possible.

The following section lists several error messages and reasons that prevent the WebNavigator Client from connecting to the WebNavigator Server:

- "The WinCC Server is currently not active": A server is not started in Runtime.
- "Unknown user name or password": This error can only occur in WinCCViewerRT. The user or password was stored or entered incorrectly. Internet Explorer allows you to enter the user name and password three times. The "HTTP Error 401.1" error page is then displayed.

Note

Passwords are case-sensitive.

- "Maximum count of users reached": The WinCC/WebNavigator license was exceeded on the WebNavigator Server.
- "Maximum number of simultaneous client connections reached as all licenses are in use": The available WinCC/WebNavigator licenses are allocated. If the WinCC/WebUX option is also used in the WinCC system, a WebUX client can also occupy a WebNavigator license. This reduces the number of available WebNavigator licenses.
- "Server workload exceeds limit": The maximum number of simultaneous connections was exceeded. You make the setting in "WebNavigator > Web settings > Runtime" in WinCC Explorer. The number of clients connected to a server is shown on the page "http://<servername>/status.html". The number of simultaneous connections could exceed the number of connected clients if, for example, several tabs are opened in the browser window.
• "Maximum count of tabs reached":
The maximum number of tabs per browser was exceeded. You make the setting in
"WebNavigator > Web settings > Runtime" in WinCC Explorer.

• "No connection to server":
The server cannot be reached. The precise cause of error is unknown. For diagnostics
information, refer to the page "http://<servername>/status.html".

Note
If the WebNavigator Client is a 64-bit computer, you have to install "Visual C++ 2010
Redistributable" on the computer. You have to perform this installation before the
connection is established.

You can install the software via the menu "Web Navigator and System Updates" in the
"download area" of the Navigation user interface of "MainControl.asp". If you are connecting
to an older WebNavigator Server, the link is not available. You can then install "Visual C+

• "Failed to load http://<servername>/Pictures/For_example.PD_":
Access to the configured start picture has failed. Check the authorizations on the
WebNavigator Server. The published picture may no longer be available on the server.

Wrong start picture
You have edited a new picture in the Graphics Designer.
1. Start the Web View Publisher in order to publish the new picture.
2. Select "Tools > Internet Options" in Internet Explorer to delete the temporary Internet files.
3. You can assign an individual start picture to each user in the User Administration.

See also
Check the activated web page (Page 200)

2.2.7.2 Functions

Supported functions

Introduction
The following list shows the functions supported by WebNavigator.
Functions not included in this list are not automatically enabled for the WebNavigator.

Functions

<table>
<thead>
<tr>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>WaitForDocumentReady</td>
</tr>
</tbody>
</table>
### 2.2 WinCC/WebNavigator Documentation

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get_Focus</td>
<td>Get Tag Character</td>
</tr>
<tr>
<td>GetAssignments</td>
<td>Get Tag Character State</td>
</tr>
<tr>
<td>GetBasePicture</td>
<td>Get Tag Character State Wait</td>
</tr>
<tr>
<td>GetFlashPicture</td>
<td>Get Tag Character Wait</td>
</tr>
<tr>
<td>GetFontName</td>
<td>Get Tag Multistate Wait</td>
</tr>
<tr>
<td>GetInputValueChar</td>
<td>Get Tag Multi Wait</td>
</tr>
<tr>
<td>GetLastChange</td>
<td>Get Text</td>
</tr>
<tr>
<td>GetOutputFormat</td>
<td>Set Tag Multi Wait</td>
</tr>
<tr>
<td>GetOutputValueChar</td>
<td>Set Tag Multi State Wait</td>
</tr>
<tr>
<td>GetPictureName</td>
<td>Set Tag Raw</td>
</tr>
<tr>
<td>GetPropChar</td>
<td>Set Tag Raw State</td>
</tr>
<tr>
<td>GetServerName</td>
<td>Set Tag Raw State Wait</td>
</tr>
<tr>
<td>AXC_OnBtnArcLong</td>
<td>AXC_OnBtnMsgNext</td>
</tr>
<tr>
<td>AXC_OnBtnArcShort</td>
<td>AXC_OnBtnMsgPrev</td>
</tr>
<tr>
<td>AXC_OnBtnComment</td>
<td>AXC_OnBtnMsgWin</td>
</tr>
<tr>
<td>AXC_OnBtnEmergAckn</td>
<td>AXC_OnBtnScroll</td>
</tr>
<tr>
<td>AXC_OnBtnInfo</td>
<td>AXC_OnBtnSelect</td>
</tr>
<tr>
<td>AXC_OnBtnLock</td>
<td>AXC_OnBtnSinglAckn</td>
</tr>
<tr>
<td>AXC_OnBtnLoop</td>
<td>AXC_OnBtnVisibleAckn</td>
</tr>
<tr>
<td>AXC_OnBtnMsgFirst</td>
<td>AXC_SetFilter</td>
</tr>
<tr>
<td>AXC_OnBtnMsgLast</td>
<td></td>
</tr>
<tr>
<td>OnBtnArcLong</td>
<td>OnBtnMsgLast</td>
</tr>
<tr>
<td>OnBtnArcShort</td>
<td>OnBtnMsgNext</td>
</tr>
<tr>
<td>OnBtnComment</td>
<td>OnBtnMsgPrev</td>
</tr>
<tr>
<td>OnBtnEmergAckn</td>
<td>OnBtnMsgWin</td>
</tr>
<tr>
<td>OnBtnHornAckn</td>
<td>OnBtnPrint</td>
</tr>
<tr>
<td>OnBtnInfo</td>
<td>OnBtnScroll</td>
</tr>
<tr>
<td>OnBtnLanguage</td>
<td>OnBtnSelect</td>
</tr>
<tr>
<td>OnBtnLock</td>
<td>OnBtnSinglAckn</td>
</tr>
<tr>
<td>OnBtnLoop</td>
<td>OnBtnVisibleAckn</td>
</tr>
<tr>
<td>OnBtnMsgFirst</td>
<td></td>
</tr>
</tbody>
</table>

### TLG Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TLGGetTemplateParameter</td>
<td>TlgTableWindowPressPrevButton</td>
</tr>
<tr>
<td>TLGPGetTemplateParameter</td>
<td>TlgTableWindowPressPrevItemButton</td>
</tr>
<tr>
<td>TLGPressToolbarButton</td>
<td>TlgTableWindowPressStartStopButton</td>
</tr>
<tr>
<td>TlgGetColumnPosition</td>
<td>TlgTableWindowPressStartStopButton</td>
</tr>
<tr>
<td>TlgGetNumberOfColumns</td>
<td>TlgTrendWindowPressFirstButton</td>
</tr>
<tr>
<td>TlgGetNumberOfRows</td>
<td>TlgTrendWindowPressLastButton</td>
</tr>
<tr>
<td>TlgGetNumberOfTrends</td>
<td>TlgTrendWindowPressLinealButton</td>
</tr>
</tbody>
</table>
### 2.2 WinCC/WebNavigator Documentation

<table>
<thead>
<tr>
<th>Function Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TlgGetRowPosition</td>
<td>TlgTrendWindowPressNextButton</td>
</tr>
<tr>
<td>TlgGetRulerArchivNameTrend</td>
<td>TlgTrendWindowPressNextItemButton</td>
</tr>
<tr>
<td>TlgGetRulerVariableNameTrend</td>
<td>TlgTrendWindowPressOpenArchiveVariableSelectionDlgButton</td>
</tr>
<tr>
<td>TlgGetTextAtPos</td>
<td>TlgTrendWindowPressOpenDlgButton</td>
</tr>
<tr>
<td>TlgGetRulerTimeTrend</td>
<td>TlgTrendWindowPressOpenItemSelectDlgButton</td>
</tr>
<tr>
<td>TlgGetRulerValueTrend</td>
<td>TlgTrendWindowPressOpenArchiveVariableSelectionDlgButton</td>
</tr>
<tr>
<td>TlgGetRulerValueTrend</td>
<td>TlgTrendWindowPressOpenArchiveVariableSelectionDlgButton</td>
</tr>
<tr>
<td>TlgTableWindowPressFirstButton</td>
<td>TlgTrendWindowPressOpenTimeSelectDlgButton</td>
</tr>
<tr>
<td>TlgTableWindowPressLastButton</td>
<td>TlgTrendWindowPressPrevButton</td>
</tr>
<tr>
<td>TlgTableWindowPressNextButton</td>
<td>TlgTrendWindowPressPrevItemButton</td>
</tr>
<tr>
<td>TlgTableWindowPressNextItemButton</td>
<td>TlgTrendWindowPressStartStopButton</td>
</tr>
<tr>
<td>TlgTableWindowPressOpenArchiveVariableSelectionDlgButton</td>
<td>TlgTrendWindowPressZoomInButton</td>
</tr>
<tr>
<td>TlgTableWindowPressOpenItemSelectDlgButton</td>
<td>TlgTrendWindowPressZoomOutButton</td>
</tr>
<tr>
<td>TlgTableWindowPressOpenTimeSelectDlgButton</td>
<td>TlgTrendWindowPressZoomOutButton</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GetLanguage</td>
<td>GetParentPicture</td>
</tr>
<tr>
<td>SetLanguage</td>
<td>GetParentPictureWindow</td>
</tr>
<tr>
<td>GetLink</td>
<td>GetServerTagPrefix</td>
</tr>
<tr>
<td>SetLink</td>
<td>OpenPicture</td>
</tr>
<tr>
<td>GetLinkedVariable</td>
<td>SetPictureDeactivated</td>
</tr>
<tr>
<td>GetLocalPicture</td>
<td>SetPictureDown</td>
</tr>
<tr>
<td>SetMultiLink</td>
<td>SetPictureUp</td>
</tr>
<tr>
<td>RPTJobPrint</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>_makepath</td>
<td>fscanf</td>
</tr>
<tr>
<td>_splitpath</td>
<td>fsetpos</td>
</tr>
<tr>
<td>abs</td>
<td>ftell</td>
</tr>
<tr>
<td>abort</td>
<td>fwrite</td>
</tr>
<tr>
<td>asctime</td>
<td>getc</td>
</tr>
<tr>
<td>atexit</td>
<td>getchar</td>
</tr>
<tr>
<td>atof</td>
<td>getenv</td>
</tr>
<tr>
<td>atoi</td>
<td>gets</td>
</tr>
<tr>
<td>atol</td>
<td>gtime</td>
</tr>
<tr>
<td>bsearch</td>
<td>labs</td>
</tr>
<tr>
<td>calld</td>
<td>ldiv</td>
</tr>
<tr>
<td>clearerr</td>
<td>localtime</td>
</tr>
<tr>
<td>clock</td>
<td>malloc</td>
</tr>
<tr>
<td>clime</td>
<td>memchr</td>
</tr>
<tr>
<td>difftime</td>
<td>memcmp</td>
</tr>
<tr>
<td>div</td>
<td>memcpy</td>
</tr>
<tr>
<td>exit</td>
<td>memmove</td>
</tr>
</tbody>
</table>

WinCC Basic Options (WebNavigator, DataMonitor, WebUX)
System Manual, 09/2018, A5E45519660-AA
### 2.2 WinCC/WebNavigator Documentation

<table>
<thead>
<tr>
<th>Function</th>
<th>Function</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>fclose</td>
<td>memset</td>
<td>strspn</td>
</tr>
<tr>
<td>feof</td>
<td>mktime</td>
<td>strstr</td>
</tr>
<tr>
<td>ferror</td>
<td>perror</td>
<td>strtod</td>
</tr>
<tr>
<td>fflush</td>
<td>printf</td>
<td>strtok</td>
</tr>
<tr>
<td>fgetc</td>
<td>putc</td>
<td>strtol</td>
</tr>
<tr>
<td>fgets</td>
<td>putchar</td>
<td>strtol</td>
</tr>
<tr>
<td>fgetpos</td>
<td>SysMalloc</td>
<td>time</td>
</tr>
<tr>
<td>fopen</td>
<td>qsort</td>
<td>system</td>
</tr>
<tr>
<td>fprintf</td>
<td>rand</td>
<td>vsprintf</td>
</tr>
<tr>
<td>fputc</td>
<td>realloc</td>
<td>vsprintf</td>
</tr>
<tr>
<td>fputs</td>
<td>remove</td>
<td>vsprintf</td>
</tr>
<tr>
<td>freopen</td>
<td>rename</td>
<td>vsprintf</td>
</tr>
<tr>
<td>fread</td>
<td>rewind</td>
<td>vsprintf</td>
</tr>
<tr>
<td>free</td>
<td>scanf</td>
<td></td>
</tr>
<tr>
<td>fseek</td>
<td>setbuf</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Function</th>
<th>Function</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check</td>
<td>Program Execute</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Function</th>
<th>Function</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>GetActualPointLeft</td>
<td>GetExponent</td>
<td>GetPicDeactTransparent</td>
</tr>
<tr>
<td>GetActualPointTop</td>
<td>GetExtendedOperation</td>
<td>GetPicDeactUseTransColor</td>
</tr>
<tr>
<td>GetAdaptBorder</td>
<td>GetFillColor</td>
<td>GetPicDownReferenced</td>
</tr>
<tr>
<td>GetAdaptPicture</td>
<td>GetFilling</td>
<td>GetPicDownTransparent</td>
</tr>
<tr>
<td>GetAdaptSize</td>
<td>GetFillingIndex</td>
<td>GetPicDownUseTransColor</td>
</tr>
<tr>
<td>GetAlarmHigh</td>
<td>GetFillStyle</td>
<td>GetPicReferenced</td>
</tr>
<tr>
<td>GetAlarmLow</td>
<td>GetFillStyle2</td>
<td>GetPicTransColor</td>
</tr>
<tr>
<td>GetAlignment</td>
<td>GetFlashBackColor</td>
<td>GetPicUpReferenced</td>
</tr>
<tr>
<td>GetAlignmentLeft</td>
<td>GetFlashBorderColor</td>
<td>GetPicUpTransparent</td>
</tr>
<tr>
<td>GetAlignmentTop</td>
<td>GetFlashFlashPicture</td>
<td>GetPicUpUseTransColor</td>
</tr>
<tr>
<td>GetAssumeOnExit</td>
<td>GetFlashForeColor</td>
<td>GetPicUseTransColor</td>
</tr>
<tr>
<td>GetAssumeOnFull</td>
<td>GetFlashPicReferenced</td>
<td>GetPictureDeactivated</td>
</tr>
<tr>
<td>GetAverage</td>
<td>GetFlashPicTransColor</td>
<td>GetPictureDown</td>
</tr>
<tr>
<td>GetAxisSection</td>
<td>GetFlashPicUseTransColor</td>
<td>GetPictureUp</td>
</tr>
<tr>
<td>GetBackColor</td>
<td>GetFlashRateBackColor</td>
<td>GetPointCount</td>
</tr>
<tr>
<td>GetBackBorderColor</td>
<td>GetFlashRateBorderColor</td>
<td>GetPosition</td>
</tr>
<tr>
<td>GetBackColor2</td>
<td>GetFlashRateFlashPic</td>
<td>GetPressed</td>
</tr>
<tr>
<td>GetBackColor3</td>
<td>GetFlashRateForeColor</td>
<td>GetProcess</td>
</tr>
<tr>
<td>GetBackColorBottom</td>
<td>GetFontBold</td>
<td>GetPropBOOL</td>
</tr>
<tr>
<td>GetBackColorTop</td>
<td>GetFontItalic</td>
<td>GetPropDouble</td>
</tr>
<tr>
<td>GetBackFlashColorOff</td>
<td>GetFontSize</td>
<td>GetPropLong</td>
</tr>
<tr>
<td>GetBackFlashColorOn</td>
<td>GetFontUnderline</td>
<td>GetPropWord</td>
</tr>
<tr>
<td>GetBasePicReferenced</td>
<td>GetForeColor</td>
<td>GetRadius</td>
</tr>
<tr>
<td>GetBasePicTransColor</td>
<td>GetForeFlashColorOff</td>
<td>GetRadiusHeight</td>
</tr>
<tr>
<td>Function</td>
<td>Function</td>
<td>Function</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-------------------------------------</td>
<td>-------------------------------------</td>
</tr>
<tr>
<td>GetBasePicUseTransColor</td>
<td>GetForeFlashColorOn</td>
<td>GetRadiusWidth</td>
</tr>
<tr>
<td>GetBitNumber</td>
<td>GetGrid</td>
<td>GetRangeMax</td>
</tr>
<tr>
<td>GetBorderBackColor</td>
<td>GetGridColor</td>
<td>GetRangeMin</td>
</tr>
<tr>
<td>GetBorderColor</td>
<td>GetGridHeight</td>
<td>GetReferenceRotationLeft</td>
</tr>
<tr>
<td>GetBorderColorBottom</td>
<td>GetGridWidth</td>
<td>GetReferenceRotationTop</td>
</tr>
<tr>
<td>GetBorderColorTop</td>
<td>GetHeight</td>
<td>GetRightComma</td>
</tr>
<tr>
<td>GetBorderEndStyle</td>
<td>GetHiddenInput</td>
<td>GetRotationAngle</td>
</tr>
<tr>
<td>GetBorderFlashColorOff</td>
<td>GetHotkey</td>
<td>GetRoundCornerHeight</td>
</tr>
<tr>
<td>GetBorderFlashColorOn</td>
<td>GetHysteresis</td>
<td>GetRoundCornerWidth</td>
</tr>
<tr>
<td>GetBorderStyle</td>
<td>GetHysteresisRange</td>
<td>GetScaleColor</td>
</tr>
<tr>
<td>GetBorderWidth</td>
<td>GetIndex</td>
<td>GetScaleTicks</td>
</tr>
<tr>
<td>GetBoxAlignment</td>
<td>GetInputValueDouble</td>
<td>GetScaling</td>
</tr>
<tr>
<td>GetBoxCount</td>
<td>GetItemBorderBackColor</td>
<td>GetScalingType</td>
</tr>
<tr>
<td>GetBoxType</td>
<td>GetItemBorderColor</td>
<td>GetScrollBars</td>
</tr>
<tr>
<td>GetButtonColor</td>
<td>GetItemBorderStyle</td>
<td>GetSelBGColor</td>
</tr>
<tr>
<td>GetCaption</td>
<td>GetItemBorderWidth</td>
<td>GetSelTextColor</td>
</tr>
<tr>
<td>GetCheckAlarmHigh</td>
<td>GetLanguageSwitch</td>
<td>GetSizeable</td>
</tr>
<tr>
<td>GetCheckAlarmLow</td>
<td>GetLayer</td>
<td>GetSmallChange</td>
</tr>
<tr>
<td>GetCheckLimitHigh4</td>
<td>GetLeft</td>
<td>GetStartAngle</td>
</tr>
<tr>
<td>GetCheckLimitHigh5</td>
<td>GetLeftComma</td>
<td>GetToggle</td>
</tr>
<tr>
<td>GetCheckLimitLow4</td>
<td>GetLimitHigh4</td>
<td>GetToleranceHigh</td>
</tr>
<tr>
<td>GetCheckLimitLow5</td>
<td>GetLimitHigh5</td>
<td>GetToleranceLow</td>
</tr>
<tr>
<td>GetCheckToleranceHigh</td>
<td>GetLimitLow4</td>
<td>GetTop</td>
</tr>
<tr>
<td>GetCheckToleranceLow</td>
<td>GetLimitLow5</td>
<td>GetTrend</td>
</tr>
<tr>
<td>GetCheckWarningHigh</td>
<td>GetLimitMax</td>
<td>GetTrendColor</td>
</tr>
<tr>
<td>GetCheckWarningLow</td>
<td>GetLimitMin</td>
<td>GetTypeErrorHigh</td>
</tr>
<tr>
<td>GetClearOnError</td>
<td>GetListMin</td>
<td>GetTypeErrorLow</td>
</tr>
<tr>
<td>GetCloseButton</td>
<td>GetLongStrokesBold</td>
<td>GetTypeErrorLimitHigh4</td>
</tr>
<tr>
<td>GetColorAlarmHigh</td>
<td>GetLongStrokesOnly</td>
<td>GetTypeErrorLimitHigh5</td>
</tr>
<tr>
<td>GetColorAlarmLow</td>
<td>GetLongStrokesSize</td>
<td>GetTypeErrorLimitLow4</td>
</tr>
<tr>
<td>GetColorAlarmLow</td>
<td>GetLongStrokesTextEach</td>
<td>GetTypeErrorLimitLow5</td>
</tr>
<tr>
<td>GetColorBottom</td>
<td>GetMarker</td>
<td>GetTypeErrorToleranceHigh</td>
</tr>
<tr>
<td>GetColorChangeType</td>
<td>GetMax</td>
<td>GetTypeErrorToleranceLow</td>
</tr>
<tr>
<td>GetColorLimitHigh4</td>
<td>GetMaximizeButton</td>
<td>GetTypeErrorWarningHigh</td>
</tr>
<tr>
<td>GetColorLimitHigh5</td>
<td>GetMin</td>
<td>GetTypeErrorWarningLow</td>
</tr>
<tr>
<td>GetColorLimitLow4</td>
<td>GetMoveable</td>
<td>GetUnselBGColor</td>
</tr>
<tr>
<td>GetColorLimitLow5</td>
<td>GetNumberLines</td>
<td>GetUnselTextColor</td>
</tr>
<tr>
<td>GetColorToleranceHigh</td>
<td>GetOffsetLeft</td>
<td>GetUpdateCycle</td>
</tr>
<tr>
<td>GetColorToleranceLow</td>
<td>GetOffsetTop</td>
<td>GetVisible</td>
</tr>
<tr>
<td>GetColorTop</td>
<td>GetOnTop</td>
<td>GetWarningHigh</td>
</tr>
<tr>
<td>GetColorWarningHigh</td>
<td>GetOperation</td>
<td>GetWarningLow</td>
</tr>
<tr>
<td>GetColorWarningLow</td>
<td>GetOperationMessage</td>
<td>GetWindowBorder</td>
</tr>
<tr>
<td>GetCursorControl</td>
<td>GetOperationReport</td>
<td>GetWindowsStyle</td>
</tr>
<tr>
<td>GetDataFormat</td>
<td>GetOrientation</td>
<td>GetWidth</td>
</tr>
</tbody>
</table>

WinCC Basic Options (WebNavigator, DataMonitor, WebUX)
System Manual, 09/2018, A5E45519660-AA
### WinCC/WebNavigator

#### 2.2 WinCC/WebNavigator Documentation

<table>
<thead>
<tr>
<th>Function Call</th>
<th>Function Call</th>
<th>Function Call</th>
</tr>
</thead>
<tbody>
<tr>
<td>GetDirection</td>
<td>GetOutputValueDouble</td>
<td>GetZeroPoint</td>
</tr>
<tr>
<td>GetEditTextOnce</td>
<td>GetPasswordLevel</td>
<td>GetZeroPointValue</td>
</tr>
<tr>
<td>GetEndPoint</td>
<td>GetPicDeactReferenced</td>
<td>GetZoom</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Function Call</th>
<th>Function Call</th>
<th>Function Call</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set_Focus</td>
<td>SetEditTextOnce</td>
<td>SetPicDownUseTransColor</td>
</tr>
<tr>
<td>SetActualPointLeft</td>
<td>SetEndPoint</td>
<td>SetPicTransColor</td>
</tr>
<tr>
<td>SetActualPointTop</td>
<td>SetExponent</td>
<td>SetPicUpTransparent</td>
</tr>
<tr>
<td>SetAlarmHigh</td>
<td>SetExtendedOperation</td>
<td>SetPicUpUseTransColor</td>
</tr>
<tr>
<td>SetAlarmLow</td>
<td>SetFillColor</td>
<td>SetPicUseTransColor</td>
</tr>
<tr>
<td>SetAlignment</td>
<td>SetFilling</td>
<td></td>
</tr>
</tbody>
</table>
### WinCC/WebNavigator Documentation

<table>
<thead>
<tr>
<th>SetCheckLimitHigh5</th>
<th>SetLimitHigh5</th>
<th>SetToleranceHigh</th>
</tr>
</thead>
<tbody>
<tr>
<td>SetCheckLimitLow4</td>
<td>SetLimitLow4</td>
<td>SetToleranceLow</td>
</tr>
<tr>
<td>SetCheckLimitLow5</td>
<td>SetLimitLow5</td>
<td>SetToggle</td>
</tr>
<tr>
<td>SetCheckToleranceHigh</td>
<td>SetLimitMax</td>
<td>SetTypeAlarmHigh</td>
</tr>
<tr>
<td>SetCheckToleranceLow</td>
<td>SetLimitMin</td>
<td>SetTypeAlarmLow</td>
</tr>
<tr>
<td>SetCheckWarningHigh</td>
<td>SetLongStrokesBold</td>
<td>SetTypeLimitHigh4</td>
</tr>
<tr>
<td>SetCheckWarningLow</td>
<td>SetLongStrokesOnly</td>
<td>SetTypeLimitHigh5</td>
</tr>
<tr>
<td>SetClearOnError</td>
<td>SetLongStrokesSize</td>
<td>SetTypeLimitLow4</td>
</tr>
<tr>
<td>SetClearOnNew</td>
<td>SetMarker</td>
<td>SetTypeLimitLow5</td>
</tr>
<tr>
<td>SetColorAlarmHigh</td>
<td>SetMax</td>
<td>SetTypeToleranceHigh</td>
</tr>
<tr>
<td>SetColorAlarmLow</td>
<td>SetMin</td>
<td>SetTypeToleranceLow</td>
</tr>
<tr>
<td>SetColorBottom</td>
<td>SetNumberLines</td>
<td>SetTypeWarningHigh</td>
</tr>
<tr>
<td>SetColorChangeType</td>
<td>SetOffsetLeft</td>
<td>SetTypeWarningLow</td>
</tr>
<tr>
<td>SetColorLimitHigh4</td>
<td>SetOffsetTop</td>
<td>SetUnselBGColor</td>
</tr>
<tr>
<td>SetColorLimitHigh5</td>
<td>SetOperation</td>
<td>SetUnselTextColor</td>
</tr>
<tr>
<td>SetColorLimitLow4</td>
<td>SetOperationMessage</td>
<td>SetVisible</td>
</tr>
<tr>
<td>SetColorLimitLow5</td>
<td>SetOrientation</td>
<td>SetWarningHigh</td>
</tr>
<tr>
<td>SetColorToleranceLow</td>
<td>SetOutputValueChar</td>
<td>SetWindowsStyle</td>
</tr>
<tr>
<td>SetColorTop</td>
<td>SetOutputValueDouble</td>
<td>SetWidth</td>
</tr>
<tr>
<td>SetColorWarningHigh</td>
<td>SetPasswordLevel</td>
<td>SetZeroPoint</td>
</tr>
<tr>
<td>SetColorWarningLow</td>
<td>SetPicDeactTransparent</td>
<td>SetZeroPointValue</td>
</tr>
<tr>
<td>SetCursorControl</td>
<td>SetPicDeactUseTransColor</td>
<td>SetZoom</td>
</tr>
<tr>
<td>SetDirection</td>
<td>SetPicDownTransparent</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>GetTagBit</th>
<th>GetTagDateTime</th>
<th>GetTagByteStateQCWait</th>
</tr>
</thead>
<tbody>
<tr>
<td>GetTagByte</td>
<td>GetTagDoubleWait</td>
<td>GetTagCharStateQC</td>
</tr>
<tr>
<td>GetTagDouble</td>
<td>GetTagDWordWait</td>
<td>GetTagCharStateQCWait</td>
</tr>
<tr>
<td>GetTagDWord</td>
<td>GetTagFloatWait</td>
<td>GetTagDoubleStateQC</td>
</tr>
<tr>
<td>GetTagFloat</td>
<td>GetTagRawWait</td>
<td>GetTagDoubleStateQCWait</td>
</tr>
<tr>
<td>GetTagRaw</td>
<td>GetTagSByteWait</td>
<td>GetTagDWordStateQC</td>
</tr>
<tr>
<td>GetTagSByte</td>
<td>GetTagSDWordWait</td>
<td>GetTagDWordStateQCWait</td>
</tr>
<tr>
<td>GetTagSDWord</td>
<td>GetTagSWordWait</td>
<td>GetTagFloatStateQCWait</td>
</tr>
<tr>
<td>GetTagSWord</td>
<td>GetTagBitStateWait</td>
<td>GetTagRawStateQC</td>
</tr>
<tr>
<td>GetTagBitState</td>
<td>GetTagByteStateWait</td>
<td>GetTagRawStateQCWait</td>
</tr>
<tr>
<td>GetTagByteState</td>
<td>GetTagDoubleStateWait</td>
<td>GetTagSByteStateQC</td>
</tr>
<tr>
<td>GetTagDoubleState</td>
<td>GetTagDWordStateWait</td>
<td>GetTagSByteStateQCWait</td>
</tr>
<tr>
<td>GetTagDWordState</td>
<td>GetTagFloatStateWait</td>
<td>GetTagSDWordStateQC</td>
</tr>
<tr>
<td>GetTagFloatState</td>
<td>GetTagRawStateWait</td>
<td>GetTagSDWordStateQCWait</td>
</tr>
<tr>
<td>GetTagRawState</td>
<td>GetTagSByteStateWait</td>
<td>GetTagSWordStateQC</td>
</tr>
<tr>
<td>GetTagSByteState</td>
<td>GetTagSDWordStateWait</td>
<td>GetTagSWordStateQCWait</td>
</tr>
<tr>
<td>GetTagSDWordState</td>
<td>GetTagSWordStateWait</td>
<td>GetTagValueStateQC</td>
</tr>
</tbody>
</table>
GetTagSWordState GetTagWordStateWait GetTagValueStateQCWait
GetTagWordState GetTagBitStateQC GetTagWordStateQC
GetTagBitWait GetTagBitStateQCWait GetTagWordStateQCWait
GetTagByteWait GetTagByteStateQC GetTagMultiStateQCWait

SetTagBit SetTagFloatState SetTagSWordWait
SetTagByte SetTagRawState SetTagWordWait
SetTagDouble SetTagSByteState SetTagBitStateWait
SetTagDWord SetTagSDWordState SetTagByteStateWait
SetTagFloat SetTagSWordState SetTagDoubleStateWait
SetTagRaw SetTagWordState SetTagDWordStateWait
SetTagSByte SetTagBitWait SetTagFloatStateWait
SetTagSDWord SetTagByteWait SetTagRawStateWait
SetTagSWord SetTagDoubleWait SetTagSByteStateWait
SetTagWord SetTagDWordWait SetTagSDWordStateWait
SetTagBitState SetTagFloatWait SetTagSWordStateWait
SetTagByteState SetTagRawWait SetTagWordStateWait
SetTagDoubleState SetTagSByteWait
SetTagDWordState SetTagSDWordWait

Supported ODK Functions

- PWRTCheckPermission
- PWRTCheckAreaPermission
- PWRTCheckPermissionOnArea
- PWRTCheckPermissionOnPicture // Only the "permlevel" parameter is evaluated.
- MSRTStartMsgService
- MSRTStopMsgService
- MSRTCreateMsg
- MSRTCreateMsgInstanceWithComment
- MSRTSetComment
- PDLRTGetLink
- PDLRTSetLink
- PDLRTSetMultiLink
- PDLRTGetPropEx // Nur das Lesen wird unterstützt.
- PDLRTSetPropEx // Nur das Setzen wird unterstützt.
- TXTRTConnect
- TXTRTDIsconect
- TXTRTGetInfoTextMC
## Supported User Archive-Functions

**Note**

User archive functions must always start with "ua" in lower case.

Functions beginning with the uppercase letters "UA" are ODK functions. These ODK functions are not supported on the WebNavigator Client.

<table>
<thead>
<tr>
<th>Function</th>
<th>Function</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>uaArchiveClose</td>
<td>uaArchiveGetName</td>
<td>uaArchiveSetFieldValueLong</td>
</tr>
<tr>
<td>uaArchiveDelete</td>
<td>uaArchiveGetSort</td>
<td>uaArchiveSetFieldValueString</td>
</tr>
<tr>
<td>uaArchiveExport</td>
<td>uaArchiveImport</td>
<td>uaArchiveSetFilter</td>
</tr>
<tr>
<td>uaArchiveGetCount</td>
<td>uaArchiveInsert</td>
<td>uaArchiveSetSort</td>
</tr>
<tr>
<td>uaArchiveGetFieldLength</td>
<td>uaArchiveMoveFirst</td>
<td>uaArchiveUpdate</td>
</tr>
<tr>
<td>uaArchiveGetFieldName</td>
<td>uaArchiveMoveLast</td>
<td>uaArchiveWriteTagValues</td>
</tr>
<tr>
<td>uaArchiveGetFields</td>
<td>uaArchiveMoveNext</td>
<td>uaArchiveWriteTagValuesByName</td>
</tr>
<tr>
<td>uaArchiveGetFieldType</td>
<td>uaArchiveMovePrevious</td>
<td>uaConnect</td>
</tr>
<tr>
<td>uaArchiveGetFieldValueDate</td>
<td>uaArchiveOpen</td>
<td>uaDisconnect</td>
</tr>
<tr>
<td>uaArchiveGetFieldValueFloat</td>
<td>uaArchiveReadTagValues</td>
<td>uaGetLastError</td>
</tr>
<tr>
<td>uaArchiveGetFieldValueDouble</td>
<td>uaArchiveReadTagValuesByName</td>
<td>uaGetLastHResult</td>
</tr>
<tr>
<td>uaArchiveGetFieldValueLong</td>
<td>uaArchiveRequery</td>
<td>uaQueryArchive</td>
</tr>
<tr>
<td>uaArchiveGetFieldValueString</td>
<td>uaArchiveSetFieldValueDate</td>
<td>uaQueryArchiveByName</td>
</tr>
<tr>
<td>uaArchiveGetFilter</td>
<td>uaArchiveSetFieldValueDouble</td>
<td>uaReleaseArchive</td>
</tr>
<tr>
<td>uaArchiveGetID</td>
<td>uaArchiveSetFieldValueFloat</td>
<td></td>
</tr>
</tbody>
</table>

### Supported MBCS Functions

<table>
<thead>
<tr>
<th>_ismbcalnum</th>
<th>_mbcat</th>
<th>_mbsncmp</th>
</tr>
</thead>
<tbody>
<tr>
<td>_ismbcalpha</td>
<td>_mbchar</td>
<td>_mbsncmpy</td>
</tr>
<tr>
<td>_ismbcdigit</td>
<td>_mbcmp</td>
<td>_mbsnicmp</td>
</tr>
<tr>
<td>_ismbcgraph</td>
<td>_mbcpy</td>
<td>_mbspbrk</td>
</tr>
<tr>
<td>_ismbclower</td>
<td>_mbdec</td>
<td>_mbchr</td>
</tr>
<tr>
<td>_ismbcprint</td>
<td>_mbicmp</td>
<td>_mbsspn</td>
</tr>
<tr>
<td>_ismbcpunct</td>
<td>_mbinc</td>
<td>_mbstr</td>
</tr>
<tr>
<td>_ismbcspace</td>
<td>_mbssn</td>
<td>_mbstok</td>
</tr>
<tr>
<td>_ismbcupper</td>
<td>_mbssnp</td>
<td>_mbctolower</td>
</tr>
<tr>
<td>_mbslen</td>
<td>_mbscat</td>
<td>_mbctoupper</td>
</tr>
</tbody>
</table>

### WaitForDocumentReady

**Function**

The function checks whether a picture is loaded in the specified picture window.
A difference must be made in the scripts of process pictures or project functions between the runtime environment of WinCC and of the WebNavigator Client. The following Compiler commands exist to this purpose:

- `#ifdef RUN_ON_WEBNAVIGATOR`
- `#ifndef RUN_ON_WEBNAVIGATOR`

This allows you to distinguish between WinCC and the WebNavigator Client in your configuration as follows:

- Script delay with "WaitForDocumentReady"
- Differing picture addressing
- Different function names for control system functions
- Functions that are not supported on the WebNavigator Client

### Syntax in ANSI-C

```c
int WaitForDocumentReady(LPCSTR lpszPictureWindow)
```

#### Parameters

**lpszPictureWindow**

Pointer to the name of the picture window that is opened in the WebNavigator Client.

The following addressing syntax is possible:

- Picture window "xxx" in the current screen: `./xxx`
- Picture window "yyy" in the child screen "xxx": `./xxx/yyy`
- Picture window "xxx" in the parent screen: `../xxx`
- Picture window "xxx" in the parent picture of the parent screen: `../../xxx`
- Absolute path compatible with WinCC

#### Return value

<table>
<thead>
<tr>
<th>Value</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>TRUE</td>
<td>0</td>
</tr>
<tr>
<td>FALSE</td>
<td>-1</td>
</tr>
</tbody>
</table>

The picture window has been found and the status checked.
The picture window has not been found.

### Example of ANSI-C

```c
#ifdef RUN_ON_WEBNAVIGATOR
SetPropChar("./", "View", "PictureName", szViewName);
WaitForDocumentReady("./View");
#else
SetPropChar(lpszParent, "View", "PictureName", szViewName);
#endif
```
Note
The syntax of the code section for WebNavigator is not checked during compilation of the WinCC script and is checked only when the pictures are published.

Unsupported Functions
The following list is only an extract of the unsupported functions. The list contains the functions that are explicitly stated as being unsupported.

Functions

<table>
<thead>
<tr>
<th>GetHWDiag</th>
<th>OnDeactivateExecute</th>
<th>ReportJob</th>
</tr>
</thead>
<tbody>
<tr>
<td>GetHWDiagLevel</td>
<td>OnErrorExecute</td>
<td>RPTJobPreview</td>
</tr>
<tr>
<td>GetKopFupAwl</td>
<td>OnTime</td>
<td>RptShowError</td>
</tr>
<tr>
<td>GetKopFupAwlLevel</td>
<td>OpenPrevPicture</td>
<td></td>
</tr>
</tbody>
</table>

VBScrip functions

- HMIRuntime.Stop: Terminates Internet Explorer and WinCCViewerRT, but not WinCC Runtime.
- AlarmLogs Object
- DataLogs Object
- Logging Object
- Project Object

Functions That Are not Required:

- DeactivateRTProject: Terminates Internet Explorer and WinCCViewerRT, but not WinCC Runtime.
- ExitWinCC
- FillDiagnoseInTags
- InquireLanguage
- TraceText
- TraceTime
Other Functions

These functions are included in the functional scope in order to ensure error-free compilation on the WebNavigator Client. The functions are not supported by the WebNavigator Client.

<table>
<thead>
<tr>
<th>Function</th>
<th>Function</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>AXC_OnBtnHornAckn</td>
<td>GetCursorMode</td>
<td>GmsgFunction</td>
</tr>
<tr>
<td>AXC_OnBtnPrint</td>
<td>SetCursorMode</td>
<td>MSRTMsgWinCommand</td>
</tr>
<tr>
<td>AXC_OnBtnProtocol</td>
<td></td>
<td>TlgTableWindowPressHelpButton</td>
</tr>
</tbody>
</table>
3.1 WinCC/DataMonitor Getting Started

3.1.1 DataMonitor

Overview

You can display and evaluate current process states and historical data with WinCC/DataMonitor via the Intranet/Internet.

WinCC/DataMonitor consists of a server component and a client component. The DataMonitor server makes functions available to the DataMonitor client for analysis and display of data. Access rights control access to the functions.

- "WinCCViewerRT": Program for monitoring of WinCC projects. The DataMonitor client is a so-called "View Only Client".

- "Excel Workbook": Display of process values and archive values in an Excel table for evaluation and display via the web or as a print template for reports.

- "Reports": Creating reports from WinCC print jobs or from published Excel workbooks. This also allows for statistics and analyses of certain process data or historical data. The reports are created in PDF format and forwarded as e-mail if necessary.

- "Webcenter": Central information portal for access to WinCC data via user-specific views. Clearly structured Webcenter pages with individual user rights for reading, writing and creating Webcenter pages.

- "Trends & Alarms": For display and analysis of archived process values and alarms. The data is displayed in tables and diagrams on predefined Webcenter pages.

Quantity Structure

WinCC/DataMonitor allows the simultaneous operation of up to 50 clients per server.

Using terminal services

A configuration with 50 DataMonitor clients per terminal services server has been tested as a typical scenario.
3.1.2 Preparations

Introduction

For the Getting Started, you will implement a WinCC single user system, on which the DataMonitor server will be installed. To access the data and display them with the DataMonitor client, the client is started on the DataMonitor server.

Requirement

Please follow the Installation Notes of WinCC and WinCC/DataMonitor.

- Internet Information Service is installed.
- WinCC is installed and has been started.
- The DataMonitor server is installed.
- The DataMonitor client is installed.
- A WinCC/DataMonitor license is installed.
- Internet Explorer is installed.

Configuration steps

You have to complete the following configuration steps to set up the DataMonitor system.

1. Configure the DataMonitor system.
   - Define Windows user and access rights in Windows.
   - Define WinCC user and access rights in "WinCC User Administrator" for WinCCViewerRT and "Excel Workbook".
   - Set up the web page and firewall.
   - Publish WinCC pictures.

2. Start the WinCC Runtime.

3. Set up the DataMonitor client.
   - Configure the security settings of the Internet Explorer.

4. Use the DataMonitor client.
   - Start the Internet Explorer and enter the address of the DataMonitor server.
   - Log on to the DataMonitor server and access the DataMonitor functions.

5. Monitor the WinCC project with the WinCCViewerRT.
   - Set up WinCCViewerRT.
   - Display pictures.
3.1.3 Configuring the DataMonitor system

3.1.3.1 Defining users in Windows

User groups in Windows

Overview

The following user groups are created automatically in Windows when the DataMonitor server is installed.

SIMATIC Report Administrators

Membership of the user group "SIMATIC Report Administrators" is required for extended rights, especially for configuration purposes. At least one user must be created and assigned to the "SIMATIC Report Administrators" user group.

- You can also do the following as "SIMATIC Report Administrators" in the "Webcenter":
  - Configuring connections
  - Creating templates for Webcenter pages
  - Creating and configuring public and private Webcenter pages

- You can also do the following as "SIMATIC Report Administrators" in "Reports":
  - Configuring reports based on WinCC print jobs or Excel workbooks.

SIMATIC Report Users

Membership of the user group "SIMATIC Report Users" or of your own user group is required for the "Webcenter", "Trends & Alarms" and "Reports".

- You can also do the following as "SIMATIC Report Users" in the "Webcenter":
  - Setting up and configuring Webcenter pages. The Webcenter pages are stored in different directories.
  - Opening public pages

- You can also do the following as "SIMATIC Report Users" in "Reports":
  - Opening reports based on WinCC print jobs or Excel workbooks.

Defining Users and Access Rights in Windows

Introduction

When using DataMonitor, users need different authentications. All users must be members of the "SIMATIC HMI" user group.
For access to the WinCC database via DataMonitor, you need a Windows user with password who is a member of the "SIMATIC HMI VIEWER" user group. This means you must create users with the matching user rights.

**Requirement**

- WinCC is installed.
- The DataMonitor server is installed.

**Procedure**

1. In the Windows Control Panel, open the entry "System and Security > Administrative Tools".
3. Navigate to the "System > Local Users and Groups > Users" directory. In the shortcut menu select the entry "New user".
4. Enter a name such as "DM_Demo" in the dialog "New user" in the "User name" box. Enter a description such as "User for DataMonitor" in the "Complete name" box. Type the desired password into the "Password" box and then repeat it in the "Repeat password" box. Create the user with "Create". Close the "New user" dialog.
5. In the right part of the table window, click on the newly created user. Select the "Properties" command in the shortcut menu. Switch to the "Member Of" tab. Click "Add".
6. In the "Select Groups" dialog, click the "Advanced > Find now" button.
7. Select the entries "SIMATIC Report Administrators", "SIMATIC HMI" and "SIMATIC HMI VIEWER" from the list at the bottom of the dialog. Click "OK" twice to close the dialog.
8. In the properties of the user, the groups "SIMATIC Report Administrators", "SIMATIC HMI" and "SIMATIC HMI VIEWER" have been added to the list of memberships. Click "OK".
9. Close the "Computer Management" dialog with "File > Exit".

**Result**

The user "DM_Demo" with membership of the user groups "SIMATIC Report Administrators", "SIMATIC HMI" and "SIMATIC HMI VIEWER" has been set up.
The user can now create directories in the Webcenter and make connections to WinCC databases.

Note
If a user wants to access remote computers via the DataMonitor server, the Windows user must be set up on the DataMonitor server as well as the remote servers with the same password.

3.1.3.2 Administering users for DataMonitor

Introduction
For the use of certain functions on the DataMonitor client, users need authentication as DataMonitor user as well as authentication as WinCC user. Use one WinCC user for "WinCCViewerRT" and "Excel Workbook".

If you are working as DataMonitor user and WinCC user at the DataMonitor client you have to log on twice. You have two alternatives to only log on once:

- The DataMonitor user and the WinCC user have identical names and passwords. The user must be configured in Windows and in WinCC and added to the "SIMATIC HMI" and "SIMATIC HMI VIEWER" user groups.

- SIMATIC logon allows the central administration of users. In order to use SIMATIC logon in connection with DataMonitor, DataMonitor users must also be added to the user group "SIMATIC HMI VIEWER".
Procedure

1. Select the entry "User Administrator" in the navigation window of WinCC Explorer. Select the "Open" command from the shortcut menu. The editor "User Administrator" is opened.

2. In the navigation window, select a user or create a new user.

3. Select a user group and then open the shortcut menu. Select the entry "New User". The name of the user can be changed directly with the <F2> function key or the shortcut menu command "Rename". The user must be selected beforehand for this purpose.

4. Enter a name and a password with at least six characters for "Login". Click "OK".

5. Select the newly created user in the table window. The properties of the user are displayed.

6. Activate the option "WebNavigator". Select a start picture from the dropdown list next to "Web start picture".

7. Check the selected language and change this setting if desired via the dropdown list next to "Web language". You can only select a new language from the dropdown list if one of the two options "WebNavigator" or "PureWebClient" is activated. The languages created in the Text Library are available for selection.

8. The user needs at least the authorization "Web Access - monitoring only". In the row in the table window, activate the corresponding authorization in the "Enable" column.

9. Close the User Administrator.
3.1.3.3 Configuring the DataMonitor web page

Introduction

You create the DataMonitor web page with the WinCC Web Configurator.

Requirement

- The DataMonitor server is installed.
- The Windows "Internet Information Service" component is installed.

Procedure

1. Select "Web Navigator" in the navigation window of WinCC Explorer. Click the "Web Configurator" command in the shortcut menu. Alternatively, select the entry "Web Configurator" in the "Siemens Automation" program group.
2. The Web Configurator detects whether a configuration already exists.
   - No configuration found: Activate "Create a new standard website (Standalone)". Click "Next".
   - Configuration found: Click "Next" and check the configuration.
3. Select "Name of the web page" and enter the name.

![Web Configurator](image)

4. Enter the number of the port used for access in the "Port" box.

5. At "IP address", specify whether the computer is to be available on the intranet or Internet or on both networks.
   Use only the addresses that are available in the selection list.
   Select "All not assigned" to enable intranet and Internet access to the computer.

6. Select "DataMonitor.asp" as the default web page.

7. Specify the time interval after which the DataMonitor client starts to reestablish a connection automatically in case of a connection error. A time setting of "0 s" disables the "Automatic reconnection" function.

8. Specify whether the web page is started once the configuration is completed.

9. Click "Finish" if you have not activated a firewall.
   Click "Next" if you have installed a firewall. See the following pages to find out how to set up a firewall.

**Result**

You have created the Web folder and activated the web page. When you have activated the firewall, use the Web Configurator to configure its settings.

### 3.1.3.4 Configuring the firewall

**Introduction**

This section describes how to activate "HTTP" and "HTTPS" services using Windows Server 2016 as an example.
Consult your network administrator if you want to set up the Windows Firewall with advanced security or for a different port.

**Requirement**

- You have created a default web page with Web Configurator.
- The Firewall is activated.
- The user who is logged has Windows administrator rights.
- You have to set up the HTTPS service in IIS if you are using it for WebNavigator. For more information, refer to "Setting up an HTTPS service in IIS ([http://support.microsoft.com/kb/324069](http://support.microsoft.com/kb/324069))".

**Procedure for the default port**

1. Click the "Windows Firewall" button in the "WinCC Web Configurator".
   
   ![WinCC Web Configurator window](image)

   The "Windows Firewall" dialog opens.

2. Click "Allow an app or feature through Windows Firewall".
3. Activate "Secure WWW services (HTTPS)" or "WWW services (HTTP)".
4. Close all Windows dialogs with "OK".
5. Click "Finish" in the Web Configurator. The server configuration is completed.
3.1.3.5 How to publish WinCC process pictures using Web View Publisher

Introduction

Use Web View Publisher to publish the process pictures that you created in Graphics Designer. The WinCC Web Publishing Wizard supports you during publishing.
Procedure

1. Select "Web Navigator" in the navigation window of WinCC Explorer. Select the "Web View Publisher" command in the shortcut menu. The WinCC Web Publishing Wizard is now launched.

2. Click "Next".
3. Activate the "Server prefix" option if you want to publish the pictures on a dedicated web server.
   Select the prefix of the WinCC Server that contains the WinCC project from the selection list. The list displays the prefixes of the servers whose packages are loaded on the WinCC Client.
   Deleting a prefix from the selection changes the paths displayed in the fields below.

4. Under "Path to your WinCC project", select the WinCC project folder containing the pictures you want to publish.
   The folder has the following format for publication on a dedicated web server:
   "\<servername>\<serverprefix>_\<projectname>".
   If you want to publish from a remote station, select the source project containing the pictures.
   The source project is displayed by its enable name on the other WinCC Server.
   The folder has the following format:
   "\<computer name>\<enable name>".

5. Select the target folder for the published pictures under "Publishing folder of the WinCC web".
   Accept the proposed folder within the WinCC project folder.
   Do not change the path specification unless you want to transfer pictures to a different project, for example. In this case, the prefix selection list will be expanded accordingly.
   Verify the specified target project to which the published pictures are saved during remote publishing.
   The path definition will be updated when you select the source project.
   Should the target project be located on another WinCC server, select the corresponding project.
6. Select the "Display hidden objects" option to show hidden objects that are published automatically in the results list.

7. Click "Next". Move the pictures that you wish to publish to the "Selected files" list.
8. Click "Next". Move the C project functions which you use in the published pictures to the "Selected files" list. You cannot publish individual VB scripts.

Click "Next".
9. Move the referenced graphics that you wish to publish to the "Selected files" list. The referenced files are in the "GraCS" folder or in subfolders of "GraCS".

Click "Next".

10. Click "Exit" to start publishing the pictures.
You have successfully published the pictures and functions. The results list displays the status of all published objects. You can click an object to view additional object information.

You can trace publishing using the "<projectfolder>\WebNavigator\WizardLog.txt" file.
Checking the scripts using "PdlPad"

The "WizardLog.txt" log file contains information about errors in the scripts used. You can also find errors using the "PdlPad" debugger.

1. Open "PdlPad" by double-clicking on the affected object in the results list of Web View Publisher. The script of the published picture is displayed.

2. Click to check the script.

3. You can temporarily correct and save the scripts. These corrections are only saved to the published pictures, not in the process picture of the WinCC project.

Alternatively, open "PdlPad" in the "Siemens Automation" program group.

3.1.4 Working with the DataMonitor client

3.1.4.1 Configuring security settings in Internet Explorer

Introduction

For full functionality on the DataMonitor client, adapt the security settings in the Internet Explorer.
Requirement

- Internet Explorer is installed.

Procedure

1. Click "Tools > "Internet Options" in the Internet Explorer. This will open the "Internet Options" dialog.
2. Select the "Security" tab.
3. Select the "Trusted Sites" icon and click the "Sites" button. The "Trusted Sites" dialog opens.
4. Enter the address of the DataMonitor server in the "Add this website to the zone" field. Possible formats and wildcards include "*:157.54.100-200", "ftp://157.54.23.41", or "http://*.microsoft.com".
5. Deactivate the "Require server verification (https:) for all sites in this zone" check box. Click "Add". Confirm the entry by clicking "OK".
6. Select the "Trusted Sites" icon.
7. Click "Default Level". Click "Adapt Level" in the next dialog. The "Security settings" dialog box is opened.
   - Activate the "Activate" option under "Initialize and script ActiveX controls not marked as safe".
   - Confirm the entry by clicking "OK".
8. Close the "Internet Options" dialog by clicking "OK".

Result

The necessary settings in the Internet Explorer of the DataMonitor client are configured.

User authentication: Activated setting "Automatic logon with current user name and password" in Internet Explorer

If the setting "Automatic logon with current user name and password" is activated in Internet Explorer in "Tools > Internet Options > "Security" tab > "Adapt Level" button > entry "User Authentication" > Logon", this can lead to unexpected behavior under the following requirements.

Requirement

- The "Automatic logon with current user name and password" The setting is activated in Internet Explorer.
- The user logs onto the DataMonitor client as a WinCC user who is not configured in the user groups on the DataMonitor server.
- The user is logged onto the computer with a Windows logon that is set up as a user name on the DataMonitor server.
Behavior
1. The DataMonitor server does not recognize the WinCC user name the user has used to log onto the DataMonitor client and therefore rejects it. The user cannot see this behavior.
2. Internet Explorer automatically starts a new logon using the current Windows logon as user name.
3. The DataMonitor server recognizes the Windows logon as DataMonitor user name and accepts the logon for this user.
4. The user is logged on but not with the DataMonitor user name the user has entered. The current DataMonitor user is not displayed.

Recommendation
Disable the "Automatic logon with current user name and password" setting.
Use the setting only when there is a clear distinction between Windows logon and DataMonitor user name.

3.1.4.2 DataMonitor start page on the DataMonitor client

Overview
You start the DataMonitor client on a standalone computer or on a DataMonitor server. The start page of the DataMonitor summarizes the functions of the DataMonitor:

- "Reports":
  Creation and output of analysis results and process data in print jobs and published Excel workbooks.
- "Webcenter":
  Creation of Webcenter pages for the display of archived data.
- "Trends & Alarms":
  Display of alarms and process values from archives in tables and diagrams.
- "Administration"
  Configuration of connections and management of users, archives and pictures.

Requirement
- The user is created in WinCC.
- The user must be a member of the Windows user group "SIMATIC Report Administrators" or "SIMATIC Report Users".
- The WinCC project on the DataMonitor server is in runtime.
Procedure

1. Start the Internet Explorer on the DataMonitor client.
2. Enter the name of the DataMonitor server in the format "http://<servername>" in the URL. Confirm the entry with "Enter". The log-in dialog is opened.
3. Enter the name of a Windows user and the associated password. Confirm with "OK".

Result

The start page with the DataMonitor functions will be displayed. The use of the functions depends on the access right of the user.

General Operations of the DataMonitor Client

- Select the desired interface language from the selection field in the header.
- Hide the header on the pages of "Webcenter" and "Trend & Alarms", if necessary. Click . To show the header line again, click on the symbol .
- In order to log off from the DataMonitor server, click on the "Log off" link. Exit Internet Explorer to free-up the used license immediately.

See also

- Working with reports (Page 419)
- Working with trends and alarms (Page 386)
- Working with the Webcenter (Page 356)
3.1.5 Working with WinCCViewerRT

3.1.5.1 Configuring WinCCViewerRT

Introduction

WinCCViewerRT is a program for visualizing WinCC projects. You can configure WinCCViewerRT for operation with the DataMonitor server and Graphics Runtime.

Use project settings

If you select the "Use project settings" option, the following settings are applied by the DataMonitor server:

- User Administrator:
  - Automatic logoff

- Computer properties:
  - Runtime language
  - Runtime Default Language
  - Start Picture
  - Start configuration of Menu and Toolbars
  - Hardware accelerated graphics representation (Direct2D):

Requirement

- On the server
  - The DataMonitor server is installed.
  - A WinCC/DataMonitor license is installed.
  - The WinCC project is in Runtime.
  - The WinCC pictures are configured and published for web access.
  - The WinCC user must be assigned authorization no. 1002 - “Web Access - monitoring only”.

- On the client
  - The DataMonitor client is installed.
Procedure

1. In the "Siemens Automation" program group, select the entry "WinCCViewerRT". The configuration dialog opens if you reconfigure WinCCViewerRT. WinCCViewerRT opens if WinCCViewerRT has already been set up. Use the <Ctrl+Alt+P> key combination to open the configuration dialog of WinCCViewerRT.

2. Enter the login data in the "General" tab:
   - Server address: "http://<Servername>" or "http://<IP-Adresse>"
   - Use project settings: Apply settings of the DataMonitor server
   - User name and password, if you want to specify a default user for the login dialog.

3. Specify the Runtime language in the "Parameters" tab.
   If necessary, disable any key combinations with which the user switches to other programs. If required, you can modify the preset <Ctrl+Alt+P> key combination that is used to open the WinCCViewerRT configuration dialog.
   Define a key combination with which a user can log off and a new user can log on. The key combination can only be used if no default user has been set in the "General" tab.
4. Specify the WinCC Runtime properties in the "Graphics Runtime" tab:
   – Start Picture
   – Configuration file for user-defined menus and toolbars
   – Window Attributes
   – Impermissible user actions
5. Specify additional user actions in the “Runtime” tab:
   – Activating the screen keyboard
   – <Ctrl+Alt+Del> key combination to allow switching to the Task Manager or operating system via the screen keyboard.
   – Settings for automatic logoff

![WinCCViewerRT configuration dialog]

6. Click “OK” to close the dialog.

Result

WinCCViewerRT is configured.

The connection to the DataMonitor server is set up after you close the dialog.

The settings are saved to the "WinCCViewerRT.xml" configuration file. The configuration file settings are used at the next start of WinCCViewerRT.

WinCCViewerRT applies the user interface language from WinCC.

The configuration file is stored in the following folder based on the operating system:

- `<User>\AppData\LocalLow\Siemens\SIMATIC.WinCC\WebNavigator\Client`

You can rename the file, for example, to "User1.xml".

You can also start WinCCViewerRT by means of the command line with the user-specific configuration file, e.g. "WinCCViewerRT.exe User1.xml". This procedure allows for different configurations, depending on the logged-on user.
The WinCCViewerRT configuration dialog opens at the start if you rename or delete "WinCCViewerRT.xml". Reconfigure WinCCViewerRT or select a different configuration file.

**Note**

WinCCViewerRT can only be closed by means of script function if you disable a key shortcut or hide the "Close" button.

Function in the C-Script: DeactivateRTProject; function in the VBScript: HMIRuntime.Stop.

### 3.1.5.2 Displaying pictures

**Requirement**

- A WinCC/DataMonitor license is installed on the DataMonitor server.
- The WinCC project on the DataMonitor server is in runtime.
- The WinCC pictures are configured and published for web access.
- The WinCC user must be assigned authorization no. 1002 - "Web Access - monitoring only".
- WinCCViewerRT is configured on the DataMonitor client.

**Procedure**

1. In the "Siemens Automation" program group, select the entry "WinCCViewerRT".
2. Log on to the DataMonitor server:
   - A login dialog is not displayed if the user name and password are set in the WinCCViewerRT configuration dialog. You are logged on automatically with the stored login data.
   - The login dialog is displayed if a user name and password is not set in the WinCCViewerRT configuration dialog. Enter the user name and password of the WinCC user. Click "OK".
3. To change the user, use the specified key combination for login/logoff of "WinCCViewerRT". The previous user is logged off. Enter the user name and password of the new WinCC user in the login dialog. Click "OK". The key combination can only be used if no default user has been set.

**Result**

WinCCViewerRT automatically connects to the activated WinCC project. The pictures of WinCC project are displayed.

The "View Only Cursor" indicates that process-related operations are not possible.
Certain operations, such as opening the properties dialog of a WinCC OnlineTrendControl, are still possible.

You can also use your own cursor icon as a "View Only Cursor", if required. For more information, refer to "Configuring Runtime settings" (Page 340).

The <F5> key triggers a reselection of WinCCViewerRT.

3.1.6 Use of DataMonitor

3.1.6.1 Create connection and set up language

Introduction

For access of the DataMonitor client to runtime data and archived data, configure connections to the WinCC databases in the "Webcenter". For each data source, set up a connection, e.g., to the WinCC server. You need the configured connections for Webcenter pages and "Trends & Alarms".

Requirement

- The user is a member of the Windows user group "SIMATIC Report Administrators".
- For access to the WinCC database via DataMonitor, a Windows user with password is created who is a member of the "SIMATIC HMI VIEWER" user group.
Procedure

1. Click "Webcenter > Administration" on the start page.
2. Click the "Connection Administration" tab.

3. Select the option "New Connection". After the new installation, no selection is possible in the "Connection" box, as no connections have been configured yet.

4. Select the language that corresponds with the linguistic region of the server or archive to be linked in "Linguistic Region". The setting ensures that special national characters are displayed correctly.

5. Enter a name in the "Connection Name" box, such as "WinCC1_Runtime". The name should include a reference to the selected connection type. Do not use any blank spaces or special characters.

6. Enter the computer name on which the archive backup data are stored. As an alternative, select the name of the computer using the "Find" button.

7. Enter the Windows user with password for the connection with the WinCC database.
8. Select the connection type to the WinCC data:
   – "Swapped-out WinCC archive". Additional steps are necessary to access data on swapped archives. More information is available under "Connecting or separating swapped archives (Page 365)".
   – "WinCC Runtime". Only the open single segment of the Runtime database is used.
   – "CAS". The WinCC data of the central archive server are used.
   – "WinCC Runtime + all segments". The open single segment and all other connected segments of the Runtime database are used.

9. Select the database for the connection type:
   – "Swapped-out WinCC archive": Click "Display database" or select the archive from the list.
   – "WinCC Runtime" and "CAS": Select the Runtime database of the activated WinCC project. As an alternative, select the name of the database using the "Find" button.
   – "WinCC Runtime + all segments": "CC_ExternalBrowsing" is automatically entered as database.

10. Activate "Automatic adaptation of RT database" so that the database name is adjusted in the connection administration during a segment change.

11. Click the "Create" button.

Result
The connection to the data source is created and can be selected in the "Connection" box of the connection administration.

3.1.6.2 Displaying process values and messages via "Trends and Alarms"

Displaying process values in a table

Introduction
Use "Trends & Alarms" to display archived process values and archived texts in a table.

Requirement
- The connection to the WinCC data is established.
- The start page of the DataMonitor is open.

Procedure
1. Click "Trends & Alarms" on the start page.
2. Click the "Process Value Table" tab. The Web part "Process Value Table" is displayed.
3. Click \[ \text{button} \]. The configuration dialog of the Web part opens.

4. Change the title in the "Title" field. Enter a note in the "Tooltip" field.

5. Select one of the configured connections in the "Connection" field.
   The archive tags available via this connection will be displayed.
   Limit the display of the tags, if necessary:
   - Select individual archives with "Archive selection".
   - Set the filter criteria with "Tag filter".

6. Click "Add" for the required archive tag.

7. Set the time range in the area "Time period".
   With relative times, enter a negative value into the respective field.
   For more information on entering time, click \[ \text{help} \].
   Click "Preview" to check the set time range in the column "Preview Time Range".

8. Specify the number of decimal points in the area "Representation of decimal points".

9. In the "Table size" area, define the size of the display window.
   If the value "0" is entered in both fields, the size is determined automatically. The size
   depends on the space requirement of the Web part.

10. The available Webcenter pages are displayed in the area "Link to Webcenter pages". Click \[ \text{link} \] to assign the web part to one or several Webcenter pages.

11. Click "OK" to confirm your entries.

**Result**

The values of the archive tags and the quality code are output in the process value table.
If the manual entry of archive values is allowed during runtime, the modified or newly created
values are identified as such. There is an "m" in a separate column to show a manual entry of
the archive value.
**Operation:**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔄</td>
<td>In absolute time required to scroll forward or backward in the selected time range.</td>
</tr>
<tr>
<td>🎉</td>
<td>Arrow buttons To scroll forward or backward in multi-page tables.</td>
</tr>
<tr>
<td>📄</td>
<td>Export alarms in CSV format.</td>
</tr>
<tr>
<td>🗒️</td>
<td>Changing the settings of the Web part.</td>
</tr>
</tbody>
</table>

**Displaying process values in a diagram**

**Introduction**

Use "Trends & Alarms" to display archived process values in trends.

**Requirement**

- The connection to the WinCC data is established.
- The start page of the DataMonitor is open.

**Procedure**

1. Click "Trends & Alarms" on the start page.
2. Click the "Trend (Process Values)" tab. The Web part "Trend (process values)" is displayed.
3. Click 🗒️. The configuration dialog of the Web part opens.
4. Change the title in the "Title" field. Enter a note in the "Tooltip" field.

5. Select one of the configured connections in the "Connection" field. The archive tags available via this connection will be displayed. Limit the display of the tags, if necessary:
   - Select individual archives with "Archive selection".
   - Set the filter criteria with "Tag filter".

6. Click "Add" for the required archive tags, e.g. "TREND_0", "TREND_1", "TREND_2". The archive tags are listed in the area "Current selection".

7. In the section "Current selection", you specify for the individual archive tag:
   - Color of time axis and value axis
   - Trend presentation type

8. In the section "Value axis editor", you can activate the automatic scaling for the different value axes or you can assign a minimum and maximum value to each axis.

9. Set the time range in the area "Time period". With relative times, enter a negative value into the respective field. For more information on entering time, click ?
   Click "Preview" to check the set time range in the column "Preview Time Range".

10. In the section "Diagram settings", you define the size of the display window. If the value "0" is entered in both fields, the size is determined automatically. The size depends on the space requirement of the Web part.

11. Activate the option "Show legend" to display the legend.

12. The available Webcenter pages are displayed in the area "Link to Webcenter pages". Click to assign the Web part to one or several Webcenter pages.

13. Click "OK" to confirm your entries.
Result

The selected process values are displayed as trends in a diagram.

The legend shows the assignment of the colors to the archive tags.

Operation:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>In absolute time required to scroll forward or backward in the selected time range.</td>
</tr>
<tr>
<td></td>
<td>Enlarge the presentation and diagram range left or right of the center line.</td>
</tr>
<tr>
<td></td>
<td>Restore the original view.</td>
</tr>
<tr>
<td></td>
<td>Exporting values of the displayed diagrams in CSV format</td>
</tr>
<tr>
<td></td>
<td>Changing the settings of the Web part.</td>
</tr>
</tbody>
</table>

Displaying messages in the alarm table

Introduction

Use "Trends & Alarms" to display alarms in an alarm table.
Requirement

- The connection to the WinCC data is established.
- The start page of the DataMonitor is open.

Procedure

1. Click "Trends & Alarms" on the start page.
2. Click on the "Alarm Table" tab. The web part "Alarm Table" is displayed.
3. Click 修改。The configuration dialog of the Web part opens.
4. Change the title in the "Title" field. Enter a note in the "Tooltip" field.
5. Select one of the configured connections in the "Connection" field.
6. Set the time range in the area "Time period". With relative times, enter a negative value into the respective field. For more information on entering time, click 帮助。Click "Preview" to check the set time range in the column "Preview Time Range".
7. In the section "Language of the alarm texts", select the language, in which the alarms are displayed.
8. Select the respective WinCC server with "Selection of WinCC server", if necessary. The setting is necessary if you select a connection to swapped archives that include archives of several WinCC servers.
9. In the section "Filter selection", you may limit the expected search results with SQL syntax. Set the filter conditions for individual columns to do so. Enter the filter condition for all columns in the "Extended Filter" field. For more information on filter conditions, click 帮助。
10. For representation of the data set the following:
   - Sort order: For more information on sorting, click 帮助。
   - Visible columns: To display all columns, click "Select All".
   - Number of decimal places.
11. In the "Table size" area, define the size of the display window. If the value "0" is entered in both fields, the size is determined automatically. The size depends on the space requirement of the Web part.
12. The available Webcenter pages are displayed in the area "Link to Webcenter pages". Click 修改 to assign the Web part to one or several Webcenter pages.
13. Click "OK" to confirm your entries.
Result

The messages are output in a table.

<table>
<thead>
<tr>
<th>Number</th>
<th>Status</th>
<th>DateTime</th>
<th>Milliseconds</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>&quot;</td>
<td>4/3/2008 8:59:31 AM</td>
<td>468</td>
<td>Time</td>
</tr>
<tr>
<td>2</td>
<td>&quot;</td>
<td>4/3/2008 8:59:32 AM</td>
<td>125</td>
<td>Time</td>
</tr>
<tr>
<td>3</td>
<td>&quot;</td>
<td>4/3/2008 8:59:32 AM</td>
<td>921</td>
<td>Time</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>4/3/2008 8:59:33 AM</td>
<td>840</td>
<td>Time</td>
</tr>
<tr>
<td>5</td>
<td>-</td>
<td>4/3/2008 8:59:34 AM</td>
<td>285</td>
<td>Time</td>
</tr>
<tr>
<td>6</td>
<td>-</td>
<td>4/3/2008 8:59:35 AM</td>
<td>46</td>
<td>Time</td>
</tr>
<tr>
<td>7</td>
<td>+</td>
<td>4/3/2008 8:59:35 AM</td>
<td>499</td>
<td>Time</td>
</tr>
<tr>
<td>8</td>
<td>+</td>
<td>4/3/2008 8:59:35 AM</td>
<td>500</td>
<td>Time</td>
</tr>
<tr>
<td>9</td>
<td>-</td>
<td>4/3/2008 8:59:35 AM</td>
<td>656</td>
<td>Time</td>
</tr>
<tr>
<td>10</td>
<td>*</td>
<td>4/3/2008 8:59:36 AM</td>
<td>202</td>
<td>Time</td>
</tr>
<tr>
<td>11</td>
<td>+</td>
<td>4/3/2008 8:59:36 AM</td>
<td>203</td>
<td>Time</td>
</tr>
<tr>
<td>12</td>
<td>-</td>
<td>4/3/2008 8:59:36 AM</td>
<td>718</td>
<td>Time</td>
</tr>
<tr>
<td>13</td>
<td>*</td>
<td>4/3/2008 8:59:37 AM</td>
<td>487</td>
<td>Time</td>
</tr>
<tr>
<td>14</td>
<td>+</td>
<td>4/3/2008 8:59:37 AM</td>
<td>488</td>
<td>Time</td>
</tr>
</tbody>
</table>

Operation:

- In absolute time required to scroll forward or backward in the selected time range.
- Arrow buttons: To scroll forward or backward in multi-page tables.
- Export alarms in CSV format.
- Changing the settings of the Web part.
3.1.6.3 Displaying process values in an Excel workbook

Overview

With the Excel add-In "Excel Workbook" you can display the following data of the WinCC project in an Excel workbook on the DataMonitor client:

- Alarms
- Values of process tags and archive tags
- Additional information, such as time stamp or quality code of tags

Data of swapped archives is not displayed.

The data is evaluated by Excel and presented as graphic, e. g. as average value calculation or diagram representation. The created Excel workbooks are made available as templates for "Reports" and as report tools.

Requirement

- Use the Download area in "Reports" to install the Excel add-ins "ExcelWorkbook Wizard" and "Excel Workbook" on the DataMonitor client.
- The "Remote Desktop" user is a member of the Windows user group "SIMATIC HMI Viewer".
Configuring with XML file or online

Simultaneous online access to process data of different WinCC servers is possible using the "Excel Workbook". This requires that you either take the data from an XML file or from a local WinCC project during the configuration with the Excel add-in "Excel Workbook Wizard". A separation between process and evaluation is possible with the XML file.

- A WinCC project is open on the DataMonitor server.
  The XML file is generated with the "Export Configuration Data" function.
  Then transfer the XML file to a computer with Microsoft Excel.
  Configure the process data display in the workbook.
  Afterwards, transfer the workbook to a DataMonitor client that displays the process data online.

- To accept the data of the WinCC project online, configure directly on the WinCC server or on a WinCC client with an online connection to the respective WinCC server.

- Import the data into an Excel workbook using the "Excel Workbook Wizard".
  Then configure the display of alarms and tag values.

Note

If you rename a table in an Excel workbook, the configuration data of the table is lost.

You can configure up to 32,767 process and archive tags in an Excel workbook. During online display with "Excel Workbook" you may experience considerable delays in updating when there is a large number of tags.

Configuring the Excel workbook

Applying data from WinCC project

Introduction

You need the WinCC configuration data for the configuration of Excel workbooks. This means you apply the data from a local WinCC project during configuration in the "Excel Workbook Wizard".
Requirement

- Server computer
  - At least Office 2013 is installed.
  - The Excel add-in "Excel Workbook" is installed.
  - The DataMonitor server is installed.
  - The WinCC project is in Runtime.
  - A user is created in WinCC.

- Configuration PC
  - At least Office 2013 is installed.
  - The Excel add-in "Excel Workbook Wizard" is installed.

- MS Office
  - Only Excel files with extensions "XLS, "XLSX, "XLSB", and "XLSM" may be used.

Procedure

1. Open an empty Excel workbook.
   Select the command "Excel Workbook Wizard" in the "DataMonitor" menu.

2. Activate the option "Establish connection with WinCC server". The "WinCC Server" box is shown.

3. Enter the desired name of the server and click "Connect". The log in dialog is displayed.

4. Enter the name and password of a WinCC user.

5. Click "Next". The "Add / delete tags" dialog opens.
Result

The Excel workbook is set up to configure the display of process data. Then publish the workbook. The workbook is made available on the DataMonitor client as report tool or as template for "Reports".

Note

Language for the Office package and the Windows Regional Settings

Make sure that the language is the same for the Office package, the "Microsoft Office Language Settings", and the Windows Regional Options.

Example:

- If you are using Office with language "English (U.K.)", select the regional setting "English (United Kingdom)".
- If you have set "Chinese (PRC)" as the region and language option in Windows, you must also select "Chinese (PRC)" as the primary editing language in the "Microsoft Office Language Settings".

More information can be obtained through Microsoft Support: http://support.microsoft.com/kb/320369/en (http://support.microsoft.com/kb/320369/en)

See also

- Configuring the display of tag values (Page 284)
- Configuring the display of archive tags (Page 288)
- Configuring the display of alarms (Page 292)

Applying data from a configuration file

Introduction

You can create reports without connection to the WinCC server.

Configuration steps:

- Create a configuration file on the server.
- Configure data access with the configuration file.
- You can also configure the data access of a dedicated Web server / WinCC client.
Requirement

- Server computer
  - The DataMonitor server is installed.
  - The online tags of the WinCC project are part of one tag group or one structure type.
  - The WinCC project is in Runtime.
  - A user is created in WinCC.
- Configuration PC
  - At least Office 2013 is installed.
  - The Excel add-in "Excel Workbook Wizard" is installed.
- MS Office
  - Only Excel files with extensions "XLS, "XLSX, "XLSB", and "XLSM" may be used.

Creating a configuration file on the server

1. Select the entry "WebNavigator" in the navigation window of WinCC Explorer. Open the menu command "Export Configuration Data" in the shortcut menu.
2. Specify the data to be exported in the "Export configuration data" dialog. If you do not want to create the online tags in one tag group or one structure type, use the "Without structure (fast export)" option for the export.
3. Specify the path and the name of the XML file.
4. Click "Export". An XML file is generated.
5. If no Excel installation exists on the server, transfer the XML file to another computer, on which Excel and the "Excel Workbook Wizard" are installed.

Configuring data access with configuration file

1. Open an empty Excel workbook on the computer with Excel. Select the command "Excel Workbook Wizard" in the "DataMonitor" menu.
2. Activate the option "Load configuration data from file". Click "Next".
3. Navigate to the desired XML file.
4. Click "Next". The "Add / delete tags" dialog opens.

Result

The Excel workbook is set up to configure the display of process data. Then publish the workbook. The workbook is made available on the DataMonitor client as report tool or as template for "Reports".
Configuring data access of a dedicated Web server / WinCC client via XML file

If you want to display the project data from a dedicated Web server / WinCC client in the Excel workbook, you need to observe the following when configuring the Excel workbook via an XML file:

- The XML file now includes the data of subordinate servers whose packages are located on the DataMonitor server. The export of the loaded packages to the dedicated DataMonitor server / WinCC client can take several minutes, depending on the size of the package.
- This XML file must be available on the Excel configuration computer. Enter the server prefix when importing the configuration data in the "Excel Workbook Wizard".
- If you configure the data display in the Excel workbook on the WinCC client in the WinCC project, you do not have to specify a server prefix. The server prefix is automatically used when data is inserted from the package.

Note

Language for the Office package and the Windows Regional Settings

Make sure that the language is the same for the Office package, the "Microsoft Office Language Settings", and the Windows Regional Options.

Example:
- If you are using Office with language "English (U.K.)", select the regional setting "English (United Kingdom)".
- If you have set "Chinese (PRC)" as the region and language option in Windows, you must also select "Chinese (PRC)" as the primary editing language in the "Microsoft Office Language Settings".

More information can be obtained through Microsoft Support: http://support.microsoft.com/kb/320369/en (http://support.microsoft.com/kb/320369/en)

See also

Configuring the display of tag values (Page 284)
Configuring the display of archive tags (Page 288)
Configuring the display of alarms (Page 292)
Publishing the Excel workbook (Page 297)

Configuring the display of tag values

Introduction

This chapter describes how to configure the display of tag values.

Requirement

- The "Excel Workbook Wizard" is started and an Excel workbook is configured.
- The dialog "Add/delete tags" is open.
Procedure

1. Check the add sequence of tag groups in the "Adding tags" area.

2. Click on . The tag selection dialog opens.

3. Select the required tag and move the tag into a field in the Excel table with drag-and-drop.

4. Close the selection dialog. The tag is displayed in the tag list.
5. Select the tag in the tag list and select the "Server settings" entry in the shortcut menu.

6. Enter the name and password of a WinCC user in the "Server setting" dialog. To avoid an additional login during online display of process data, enable "Activate automatic login".
   Confirm your entries with "OK".
7. Select the tag in the tag list and select the "Properties" entry in the shortcut menu. The dialog "Tag properties" will be opened.

8. You set the properties for the display in the table. For example, the update cycle or the display of time stamp and quality code.

9. Specify settings for the headings.

10. You can save the settings to the properties. You can then load the settings and use them again after exiting Excel and opening it again. Click "Save" to save the settings in an "xml" file.

11. Confirm your entries with "OK". If necessary, repeat the procedure for additional online tags. The settings for the properties will be used again. Multiple selection of tags is also possible in the tag list.

12. Click "Next" to display archive tags and alarms. Additional information is available under "Configuring display of archive tags (Page 288)" and "Configuring display of alarms (Page 292)".

**Result**

The display of tag values is configured in the Excel workbook. Once you have saved the properties, you can use the settings whenever you need to.
Each table field receives a short text and a comment in the Excel workbook. The short text "OV" in tag values stands for online tags. In the comments, the source of the displayed values is shown in the format "WDWO_<number>_<tagname>".

**Note**

**Running the Excel Workbook Wizard again**

You need to run the Excel Workbook Wizard again:

- after deleting or moving cells with configuration data.
- after deleting or inserting new rows or columns in the Excel workbook.

The configuration data is checked and automatically adapted as a result. Confirm the data displayed with "Next". Save the workbook and close Excel.

**Tags with local computer updating are not supported**

In multiple station projects, you can activate the "Computer-local update" option in the tag management for internal tags. Any change of the tags only has an effect on the local computer in this case. This function is not supported by Excel Workbooks.

**See also**

[Publishing the Excel workbook](Page 297)

**Configuring the display of archive tags**

**Introduction**

This chapter describes how to configure the display of archive tags.

**Requirement**

- The "Excel Workbook Wizard" is started and an Excel workbook is configured.
- The "Add/delete archive tags" dialog is open.
Procedure

1. Click in the dialog “Add/delete archive tags”.

Add archive tags
Select a tag from the archive tree and drag it onto your selected cell.
This operation is not allowed for an entire archive tag group because archive tags may need several sequential cells. The number of these cells depends on the properties ‘time window’ and ‘resolution’ of the archive tag.

Delete archive tags
Delete either a line in the archive list or the comment in the cell.

Change the properties of the archive tags display
Double-click on the element in the archive tag list, or select ‘Properties’ in the shortcut menu.

2. The tag selection dialog opens.
   Select the desired archive tag.
   Drag the tag to a cell in the Excel table with drag-and-drop.

3. Close the selection dialog. The tag is displayed in the tag list.
4. Select the archive tag in the tag list, and select the "Properties" entry in the shortcut menu. The "Archive tag properties" dialog opens.

5. Specify the settings for the insertion sequence and headings.
6. Specify how much data you want to display. For a user-defined resolution, specify an integer number and the time unit or specify the quantity of data.

**Note**
If you use a user-defined data resolution with a combination of "Resolution" and "Quantity of data", it is possible that the amount of extracted data is not correctly determined. This results under certain circumstances in a mismatch between the displayed values and the configured quantity of data.

If you use the option "Quantity of data" in "User-defined resolution", enter an even value in the input box. Even values ensure a trend-true display.

7. In the "Time window" box, specify the time window from which you want to display archive tags:

- The time settings on the "Standard time" tag are based on the standard times:
  - The settings for the relative time period refer to a period starting from the current time. You can enter positive and negative values for the past time period in the lines "From" and "To". For example, it is 12:00 (noon). You want to display the values for the last ten minutes. Activate all time options in the "Relative" line. Enter the value "-10" in the "Minutes" column of the "From" line.
  - For settings of the absolute time period, enter the corresponding time parameters in the "From" and "To" lines and in the corresponding columns.

Click on the "Preview" button to check the time range set.

- You can define a time window yourself or set a fixed interval, for example, "last week", on the "Legacy time" tab. If you want to define a time window yourself, you have the following possible settings:
  - Relative time window: Specify the starting point and the duration. You can specify a duration ranging from a minute to days.
  - Absolute time window: Specify the start and end of the time window.

1. If you select the option "Display manually entered values", an additional column is displayed. You then see the letter "m" if an archived value was manually entered during runtime.

2. You can save the settings to the properties. You can then load the settings and use them again after exiting Excel and opening it again. Click "Save" to save the settings in an "xml" file.

3. Confirm your entries with "OK".
   If necessary, repeat the procedure for additional archive tags. The settings for the properties will be used again. Multiple selection of tags is also possible in the tag list.

4. Click "Next" to display alarms. For more information, refer to "Configuring display of alarms" (Page 292).

**Result**

The display of archive tag values is configured in the Excel workbook. Once you have saved the properties, you can use the settings whenever you need to.

Each table field receives a short text and a comment in the Excel workbook.
The short text "AV" in tag values stands for archive tags. In the comments, the source of the displayed values is shown in the format "WDWA_<number>_<tagname>".

**Note**

**Running the Excel Workbook Wizard again**

You need to run the Excel Workbook Wizard again:

- after deleting or moving cells with configuration data
- after deleting or inserting new rows or columns in the Excel workbook

The configuration data is checked and automatically adapted as a result. Confirm the data displayed with "Next". Save the workbook and close Excel.

---

**See also**

[Publishing the Excel workbook](Page 297)

**Configuring the display of alarms**

**Introduction**

This chapter describes how to configure the display of alarms.

**Requirement**

- The "Excel Workbook Wizard" is started and an Excel workbook is configured.
- The "Add/delete alarms" dialog is open.
Procedure

1. Configure the alarms in the dialog "Add/delete alarms".

2. Select the required cell in the Excel table.
3. Click \( \text{verb} \). The "Alarm - properties" dialog opens.

4. On the "Standard configuration" tab, define the display options for alarms in the Excel table.

5. Enter a filter condition in the "Filter string" box or use the selection dialog to define a filter, for example, to display only specific alarms. If the filter contains a date or time, the "Time window" box is disabled.
6. In the "Time window" box, specify the time window from which you want to display alarms:
   - The settings for the relative time period refer to a period starting from the current time. You can enter positive and negative values for the past time period in the lines "From" and "To". For example, it is exactly 12:00. You want to display the alarms for the last ten minutes. Activate all time options in the "Relative" line. Enter the value "-10" in the "Minutes" column of the "From" line.
   - For settings of the absolute time period, enter the corresponding time parameters in the "From" and "To" lines and in the corresponding columns.

   Click on the "Preview" button to check the time range set.

7. Use the "Maximum number of alarms" option to limit the number of most recent alarms displayed. You can display maximum 1,000 messages.
8. On the "Attributes" tab, select the required attributes of the alarms that you want to display. Further details can be found in "Alarm attributes (Page 417)".

![Alarm Properties](image)

9. Specify the settings for the attribute insertion sequence and headings.

10. You can save the settings to the properties. You can then load the settings and use them again after exiting Excel and opening it again. Click "Save" to save the settings in an "xml" file.

11. Confirm your entries with "OK". If necessary, repeat the procedure for additional alarms. The settings for the properties will be used again. Multiple selection of alarms is also possible in the "Alarm list".
12. Click "Next". The "Description" dialog box opens.
13. You can enter a comment if needed. This comment is displayed when selecting files provided for download by the DataMonitor server.

Result

The display of alarms is configured in the Excel workbook. Once you have saved the properties, you can use the settings whenever you need to.

Each table field receives a short text and a comment in the Excel workbook.

The short text for alarms is "AL". In the comments, the source of the displayed alarm is shown in the format "WDWL_<number>_<box name>".

Note

Running the Excel Workbook Wizard again

You need to run the Excel Workbook Wizard again:
- after deleting or moving cells with configuration data
- after deleting or inserting new rows or columns in the Excel workbook

The configuration data is checked and automatically adapted as a result. Confirm the data displayed with "Next". Save the workbook and close Excel.

See also

Publishing the Excel workbook (Page 297)

Publishing the Excel workbook

Introduction

You make the configured Excel workbooks available on the DataMonitor client. The workbooks are published as report tool for the Intranet/Internet or used as template for "Reports".

Requirement

- The DataMonitor server is installed on the computer.
- The display of tag values, archive values and alarms is configured.
- The "Description" dialog is open in the "Excel Workbook Wizard".
Procedure

1. You make the workbooks available in the "Description" dialog.

![Excel Workbook Wizard description](image)

- Press the "Publish" button in order to make your Excel worksheet available on the Web.
- Press the "Template" button in order to make your Excel worksheet available as template for reports.

DataMonitor server must be installed.

2. If you click "Publish", the Excel workbook is made available on the DataMonitor client under "Report tools" in "Reports".
   If you click "Template", the Excel workbook is made available on the DataMonitor client as template in "Reports" under "Excel Workbooks".

3. Exit the Excel Workbook-Wizard.

4. Save the workbook and close Excel.

Alternative Procedure

You upload the Excel workbooks on the DataMonitor client. Additional information is available under "Making Excel workbooks available as template (Page 419)" and "Making Excel workbooks available as report tool (Page 420)".
Result

The Excel workbooks are made available on the DataMonitor client:

- The workbook is available on the "Report tools" tab. You can use the workbook to display process data in runtime. For more information, refer to "Displaying process data in an Excel workbook (Page 415)".

- You can create time-controlled and event-controlled reports using the workbook as template. For more information, refer to "Creating reports with an Excel workbook (Page 423)".

See also

- Configuring the display of tag values (Page 284)
- Configuring the display of archive tags (Page 288)
- Configuring the display of alarms (Page 292)

Displaying process data in an Excel workbook

Introduction

You can display process values or archive values and alarms in an available Excel workbook. You can edit and save the workbook.

Requirement

- The Excel workbooks were made available as report tool.
- MS Excel for online display in the Excel workbook
- The DataMonitor server is installed.
- The WinCC project is in Runtime.
- The start page of the DataMonitor is open.
- A user is created in WinCC.
Procedure

1. Click "Reports" on the start page.

2. Click "Report tools". You see the Excel workbooks that you have published in the Excel Workbook Wizard or made available as report tool.

3. Select a workbook.

4. Double-click the icon of the Excel workbook.

5. In the dialog that follows, click "Open". The workbook is opened.

6. Select the entry "Excel Workbook" in the "DataMonitor" menu.

7. The name of the server whose process data are configured in the workbook is displayed in the "WinCC server" field. The "WinCC Server" field can include the following information:
   - Access via domain: The server name and the domain are listed for access outside the network domain.
   - The DataMonitor start page is the default web page: The "WinCC Server" field contains only the server name.
   - The DataMonitor start page is in the virtual folder: The server name and the name of the virtual folder are displayed, e.g. "/webrnavigtor".

8. If the tags in the Excel sheet are from several servers, activate "all servers". The tag values of all servers are updated in the online display.

   **Note**
   To establish connections to all servers, activate "all servers" with "Connect" before you establish the connections.

9. Activate the connection to the WinCC project via the button "Connect". After a successful connection, the log-in dialog will be opened. Type in the user name and associated password. In case of several servers, the log-in dialogs of the respective servers open one after the other. If a connection was not established, a corresponding alarm is displayed. Clicking on the dialog will display additional information about the error that has occurred.

   **Note**
   Do not close the "Excel Workbook" dialog as long as the log-in dialog for connection establishment to the server is still open.
10. The connection status will be displayed in the dialog.
   Click the "Read tags", "Read archive tags" and "Read alarms" buttons to update the respective values or displays.

11. Activate the check box "Read cyclically" to update the tag values in cycles.
12. Close the "Excel Workbook" dialog after finishing your calculations in Excel.
13. Save the results in the workbook with the "Save as" menu command.

Result

The process data are displayed in the Excel workbook and can be processed further.
If errors occur during display of the Excel workbook or no connection to the WinCC server is established, the log entries are displayed in a workbook. The entries contain the date, the tags or alarms affected, the server, and the error message.

3.1.6.4 Outputting data using "Reports"

Reports

Introduction

Use "Reports" to create time-controlled and event-controlled reports independent of the SCADA system. Use the WinCC print jobs and published Excel workbooks to output analysis results and process data. The reports are output as PDF or XLS file and can be attached to an e-mail.
WinCC/DataMonitor

3.1 WinCC/DataMonitor Getting Started

Requirement

- You need a PDF reader for output as PDF file. The PDF reader can be obtained from www.adobe.com for example.
- For Output as XLS-file (Excel workbook):
  - MS Excel as of Office 2013 is installed.
  - To use the automatic creation of Excel reports on the DataMonitor server, MS Excel must be installed on the server.
  - The Excel workbook is created and published as template on the DataMonitor server.
- Use the Download area in "Reports" to install the Excel add-ins "ExcelWorkbook Wizard" and "Excel Workbook".

Using reports

You determine on the DataMonitor server when you want to create reports:

- Manually, for example, by a plant operator.
- Event-controlled, for example, when a tag value changes.
- Time-controlled, such as daily, for example.

The created reports are centrally saved in the directories on the DataMonitor server. Users can access the different folders with appropriate authorization from the DataMonitor client.

Note

The creation time is always displayed on a DataMonitor client in the local time zone of the server.

Making an Excel workbook available as template

Introduction

You can make Excel workbooks available as templates to create "Reports". For this you have the following options:

- You publish the Excel workbooks on the WinCC server with "Excel Workbook Wizard" using the "Template" button.
- You upload an Excel workbook not yet published to the DataMonitor client.

This page includes a description of how you make a template available on a DataMonitor client.

Requirement

- The Excel workbook is created.
- The file size of the Excel workbook is less than 4 MB.
- The start page of the DataMonitor is open.
Procedure

1. Click "Reports" on the start page.
2. Click the "Upload templates" tab.

   ![Upload template interface](image)

3. Select a directory, in which the template will be stored in the "Target directory" field. Only the directories, for which the user that is logged in has "Create" access rights, can be selected.
4. Click "Find" for the "Selected template". Navigate to the desired Excel workbook.
5. Click the "Upload" button.

Result

You can create time-controlled and event-controlled reports using the workbook as template.

See also

- Displaying a report with an Excel Workbook (Page 306)

Making an Excel workbook available as a report tool

Introduction

You can make Excel workbooks centrally available as report tools in "Reports". For this you have the following options:

- You publish the Excel workbooks on the WinCC server with "Excel Workbook Wizard" using the "Publish" button.
- You upload an Excel workbook not yet published to the DataMonitor client.

Here you find a description of how you make an Excel workbook not yet published available on the DataMonitor client.
WinCC/DataMonitor

3.1 WinCC/DataMonitor Getting Started

Requirement

- The Excel workbook is created.
- The file size of the Excel workbook is less than 4 MB.
- The start page of the DataMonitor is open.

Procedure

1. Click "Reports" on the start page.
2. Click the "Upload templates" tab.
3. Click "Find" for "Uploading templates for Excel workbooks". Navigate to the desired Excel workbook.
4. Click the "Upload" button.

Result

The workbook is available on the "Report tools" tab. You can use the workbook to display process data in runtime.

See also

Displaying process data in an Excel workbook (Page 299)

Making Settings for Reports

Introduction

Different settings are required for using the "Reports" function in DataMonitor.
Requirement

- PDF Reader is installed.
- The WinCC project is activated on the DataMonitor server.
- The option "Report Runtime" is activated in the WinCC project in the properties of the computer.
- The start page of the DataMonitor is open.

Procedure

1. Click "Reports" on the start page.
2. Click on the "Settings" tab. The "Settings" page is displayed.
3. Check the entries in the section "General project settings". You can now select the printer of the Web server. Printing is only possible in files.
4. To enable the output to a PDF file, activate the option "Activate API print".
5. Enter the data for sending mail in the "Mail" area:
   - Server: Outgoing mail server (SMTP)
   - User name: Name for the sender
   - Password
   - Sender: E-mail account used to sending the e-mail
6. Click the disk icon in the section "General project settings" to save your settings.
7. In the "Settings of the circular buffer" area, you can define the number of created reports that are stored in the selected destination directory. The box has a pre-assigned value of 20. If the maximum number of reports of the same type has been reached, the "First in First out" principle applies. For example, if 21 reports of "Alarm Table" type have been created, the report that was created first is removed.

8. Click the disk icon in this section to save your settings.

Result

The settings for "Reports" have been made.

Product support - example

FAQ "51334611" on the Internet under "Product support" gives a detailed example:


Displaying a report with an Excel Workbook

Introduction

Use "Reports" to create reports from Excel workbooks or print jobs in PDF format. The following is a description for creating reports from Excel workbooks.

Note

Information on event-controlled "Excel Workbooks"

An event-controlled report is only created if the time period in which the tag changes is greater than one minute.

Keep in mind that the frequent creation of one or more event-controlled reports over a long period of time takes up a lot of memory and uses up valuable resources. This case occurs, for example, with frequent signal changes of a tag that triggers an event-controlled report.

Requirement

- The WinCC project is activated on the DataMonitor server.
- The option "Report Runtime" is activated in the WinCC project in the properties of the computer.
- You have already published or made available as templates the Excel workbooks you want to use.
- The start page of the DataMonitor is open.
Procedure

1. Click "Reports" on the start page.

2. Click on the "Excel Workbooks" tab.
   The "Excel Workbooks" page is displayed.
   The icons in front of "List of time-controlled Excel workbooks" and "List of event-controlled Excel workbooks" are deactivated. The icons indicate that no reports are currently configured.

3. Select one of the available Excel workbooks under "Available Excel workbooks".

4. Select the target directory in which you want to store the reports.
   Only the directories, for which the user that is logged in has "Create" access rights, can be selected.

5. If you want to send the report as an e-mail, enter the e-mail addresses in the "E-mail recipient" field. You can enter several recipients as you would with any standard e-mail program.

6. Use \click{Create} to create the report immediately.

7. If you do not want to create the report immediately, configure a time-controlled or event-controlled creation of the report in the following steps.

8. To configure a time-controlled report, enter the following in the "Time-controlled Excel workbooks" area:
   - Date: Enter the date in the respective field or enter the date using the calendar. To open the calendar, click the "Calendar" icon.
   - Time: Define the time when you want the report to be created.
   - Repetition: Define the repetition rate, for example, "Once" or "Weekly".
9. Click "Add" in the "Time-controlled Excel workbooks" area.
The report is displayed in the "List of time-controlled Excel workbooks".

10. To configure an event-controlled report, enter the following in the "Event-controlled Excel workbooks" area:
   - Selected WinCC tag:
     Click Click. Select the required tag in the selection dialog.
     Use the filter to limit the number of tags displayed.
   - Defining event control:
     Set the triggering event, for example, when the tag value changes.
     If you have selected "lower limit", "upper limit" or "both limits" for event control, enter the respective limits.

11. Click "Add" in the "Event-controlled Excel workbooks" area.
The report is displayed in the "List of event-controlled Excel workbooks".

Result

A time-controlled or event-controlled report is configured as "Excel Workbook".
The configured reports are displayed in the lists of the "Excel Workbooks". You can edit or delete the reports in the lists.

Once the report has been created, it is available in runtime on the "Published Reports" tab in the selected directory.

Creating a report with a print job

Introduction

Use "Reports" to create reports from Excel workbooks or print jobs in PDF format. The following is a description for creating reports using print jobs in PDF format.

Note

Opening Asian PDF files with Acrobat Reader

To open Asian PDF files created with "Reports", you need the country-specific version or the respective font package of Adobe Acrobat Reader.
The four Asian languages are each permanently associated with one font. This means the font settings in the report layout will not have an effect on the Asian languages.

Information on event-controlled print jobs

An event-controlled print job is only created if the time period in which the tag changes is greater than one minute.
Keep in mind that the frequent creation of one or more event-controlled print jobs over a long period of time takes up a lot of memory and uses up valuable resources. This case occurs, for example, with frequent signal changes of a tag that triggers an event-controlled print job.
Requirement

- PDF Reader is installed.
- The WinCC project is activated on the DataMonitor server.
- The option "Report Runtime" is activated in the WinCC project in the properties of the computer.
- The start page of the DataMonitor is open.

Procedure

1. Click "Reports" on the start page.
2. Click on the "Print jobs" tab.
   The "Print jobs configuration" page is displayed.
   The icons in front of "List of time-controlled print jobs" and "List of event-controlled print jobs" are deactivated. The icons indicate that no print jobs are currently configured.

3. Select the desired print job under "Available print jobs".
4. Select the target directory in which you want to store the reports.
   Only the directories, for which the user that is logged in has "Create" access rights, can be selected.
5. If you want to send the report as an e-mail, enter the e-mail addresses in the "E-mail recipient" field. You can enter several recipients as you would with any standard e-mail program.
6. Use to create the report immediately.
7. If you do not want to create the report immediately, configure a time-controlled or event-controlled creation of the report in the following steps.
8. To configure a time-controlled report, enter the following in the "Time-controlled print jobs" area:
   - Date: Enter the date in the respective field or enter the date using the calendar. To open the calendar, click the "Calendar" icon.
   - Time: Define the time when you want the report to be created.
   - Repetition: Define the repetition rate, for example, "Once" or "Weekly".
9. Click "Add" in the "Time-controlled print jobs" area. The report is displayed in the "List of time-controlled print jobs".
10. To configure an event-controlled report, enter the following in the "Event-controlled print jobs" area:
    - Selected WinCC tag: Click 
      Click . Select the required tag in the selection dialog. Use the filter to limit the number of tags displayed.
    - Defining event control: Set the triggering event, for example, when the tag value changes. If you have selected "lower limit", "upper limit" or "both limits" for event control, enter the respective limits.
11. Click "Add" in the "Time-controlled print jobs" area. The report is displayed in the "List of event-controlled print jobs".

Result

A time-controlled or event-controlled report is configured as print job in PDF format. The configured reports are displayed in the lists of the print jobs. You can edit or delete the reports in the lists.

The report is created in the language that was set during WinCC configuration. The WinCC Runtime language does not have an effect on the representation of dynamic elements, such as tables.

Once the report has been created, the PDF files are available in runtime on the "Published Reports" tab in the selected directory.

3.1.6.5 Creating Webcenter pages in "Webcenter"

Web center

Overview

The Webcenter is the central information portal for access to WinCC data via Intranet/Internet. Users can use the Webcenter pages and web parts to compile and save their views of WinCC data. The Webcenter pages are stored in directories.

The Webcenter pages are stored in modular fashion. The modules are defined by layout templates. Users can either use the supplied layout templates or the ones they create themselves.
The web parts are the individual blocks that prepare and display data. You can combine up to 15 web parts in one screen view. For more information, refer to "Overview of web parts" (Page 311).

Within the WebCenter pages, the configuration of the respective web part is stored and can be called up again at any time. The multiple use of the same web part with different configuration is also possible. The WebCenter pages that have been created in this way can be opened with the same configuration by different users depending on the assigned rights.

You can export the configuration of web parts as XML file.

To transfer the configuration data to another computer, copy the folder: 
"\Siemens\WinCC\WebNavigator\DataMonitorServer\WebCenter\App_Data\WebCenter"

Basic procedure

1. Creating directories for Webcenter pages
2. Assigning Access Rights
3. Establishing connection to the WinCC data
4. Publishing pictures for the Webcenter
5. Creating layout template for Webcenter pages
6. Creating Webcenter page
7. Inserting web parts to the Webcenter page
8. Configuring web parts within Webcenter pages

Overview of Web Parts

Overview

You compile Webcenter pages from the web parts in the "Webcenter".

The following web parts are available:

- Process value table
  The available process values are displayed for the defined time period.

- Process Values in the Table (Timestep)
  The complete archive name and the tag name are displayed as tooltip in the column header. The process values are combined beginning with the starting time in the defined time interval.

  Depending on the set aggregate type, the interval for the interval event is displayed.
  For example, a process value was archived every 30 seconds. You have selected an interval of 60 seconds and the aggregate type "Average value". It determines the average value of two archive values each, which is then displayed in the table with the first time stamp of the averaging interval.
  If you select an aggregate type without interpolation, and if no value is present in the interval, no interval result will be displayed. If you select an aggregate type with linear interpolation, an interval result is displayed for each interval.
• Statistics functions for process values
  All available process values are used for the defined time period, for example, to calculate and display the average value.

• Trend Process Values
  The process values are displayed with trends.

• Trend (Timestep)
  Clear presentation of precompressed values in trends with aggregate functions, such as sum or average.

• Bar Chart (Aggregates)
• Pie Chart (Aggregates)
• Alarm table
  Presentation of accrued alarms.

• Alarm hit list
  Presentation of statistical information on alarms.

• Link to WebCenter pages
• Links (external)
  Links to internal Webcenter pages and external Internet pages, such as stock market news.

• Displaying information
  Such as news, for example.

• Static process pictures
  WinCC pictures are integrated into the Webcenter without installation download. A JPG screenshot of the process picture is created on the DataMonitor server at regular intervals.

• Display Graphic
  JPG screenshots, such as company logo.

• The Last Reports
  Display the reports created last, for example, the last ten print jobs in PDF format created with "Reports".

See also

Displaying process values in a table (Page 386)
Displaying process values in a diagram (Page 387)
Displaying the hit list of messages (Page 393)
Displaying messages in the alarm table (Page 389)
Displaying statistics function for process values (Page 395)

Creating layout template for Webcenter pages

Introduction

You need a layout template to create a Webcenter page. Predefined layouts were installed during the installation. Additionally, you can create your own Layout Templates.
### Requirement

- The logged in user is a member of the Windows user group "SIMATIC Report Administrators".
- The start page of the DataMonitor is open.

### Procedure

1. Click "Webcenter > Configuration" on the start page.
2. Click on the "Creating layout" tab.

   ![CREATE NEW LAYOUT TEMPLATE](image)

   - **Columns**: 2
   - **Lines**: 3
   - **Name of the layout file**: mylayout_23

3. Define the number of columns and the number of lines.
4. Enter the name in the "Name of the layout file" box, for example, "mylayout_23". Click "Next".
5. Combine the table fields, if necessary. To do so, click the desired arrow symbol, such as "Arrow up", in the desired field, for example line 3 / column 1. The modified view will be displayed.
6. To restore the original table layout, click "Reset configuration". Click "Next".

7. Arrange the web parts in the table fields. If necessary, activate the corresponding symbol in a table field to place the web parts vertically or horizontally.

8. Click "Save".

**Result**

The layout template "mylayout_23" is created. You can use the layout template as a template for creating a Webcenter page.

**Creating Webcenter page**

**Introduction**

You create Webcenter pages in which you add web parts. The Webcenter pages are stored in directories. In this example, the WebCenter page is saved in the "myPart" directory.

You can only change or create Webcenter pages in directories for which the Windows user group has the "Edit" or "Create" access rights.
Requirement

- The directory "myPart" is set up.
- The logged in user is a member of the Windows user group "SIMATIC Report Administrators" or "SIMATIC Report Users".
- The Windows user groups have the access rights "Edit" or "Create" for the directory.
- The start page of the DataMonitor is open.

Procedure

1. Click "Webcenter > Configuration" on the start page.
2. Click on the "Creating page" tab.
3. Click on the desired layout template. The file name is displayed in the "Layout file" box.
4. Enter a name in the "Webcenter page" box, for example, "My_Webcenter".

5. Select the directory in which the Webcenter page is stored. The selected directory is displayed in the box "Save WebCenter page as".

![WebCenter Page Creation Screen](image)

6. Click "Save".

**Result**

The Webcenter page "My_Webcenter" is created and saved.
Inserting web parts to the Webcenter page

Introduction

You compile the contents of the Webcenter pages from the web parts.

Requirement

- The directory "myPart" is set up.
- The Webcenter page "My_Webcenter" is stored in the directory.
- The logged in user is a member of the Windows user group "SIMATIC Report Administrators" or "SIMATIC Report Users".
- The Windows user groups have the access rights "Edit" or "Create" for the directory.
- The start page of the DataMonitor is open.

Procedure

1. Click "Webcenter > Pages" on the start page.
2. Click on the "myPart" tab.
3. Click on the entry "My_Webcenter".
4. To add web parts, click at the top right edge of the page. The available web parts are listed. If you have exported web parts that have already been configured, they are listed under "Imported web parts". If necessary, insert these web parts into your Webcenter page.

5. Activate the entry "Trend (Timestep)".

6. Select the entry "WPZ_01_01" and click "Add".

7. Activate the entry "Hit list of alarms". If you insert several web parts into a table field, the web parts are arranged horizontally or vertically. You specify the arrangement when you create the layout template.

8. Select the entry "WPZ_02_01" and click "Add".

9. Click "Exit".
Result

Web parts to display data are inserted into the Webcenter page "My_Webcenter". The current compilation of the Webcenter page is displayed.
3.2 WinCC/DataMonitor Documentation

3.2.1 Basic principles

3.2.1.1 DataMonitor

Overview

You can display and evaluate current process states and historical data with WinCC/DataMonitor via the Intranet/Internet.

WinCC/DataMonitor consists of a server component and a client component. The DataMonitor server makes functions available to the DataMonitor client for analysis and display of data. Access rights control access to the functions.

- "WinCCViewerRT":
  Program for monitoring of WinCC projects. The DataMonitor client is a so-called "View Only Client".

- "Excel Workbook":
  Display of process values and archive values in an Excel table for evaluation and display via the web or as a print template for reports

- "Reports":
  Creating reports from WinCC print jobs or from published Excel workbooks. This also allows for statistics and analyses of certain process data or historical data. The reports are created in PDF format and forwarded as e-mail if necessary.

- "Webcenter":
  Central information portal for access to WinCC data via user-specific views. Clearly structured Webcenter pages with individual user rights for reading, writing and creating Webcenter pages.

- "Trends & Alarms":
  For display and analysis of archived process values and alarms. The data is displayed in tables and diagrams on predefined Webcenter pages.

Quantity Structure

WinCC/DataMonitor allows the simultaneous operation of up to 50 clients per server.

Using terminal services

A configuration with 50 DataMonitor clients per terminal services server has been tested as a typical scenario.
3.2.1.2 WinCCViewerRT

Overview
The Web Viewer "WinCCViewerRT" is solely a display program for WinCC projects that is installed with the DataMonitor client. The DataMonitor Client is therefore a "View Only Client". You run the "WinCCViewerRT.exe" application instead of Internet Explorer on the DataMonitor Client.

The Web Viewer accesses the DataMonitor server using its own communication. This way you prevent access by users to the Internet and protect the system from viruses and trojans.

The viewer only displays the pictures that you configured for web access and published on the DataMonitor server.

The WinCC user must be assigned authorization no. 1002 - "Web Access - monitoring only". The "View Only Cursor" indicates that process-related operations are not possible. Certain operations, such as opening the properties dialog of an OnlineTrendControl, are still possible.

If the WinCC user does not have authorization no. 1002, the DataMonitor client runs in demo mode after logon.

3.2.1.3 Web center

Overview
The Webcenter is the central information portal for access to WinCC data via Intranet/Internet. Users can use the Webcenter pages and web parts to compile and save their views of WinCC data. The Webcenter pages are stored in directories.

The Webcenter pages are stored in modular fashion. The modules are defined by layout templates. Users can either use the supplied layout templates or the ones they create themselves.

The web parts are the individual blocks that prepare and display data. You can combine up to 15 web parts in one screen view. For more information, refer to "Overview of web parts (Page 323)".

Within the WebCenter pages, the configuration of the respective web part is stored and can be called up again at any time. The multiple use of the same web part with different configuration is also possible. The WebCenter pages that have been created in this way can be opened with the same configuration by different users depending on the assigned rights.

You can export the configuration of web parts as XML file.

To transfer the configuration data to another computer, copy the folder:
"\Siemens\WinCC\WebNavigator\DataMonitorServer\WebCenter\App_Data\WebCenter"

Basic procedure
1. Creating directories for Webcenter pages
2. Assigning Access Rights
3. Establishing connection to the WinCC data
4. Publishing pictures for the Webcenter
5. Creating layout template for Webcenter pages
6. Creating Webcenter page
7. Inserting web parts to the Webcenter page
8. Configuring web parts within Webcenter pages

3.2.1.4 Overview of Web Parts

Overview

You compile Webcenter pages from the web parts in the “Webcenter”.

The following web parts are available:

- Process value table
  The available process values are displayed for the defined time period.

- Process Values in the Table (Timestep)
  The complete archive name and the tag name are displayed as tooltip in the column header.
  The process values are combined beginning with the starting time in the defined time interval.
  Depending on the set aggregate type, the interval for the interval event is displayed.
  For example, a process value was archived every 30 seconds. You have selected an interval of 60 seconds and the aggregate type "Average value". It determines the average value of two archive values each, which is then displayed in the table with the first time stamp of the averaging interval.
  If you select an aggregate type without interpolation, and if no value is present in the interval, no interval result will be displayed. If you select an aggregate type with linear interpolation, an interval result is displayed for each interval.

- Statistics functions for process values
  All available process values are used for the defined time period, for example, to calculate and display the average value.

- Trend Process Values
  The process values are displayed with trends.

- Trend (Timestep)
  Clear presentation of precompressed values in trends with aggregate functions, such as sum or average.

- Bar Chart (Aggregates)

- Pie Chart (Aggregates)

- Alarm table
  Presentation of accrued alarms.

- Alarm hit list
  Presentation of statistical information on alarms.

- Link to WebCenter pages
• Links (external)
  Links to internal Webcenter pages and external Internet pages, such as stock market news.

• Displaying information
  Such as news, for example.

• Static process pictures
  WinCC pictures are integrated into the Webcenter without installation download. A JPG screenshot of the process picture is created on the DataMonitor server at regular intervals.

• Display Graphic
  JPG screenshots, such as company logo.

• The Last Reports
  Display the reports created last, for example, the last ten print jobs in PDF format created with "Reports".

See also

- Displaying process values in a table (Page 386)
- Displaying process values in a diagram (Page 387)
- Displaying the hit list of messages (Page 393)
- Displaying messages in the alarm table (Page 389)
- Displaying statistics function for process values (Page 395)

3.2.1.5 Trends and Alarms

Overview

"Trends & Alarms" is used for display and analysis of archived process values and alarms.

Predefined web pages have the following content:

• Displaying process values in a table (Page 386)
• Displaying a maximum of three process values in a diagram. Displaying process values in a diagram (Page 387)
• Displaying statistics function for process values (Page 395)
• Displaying alarm hit list (Page 393)
• Displaying alarms in the alarm table (Page 389)

The functions of "Trends & Alarms" are configured with web parts. Use the same web parts for this purpose that you used for the Webcenter pages.

Within Trends & Alarms each user can only make one configuration for each web part. The configuration is saved for the user. Other users cannot access the configuration of this web part directly.
3.2.1.6 Excel workbook

Overview

With the Excel add-In "Excel Workbook" you can display the following data of the WinCC project in an Excel workbook on the DataMonitor client:

- Alarms
- Values of process tags and archive tags
- Additional information, such as time stamp or quality code of tags

Data of swapped archives is not displayed.

The data is evaluated by Excel and presented as graphic, e.g. as average value calculation or diagram representation. The created Excel workbooks are made available as templates for "Reports" and as report tools.

Requirement

- Use the Download area in "Reports" to install the Excel add-ins "ExcelWorkbook Wizard" and "Excel Workbook" on the DataMonitor client.
- The "Remote Desktop" user is a member of the Windows user group "SIMATIC HMI Viewer".

Configuring with XML file or online

Simultaneous online access to process data of different WinCC servers is possible using the "Excel Workbook". This requires that you either take the data from an XML file or from a local WinCC project during the configuration with the Excel add-in "Excel Workbook Wizard". A separation between process and evaluation is possible with the XML file.

- A WinCC project is open on the DataMonitor server.
  The XML file is generated with the "Export Configuration Data" function.
  Then transfer the XML file to a computer with Microsoft Excel.
  Configure the process data display in the workbook.
  Afterwards, transfer the workbook to a DataMonitor client that displays the process data online.

- To accept the data of the WinCC project online, configure directly on the WinCC server or on a WinCC client with an online connection to the respective WinCC server.

- Import the data into an Excel workbook using the "Excel Workbook Wizard".
  Then configure the display of alarms and tag values.

Note

If you rename a table in an Excel workbook, the configuration data of the table is lost.

You can configure up to 32,767 process and archive tags in an Excel workbook. During online display with "Excel Workbook" you may experience considerable delays in updating when there is a large number of tags.
3.2.1.7 Reports

Introduction

Use "Reports" to create time-controlled and event-controlled reports independent of the SCADA system. Use the WinCC print jobs and published Excel workbooks to output analysis results and process data. The reports are output as PDF or XLS file and can be attached to an e-mail.

Requirement

- You need a PDF reader for output as PDF file. The PDF reader can be obtained from www.adobe.com for example.
- For Output as XLS-file (Excel workbook):
  - MS Excel as of Office 2013 is installed.
    To use the automatic creation of Excel reports on the DataMonitor server, MS Excel must be installed on the server.
  - The Excel workbook is created and published as template on the DataMonitor server.
- Use the Download area in "Reports" to install the Excel add-ins "ExcelWorkbook Wizard" and "Excel Workbook".

Using reports

You determine on the DataMonitor server when you want to create reports:

- Manually, for example, by a plant operator.
- Event-controlled, for example, when a tag value changes.
- Time-controlled, such as daily, for example.

The created reports are centrally saved in the directories on the DataMonitor server. Users can access the different folders with appropriate authorization from the DataMonitor client.

Note

The creation time is always displayed on a DataMonitor client in the local time zone of the server.

See also

- Configuring the display of tag values (Page 284)
- Making an Excel workbook available as template (Page 419)
- Configuring the Excel workbook (Page 280)
3.2.2 Configuring the DataMonitor system

3.2.2.1 Overview of the configuration steps

Introduction

For use of WinCC/DataMonitor the data and process pictures are made available on the DataMonitor server. The DataMonitor client accesses the available data to display data and process pictures.

Requirement

- Server and client are interconnected.
- On the server
  - Internet Information Service is installed.
  - The DataMonitor server is installed.
  - A WinCC/DataMonitor license is installed.
  - WinCC is installed.
- On the client
  - Internet Explorer is installed.

Configuration steps

You have to complete the following configuration steps to set up the DataMonitor system.

1. Configuration of the WinCC project.
   - Publish WinCC pictures.
   - Define users and access rights in "WinCC User Administrator", if you use WinCCViewerRT and/or "Excel Workbook".
   - Configure the settings for Runtime.

2. Configure the DataMonitor server.
   - Set up the web page and firewall.
   - Define users and access rights in Windows, if you use "Trend & Alarms", "Reports" and "Webcenter".

   – Check the security settings of the Internet Explorer.
   – Start the Internet Explorer and enter the address of the DataMonitor server.
   – Log on to the DataMonitor server and access the DataMonitor functions.

5. Monitor the WinCC project on the DataMonitor client.
   – Configuring WinCCViewerRT
   – Displaying pictures

See also

- Configuring the DataMonitor web page (Page 344)
- Configuring security settings in Internet Explorer (Page 348)
- Configuring runtime settings (Page 340)
- Creating static process pictures for the Webcenter (Page 372)
- Defining users in Windows (Page 342)

3.2.2.2 Configure the WinCC project

Publishing WinCC process pictures

Publishing WinCC Process Pictures

Introduction

If you wish to display WinCC process pictures on the WebNavigator Client or DataMonitor Client, you have to publish the pictures. For publishing, you use the Web View Publisher, which automatically makes the necessary adaptations to the project data.
Overview

The Web View Publisher enables the following types of publishing:

- Publishing on the local computer.
  The current WinCC project folder is the source folder.
  The target folder is a subfolder, for example, "Projectname/WebNavigator/Pictures".

- Publishing on a dedicated web server with a server prefix.
  The source folder is the WinCC project folder on another WinCC computer that is defined
  by the server prefix.
  The target folder is located in subfolder "../WebNavigator/Pictures" of the WinCC project
  on the WinCC Client. The pictures of your own project are saved with the name
  "<typename>.PD_", while the pictures of other projects are saved with the name
  "<serverprefix>_<typename>.PD_".

- Remote publishing.
  The source and target folders can be located on the same or different web servers.
  You can start the Web View Publisher on the web server with the source and target folder
  or on a third web server.

- Remote publishing on a dedicated web server or WinCC Client from a different remote
  station.
  The project folder of the WinCC project must be released in Windows on the dedicated web
  server/WinCC Client. You can start the Web View Publisher remotely by opening the WinCC
  project of the web server/WinCC Client on the remote computer. On the remote station,
  you publish the WinCC pictures from other WinCC Servers to the dedicated web server.

The Web View Publisher performs the following adjustments:

- Compression of the data for optimizing performance on the Internet.
- Removal of project-specific data that is not required for the operation.
- Conversion of picture windows into an ActiveX component.
- Conversion of scripts so that they can be run on the Client.

Opening a published picture in Internet Explorer

In order to open a published picture directly, a website must already be set up.

1. In WinCC Explorer, select a published picture in the table area of the WebNavigator.
2. Select the "Copy URL to clipboard" command from the shortcut menu.
3. Paste the link from the clipboard in the address bar of Internet Explorer.

The file with the picture opens in Internet Explorer.

Publication of pictures with faulty scripts

If warnings or errors are generated during publishing, the process pictures affected are marked
in the output field of the Web Publishing Wizard. The pictures with errors in the scripts are
nonetheless published. However, errors can still occur in Runtime and are reported by the
WebNavigator Client.

The "PdiPad" tool can be started directly in the Web View Publisher in order to check and, if
necessary, correct the scripts used in the published pictures.
Publishing Without Project Functions

Publishing without project functions can be an additional source of error. When publishing with the Web View Publisher, the selected project functions are always published. When published without project functions, the pictures no longer contain any project functions. The project functions of the last publishing process are always available in the published pictures and, therefore, on the client.

The selection of project functions in the Publisher is independent of the pictures published in the same process. If, for example, you modify selected project functions but not their interfaces, you need to publish all necessary project functions. In this case, you do not have to publish the picture.

Changing the process picture in Graphics Designer

Process pictures that you edit in runtime in Graphics Designer on the WebNavigator Server must be published once again. This is required for the process picture to be displayed on the WebNavigator Client.

When using a dedicated web server, open the WinCC project on that server from a remote station in order to transfer the changes to the WebNavigator Client. On completion, open and save the modified picture in Graphics Designer. Publish the picture in the next step using Web View Publisher on the dedicated web server.

If you have modified a large number of pictures, you can simplify this process. For this purpose, call the "Convert pictures" function in the shortcut menu of Graphics Designer. On completion, you once again have to publish the pictures.

Requirements for publishing pictures

General requirements

- The picture names may not contain double underscores, e.g. "__furnace_overview.pdl". The string before the double underscore will be interpreted as server prefix.
- The package names and/or symbolic computer names may not contain any double underscores.
- The package names and/or symbolic computer names may not end in an underscore.
- Moreover, the name cannot begin with a single underscore if you are using Basic Process Control. When using Picture Tree, the name string of higher-level pictures will have a "@PTN_" prefix. With the leading underscore, the picture name will then have a double underscore.
- If two header files of the same name exist in the project path and in the installation path of WinCC, Web View Publisher will use the header file from the installation path.

Requirements for publishing on a dedicated web server

- The Web Navigator Server is installed on the WinCC Client.
- The C and VB scripts of all WinCC servers to which the WinCC Client has access have been copied to the WinCC Client.
The WinCC server packages that the WinCC Client can access are loaded on the WinCC Client.

If you wish to publish projects on other computers, these computers must be linked by means of network drive before you start Web View Publisher. This procedure enables the display of your projects in the selection dialog of the Publisher. You cannot enter the path directly.

Requirements for remote publishing

- Access to the target and source folders is enabled for Web View Publisher. WinCC configures these Windows enables by default. Verify that these enables are not restricted, for example, valid for specific users only.

- If you wish to publish projects on other computers, these computers must be linked by means of network drive before you start Web View Publisher. This procedure enables the display of your projects in the selection dialog of the Publisher. You cannot enter the path directly.

How to publish WinCC process pictures using Web View Publisher

Introduction

Use Web View Publisher to publish the process pictures that you created in Graphics Designer. The WinCC Web Publishing Wizard supports you during publishing.
Procedure

1. Select "Web Navigator" in the navigation window of WinCC Explorer. Select the "Web View Publisher" command in the shortcut menu. The WinCC Web Publishing Wizard is now launched.

2. Click "Next".
3. Activate the "Server prefix" option if you want to publish the pictures on a dedicated web server.
Select the prefix of the WinCC Server that contains the WinCC project from the selection list. The list displays the prefixes of the servers whose packages are loaded on the WinCC Client.
Deleting a prefix from the selection changes the paths displayed in the fields below.

4. Under "Path to your WinCC project", select the WinCC project folder containing the pictures you want to publish.
The folder has the following format for publication on a dedicated web server:
"\<servername\\serverprefix\\〈projectname\\".
If you want to publish from a remote station, select the source project containing the pictures.
The source project is displayed by its enable name on the other WinCC Server.
The folder has the following format:
"\<computer name\\〈enable name\\".

5. Select the target folder for the published pictures under "Publishing folder of the WinCC web".
Accept the proposed folder within the WinCC project folder.
Do not change the path specification unless you want to transfer pictures to a different project, for example. In this case, the prefix selection list will be expanded accordingly.
Verify the specified target project to which the published pictures are saved during remote publishing.
The path definition will be updated when you select the source project.
Should the target project be located on another WinCC server, select the corresponding project.
6. Select the "Display hidden objects" option to show hidden objects that are published automatically in the results list.

7. Click "Next". Move the pictures that you wish to publish to the "Selected files" list.
8. Click "Next". Move the C project functions which you use in the published pictures to the "Selected files" list. You cannot publish individual VB scripts.

Click "Next".
9. Move the referenced graphics that you wish to publish to the "Selected files" list. The referenced files are in the "GraCS" folder or in subfolders of "GraCS".

Click "Next".

10. Click "Exit" to start publishing the pictures.
You have successfully published the pictures and functions. The results list displays the status of all published objects. You can click an object to view additional object information.

You can trace publishing using the "<projectfolder>\WebNavigator\WizardLog.txt" file.
Checking the scripts using "PdlPad"

The "WizardLog.txt" log file contains information about errors in the scripts used. You can also find errors using the "PdlPad" debugger.

1. Open "PdlPad" by double-clicking on the affected object in the results list of Web View Publisher. The script of the published picture is displayed.

2. Click in order to check the script.

3. You can temporarily correct and save the scripts. These corrections are only saved to the published pictures, not in the process picture of the WinCC project.

Alternatively, open "PdlPad" in the "Siemens Automation" program group.

Administering users for DataMonitor

Introduction

For the use of certain functions on the DataMonitor client, users need authentication as DataMonitor user as well as authentication as WinCC user. Use one WinCC user for "WinCCViewerRT" and "Excel Workbook".
If you are working as DataMonitor user and WinCC user at the DataMonitor client you have to log on twice. You have two alternatives to only log on once:

- The DataMonitor user and the WinCC user have identical names and passwords. The user must be configured in Windows and in WinCC and added to the “SIMATIC HMI” and “SIMATIC HMI VIEWER” user groups.
- SIMATIC logon allows the central administration of users. In order to use SIMATIC logon in connection with DataMonitor, DataMonitor users must also be added to the user group “SIMATIC HMI VIEWER”.

Procedure

1. Select the entry "User Administrator" in the navigation window of WinCC Explorer. Select the "Open" command from the shortcut menu. The editor "User Administrator" is opened.

2. In the navigation window, select a user or create a new user.

3. Select a user group and then open the shortcut menu. Select the entry "New User". The name of the user can be changed directly with the <F2> function key or the shortcut menu command "Rename". The user must be selected beforehand for this purpose.

4. Enter a name and a password with at least six characters for "Login". Click "OK".

5. Select the newly created user in the table window. The properties of the user are displayed.

6. Activate the option "WebNavigator". Select a start picture from the dropdown list next to "Web start picture".
7. Check the selected language and change this setting if desired via the dropdown list next to "Web language". You can only select a new language from the dropdown list if one of the two options "WebNavigator" or "PureWebClient" is activated. The languages created in the Text Library are available for selection.

8. The user needs at least the authorization "Web Access - monitoring only". In the row in the table window, activate the corresponding authorization in the "Enable" column.

9. Close the User Administrator.

**Configuring runtime settings**

**Introduction**

Define the settings for behavior in runtime when you use the DataMonitor.
Procedure

1. Select "WebNavigator" in the navigation window of WinCC Explorer. Select the "Web settings" command from the shortcut menu.

2. Change to the "Runtime" tab in the "WinCC web settings" dialog. Select the required settings. Close the dialog with "OK".

Use "WinCC Classic" design

Activate the option to improve the performance of the DataMonitor client. The original style of WinCC V6 is now used.

"Monitoring only" cursor

A default cursor shows that the user of the DataMonitor client is not permitted to operate Runtime. The user has been assigned system authorization no. 1002 - "Web access - monitoring only" in the WinCC User Administrator.

If you want to use your own cursor, enter its path and file name. You can also use the "..." button to navigate to the file of the selected cursor.
Server load
You do not need the settings in the area "Server load" for DataMonitor.

Activate WinCC system messages
The system messages "No. 1012400" or "No. 1012401" are output and archived at the login/logoff of a DataMonitor client.

Enable event log messages
A successful session login or logoff is recorded in the Windows event viewer.

Disable local groups of SIMATIC Logon
The DataMonitor server can only be accessed by groups in the same domain.

Hardware accelerated graphics representation
The Direct2D representation is activated for the entire project on the WebNavigator clients.

3.2.2.3 Configuring the DataMonitor system

Defining users in Windows

User groups in Windows

Overview
The following user groups are created automatically in Windows when the DataMonitor server is installed.

SIMATIC Report Administrators
Membership of the user group "SIMATIC Report Administrators" is required for extended rights, especially for configuration purposes. At least one user must be created and assigned to the "SIMATIC Report Administrators" user group.

- You can also do the following as "SIMATIC Report Administrators" in the "Webcenter":
  - Configuring connections
  - Creating templates for Webcenter pages
  - Creating and configuring public and private Webcenter pages
- You can also do the following as "SIMATIC Report Administrators" in "Reports":
  - Configuring reports based on WinCC print jobs or Excel workbooks.
SIMATIC Report Users

Membership of the user group "SIMATIC Report Users" or of your own user group is required for the "Webcenter", "Trends & Alarms" and "Reports".

- You can also do the following as "SIMATIC Report Users" in the "Webcenter":
  - Setting up and configuring Webcenter pages. The Webcenter pages are stored in different directories.
  - Opening public pages
- You can also do the following as "SIMATIC Report Users" in "Reports":
  - Opening reports based on WinCC print jobs or Excel workbooks.

Defining Users and Access Rights in Windows

Introduction

When using DataMonitor, users need different authentications. All users must be members of the "SIMATIC HMI" user group.

For access to the WinCC database via DataMonitor, you need a Windows user with password who is a member of the "SIMATIC HMI VIEWER" user group.

This means you must create users with the matching user rights.

Requirement

- WinCC is installed.
- The DataMonitor server is installed.

Procedure

1. In the Windows Control Panel, open the entry "System and Security > Administrative Tools".
3. Navigate to the "System > Local Users and Groups > Users" directory.
   In the shortcut menu select the entry "New user".
4. Enter a name such as "DM_Demo" in the dialog "New user" in the "User name" box.
   Enter a description such as "User for DataMonitor" in the "Complete name" box.
   Type the desired password into the "Password" box and then repeat it in the "Repeat password" box.
   Create the user with "Create".
   Close the "New user" dialog.
5. In the right part of the table window, click on the newly created user. Select the "Properties" command in the shortcut menu.
   Switch to the "Member Of" tab.
   Click "Add".
6. In the "Select Groups" dialog, click the "Advanced > Find now" button.
7. Select the entries "SIMATIC Report Administrators", "SIMATIC HMI" and "SIMATIC HMI VIEWER" from the list at the bottom of the dialog. Click "OK" twice to close the dialog.
8. In the properties of the user, the groups "SIMATIC Report Administrators", "SIMATIC HMI" and "SIMATIC HMI VIEWER" have been added to the list of memberships. Click "OK".
9. Close the "Computer Management" dialog with "File > Exit".

Result

The user "DM_Demo" with membership of the user groups "SIMATIC Report Administrators", "SIMATIC HMI" and "SIMATIC HMI VIEWER" has been set up.

The user can now create directories in the Webcenter and make connections to WinCC databases.

Note

If a user wants to access remote computers via the DataMonitor server, the Windows user must be set up on the DataMonitor server as well as the remote servers with the same password.

Configuring the DataMonitor web page

Introduction

You create the DataMonitor web page with the WinCC Web Configurator.

Requirement

- The DataMonitor server is installed.
- The Windows "Internet Information Service" component is installed.
Procedure

1. Select "Web Navigator" in the navigation window of WinCC Explorer. Click the "Web Configurator" command in the shortcut menu. Alternatively, select the entry "Web Configurator" in the "Siemens Automation" program group.

2. The Web Configurator detects whether a configuration already exists.
   - No configuration found: Activate "Create a new standard website (Standalone)". Click "Next".
   - Configuration found: Click "Next" and check the configuration.

---

Here, you can create a new standard Web site or add a virtual folder to an existing activated Web site:

- Create a new standard Web site (stand-alone)
- Add to an existing Web site (virtual folder)

---

- Configuration found: Click "Next" and check the configuration.
3. Select "Name of the web page" and enter the name.

4. Enter the number of the port used for access in the "Port" box.

5. At "IP address", specify whether the computer is to be available on the intranet or Internet or on both networks. Use only the addresses that are available in the selection list. Select "All not assigned" to enable intranet and Internet access to the computer.

6. Select "DataMonitor.asp" as the default web page.

7. Specify the time interval after which the DataMonitor client starts to reestablish a connection automatically in case of a connection error. A time setting of "0 s" disables the "Automatic reconnection" function.

8. Specify whether the web page is started once the configuration is completed.

9. Click "Finish" if you have not activated a firewall. Click "Next" if you have installed a firewall. See the following pages to find out how to set up a firewall.

Result

You have created the Web folder and activated the web page. When you have activated the firewall, use the Web Configurator to configure its settings.

Configuring the firewall

Introduction

This section describes how to activate "HTTP" and "HTTPS" services using Windows Server 2016 as an example.
Consult your network administrator if you want to set up the Windows Firewall with advanced security or for a different port.

Requirement

- You have created a default web page with Web Configurator.
- The Firewall is activated.
- The user who is logged has Windows administrator rights.
- You have to set up the HTTPS service in IIS if you are using it for WebNavigator. For more information, refer to "Setting up an HTTPS service in IIS (http://support.microsoft.com/kb/324069)".

Procedure for the default port

1. Click the "Windows Firewall" button in the "WinCC Web Configurator".

   ![Configuring the Windows Firewall dialog](image]

   The "Windows Firewall" dialog opens.

2. Click "Allow an app or feature through Windows Firewall".
3. Activate "Secure WWW services (HTTPS)" or "WWW services (HTTP)".
4. Close all Windows dialogs with "OK".
5. Click "Finish" in the Web Configurator. The server configuration is completed.
3.2.2.4 Working with the DataMonitor client

Configuring security settings in Internet Explorer

Introduction

For full functionality on the DataMonitor client, adapt the security settings in the Internet Explorer.

Requirement

- Internet Explorer is installed.

Procedure

1. Click "Tools > "Internet Options" in the Internet Explorer. This will open the "Internet Options" dialog.
2. Select the "Security" tab.
3. Select the "Trusted Sites" icon and click the "Sites" button. The "Trusted Sites" dialog opens.
4. Enter the address of the DataMonitor server in the "Add this website to the zone" field. Possible formats and wildcards include "*:157.54.100 - 200", "ftp://157.54.23.41", or "http://*.microsoft.com".
5. Deactivate the "Require server verification (https:) for all sites in this zone" check box. Click "Add". Confirm the entry by clicking "OK".
6. Select the "Trusted Sites" icon.
7. Click "Default Level". Click "Adapt Level" in the next dialog. The "Security settings" dialog box is opened.
   - Activate the "Activate" option under "Initialize and script ActiveX controls not marked as safe".
   - Confirm the entry by clicking "OK".
8. Close the "Internet Options" dialog by clicking "OK".

Result

The necessary settings in the Internet Explorer of the DataMonitor client are configured.
User authentication: Activated setting "Automatic logon with current user name and password" in Internet Explorer

If the setting "Automatic logon with current user name and password" is activated in Internet Explorer in "Tools > Internet Options > "Security" tab > "Adapt Level" button > entry "User Authentication" > Logon", this can lead to unexpected behavior under the following requirements.

Requirement

● The "Automatic logon with current user name and password" setting is activated in Internet Explorer.

● The user logs onto the DataMonitor client as a WinCC user who is not configured in the user groups on the DataMonitor server.

● The user is logged onto the computer with a Windows logon that is set up as a user name on the DataMonitor server.

Behavior

1. The DataMonitor server does not recognize the WinCC user name the user has used to log onto the DataMonitor client and therefore rejects it. The user cannot see this behavior.

2. Internet Explorer automatically starts a new logon using the current Windows logon as user name.

3. The DataMonitor server recognizes the Windows logon as DataMonitor user name and accepts the logon for this user.

4. The user is logged on but not with the DataMonitor user name the user has entered. The current DataMonitor user is not displayed.

Recommendation

Disable the "Automatic logon with current user name and password" setting.

Use the setting only when there is a clear distinction between Windows logon and DataMonitor user name.

DataMonitor start page on the DataMonitor client

Overview

You start the DataMonitor client on a standalone computer or on a DataMonitor server. The start page of the DataMonitor summarizes the functions of the DataMonitor:

● "Reports": Creation and output of analysis results and process data in print jobs and published Excel workbooks.

● "Webcenter": Creation of Webcenter pages for the display of archived data.
"Trends & Alarms":
Display of alarms and process values from archives in tables and diagrams.

"Administration"
Configuration of connections and management of users, archives and pictures.

Requirement

- The user is created in WinCC.
- The user must be a member of the Windows user group "SIMATIC Report Administrators" or "SIMATIC Report Users".
- The WinCC project on the DataMonitor server is in runtime.

Procedure

1. Start the Internet Explorer on the DataMonitor client.
2. Enter the name of the DataMonitor server in the format "http://<servername>" in the URL. Confirm the entry with "Enter". The log-in dialog is opened.
3. Enter the name of a Windows user and the associated password. Confirm with "OK".

Result

The start page with the DataMonitor functions will be displayed. The use of the functions depends on the access right of the user.
## General Operations of the DataMonitor Client

- Select the desired interface language from the selection field in the header.
- Hide the header on the pages of "Webcenter" and "Trend & Alarms", if necessary. Click ![hide-header]. To show the header line again, click on the symbol ![show-header].
- In order to log off from the DataMonitor server, click on the "Log off" link. Exit Internet Explorer to free-up the used license immediately.

### See also
- Working with trends and alarms (Page 386)
- Working with reports (Page 419)
- Working with the Webcenter (Page 356)

### 3.2.3 Working with WinCCViewerRT

#### 3.2.3.1 Configuring WinCCViewerRT

#### Introduction

WinCCViewerRT is a program for visualizing WinCC projects. You can configure WinCCViewerRT for operation with the DataMonitor server and Graphics Runtime.

#### Use project settings

If you select the "Use project settings" option, the following settings are applied by the DataMonitor server:

- **User Administrator:**
  - Automatic logoff
- **Computer properties:**
  - Runtime language
  - Runtime Default Language
  - Start Picture
  - Start configuration of Menu and Toolbars
  - Hardware accelerated graphics representation (Direct2D):
Requirement

- On the server
  - The DataMonitor server is installed.
  - A WinCC/DataMonitor license is installed.
  - The WinCC project is in Runtime.
  - The WinCC pictures are configured and published for web access.
  - The WinCC user must be assigned authorization no. 1002 - "Web Access - monitoring only".
- On the client
  - The DataMonitor client is installed.

Procedure

1. In the "Siemens Automation" program group, select the entry "WinCCViewerRT". The configuration dialog opens if you reconfigure WinCCViewerRT. WinCCViewerRT opens if WinCCViewerRT has already been set up. Use the <Ctrl+Alt+P> key combination to open the configuration dialog of WinCCViewerRT.

2. Enter the login data in the "General" tab:
   - Server address: "http://<Servername>" or "http://<IP-Adresse>"
   - Use project settings: Apply settings of the DataMonitor server
   - User name and password, if you want to specify a default user for the login dialog.

3. Specify the Runtime language in the "Parameters" tab.
   - If necessary, disable any key combinations with which the user switches to other programs.
   - If required, you can modify the preset <Ctrl+Alt+P> key combination that is used to open the WinCCViewerRT configuration dialog.
   - Define a key combination with which a user can log off and a new user can log on.
   - The key combination can only be used if no default user has been set in the "General" tab.
4. Specify the WinCC Runtime properties in the "Graphics Runtime" tab:
   - Start Picture
   - Configuration file for user-defined menus and toolbars
   - Window Attributes
   - Impermissible user actions
5. Specify additional user actions in the “Runtime” tab:
   - Activating the screen keyboard
   - <Ctrl+Alt+Del> key combination to allow switching to the Task Manager or operating system via the screen keyboard.
   - Settings for automatic logoff

![WinCCViewerRT Runtime tab]

6. Click “OK” to close the dialog.

**Result**

WinCCViewerRT is configured.

The connection to the DataMonitor server is set up after you close the dialog.

The settings are saved to the "WinCCViewerRT.xml" configuration file. The configuration file settings are used at the next start of WinCCViewerRT.

WinCCViewerRT applies the user interface language from WinCC.

The configuration file is stored in the following folder based on the operating system:

- <User>\AppData\LocalLow\Siemens\SIMATIC.WinCC\WebNavigator\Client

You can rename the file, for example, to "User1.xml".

You can also start WinCCViewerRT by means of the command line with the user-specific configuration file, e.g. "WinCCViewerRT.exe User1.xml". This procedure allows for different configurations, depending on the logged-on user.
The WinCCViewerRT configuration dialog opens at the start if you rename or delete "WinCCViewerRT.xml". Reconfigure WinCCViewerRT or select a different configuration file.

Note

WinCCViewerRT can only be closed by means of script function if you disable a key shortcut or hide the "Close" button.

Function in the C-Script: DeactivateRTProject; function in the VBScript: HMRuntime.Stop.

3.2.3.2 Displaying pictures

Requirement

- A WinCC/DataMonitor license is installed on the DataMonitor server.
- The WinCC project on the DataMonitor server is in runtime.
- The WinCC pictures are configured and published for web access.
- The WinCC user must be assigned authorization no. 1002 - "Web Access - monitoring only".
- WinCCViewerRT is configured on the DataMonitor client.

Procedure

1. In the "Siemens Automation" program group, select the entry "WinCCViewerRT".
2. Log on to the DataMonitor server:
   - A login dialog is not displayed if the user name and password are set in the WinCCViewerRT configuration dialog. You are logged on automatically with the stored login data.
   - The login dialog is displayed if a user name and password is not set in the WinCCViewerRT configuration dialog. Enter the user name and password of the WinCC user. Click "OK".
3. To change the user, use the specified key combination for login/logoff of "WinCCViewerRT". The previous user is logged off. Enter the user name and password of the new WinCC user in the login dialog. Click "OK". The key combination can only be used if no default user has been set.

Result

WinCCViewerRT automatically connects to the activated WinCC project. The pictures of WinCC project are displayed.

The "View Only Cursor" indicates that process-related operations are not possible.
Certain operations, such as opening the properties dialog of a WinCC OnlineTrendControl, are still possible.

You can also use your own cursor icon as a "View Only Cursor", if required. For more information, refer to "Configuring Runtime settings" (Page 340).

The <F5> key triggers a reselection of WinCCViewerRT.

3.2.4 Working with the Webcenter

3.2.4.1 Administration

User Groups and Directories

Overview

WebCenter pages and reports are stored in directories on the DataMonitor server.

Its standard complement of directories is as follows:

- "Public"
- "Private" Every user has a "Private" directory. Only the respective user has access rights to this directory.

A user of the user group "SIMATIC Report Administrators" can create other directories and assign the other user groups different access rights to these directories.

More information on setting up directories can be found in chapter "Setting up directories" (Page 359).

Windows User Groups

The user groups "SIMATIC Report Administrators" and "SIMATIC Report Users" are created when the DataMonitor server is installed. You can create more user groups. More information on setting up user groups and users can be found in chapter "Defining users and access rights in Windows" (Page 343).

To access the DataMonitor, assign all members of a user group the same access rights to the directories of the DataMonitor server.
The following access authorization is possible:

- Read
- Change
- Create

A user, as a member of a user group, only has access to a directory if the respective user group has access rights to that directory. This permits user group-specific access. More information on assigning access authorization can be found in chapter "Assigning access rights (Page 359)".

The following picture shows the basic user administration for the WebCenter.
Windows User Administration

The installation routine of DataMonitor creates Windows user groups.

Individual user groups

- User groups
- System groups

DataMonitor Administration

FOLDER ADMINISTRATION

Connection administration  Folder administration

List of existing directories

- Directory list
  - Public (default)
  - Personal (DM_ad)
  - NewFolder
  - ProcessPlans
  - ServiceGroup
  - Water

Windows user groups are assigned different access rights for DataMonitor directories.

Individual access of Windows user groups to web center pages

WINCC / DATAMONITOR - WEBCENTER

- Start page
- Reports
- Webcenter
- Pages

Public (default)  Personal (Service_014)  ServiceGroup  Water

General Information
- News
- Screens
Creating Directories

Introduction
You store Webcenter pages in directories. The default directories are "Public" and "Private".

Requirement
- The logged in user is a member of the Windows user group "SIMATIC Report Administrators".
- The start page of the DataMonitor is open.

Procedure
1. Click "Webcenter > Administration" on the start page.
2. Click the "Directory administration" tab.
3. Enter a name, such as "mypart", in the "New directory" field.
4. Click the "Create" button.

Result
The directory "mypart" is created. The directories are created in a layer.

Assigning Access Rights

Introduction
Directories are created within the Webcenter in which you store, for example, Webcenter pages. You can assign different access rights for the individual directories to Windows user groups.
The following access authorization is possible:

- Read
- Change
- Create

**Requirement**

- The logged in user is a member of the Windows user group "SIMATIC Report Administrators".
Procedure

1. Click "Webcenter > Administration" on the start page.
2. Click on the "User administration" tab.
3. Select the desired directory from the "Current directory". All existing Windows user groups are listed.
4. Activate the access rights in the line of the required Windows user group.
5. Click "Save".

Result

The access rights for the required directory are configured.
Example: User Groups and Directories

Overview

The user groups "Service" and "Planning" have been created in the following example. The directories "ServiceGroup", "Water" and "ProcessPlans" are created in the Webcenter.

The following table shows which access rights the members of the user groups "Service" and "Planning" have for the following directories:

<table>
<thead>
<tr>
<th>Directory</th>
<th>User group &quot;Service&quot;</th>
<th>User group &quot;Planning&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Public</td>
<td>● Read</td>
<td>● Read</td>
</tr>
<tr>
<td>Private</td>
<td>● Read ● Change ● Create</td>
<td>● Read ● Change ● Create</td>
</tr>
<tr>
<td>ServiceGroup</td>
<td>● Read ● Change ● Create</td>
<td>● Read</td>
</tr>
<tr>
<td>Water</td>
<td>● Read ● Change</td>
<td>No access authorization</td>
</tr>
<tr>
<td>ProcessPlans</td>
<td>No access authorization ● Read ● Change</td>
<td></td>
</tr>
</tbody>
</table>

When a member of the user group "Service" logs in and clicks "Pages" in the Webcenter, the member will see the directories as tabs to which the user group has at least read access. The "Webcenter > Pages" looks as follows for the member "Service_014" of the user group "Service":

![Webcenter screenshot]

The "Webcenter > Pages" looks as follows for the member "Plan_012" of the user group "Planning":

![Webcenter screenshot]
Create connection and set up language

Introduction

For access of the DataMonitor client to runtime data and archived data, configure connections to the WinCC databases in the "Webcenter". For each data source, set up a connection, e.g., to the WinCC server. You need the configured connections for Webcenter pages and "Trends & Alarms".

Requirement

- The user is a member of the Windows user group "SIMATIC Report Administrators".
- For access to the WinCC database via DataMonitor, a Windows user with password is created who is a member of the "SIMATIC HMI VIEWER" user group.
Procedure

1. Click "Webcenter > Administration" on the start page.
2. Click the "Connection Administration" tab.
3. Select the option "New Connection". After the new installation, no selection is possible in the "Connection" box, as no connections have been configured yet.
4. Select the language that corresponds with the linguistic region of the server or archive to be linked in "Linguistic Region". The setting ensures that special national characters are displayed correctly.
5. Enter a name in the "Connection Name" box, such as "WinCC1_Runtime". The name should include a reference to the selected connection type. Do not use any blank spaces or special characters.
6. Enter the computer name on which the archive backup data are stored. As an alternative, select the name of the computer using the "Find" button.
7. Enter the Windows user with password for the connection with the WinCC database.
8. Select the connection type to the WinCC data:
   - "Swapped-out WinCC archive". Additional steps are necessary to access data on
     swapped archives. More information is available under "Connecting or separating
     swapped archives (Page 365)".
   - "WinCC Runtime". Only the open single segment of the Runtime database is used.
   - "CAS". The WinCC data of the central archive server are used.
   - "WinCC Runtime + all segments". The open single segment and all other connected
     segments of the Runtime database are used.

9. Select the database for the connection type:
   - "Swapped-out WinCC archive": Click "Display database" or select the archive from the
     list.
   - "WinCC Runtime" and "CAS": Select the Runtime database of the activated WinCC
     project. As an alternative, select the name of the database using the "Find" button.
   - "WinCC Runtime + all segments": "CC_ExternalBrowsing" is automatically entered as
     database.

10. Activate "Automatic adaptation of RT database" so that the database name is adjusted in
    the connection administration during a segment change.

11. Click the "Create" button.

Result

The connection to the data source is created and can be selected in the "Connection" box of
the connection administration.

See also

- Configuring a symbolic directory (Page 365)
- Connect archives using the WinCC Archive Connector (Page 369)

Connecting or disconnecting swapped archives

Configuring a symbolic directory

Introduction

To access data on swapped-out WinCC archives, these archives must be connected to an
SQL server once again.

You can connect all or individual archive backup files of a directory with the SQL server.

If you want to remove a directory containing archives from the list of symbolic names,
disconnect all archives contained therein.
You see the status of the archives in the tab "Connecting/disconnecting archives".

**Note**

**Connected archives on changeable media**

Before changing the media in the drive you need to disconnect the archives on this medium.

After changing the medium, check whether the archives are connected on the new medium.

**Requirement**

- Archive backup files are write-protected. Create a backup copy of the file before connecting and remove the write-protection of the copied archive backup file.
- The archive backup files are stored on a local drive.
- The directories in which the archive backup files are stored have been released.
  - The directory must be set for sharing in the Windows Explorer before you start the DataMonitor server.
  - Restart the DataMonitor server if you are releasing the directories at a later time.
- The user group "SIMATIC HMI VIEWER" has "Full access" to the directories.
- The logged in user is a member of the Windows user group "SIMATIC Report Administrators".
- "Network service" is added in the "Print operators" group.

**Procedure**

1. Click "Webcenter > Administration" on the start page.
2. Click on the "Archive administration" tab.

   ![CONNECT/DISCONNECT ARCHIVE](image)

3. In the "Symbolic Name" box, enter a unique symbolic name for each directory. The name should only contain characters permitted in the SQL syntax. You use the symbolic name for access via the DataMonitor client.
4. Select the folder which contains the archive backup files. You can only select released directories.
5. To automatically connect all existing archive backup files of the directory, activate "Automatically connect all archives in this directory".

6. To connect individual archive backup files of the directory, deactivate "Automatically connect all archives in this directory".

7. Click "Add".

**Result**

The symbolic directory "Test" is created.

If you have deactivated "Automatically connect all archives in this directory", specify the archive backup files in the "Connecting/disconnecting archives" tab.

To disconnect archives, deactivate the respective archives in the "Connecting/disconnecting archives" tab.

**Connecting or disconnecting archives**

**Introduction**

All archives of a selected archiving directory are displayed on the "Connecting/disconnecting archives" tab. You can connect or disconnect the existing archives.

**Requirement**

- Archive backup files are write-protected. Create a backup copy of the file before connecting and remove the write-protection of the copied archive backup file.
- The logged in user is a member of the Windows user group "SIMATIC Report Administrators".
- A symbolic directory is created, such as "Test".
Procedure

1. Click "Webcenter > Administration" on the start page.
2. Click on the "Connecting/disconnecting archives" tab.

### CONNECT/DISCONNECT ARCHIVE

<table>
<thead>
<tr>
<th>Symbolic directories:</th>
<th>Test</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatically connect all archives in this directory</td>
<td>☑</td>
</tr>
</tbody>
</table>

**List of existing archives**

<table>
<thead>
<tr>
<th>Type</th>
<th>Server name</th>
<th>Project</th>
<th>From</th>
<th>To</th>
<th>Info</th>
</tr>
</thead>
<tbody>
<tr>
<td>TagLogging</td>
<td>AD054699PC</td>
<td>WEBDEMOPROJECTV7</td>
<td>6/26/2010 8:32:00 AM</td>
<td>6/26/2010 5:01:00 AM</td>
<td>Green</td>
</tr>
<tr>
<td>TagLogging</td>
<td>AD054699PC</td>
<td>WEBDEMOPROJECTV7</td>
<td>6/26/2010 8:32:00 AM</td>
<td>6/26/2010 5:01:00 AM</td>
<td>Red</td>
</tr>
<tr>
<td>AlarmLogging</td>
<td>AD054699PC</td>
<td>WebDemoProjectV7</td>
<td>6/26/2010 8:32:00 AM</td>
<td>6/26/2010 5:01:00 AM</td>
<td>Green</td>
</tr>
<tr>
<td>TagLogging</td>
<td>AD054699PC</td>
<td>WEBDEMOPROJECTV7</td>
<td>6/26/2010 8:32:00 AM</td>
<td>6/26/2010 5:01:00 AM</td>
<td>Red</td>
</tr>
<tr>
<td>TagLogging</td>
<td>AD054699PC</td>
<td>WEBDEMOPROJECTV7</td>
<td>6/26/2010 8:32:00 AM</td>
<td>6/26/2010 5:01:00 AM</td>
<td>Green</td>
</tr>
<tr>
<td>AlarmLogging</td>
<td>AD054699PC</td>
<td>WebDemoProjectV7</td>
<td>6/26/2010 8:32:00 AM</td>
<td>6/26/2010 5:01:00 AM</td>
<td>Red</td>
</tr>
<tr>
<td>TagLogging</td>
<td>AD054699PC</td>
<td>WEBDEMOPROJECTV7</td>
<td>6/26/2010 8:32:00 AM</td>
<td>6/26/2010 5:01:00 AM</td>
<td>Green</td>
</tr>
<tr>
<td>TagLogging</td>
<td>AD054699PC</td>
<td>WEBDEMOPROJECTV7</td>
<td>6/26/2010 8:32:00 AM</td>
<td>6/26/2010 5:01:00 AM</td>
<td>Red</td>
</tr>
<tr>
<td>AlarmLogging</td>
<td>AD054699PC</td>
<td>WebDemoProjectV7</td>
<td>6/26/2010 8:32:00 AM</td>
<td>6/26/2010 5:01:00 AM</td>
<td>Green</td>
</tr>
<tr>
<td>TagLogging</td>
<td>AD054699PC</td>
<td>WEBDEMOPROJECTV7</td>
<td>6/26/2010 8:32:00 AM</td>
<td>6/26/2010 5:01:00 AM</td>
<td>Red</td>
</tr>
</tbody>
</table>

3. Select a directory from "Symbolic directories", such as "Test". The available archives are displayed in a list. The "Info" column indicates the status:
   - Green: Connected
   - Red: Disconnected
4. To limit the display, click "Filter".
5. Enter a filter criterion in a column and click ☐. Click ☐ with "From" and "To" to enter a required period of time. Then click ☐.
6. To connect an individual archive, activate the desired archive in the "List of available archives". Click "Save".
7. To disconnect an individual archive, deactivate the desired archive in the "List of available archives". Click "Save".
8. You sort the list entries by clicking on one of the column headers.

Alternative Procedure

To connect archive backup files, you can also use the WinCC Archive Connector. For additional information, refer to "Connecting archives using the WinCC Archive Connector (Page 369)".
Result

The required swapped-out WinCC archives are connected. If you connect signed archives, which have been changed after the swap, a message is output.

Connect archives using the WinCC Archive Connector

Introduction

You use the Archive Connector to reconnect swapped-out WinCC archives with an SQL Server. The Archive Connector has the following functions:

- Manual Connection: Local databases are selected and connected to the local SQL Server.
- Manual disconnection: Connected databases are disconnected from the SQL Server.
- Automatic Connection: Local directories can be selected in which WinCC archives have been exported. After activation of monitoring, all archives added to the directory are automatically connected with the SQL Server.

Note

Connected archives on changeable media

Before changing the media in the drive you need to disconnect the archives on this medium using the Archive Connector. After changing the medium, check in Archive Connector whether the archives are connected on the new medium.

Requirement

- The Archive Connector may only be operated using a local SQL Server and a WinCC/DataMonitor license.
- Archive backup files are write-protected. Create a backup copy of the file before connecting and remove the write-protection of the copied archive backup file.
- The archive backup files are stored on a local drive.
- The directories in which the archive backup files are stored have been released.
- The user group "SIMATIC HMI VIEWER" has "Full access" to the directories.
- The logged in user is a member of the Windows user group "SIMATIC Report Administrators".
Procedure

1. In the "Siemens Automation" program group, select the entry "ArchiveConnector".

2. Click "Add" in the "Configuration" tab. The "New directory" dialog opens.

3. Navigate to the directory in which the archive backup files are stored.

4. Enter a unique symbolic name for the directory. The name should only contain characters permitted in the SQL syntax. You use the symbolic name for access via the DataMonitor client.

5. Click "OK". The directory is displayed on the "Configuration" tab.

6. If you activate the checkbox for a directory in the "Monitored" column, then all archives that are added to the directory from the time of activation are automatically connected to the SQL server.

7. Remove a selected directory again, if necessary. The archives in the directory must already be disconnected. The status of the archives of a directory can be verified on the "Connect/disconnect archives" tab in the "Connected" column.
8. Click on the "Connecting/disconnecting archives" tab. All archives of a selected directory are displayed on the "Connecting/disconnecting archives" tab.

9. Select a directory with archives either from the list of directories or by its symbolic name.
10. Select the required archive and click "Connect".
11. Disconnect the connection of a selected archive, if necessary.

Result

A connection is created and the required archive backup files are connected with the SQL Server.

The "Connecting/disconnecting archives" tab displays the connection status of each archive. "From" and "To" columns contain the archiving period in the local time zone.

The "Type" column contains the details for archive type:
- A - Alarm archive
- TF - Tag Logging Fast
- TS - Tag Logging Slow

If you connect signed archives, which have been changed after the swap, a message is output.
3.2.4.2 Creating static process pictures for the Webcenter

Introduction

In the picture administration you specify which pictures you need for the web part "Static process pictures". The process pictures cannot be operated.

The DataMonitor server creates copies of pictures in a cycle that can be set. The server makes the pictures available as static process pictures on the DataMonitor client.

The following objects are not displayed in the web part "Static process pictures":

- Global Script Diagnostics Window
- WinCC Media Control
- WinCC Controls from migrated projects that have been created with versions prior to WinCC V7.0.

Requirement

- The logged in user is a member of the Windows user group "SIMATIC Report Administrators".
- The WinCC pictures are published for web access. Additional information is available under "Publishing WinCC process pictures (Page 328)".
- The start page of the DataMonitor is open.
- The "Picture administration" tab is open. All published process pictures are listed.
**Procedure**

1. Select the desired pictures.
   - To select all pictures, activate the checkbox in the column header.
   - To select individual pictures, activate the checkbox in front of the required picture.

2. To show only a part of the picture, specify the following:
   - X position: Start positions in x direction in pixels
   - Y position: Start positions in y direction in pixels
   - Height: Height of the picture in pixels
   - Width: Width of the picture in pixels

3. If you have configured and published pictures in different languages, select a language from the list to display the language-specific picture.

4. To output the time when the process picture was created by the DataMonitor server, activate "Stamp". The date and time are displayed in the picture.

5. In order to change the update cycle, enter the desired value in "Update time interval". Select this cycle as large as possible. A cycle that is too small results in limited performance.

6. Click "Save".

**Result**

The DataMonitor server creates static process pictures from the selected pictures. You can configure the static process pictures in the web part "Static process pictures".
Deleting static process pictures

To delete static process pictures, select the checkbox "Delete graphic" for the selected picture name. Click "Save" to delete the static process picture or the copy. You can no longer configure the deleted process picture in the web part "Static process pictures".

Finding picture names or limiting display

Use a filter to find a picture name or limit the display to certain picture names.

When you click with "Filter", the filter is shown above the table. Enter a picture name in the text field or click <Enter>.

To hide the filter, click .

3.2.4.3 Creating layout template for Webcenter pages

Introduction

You need a layout template to create a Webcenter page. Predefined layouts were installed during the installation. Additionally, you can create your own Layout Templates.

Requirement

- The logged in user is a member of the Windows user group "SIMATIC Report Administrators".
- The start page of the DataMonitor is open.

Procedure

1. Click "Webcenter > Configuration" on the start page.
2. Click on the "Creating layout" tab.
3. Define the number of columns and the number of lines.
4. Enter the name in the "Name of the layout file" box, for example, "mylayout_23". Click "Next".

CREATE NEW LAYOUT TEMPLATE.

Create page | Import page | Delete pages | Create layout | Delete layout

Columns: 2
Lines: 3
Name of the layout file: mylayout_23

Continue
5. Combine the table fields, if necessary. To do so, click the desired arrow symbol, such as "Arrow up", in the desired field, for example line 3 / column 1. The modified view will be displayed.
6. To restore the original table layout, click "Reset configuration". Click "Next".

7. Arrange the web parts in the table fields. If necessary, activate the corresponding symbol in a table field to place the web parts vertically or horizontally.

8. Click "Save".

Result

The layout template "mylayout_23" is created. You can use the layout template as a template for creating a Webcenter page.

3.2.4.4 Creating Webcenter page

Introduction

You create Webcenter pages in which you add web parts. The Webcenter pages are stored in directories. In this example, the WebCenter page is saved in the "myPart" directory.

You can only change or create Webcenter pages in directories for which the Windows user group has the "Edit" or "Create" access rights.
Requirement

- The directory "myPart" is set up.
- The logged in user is a member of the Windows user group "SIMATIC Report Administrators" or "SIMATIC Report Users".
- The Windows user groups have the access rights "Edit" or "Create" for the directory.
- The start page of the DataMonitor is open.

Procedure

1. Click "Webcenter > Configuration" on the start page.
2. Click on the "Creating page" tab.
3. Click on the desired layout template. The file name is displayed in the "Layout file" box.
4. Enter a name in the "Webcenter page" box, for example, "My_Webcenter".
5. Select the directory in which the Webcenter page is stored. The selected directory is displayed in the box "Save WebCenter page as".

6. Click "Save".

Result

The Webcenter page "My_Webcenter" is created and saved.

See also

- Inserting web parts to the Webcenter page (Page 379)
- Configuring web parts within Webcenter pages (Page 382)
3.2.4.5 Inserting web parts to the Webcenter page

Introduction
You compile the contents of the Webcenter pages from the web parts.

Requirement
- The directory "myPart" is set up.
- The Webcenter page "My_Webcenter" is stored in the directory.
- The logged in user is a member of the Windows user group "SIMATIC Report Administrators" or "SIMATIC Report Users".
- The Windows user groups have the access rights "Edit" or "Create" for the directory.
- The start page of the DataMonitor is open.

Procedure
1. Click "Webcenter > Pages" on the start page.
2. Click on the "myPart" tab.
3. Click on the entry "My_Webcenter".
4. To add web parts, click at the top right edge of the page. The available web parts are listed.
   If you have exported web parts that have already been configured, they are listed under "Imported web parts". If necessary, insert these web parts into your Webcenter page.

5. Activate the entry "Trend (Timestep)".

6. Select the entry "WPZ_01_01" and click "Add".

7. Activate the entry "Hit list of alarms".
   If you insert several web parts into a table field, the web parts are arranged horizontally or vertically. You specify the arrangement when you create the layout template.

8. Select the entry "WPZ_02_01" and click "Add".

9. Click "Exit".

---

WinCC/DataMonitor

3.2 WinCC/DataMonitor Documentation

---

WinCC Basic Options (WebNavigator, DataMonitor, WebUX)
System Manual, 09/2018, A5E45519660-AA
Result

Web parts to display data are inserted into the Webcenter page "My_Webcenter". The current compilation of the Webcenter page is displayed.

See also

- Overview of Web Parts (Page 323)
- Creating Webcenter page (Page 376)
- Configuring web parts within Webcenter pages (Page 382)
3.2.4.6 Configuring web parts within Webcenter pages

Introduction

To display data from WinCC Runtime or an archive, you must configure the web parts.

Web part configuration

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Open the configuration dialog of the web part</td>
</tr>
<tr>
<td></td>
<td>Deleting the web part</td>
</tr>
<tr>
<td></td>
<td>Minimizing the web part</td>
</tr>
<tr>
<td></td>
<td>Maximizing the web part</td>
</tr>
<tr>
<td></td>
<td>Exporting the web part</td>
</tr>
<tr>
<td></td>
<td>Exporting the configuration of the web part as XML file</td>
</tr>
</tbody>
</table>

Requirement

- The logged in user is a member of the Windows user group "SIMATIC Report Administrators" or "SIMATIC Report Users".
- The Windows user groups have the access rights "Edit" or "Create" for the directory.
- The Webcenter page "My_Webcenter" is open.
- The WinCC project is in Runtime.
Procedure

1. Click in the required web part. The configuration dialog is opened.

2. Configure the web part:
   - Displaying process values in a table (Page 386)
   - Displaying process values in a diagram (Page 387)
   - Displaying alarm hit list (Page 393)
   - Displaying alarms in the alarm table (Page 389)
   - Displaying statistics function for process values (Page 395)

3. To change the position of the web part, move the web part to the desired position with the mouse.
See also

- Creating Webcenter page (Page 376)
- Inserting web parts to the Webcenter page (Page 379)

3.2.4.7 Deleting Webcenter pages and layout templates

Introduction

You can delete layout templates and Webcenter pages that are no longer required.

Requirements - Deleting Layout Templates

- The user is a member of the Windows user group "SIMATIC Report Administrators".
- The start page of the DataMonitor is open.

Requirements - Deleting Webcenter pages

- The logged in user must have "Create" access rights for the directory, in which the page to be deleted is stored.
- The start page of the DataMonitor is open.
Deleting layout templates

1. Click "Webcenter > Configuration" on the start page.
2. Click on the "Deleting layout" tab.
3. Delete the required layout files:
   - To delete several layout files, activate the checkbox "Selection" for the files you want to delete. Click "Delete".
   - To delete all layout files, click "Select All". Click "Delete".
   - To delete individual layout files, click the respective "Delete" button in the "Action" column.

Result

The selected layout file is deleted. You can also delete the supplied layout files. Existing Webcenter pages that are using this layout template are not deleted. You cannot create new Webcenter pages with this layout.

Deleting Webcenter pages

1. Click "Webcenter > Configuration" on the start page.
2. Click on the "Deleting page" tab.
3. Activate the respective check box to mark the pages to be deleted.
4. Click on the "Delete" button.
Result

The selected Webcenter pages are deleted.

3.2.5 Working with trends and alarms

3.2.5.1 Displaying process values in a table

Introduction

Use "Trends & Alarms" to display archived process values and archived texts in a table.

Requirement

- The connection to the WinCC data is established.
- The start page of the DataMonitor is open.

Procedure

1. Click "Trends & Alarms" on the start page.
2. Click the "Process Value Table" tab.
   The Web part "Process Value Table" is displayed.
3. Click . The configuration dialog of the Web part opens.
4. Change the title in the "Title" field. Enter a note in the "Tooltip" field.
5. Select one of the configured connections in the "Connection" field.
   The archive tags available via this connection will be displayed.
   Limit the display of the tags, if necessary:
   - Select individual archives with "Archive selection".
   - Set the filter criteria with "Tag filter".
6. Click "Add" for the required archive tag.
7. Set the time range in the area "Time period".
   With relative times, enter a negative value into the respective field.
   For more information on entering time, click .
   Click "Preview" to check the set time range in the column "Preview Time Range".
8. Specify the number of decimal points in the area "Representation of decimal points".
9. In the "Table size" area, define the size of the display window.
   If the value "0" is entered in both fields, the size is determined automatically. The size
   depends on the space requirement of the Web part.
10. The available Webcenter pages are displayed in the area "Link to Webcenter pages". Click
    to assign the web part to one or several Webcenter pages.
11. Click "OK" to confirm your entries.
Result

The values of the archive tags and the quality code are output in the process value table. If the manual entry of archive values is allowed during runtime, the modified or newly created values are identified as such. There is an "m" in a separate column to show a manual entry of the archive value.

![Process value table example]

Operation:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>In absolute time required to scroll forward or backward in the selected time range.</td>
</tr>
<tr>
<td>Arrow buttons</td>
<td>To scroll forward or backward in multi-page tables.</td>
</tr>
<tr>
<td></td>
<td>Export alarms in CSV format.</td>
</tr>
<tr>
<td></td>
<td>Changing the settings of the Web part.</td>
</tr>
</tbody>
</table>

3.2.5.2 Displaying process values in a diagram

Introduction

Use "Trends & Alarms" to display archived process values in trends.

Requirement

- The connection to the WinCC data is established.
- The start page of the DataMonitor is open.
Procedure

1. Click “Trends & Alarms” on the start page.
2. Click the "Trend (Process Values)" tab. The Web part “Trend (process values)” is displayed.
3. Click the \( \equiv \) . The configuration dialog of the Web part opens.
4. Change the title in the "Title" field. Enter a note in the "Tooltip" field.
5. Select one of the configured connections in the "Connection" field. The archive tags available via this connection will be displayed.
   Limit the display of the tags, if necessary:
   - Select individual archives with "Archive selection".
   - Set the filter criteria with "Tag filter".
6. Click "Add" for the required archive tags, e.g. "TREND_0", "TREND_1", "TREND_2.
   The archive tags are listed in the area "Current selection".
7. In the section "Current selection", you specify for the individual archive tag:
   - Color of time axis and value axis
   - Trend presentation type
8. In the section "Value axis editor", you can activate the automatic scaling for the different value axes or you can assign a minimum and maximum value to each axis.
9. Set the time range in the area "Time period".
   With relative times, enter a negative value into the respective field.
   For more information on entering time, click \( \equiv \).
   Click "Preview" to check the set time range in the column "Preview Time Range".
10. In the section "Diagram settings", you define the size of the display window.
    If the value "0" is entered in both fields, the size is determined automatically. The size depends on the space requirement of the Web part.
11. Activate the option "Show legend" to display the legend.
12. The available Webcenter pages are displayed in the area "Link to Webcenter pages". Click \( \equiv \) to assign the Web part to one or several Webcenter pages.
13. Click "OK" to confirm your entries.
Result

The selected process values are displayed as trends in a diagram.

<table>
<thead>
<tr>
<th>Process value table</th>
<th>Trend (process values)</th>
<th>Alarm table</th>
<th>Hit list of alarms</th>
<th>Statistics functions for process value values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trend (process values)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The legend shows the assignment of the colors to the archive tags.

Operation:

- In absolute time required to scroll forward or backward in the selected time range.
- Enlarge the presentation and diagram range left or right of the center line.
- Restore the original view.
- Exporting values of the displayed diagrams in CSV format
- Changing the settings of the Web part.

3.2.5.3 Displaying messages in the alarm table

Introduction

Use "Trends & Alarms" to display alarms in an alarm table.
**Requirement**

- The connection to the WinCC data is established.
- The start page of the DataMonitor is open.

**Procedure**

1. Click "Trends & Alarms" on the start page.
2. Click on the "Alarm Table" tab.
   The web part "Alarm Table" is displayed.
3. Click 📃. The configuration dialog of the Web part opens.
4. Change the title in the "Title" field. Enter a note in the "Tooltip" field.
5. Select one of the configured connections in the "Connection" field.
6. Set the time range in the area "Time period".
   With relative times, enter a negative value into the respective field.
   For more information on entering time, click 🔄.
   Click "Preview" to check the set time range in the column "Preview Time Range".
7. In the section "Language of the alarm texts", select the language, in which the alarms are displayed.
8. Select the respective WinCC server with "Selection of WinCC server", if necessary. The setting is necessary if you select a connection to swapped archives that include archives of several WinCC servers.
9. In the section "Filter selection", you may limit the expected search results with SQL syntax.
   Set the filter conditions for individual columns to do so.
   Enter the filter condition for all columns in the "Extended Filter" field.
   For more information on filter conditions, click 🔄.
10. For representation of the data set the following:
    - Sort order: For more information on sorting, click 🔄.
    - Visible columns: To display all columns, click "Select All".
    - Number of decimal places.
11. In the "Table size" area, define the size of the display window.
    If the value "0" is entered in both fields, the size is determined automatically. The size depends on the space requirement of the Web part.
12. The available Webcenter pages are displayed in the area "Link to Webcenter pages".
    Click ✗ to assign the Web part to one or several Webcenter pages.
13. Click "OK" to confirm your entries.
Result

The messages are output in a table.

```
<table>
<thead>
<tr>
<th>Number</th>
<th>Status</th>
<th>DateTime</th>
<th>Milliseconds</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>+</td>
<td>4/3/2008 8:59:31 AM</td>
<td>468</td>
<td>Time</td>
</tr>
<tr>
<td>2</td>
<td>+</td>
<td>4/3/2008 8:59:32 AM</td>
<td>125</td>
<td>Time</td>
</tr>
<tr>
<td>3</td>
<td>+</td>
<td>4/3/2008 8:59:32 AM</td>
<td>921</td>
<td>Time</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>4/3/2008 8:59:33 AM</td>
<td>840</td>
<td>Time</td>
</tr>
<tr>
<td>5</td>
<td>-</td>
<td>4/3/2008 8:59:34 AM</td>
<td>365</td>
<td>Time</td>
</tr>
<tr>
<td>6</td>
<td>+</td>
<td>4/3/2008 8:59:35 AM</td>
<td>48</td>
<td>Time</td>
</tr>
<tr>
<td>7</td>
<td>+</td>
<td>4/3/2008 8:59:36 AM</td>
<td>429</td>
<td>Time</td>
</tr>
<tr>
<td>8</td>
<td>+</td>
<td>4/3/2008 8:59:36 AM</td>
<td>500</td>
<td>Time</td>
</tr>
<tr>
<td>9</td>
<td>+</td>
<td>4/3/2008 8:59:36 AM</td>
<td>656</td>
<td>Time</td>
</tr>
<tr>
<td>10</td>
<td>+</td>
<td>4/3/2008 8:59:36 AM</td>
<td>202</td>
<td>Time</td>
</tr>
<tr>
<td>11</td>
<td>+</td>
<td>4/3/2008 8:59:36 AM</td>
<td>203</td>
<td>Time</td>
</tr>
<tr>
<td>12</td>
<td>-</td>
<td>4/3/2008 8:59:36 AM</td>
<td>718</td>
<td>Time</td>
</tr>
<tr>
<td>13</td>
<td>+</td>
<td>4/3/2008 8:59:37 AM</td>
<td>487</td>
<td>Time</td>
</tr>
<tr>
<td>14</td>
<td>+</td>
<td>4/3/2008 8:59:38 AM</td>
<td>488</td>
<td>Time</td>
</tr>
</tbody>
</table>
```

Operation:

- **In absolute time required to scroll forward or backward in the selected time range.**
- **Arrow buttons** To scroll forward or backward in multi-page tables.
- **Export alarms in CSV format.**
- **Changing the settings of the Web part.**

See also

- [Alarm Log Column Names](Page 391)

3.2.5.4 Alarm Log Column Names

Introduction

You can select the alarm log columns while displaying alarms in "Trends & Alarms".
Overview of column names

<table>
<thead>
<tr>
<th>Position</th>
<th>Name</th>
<th>Type</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>MsgNo</td>
<td>Integer 4 Bytes</td>
<td>Message number</td>
</tr>
<tr>
<td>2</td>
<td>State</td>
<td>Small Integer 2 Bytes</td>
<td>Alarm Log Status</td>
</tr>
<tr>
<td>3</td>
<td>DateTime</td>
<td>DateTime 8 Bytes</td>
<td>Time stamp of message (Date/time without milliseconds)</td>
</tr>
<tr>
<td>4</td>
<td>Ms</td>
<td>Small Integer 2 Bytes</td>
<td>Time stamp of message (milliseconds)</td>
</tr>
<tr>
<td>5</td>
<td>Instance</td>
<td>VarChar (255)</td>
<td>Instance Name of the Alarm Log</td>
</tr>
<tr>
<td>6</td>
<td>Flags1</td>
<td>Integer 4 Bytes</td>
<td>(only for internal use)</td>
</tr>
<tr>
<td>7</td>
<td>PValueUsed</td>
<td>Integer 4 Bytes</td>
<td>Process Values used</td>
</tr>
<tr>
<td>8 to 17</td>
<td>PValue1 to PValue10</td>
<td>Real 8 Bytes</td>
<td>Numerical Process Value 1 to 10</td>
</tr>
<tr>
<td>18 to 27</td>
<td>PText1 to PText10</td>
<td>VarChar (255)</td>
<td>Process Value Text 1 to 10</td>
</tr>
<tr>
<td>28</td>
<td>ComputerName</td>
<td>VarChar (255)</td>
<td>Computer Name</td>
</tr>
<tr>
<td>29</td>
<td>Application</td>
<td>VarChar (255)</td>
<td>Application Name</td>
</tr>
<tr>
<td>30</td>
<td>Comment</td>
<td>VarChar (255)</td>
<td>Comments</td>
</tr>
<tr>
<td>31</td>
<td>UserName</td>
<td>VarChar (255)</td>
<td>User Name</td>
</tr>
<tr>
<td>32</td>
<td>Counter</td>
<td>Integer 4 Bytes</td>
<td>Running Alarm Message Counter</td>
</tr>
<tr>
<td>33</td>
<td>TimeDiff</td>
<td>Integer 4 Bytes</td>
<td>Time difference to &quot;Came in&quot; status</td>
</tr>
<tr>
<td>34</td>
<td>ClassName</td>
<td>VarChar (255)</td>
<td>Name of the alarm class</td>
</tr>
<tr>
<td>35</td>
<td>Type name</td>
<td>VarChar (255)</td>
<td>Name of the alarm type</td>
</tr>
<tr>
<td>36</td>
<td>Class</td>
<td>Small Integer 2 Bytes</td>
<td>Message class ID</td>
</tr>
<tr>
<td>37</td>
<td>Type</td>
<td>Small Integer 2 Bytes</td>
<td>Message type ID</td>
</tr>
<tr>
<td>38 to 47</td>
<td>Text1 to Text10</td>
<td>VarChar (255)</td>
<td>Message Text 1 to 10</td>
</tr>
<tr>
<td>48</td>
<td>AG_NR</td>
<td>Small Integer 2 Bytes</td>
<td>Number of the PLC</td>
</tr>
<tr>
<td>49</td>
<td>CPU_NR</td>
<td>Small Integer 2 Bytes</td>
<td>Number of the CPU</td>
</tr>
<tr>
<td>50</td>
<td>CrComeFore</td>
<td>Integer 4 Bytes</td>
<td>Foreground Color for the &quot;Came in&quot; Status</td>
</tr>
<tr>
<td>51</td>
<td>CrComeBack</td>
<td>Integer 4 Bytes</td>
<td>Background Color for the &quot;Came in&quot; Status</td>
</tr>
<tr>
<td>52</td>
<td>CrGoFore</td>
<td>Integer 4 Bytes</td>
<td>Foreground Color for the &quot;Went out&quot; Status</td>
</tr>
<tr>
<td>53</td>
<td>CrGoBack</td>
<td>Integer 4 Bytes</td>
<td>Background Color for the &quot;Went out&quot; Status</td>
</tr>
<tr>
<td>54</td>
<td>CrAckFore</td>
<td>Integer 4 Bytes</td>
<td>Foreground Color for the &quot;Acknowledged&quot; Status</td>
</tr>
<tr>
<td>55</td>
<td>CrAckBack</td>
<td>Integer 4 Bytes</td>
<td>Background Color for the &quot;Acknowledged&quot; Status</td>
</tr>
<tr>
<td>56</td>
<td>LocalID</td>
<td>Integer 4 Bytes</td>
<td>Location of the Alarm</td>
</tr>
<tr>
<td>57</td>
<td>Priority</td>
<td>Integer 4 Bytes</td>
<td>Priority</td>
</tr>
<tr>
<td>58</td>
<td>AP_type</td>
<td>Integer 4 Bytes</td>
<td>Loop-in alarm</td>
</tr>
<tr>
<td>59</td>
<td>AP_name</td>
<td>VarChar (255)</td>
<td>Loop-in-Alarm Function Name</td>
</tr>
<tr>
<td>60</td>
<td>AP_PAR</td>
<td>VarChar (255)</td>
<td>Loop-in-Alarm Screen</td>
</tr>
<tr>
<td>61</td>
<td>InfoText</td>
<td>VarChar (255)</td>
<td>Info text</td>
</tr>
<tr>
<td>62</td>
<td>TxtCame</td>
<td>VarChar (255)</td>
<td>Text came in</td>
</tr>
<tr>
<td>63</td>
<td>TxtWent</td>
<td>VarChar (255)</td>
<td>Text went out</td>
</tr>
<tr>
<td>64</td>
<td>TxtCameNWent</td>
<td>VarChar (255)</td>
<td>Text came in and went out</td>
</tr>
<tr>
<td>65</td>
<td>TxtAck</td>
<td>VarChar (255)</td>
<td>Text acknowledged</td>
</tr>
<tr>
<td>66</td>
<td>AlarmTag</td>
<td>Integer 4 Bytes</td>
<td>Message tag</td>
</tr>
</tbody>
</table>
3.2.5.5 Displaying the hit list of messages

Introduction

Use "Trends & Alarms" to display the hit list of alarms in a table.

Note

The display of alarms in the hit list may take some time and may place a strong load on the CPU. A message is displayed in "Trends & Alarms" if the data volume is too high.

Confirm this message to continue without changes. If you want to reduce the data volume, stop the process and change the filter criteria.

Requirement

- Connection to the WinCC data is established.
- The start page of the DataMonitor is open.

Procedure

1. Click "Trends & Alarms" on the start page.
2. Select the "Hit list of the alarms" tab. The web part "Hit list of the alarms" is displayed.
3. Click . The configuration dialog of the web part opens.
4. Change the title in the "Title" field. Enter a short message in the "Tooltip" field.
5. Select one of the configured connections in the "Connection" field.
6. Set the time range in the area "Time period". With relative times, enter a negative value into the respective field. For more information on entering time, click .
   Click "Preview" to check the set time range in the column "Preview Time Range".
7. In the section "Language of the alarm texts", select the language, in which the alarms are displayed.
8. Select the respective WinCC server with "Selection of WinCC server". The setting is necessary if you select a connection to swapped archives that include archives of several WinCC servers.
9. In the section "Filter selection", you may limit the expected search results with SQL syntax. Set the filter conditions for individual columns to do so. Enter the filter condition for all columns in the "Extended Filter" field. For more information on filter conditions, click .
10. For representation of the data set the following:
   - Sort order: For more information on sorting, click 🛠.
   - Visible columns: To display all columns, click "Select All".
   - Number of decimal places.

11. In the "Table size" area, define the size of the display window.
    If the value "0" is entered in both fields, the size is determined automatically. The size depends on the space requirement of the web part.

12. The available Webcenter pages are displayed in the area "Link to Webcenter pages". Click ✗ to assign the web part to one or several Webcenter pages.

13. Click "OK" to confirm your entries.

**Result**

The analysis values for the alarms are displayed in a hit list.

The table includes configured data and statistical values, such as the frequency of the alarm.

If you move the mouse above the column header, an explanation is displayed in a tooltip.

**Operation:**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📈</td>
<td>In absolute time required to scroll forward or backward in the selected time range.</td>
</tr>
<tr>
<td>Arrow buttons</td>
<td>To scroll forward or backward in multi-page tables.</td>
</tr>
<tr>
<td>📄</td>
<td>Export alarms in CSV format.</td>
</tr>
<tr>
<td>🗑</td>
<td>Changing the settings of the web part.</td>
</tr>
</tbody>
</table>
3.2.5.6 Displaying statistics function for process values

Introduction

Use "Trends & Alarms" to display the statistics functions for process values in a table.

Requirement

- The connection to the WinCC data is established.
- The start page of the DataMonitor is open.

Procedure

1. Click "Trends & Alarms" on the start page.
2. Click on the "Statistics functions for process values" tab. The web part "Statistics functions for process values" is displayed.
3. Click \( \text{Trends & Alarms} \). The configuration dialog of the web part opens.
4. Change the title in the "Title" field. Enter a note in the "Tooltip" field.
5. Select one of the configured connections in the "Connection" field. The archive tags available via this connection will be displayed. You can limit the number of tags displayed using the "Archive selection" and "Tag filter" fields.
6. Click "Add" for the required archive tag.
7. Set the time range in the area "Time period". With relative times, enter a negative value into the respective field. For more information on entering time, click \( \text{Trends & Alarms} \). Click "Preview" to check the set time range in the column "Preview Time Range".
8. For representation of the data set the following:
   - Number of decimal places
   - Aggregate selection: Define the analysis function for the process values.
9. In the "Table size" area, define the size of the display window. If the value "0" is entered in both fields, the size is determined automatically. The size depends on the space requirement of the web part.
10. The available Webcenter pages are displayed in the area "Link to Webcenter pages". Click \( \times \) to assign the web part to one or several Webcenter pages.
11. Click "OK" to confirm your entries.
3.2 WinCC/DataMonitor Documentation

Result

Statistics functions for the selected process values were executed and output in the table.

<table>
<thead>
<tr>
<th>Process value table</th>
<th>Trend (process values)</th>
<th>Alarm table</th>
<th>Hit list of alarms</th>
<th>Statistics functions for process values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>4/3/2008 8:53:03 AM</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>End</td>
<td>4/3/2008 8:53:13 AM</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Link</td>
<td>Conf01_WinCC_Runtime</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

If you move the mouse above the column header, the archive name and the tag name are displayed in a tooltip.

You can export the displayed table in CSV format using the icon.

To change the settings, click.

3.2.6 Working with Excel Workbook

3.2.6.1 Configuring the Excel workbook

Applying data from WinCC project

Introduction

You need the WinCC configuration data for the configuration of Excel workbooks. This means you apply the data from a local WinCC project during configuration in the "Excel Workbook Wizard".
**Requirement**

- Server computer
  - At least Office 2013 is installed.
  - The Excel add-in "Excel Workbook" is installed.
  - The DataMonitor server is installed.
  - The WinCC project is in Runtime.
  - A user is created in WinCC.

- Configuration PC
  - At least Office 2013 is installed.
  - The Excel add-in "Excel Workbook Wizard" is installed.

- MS Office
  - Only Excel files with extensions "XLS, "XLSX, "XLSB", and "XLSM" may be used.

**Procedure**

1. Open an empty Excel workbook.
   Select the command "Excel Workbook Wizard" in the "DataMonitor" menu.

2. Activate the option "Establish connection with WinCC server". The "WinCC Server" box is shown.

3. Enter the desired name of the server and click "Connect". The log in dialog is displayed.

4. Enter the name and password of a WinCC user.

5. Click "Next". The "Add / delete tags" dialog opens.
Result

The Excel workbook is set up to configure the display of process data. Then publish the workbook. The workbook is made available on the DataMonitor client as report tool or as template for "Reports".

Note

Language for the Office package and the Windows Regional Settings

Make sure that the language is the same for the Office package, the "Microsoft Office Language Settings", and the Windows Regional Options.

Example:

- If you are using Office with language "English (U.K.)", select the regional setting "English (United Kingdom)".
- If you have set "Chinese (PRC)" as the region and language option in Windows, you must also select "Chinese (PRC)" as the primary editing language in the "Microsoft Office Language Settings".

More information can be obtained through Microsoft Support: http://support.microsoft.com/kb/320369/en (http://support.microsoft.com/kb/320369/en)

See also

- Configuring the display of tag values (Page 284)
- Configuring the display of archive tags (Page 288)
- Configuring the display of alarms (Page 292)

Applying data from a configuration file

Introduction

You can create reports without connection to the WinCC server.

Configuration steps:

- Create a configuration file on the server.
- Configure data access with the configuration file.
- You can also configure the data access of a dedicated Web server / WinCC client.
Requirement

- Server computer
  - The DataMonitor server is installed.
  - The online tags of the WinCC project are part of one tag group or one structure type.
  - The WinCC project is in Runtime.
  - A user is created in WinCC.
- Configuration PC
  - At least Office 2013 is installed.
  - The Excel add-in "Excel Workbook Wizard" is installed.
- MS Office
  - Only Excel files with extensions "XLS, "XLSX, "XLSB", and "XLSM" may be used.

Creating a configuration file on the server

1. Select the entry "WebNavigator" in the navigation window of WinCC Explorer. Open the menu command "Export Configuration Data" in the shortcut menu.
2. Specify the data to be exported in the "Export configuration data" dialog. If you do not want to create the online tags in one tag group or one structure type, use the "Without structure (fast export)" option for the export.
3. Specify the path and the name of the XML file.
4. Click "Export". An XML file is generated.
5. If no Excel installation exists on the server, transfer the XML file to another computer, on which Excel and the "Excel Workbook Wizard" are installed.

Configuring data access with configuration file

1. Open an empty Excel workbook on the computer with Excel. Select the command "Excel Workbook Wizard" in the "DataMonitor" menu.
2. Activate the option "Load configuration data from file". Click "Next".
3. Navigate to the desired XML file.
4. Click "Next". The "Add / delete tags" dialog opens.

Result

The Excel workbook is set up to configure the display of process data. Then publish the workbook. The workbook is made available on the DataMonitor client as report tool or as template for "Reports".
Configuring data access of a dedicated Web server / WinCC client via XML file

If you want to display the project data from a dedicated Web server / WinCC client in the Excel workbook, you need to observe the following when configuring the Excel workbook via an XML file:

- The XML file now includes the data of subordinate servers whose packages are located on the DataMonitor server. The export of the loaded packages to the dedicated DataMonitor server / WinCC client can take several minutes, depending on the size of the package.
- This XML file must be available on the Excel configuration computer. Enter the server prefix when importing the configuration data in the "Excel Workbook Wizard".
- If you configure the data display in the Excel workbook on the WinCC client in the WinCC project, you do not have to specify a server prefix. The server prefix is automatically used when data is inserted from the package.

Note

Language for the Office package and the Windows Regional Settings

Make sure that the language is the same for the Office package, the "Microsoft Office Language Settings", and the Windows Regional Options.

Example:

- If you are using Office with language "English (U.K.)", select the regional setting "English (United Kingdom)".
- If you have set "Chinese (PRC)" as the region and language option in Windows, you must also select "Chinese (PRC)" as the primary editing language in the "Microsoft Office Language Settings".

More information can be obtained through Microsoft Support: http://support.microsoft.com/kb/320369/en (http://support.microsoft.com/kb/320369/en)

See also

- Configuring the display of tag values (Page 284)
- Configuring the display of archive tags (Page 288)
- Configuring the display of alarms (Page 292)
- Publishing the Excel workbook (Page 297)

Configuring the display of tag values

Introduction

This chapter describes how to configure the display of tag values.

Requirement

- The "Excel Workbook Wizard" is started and an Excel workbook is configured.
- The dialog "Add/delete tags" is open.
Procedure

1. Check the add sequence of tag groups in the "Adding tags" area.

2. Click on . The tag selection dialog opens.

3. Select the required tag and move the tag into a field in the Excel table with drag-and-drop.

4. Close the selection dialog. The tag is displayed in the tag list.
5. Select the tag in the tag list and select the "Server settings" entry in the shortcut menu.

![Server settings dialog]

6. Enter the name and password of a WinCC user in the "Server setting" dialog. To avoid an additional login during online display of process data, enable "Activate automatic login". Confirm your entries with "OK".
7. Select the tag in the tag list and select the "Properties" entry in the shortcut menu. The dialog "Tag properties" will be opened.

8. You set the properties for the display in the table. For example, the update cycle or the display of time stamp and quality code.

9. Specify settings for the headings.

10. You can save the settings to the properties. You can then load the settings and use them again after exiting Excel and opening it again. Click "Save" to save the settings in an "xml" file.

11. Confirm your entries with "OK". If necessary, repeat the procedure for additional online tags. The settings for the properties will be used again. Multiple selection of tags is also possible in the tag list.

12. Click "Next" to display archive tags and alarms. Additional information is available under "Configuring display of archive tags (Page 288)" and "Configuring display of alarms (Page 292)".

Result

The display of tag values is configured in the Excel workbook. Once you have saved the properties, you can use the settings whenever you need to.
Each table field receives a short text and a comment in the Excel workbook. The short text "OV" in tag values stands for online tags. In the comments, the source of the displayed values is shown in the format "WDWO_<number>_<tagname>".

**Note**

**Running the Excel Workbook Wizard again**

You need to run the Excel Workbook Wizard again:

- after deleting or moving cells with configuration data.
- after deleting or inserting new rows or columns in the Excel workbook.

The configuration data is checked and automatically adapted as a result. Confirm the data displayed with "Next". Save the workbook and close Excel.

**Tags with local computer updating are not supported**

In multiple station projects, you can activate the "Computer-local update" option in the tag management for internal tags. Any change of the tags only has an effect on the local computer in this case. This function is not supported by Excel Workbooks.

**See also**

- [Publishing the Excel workbook](Page 297)

**Configuring the display of archive tags**

**Introduction**

This chapter describes how to configure the display of archive tags.

**Requirement**

- The "Excel Workbook Wizard" is started and an Excel workbook is configured.
- The "Add/delete archive tags" dialog is open.
Procedure

1. Click in the dialog "Add/delete archive tags".

   ![Add/Delete Excel Workbook Wizard - Archive tag#]

   **Add archive tags**
   Select a tag from the archive tree and drag it onto your selected cell.
   This operation is not allowed for an entire archive tag group because archive tags may need several sequential cells. The number of these cells depends on the properties 'time window' and 'resolution' of the archive tag.

   **Delete archive tags**
   Delete either a line in the archive list or the comment in the cell.

   **Change the properties of the archive tags display**
   Double-click on the element in the archive tag list, or select 'Properties in the shortcut menu.

<table>
<thead>
<tr>
<th>Tag</th>
<th>Cell</th>
<th>Fill</th>
<th>Time window</th>
<th>Resolution</th>
<th>Server</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

   ![Tag tree:](image)

2. The tag selection dialog opens.
   Select the desired archive tag.
   Drag the tag to a cell in the Excel table with drag-and-drop.

3. Close the selection dialog. The tag is displayed in the tag list.
4. Select the archive tag in the tag list, and select the "Properties" entry in the shortcut menu. The "Archive tag properties" dialog opens.

5. Specify the settings for the insertion sequence and headings.
6. Specify how much data you want to display. For a user-defined resolution, specify an integer number and the time unit or specify the quantity of data.

**Note**

If you use a user-defined data resolution with a combination of "Resolution" and "Quantity of data", it is possible that the amount of extracted data is not correctly determined. This results under certain circumstances in a mismatch between the displayed values and the configured quantity of data.

If you use the option "Quantity of data" in "User-defined resolution", enter an even value in the input box. Even values ensure a trend-true display.

7. In the "Time window" box, specify the time window from which you want to display archive tags:

- The time settings on the "Standard time" tag are based on the standard times:
  - The settings for the relative time period refer to a period starting from the current time. You can enter positive and negative values for the past time period in the lines "From" and "To". For example, it is 12:00 (noon). You want to display the values for the last ten minutes. Activate all time options in the "Relative" line. Enter the value "-10" in the "Minutes" column of the "From" line.
  - For settings of the absolute time period, enter the corresponding time parameters in the "From" and "To" lines and in the corresponding columns. Click on the "Preview" button to check the time range set.

- You can define a time window yourself or set a fixed interval, for example, "last week", on the "Legacy time" tab. If you want to define a time window yourself, you have the following possible settings:
  - Relative time window: Specify the starting point and the duration. You can specify a duration ranging from a minute to days.
  - Absolute time window: Specify the start and end of the time window.

1. If you select the option "Display manually entered values", an additional column is displayed. You then see the letter "m" if an archived value was manually entered during runtime.

2. You can save the settings to the properties. You can then load the settings and use them again after exiting Excel and opening it again. Click "Save" to save the settings in an "xml" file.

3. Confirm your entries with "OK". If necessary, repeat the procedure for additional archive tags. The settings for the properties will be used again. Multiple selection of tags is also possible in the tag list.

4. Click "Next" to display alarms. For more information, refer to "Configuring display of alarms" (Page 292).

**Result**

The display of archive tag values is configured in the Excel workbook. Once you have saved the properties, you can use the settings whenever you need to.

Each table field receives a short text and a comment in the Excel workbook.
The short text "AV" in tag values stands for archive tags. In the comments, the source of the displayed values is shown in the format "WDWA_<number>_<tagname>".

Note

Running the Excel Workbook Wizard again

You need to run the Excel Workbook Wizard again:

- after deleting or moving cells with configuration data
- after deleting or inserting new rows or columns in the Excel workbook

The configuration data is checked and automatically adapted as a result. Confirm the data displayed with "Next". Save the workbook and close Excel.

See also

Publishing the Excel workbook (Page 297)

Configuring the display of alarms

Introduction

This chapter describes how to configure the display of alarms.

Requirement

- The "Excel Workbook Wizard" is started and an Excel workbook is configured.
- The "Add/delete alarms" dialog is open.
Procedure

1. Configure the alarms in the dialog "Add/delete alarms".

   [Image of the Add/Delete Excel Workbook Wizard alarms dialog]

   **Add alarm**
   Click on the desired cell and add a new alarm.
   The "Properties" window automatically opens, where you can configure the alarm.

   **Delete alarm**
   Delete either a row in the alarm list or the comment from the cell.

   **Change alarm properties**
   Double-click on the element in the alarm list or select "Properties" in the context-sensitive menu.

2. Select the required cell in the Excel table.
3. Click 🔄. The "Alarm - properties" dialog opens.

4. On the "Standard configuration" tab, define the display options for alarms in the Excel table.

5. Enter a filter condition in the "Filter string" box or use the selection dialog to define a filter, for example, to display only specific alarms. If the filter contains a date or time, the "Time window" box is disabled.
6. In the "Time window" box, specify the time window from which you want to display alarms:
   - The settings for the relative time period refer to a period starting from the current time. You can enter positive and negative values for the past time period in the lines "From" and "To". For example, it is exactly 12:00. You want to display the alarms for the last ten minutes. Activate all time options in the "Relative" line. Enter the value "-10" in the "Minutes" column of the "From" line.
   - For settings of the absolute time period, enter the corresponding time parameters in the "From" and "To" lines and in the corresponding columns.

Click on the "Preview" button to check the time range set.

7. Use the "Maximum number of alarms" option to limit the number of most recent alarms displayed. You can display maximum 1,000 messages.
8. On the "Attributes" tab, select the required attributes of the alarms that you want to display. Further details can be found in "Alarm attributes (Page 417)".

9. Specify the settings for the attribute insertion sequence and headings.

10. You can save the settings to the properties. You can then load the settings and use them again after exiting Excel and opening it again. Click "Save" to save the settings in an "xml" file.

11. Confirm your entries with "OK". If necessary, repeat the procedure for additional alarms. The settings for the properties will be used again. Multiple selection of alarms is also possible in the "Alarm list".
12. Click "Next". The "Description" dialog box opens.

13. You can enter a comment if needed. This comment is displayed when selecting files provided for download by the DataMonitor server.

**Result**

The display of alarms is configured in the Excel workbook. Once you have saved the properties, you can use the settings whenever you need to.

Each table field receives a short text and a comment in the Excel workbook.

The short text for alarms is "AL". In the comments, the source of the displayed alarm is shown in the format "WDWL_<number>_<box name>".

---

**Note**

**Running the Excel Workbook Wizard again**

You need to run the Excel Workbook Wizard again:

- after deleting or moving cells with configuration data
- after deleting or inserting new rows or columns in the Excel workbook

The configuration data is checked and automatically adapted as a result. Confirm the data displayed with "Next". Save the workbook and close Excel.

---

**See also**

[Publishing the Excel workbook](#) (Page 297)

---

**Publishing the Excel workbook**

**Introduction**

You make the configured Excel workbooks available on the DataMonitor client. The workbooks are published as report tool for the Intranet/Internet or used as template for "Reports".

**Requirement**

- The DataMonitor server is installed on the computer.
- The display of tag values, archive values and alarms is configured.
- The "Description" dialog is open in the "Excel Workbook Wizard".
Procedure

1. You make the workbooks available in the "Description" dialog.

   ![Excel Workbook Wizard description](image)

   Press the Publish button, in order to make your Excel worksheet available on the Web.

   Press the Template button, in order to make your Excel worksheet available as template for reports.

   DataMonitor server must be installed.

   - Publish
   - Template

   - Files are automatically updated when opening a workbook.

2. If you click "Publish", the Excel workbook is made available on the DataMonitor client under "Report tools" in "Reports".
   If you click "Template", the Excel workbook is made available on the DataMonitor client as template in "Reports" under "Excel Workbooks".

3. Exit the Excel Workbook-Wizard.

4. Save the workbook and close Excel.

Alternative Procedure

You upload the Excel workbooks on the DataMonitor client. Additional information is available under "Making Excel workbooks available as template" (Page 419) and "Making Excel workbooks available as report tool" (Page 420).
Result

The Excel workbooks are made available on the DataMonitor client:

- The workbook is available on the "Report tools" tab. You can use the workbook to display process data in runtime. For more information, refer to "Displaying process data in an Excel workbook (Page 415)".
- You can create time-controlled and event-controlled reports using the workbook as template. For more information, refer to "Creating reports with an Excel workbook (Page 423)".

See also

- Configuring the display of tag values (Page 284)
- Configuring the display of archive tags (Page 288)
- Configuring the display of alarms (Page 292)

3.2.6.2 Displaying process data in an Excel workbook

Introduction

You can display process values or archive values and alarms in an available Excel workbook. You can edit and save the workbook.

Requirement

- The Excel workbooks were made available as report tool.
- MS Excel for online display in the Excel workbook
- The DataMonitor server is installed.
- The WinCC project is in Runtime.
- The start page of the DataMonitor is open.
- A user is created in WinCC.
Procedure

1. Click "Reports" on the start page.

2. Click "Report tools". You see the Excel workbooks that you have published in the Excel Workbook Wizard or made available as report tool.

3. Select a workbook.

4. Double-click the icon of the Excel workbook.

5. In the dialog that follows, click "Open". The workbook is opened.

6. Select the entry "Excel Workbook" in the "DataMonitor" menu.

7. The name of the server whose process data are configured in the workbook is displayed in the "WinCC server" field. The "WinCC Server" field can include the following information:

   - Access via domain: The server name and the domain are listed for access outside the network domain.
   - The DataMonitor start page is the default web page: The "WinCC Server" field contains only the server name.
   - The DataMonitor start page is in the virtual folder: The server name and the name of the virtual folder are displayed, e.g. "/webnavigator".

8. If the tags in the Excel sheet are from several servers, activate "all servers". The tag values of all servers are updated in the online display.

   Note
   To establish connections to all servers, activate "all servers" with "Connect" before you establish the connections.

9. Activate the connection to the WinCC project via the button "Connect". After a successful connection, the log-in dialog will be opened. Type in the user name and associated password. In case of several servers, the log-in dialogs of the respective servers open one after the other.

   If a connection was not established, a corresponding alarm is displayed. Clicking on the dialog will display additional information about the error that has occurred.

   Note
   Do not close the "Excel Workbook" dialog as long as the log-in dialog for connection establishment to the server is still open.
10. The connection status will be displayed in the dialog. Click the "Read tags", "Read archive tags" and "Read alarms" buttons to update the respective values or displays.

11. Activate the check box "Read cyclically" to update the tag values in cycles.

12. Close the "Excel Workbook" dialog after finishing your calculations in Excel.

13. Save the results in the workbook with the "Save as" menu command.


**Result**

The process data are displayed in the Excel workbook and can be processed further. If errors occur during display of the Excel workbook or no connection to the WinCC server is established, the log entries are displayed in a workbook. The entries contain the date, the tags or alarms affected, the server, and the error message.

**See also**

Administering users for DataMonitor (Page 338)

### 3.2.6.3 Alarm Attributes

**Introduction**

When displaying alarms in "Excel Workbook" you can select the attributes to be displayed in the table in the "Excel Workbook Wizard".
### Overview

<table>
<thead>
<tr>
<th>Position</th>
<th>Attribute</th>
<th>Type</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Name of the alarm class</td>
<td>VarChar (255)</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Name of the alarm type</td>
<td>VarChar (255)</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Foreground color</td>
<td>Integer 4 Bytes</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Background color</td>
<td>Integer 4 Bytes</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Flash color</td>
<td>Integer 4 Bytes</td>
<td></td>
</tr>
<tr>
<td>6 to 15</td>
<td>Message Text 1 to 10</td>
<td>VarChar (255)</td>
<td></td>
</tr>
<tr>
<td>16 to 25</td>
<td>Process value 1 to 10</td>
<td>Real 8 Bytes</td>
<td>Numerical Process Value 1 to 10</td>
</tr>
<tr>
<td>26</td>
<td>State</td>
<td>VarChar (255)</td>
<td>Status text</td>
</tr>
<tr>
<td>27</td>
<td>Info text</td>
<td>VarChar (255)</td>
<td></td>
</tr>
<tr>
<td>28</td>
<td>Message class ID</td>
<td>Integer 4 Bytes</td>
<td></td>
</tr>
<tr>
<td>29</td>
<td>Message type ID</td>
<td>Integer 4 Bytes</td>
<td></td>
</tr>
<tr>
<td>30</td>
<td>AS Number</td>
<td>Small Integer 2 Bytes</td>
<td></td>
</tr>
<tr>
<td>31</td>
<td>CPU Number</td>
<td>Small Integer 2 Bytes</td>
<td></td>
</tr>
<tr>
<td>32</td>
<td>Duration</td>
<td>Integer 4 Bytes</td>
<td>Time difference to &quot;Came in&quot; status</td>
</tr>
<tr>
<td>33</td>
<td>Alarm counter</td>
<td>Integer 4 Bytes</td>
<td>Consecutive alarm counter</td>
</tr>
<tr>
<td>34</td>
<td>Acknowledgment Status</td>
<td>VarChar (255)</td>
<td>Text of the acknowledgement status</td>
</tr>
<tr>
<td>35</td>
<td>Priority</td>
<td>Integer 4 Bytes</td>
<td></td>
</tr>
<tr>
<td>36</td>
<td>Application</td>
<td></td>
<td>Application with which the comment was created.</td>
</tr>
<tr>
<td>37</td>
<td>Computer</td>
<td>VarChar (255)</td>
<td>Computer on which the comment was created.</td>
</tr>
<tr>
<td>38</td>
<td>Users</td>
<td>VarChar (255)</td>
<td>User who created the comment.</td>
</tr>
<tr>
<td>39</td>
<td>Comments</td>
<td>VarChar (255)</td>
<td></td>
</tr>
</tbody>
</table>

#### 3.2.6.4 VBA Functions of the Excel Workbook

**VBA Functions of the Excel Workbook**

The following functions are available to you in an Excel workbook if you have generated an instance of the Excel workbook object using the "Application.COMAddIns.Item("ExcelWorkbook.Connect").Object":

- **ShowDialog(0):**
  Opens the "Excel Workbook" dialog with a normal size.

- **ShowDialog(1):**
  Opens the "Excel Workbook" dialog with a minimized size.

- **ShowDialog(2):**
  Opens the "Excel Workbook" dialog hidden.

- **CloseDialog:**
  Closes the "Excel Workbook" dialog.

- **GetServerID(server name):**
  Gets the ID of the WinCC server with a specified name, for example: "http://Local_PC".
• Connect(ServerID):
  Connects the specified WinCC server to the Excel workbooks. You can get the "ServerID" using the "GetServerID(server name)" function.
  The “Excel Workbook” dialog must be opened before establishing a connection.

• ConnectAll:
  Connects all WinCC servers to Excel workbooks. The "Excel Workbook" dialog must be opened before establishing a connection.

• Disconnect(ServerID):
  Disconnects the Excel workbook from the specified WinCC server.

• DisconnectAll:
  Disconnects the Excel workbook from all WinCC servers.

• ReadTags(ServerID):
  Reads the tags from WinCC server with "ServerID". The connection must be established before tags can be read.

• ReadArchives(ServerID):
  Reads the archives from WinCC server with "ServerID". The connection must be established before archives can be read.

• ReadAlarms(ServerID):
  Reads the alarms from the WinCC server with "ServerID". The connection must be established before alarms can be read.

As soon as a connection is established or closed, the event "ServerConnected(ServerID)" or "ServerDisconnected(ServerID)" is output by the "ExcelWorkbook.Connect" object. These events can be integrated, for example, using "WithEvents" (VB standard).

### 3.2.7 Working with reports

#### 3.2.7.1 Making an Excel workbook available as template

**Introduction**

You can make Excel workbooks available as templates to create "Reports". For this you have the following options:

- You publish the Excel workbooks on the WinCC server with "Excel Workbook Wizard" using the "Template" button.
- You upload an Excel workbook not yet published to the DataMonitor client.

This page includes a description of how you make a template available on a DataMonitor client.

**Requirement**

- The Excel workbook is created.
- The file size of the Excel workbook is less than 4 MB.
- The start page of the DataMonitor is open.
Procedure

1. Click "Reports" on the start page.
2. Click the "Upload templates" tab.

![Image of upload template interface]

3. Select a directory, in which the template will be stored in the "Target directory" field. Only the directories, for which the user that is logged in has "Create" access rights, can be selected.
4. Click "Find" for the "Selected template". Navigate to the desired Excel workbook.
5. Click the "Upload" button.

Result

You can create time-controlled and event-controlled reports using the workbook as template.

See also

- Assigning Access Rights (Page 359)
- Displaying a report with an Excel Workbook (Page 423)
- Configuring the Excel workbook (Page 280)

3.2.7.2 Making an Excel workbook available as a report tool

Introduction

You can make Excel workbooks centrally available as report tools in "Reports". For this you have the following options:

- You publish the Excel workbooks on the WinCC server with "Excel Workbook Wizard" using the "Publish" button.
- You upload an Excel workbook not yet published to the DataMonitor client.
Here you find a description of how you make an Excel workbook not yet published available on the DataMonitor client.

Requirement

- The Excel workbook is created.
- The file size of the Excel workbook is less than 4 MB.
- The start page of the DataMonitor is open.

Procedure

1. Click "Reports" on the start page.
2. Click the "Upload templates" tab.
3. Click "Find" for "Uploading templates for Excel workbooks". Navigate to the desired Excel workbook.
4. Click the "Upload" button.

Result

The workbook is available on the "Report tools" tab. You can use the workbook to display process data in runtime.

See also

Displaying process data in an Excel workbook (Page 415)
3.2.7.3 Making Settings for Reports

Introduction

Different settings are required for using the "Reports" function in DataMonitor.

Requirement

- PDF Reader is installed.
- The WinCC project is activated on the DataMonitor server.
- The option "Report Runtime" is activated in the WinCC project in the properties of the computer.
- The start page of the DataMonitor is open.

Procedure

1. Click "Reports" on the start page.
2. Click on the "Settings" tab. The "Settings" page is displayed.
3. Check the entries in the section "General project settings".
   You can now select the printer of the Web server. Printing is only possible in files.
4. To enable the output to a PDF file, activate the option "Activate API print".
5. Enter the data for sending mail in the "Mail" area:
   - Server: Outgoing mail server (SMTP)
   - User name: Name for the sender
   - Password
   - Sender: E-mail account used to sending the e-mail

6. Click the disk icon in the section "General project settings" to save your settings.

7. In the "Settings of the circular buffer" area, you can define the number of created reports that are stored in the selected destination directory. The box has a pre-assigned value of 20. If the maximum number of reports of the same type has been reached, the "First in First out" principle applies. For example, if 21 reports of "Alarm Table" type have been created, the report that was created first is removed.

8. Click the disk icon in this section to save your settings.

Result

The settings for "Reports" have been made.

Product support - example

FAQ "51334611" on the Internet under "Product support" gives a detailed example:


See also

Sending WinCC/DataMonitor reports by e-mail (http://support.automation.siemens.com/WW/view/de/5134611)

3.2.7.4 Displaying a report with an Excel Workbook

Introduction

Use "Reports" to create reports from Excel workbooks or print jobs in PDF format. The following is a description for creating reports from Excel workbooks.

Note

Information on event-controlled "Excel Workbooks"

An event-controlled report is only created if the time period in which the tag changes is greater than one minute.

Keep in mind that the frequent creation of one or more event-controlled reports over a long period of time takes up a lot of memory and uses up valuable resources. This case occurs, for example, with frequent signal changes of a tag that triggers an event-controlled report.
**Requirement**

- The WinCC project is activated on the DataMonitor server.
- The option "Report Runtime" is activated in the WinCC project in the properties of the computer.
- You have already published or made available as templates the Excel workbooks you want to use.
- The start page of the DataMonitor is open.

**Procedure**

1. Click "Reports" on the start page.
2. Click on the "Excel Workbooks" tab. The "Excel Workbooks" page is displayed. The icons in front of "List of time-controlled Excel workbooks" and "List of event-controlled Excel workbooks" are deactivated. The icons indicate that no reports are currently configured.
3. Select one of the available Excel workbooks under "Available Excel workbooks".
4. Select the target directory in which you want to store the reports. Only the directories, for which the user that is logged in has "Create" access rights, can be selected.
5. If you want to send the report as an e-mail, enter the e-mail addresses in the "E-mail recipient" field. You can enter several recipients as you would with any standard e-mail program.
6. Use the button to create the report immediately.
7. If you do not want to create the report immediately, configure a time-controlled or event-controlled creation of the report in the following steps.

8. To configure a time-controlled report, enter the following in the "Time-controlled Excel workbooks" area:
   - Date: Enter the date in the respective field or enter the date using the calendar. To open the calendar, click the "Calendar" icon.
   - Time: Define the time when you want the report to be created.
   - Repetition: Define the repetition rate, for example, "Once" or "Weekly".

9. Click "Add" in the "Time-controlled Excel workbooks" area.
   The report is displayed in the "List of time-controlled Excel workbooks".

10. To configure an event-controlled report, enter the following in the "Event-controlled Excel workbooks" area:
    - Selected WinCC tag:
      Click 📝. Select the required tag in the selection dialog.
      Use the filter to limit the number of tags displayed.
    - Defining event control:
      Set the triggering event, for example, when the tag value changes.
      If you have selected "lower limit", "upper limit" or "both limits" for event control, enter the respective limits.

11. Click "Add" in the "Event-controlled Excel workbooks" area.
   The report is displayed in the "List of event-controlled Excel workbooks".

Result

A time-controlled or event-controlled report is configured as "Excel Workbook".

The configured reports are displayed in the lists of the "Excel Workbooks". You can edit or delete the reports in the lists.

Once the report has been created, it is available in runtime on the "Published Reports" tab in the selected directory.

See also

Making an Excel workbook available as template (Page 419)
Publishing the Excel workbook (Page 297)
3.2.7.5 Creating a report with a print job

Introduction

Use "Reports" to create reports from Excel workbooks or print jobs in PDF format. The following is a description for creating reports using print jobs in PDF format.

Note

Opening Asian PDF files with Acrobat Reader

To open Asian PDF files created with "Reports", you need the country-specific version or the respective font package of Adobe Acrobat Reader.

The four Asian languages are each permanently associated with one font. This means the font settings in the report layout will not have an effect on the Asian languages.

Information on event-controlled print jobs

An event-controlled print job is only created if the time period in which the tag changes is greater than one minute.

Keep in mind that the frequent creation of one or more event-controlled print jobs over a long period of time takes up a lot of memory and uses up valuable resources. This case occurs, for example, with frequent signal changes of a tag that triggers an event-controlled print job.

Requirement

- PDF Reader is installed.
- The WinCC project is activated on the DataMonitor server.
- The option "Report Runtime" is activated in the WinCC project in the properties of the computer.
- The start page of the DataMonitor is open.
Procedure

1. Click "Reports" on the start page.

2. Click on the "Print jobs" tab.
   The "Print jobs configuration" page is displayed.
   The icons in front of "List of time-controlled print jobs" and "List of event-controlled print jobs" are deactivated. The icons indicate that no print jobs are currently configured.

3. Select the desired print job under "Available print jobs".

4. Select the target directory in which you want to store the reports.
   Only the directories, for which the user that is logged in has "Create" access rights, can be selected.

5. If you want to send the report as an e-mail, enter the e-mail addresses in the "E-mail recipient" field. You can enter several recipients as you would with any standard e-mail program.

6. Use \ to create the report immediately.

7. If you do not want to create the report immediately, configure a time-controlled or event-controlled creation of the report in the following steps.

8. To configure a time-controlled report, enter the following in the "Time-controlled print jobs" area:
   - Date: Enter the date in the respective field or enter the date using the calendar. To open the calendar, click the "Calendar" icon.
   - Time: Define the time when you want the report to be created.
   - Repetition: Define the repetition rate, for example, "Once" or "Weekly".

9. Click "Add" in the "Time-controlled print jobs" area.
   The report is displayed in the "List of time-controlled print jobs".
10. To configure an event-controlled report, enter the following in the "Event-controlled print jobs" area:

- **Selected WinCC tag:**
  Click 📇. Select the required tag in the selection dialog.
  Use the filter to limit the number of tags displayed.

- **Defining event control:**
  Set the triggering event, for example, when the tag value changes.
  If you have selected "lower limit", "upper limit" or "both limits" for event control, enter the respective limits.

11. Click "Add" in the "Time-controlled print jobs" area.
   The report is displayed in the "List of event-controlled print jobs".

**Result**

A time-controlled or event-controlled report is configured as print job in PDF format.

The configured reports are displayed in the lists of the print jobs. You can edit or delete the reports in the lists.

The report is created in the language that was set during WinCC configuration. The WinCC Runtime language does not have an effect on the representation of dynamic elements, such as tables.

Once the report has been created, the PDF files are available in runtime on the "Published Reports" tab in the selected directory.
WinCC/WebUX

4.1 WinCC/WebUX - Documentation

4.1.1 WebUX - Overview

Overview

WinCC/WebUX provides a solution for operator control and monitoring of the automation system independent of device and browser.

In the interests of process security, only HTTPS connections are supported with SSL certificates.

The employed Web technology results in restrictions to the WinCC basic system. Some Graphics Designer objects and their properties are not supported. You can find additional information under:

- Functions supported in WebUX (Page 438)

Distinction WebUX - WebNavigator

<table>
<thead>
<tr>
<th>WinCC/WebUX</th>
<th>WinCC/WebNavigator</th>
</tr>
</thead>
<tbody>
<tr>
<td>Based on generally established Web standards</td>
<td>Based on ActiveX technology from Microsoft</td>
</tr>
<tr>
<td>Can be used regardless of browser.</td>
<td>Only supports Microsoft Internet Explorer</td>
</tr>
<tr>
<td>Runs on a wide variety of devices, regardless of</td>
<td>Runs only on Windows computers.</td>
</tr>
<tr>
<td>operating system, for example on tablets, PCs</td>
<td></td>
</tr>
<tr>
<td>and smart phones.</td>
<td></td>
</tr>
<tr>
<td>Does not require a client installation.</td>
<td>Requires a client installation.</td>
</tr>
<tr>
<td>Default user rights are sufficient</td>
<td>Requires administrative rights to install.</td>
</tr>
</tbody>
</table>

Visualization in WebUX

WinCC pictures and the supported WinCC controls are displayed in the Web browser with the “HTML5” and “SVG” standards:

- The graphic elements are created with SVG elements.
- The dynamic updating of the process picture is performed via a permanent connection between the browser and server.
Note

Browser-dependent representation

Minor differences in display and behavior are possible for the different browser versions.

To display a configured character set, for example, this must also be available in the browser or on the device.

Working with WebUX

In order to use WinCC/WebUX, following these steps:

1. **Install WinCC and WinCC/WebUX on the WebUX server** (Page 434)
2. **Set up a WebUX website** (Page 436)
3. **Configure a WinCC project for WebUX** (Page 448)
4. **Access the WebUX server with the terminal device** (Page 450)

Performance data

The performance of the WebUX system depends on the employed hardware of the WebUX server and the volume of graphic objects and scripts.

**Configuration**

As a typical scenario, we tested the simultaneous access of 100 WebUX clients to one WebUX server.

**Picture change in Runtime:**

The performance on a WebUX client basically corresponds to the behavior on a WinCC client. However, the load times during picture changes on a WebUX client are influenced by the following factors:

- Number of WebUX clients that access the WebUX server simultaneously
- Performance of the WebUX clients
- Utilized browser
  - Depending on the browser, the picture setup time can vary by several seconds. Additional information on tested browsers is available on the Internet on the Customer Support pages under entry ID =109480708:
- Number of scripts in the process pictures
  - Unlike with WinCC clients, all scripts are executed on the WebUX server.
- Number of graphic objects in the process pictures
- Type of graphic objects in the process pictures
  - Web controls can extend the load times.
Note
Connection loss due to performance load
High performance load can result in a timeout. The connection of the WebUX client to the WebUX server is disconnected as a result.

WinCC/WebUX V7.3: Migration
To use a project migrated from V7.3 in WebUX V7.4 and higher, convert the process pictures and project functions.
You can find additional information in the WinCC Information System under: "First Steps > Migration > Additional Steps".

See also
- Functions supported in WebUX (Page 438)
- Configuring the WebUX website (Page 436)
- Configuring a WinCC project for WebUX (Page 448)
- How to use WebUX (Page 450)
- http://support.automation.siemens.com/WW/view/de/109480708

4.1.2 WebUX licensing
The WinCC/WebUX basic package with an integrated WinCC WebUX Monitor license is included in WinCC.

WebUX client
The WebUX clients are licensed on the WebUX server.
No license is required for the WebUX client on the computer.

WebUX server
The WebUX server is installed on a WinCC system. The WinCC basic system requires at least the WinCC basic RT license.
The license keys are differentiated as described below and run in parallel on the WinCC/WebUX server:

<table>
<thead>
<tr>
<th>License</th>
<th>Function</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>WinCC WebUX Monitor</td>
<td>The user has only read access.</td>
<td>The authorization level 1002 &quot;Web access - monitoring only&quot; is configured for the user in the User Administrator. If the available &quot;Monitor&quot; licenses have been allocated, an &quot;Operate&quot; license or a WebNavigator license can also be allocated to a WebUX client for read access.</td>
</tr>
<tr>
<td>WinCC WebUX Operate</td>
<td>User has read and write access</td>
<td>If the available &quot;Operate&quot; licenses have been allocated, a WebNavigator license can also be allocated to a WebUX client for read or write access.</td>
</tr>
<tr>
<td>WinCC/WebNavigator</td>
<td>The user's authorizations determine whether write access is possible in addition to read access.</td>
<td>If a WinCC/WebNavigator license is also installed in the WinCC system, the WebNavigator license can also be allocated to a WebUX client. First, however, all available WebUX licenses are used.</td>
</tr>
</tbody>
</table>

License packages
The license packages are available with 1, 3, 10, 30 and 100 clients.
If you have upgraded from WebUX V7.3, there may also be licenses for 5 / 25 / 50 / 150 clients.
If the number of licensed clients is exceeded during the logon attempt by a WebUX client, no further logon is permitted.
The packages are version-independent and can be combined.

Reserved license
A reserved WebUX license always gives the user guaranteed access to the WebUX server.
A connection remains reserved for the user. The number of freely available WebUX licenses is reduced by each configured reserved license.

Applications
Possible applications include:
- Remote operator access:
  If the connections to the WebUX server are occupied by read-only access, a connection remains reserved for operation.
- Central display:
  Central client stations are always connected, for example, to display the status of the WinCC system.

Reserve WebUX license
In the User Administrator, you assign one of the available licenses to a WebUX user as a reserve license.
To do this, enable the "Reserve WebUX license" option for the user. The field "WebUX Number of reserved licenses" shows how many WebUX licenses are assigned through reservation.
Reserved licenses cannot be configured for user groups, only for individual users.
If more reserved licenses are configured than those available on the WebUX server, the licenses of the first users logged on are used.

4.1.3 Communication: SSL certificate for HTTPS connections

To improve the security of your communication, WebUX only supports HTTPS connections. You need a digital SSL certificate for the WebUX server. You can find more information in the Microsoft Support under "How to Set Up an HTTPS Service in IIS":

- http://support.microsoft.com/kb/324069

| NOTICE |
| Protecting the infrastructure |
| Setting up a Web server may enable access to your plant infrastructure. Therefore, protect the computer on which the Web server is installed. Make sure that the following rules are followed: |
| - The computer is only accessible via secure connections. |
| - The check mechanisms provided by software vendors are activated and cannot be bypassed under any circumstances. |

Install a SSL certificate

You have the following options when setting up the WebUX website:

- Select an existing certificate
- Create self-signed certificates:
- Install a certificate after setting it up

Creating a new certificate

1. Activate the "Create a new certificate" option.
2. Enter a name of your choice.
When the configuration is completed, a self-signed certificate is created. The certificate is valid for one year.

**Note**

**Restricted authentication**

The certificates that you create when you configure the WebUX website itself are not verified by an official certification body. Depending on your browser settings, a warning message is displayed when you access the website.

To better secure the server authentication, install the certificate of an official certification body.

**Display of secure data sources only**

For display of websites and external files, one of the following conditions must be met:

- Call via the HTTPS connection
- Call of a trusted site

---

**See also**

- Configuring the WebUX website (Page 436)
- [http://support.microsoft.com/kb/324069](http://support.microsoft.com/kb/324069)

---

**4.1.4 Installation of WebUX**

**Software requirements**

Certain requirements concerning operating system and software configuration must be met for the installation.

**WebUX server: Operating system**

<table>
<thead>
<tr>
<th>Software</th>
<th>Configuration</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 10</td>
<td>Pro</td>
<td>Standard installation</td>
</tr>
<tr>
<td></td>
<td>Enterprise</td>
<td>64-bit</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Only a limited number of connections is possible. A maximum of three WebUX clients can connect to the WebUX server.</td>
</tr>
<tr>
<td>Windows 10</td>
<td>Enterprise LTSB (Long-Term Servicing Branch)</td>
<td>Standard installation</td>
</tr>
<tr>
<td></td>
<td></td>
<td>64-bit</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Only a limited number of connections is possible. A maximum of three WebUX clients can connect to the WebUX server.</td>
</tr>
<tr>
<td>Windows Server 2012 R2</td>
<td>Standard Datacenter</td>
<td>64-bit</td>
</tr>
<tr>
<td>Windows Server 2016</td>
<td>Standard Datacenter</td>
<td>64-bit</td>
</tr>
</tbody>
</table>
### Additional software requirements

<table>
<thead>
<tr>
<th>Version / setting</th>
<th>Relevant for</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Web browser</strong></td>
<td>The browser must support HTML5.</td>
<td>WebUX client / terminal</td>
</tr>
<tr>
<td><strong>WinCC version</strong></td>
<td>WinCC V7.5</td>
<td>WebUX server</td>
</tr>
<tr>
<td><strong>SIMATIC Logon version (optional)</strong></td>
<td>SIMATIC Logon V1.6</td>
<td>WebUX server</td>
</tr>
<tr>
<td><strong>User rights for installation</strong></td>
<td>Administrator rights</td>
<td>WebUX server</td>
</tr>
<tr>
<td><strong>User rights for operation</strong></td>
<td>Default user rights</td>
<td>WebUX client WebUX server</td>
</tr>
</tbody>
</table>
| **Microsoft Internet Information Service (IIS)** | WWW Services > Common HTTP Features or Shared HTTP Features:  
- HTTP error  
- HTTP redirect  
- Standard document  
- Static content  
WWW Services > Performance Features:  
- Compression of dynamic content  
- Compression of static content  
WWW Services > Application Development Features (only for Windows Server 2012):  
- WebSocket protocol | WebUX server | The WebUX server requires the Microsoft Internet Information Service (IIS). Enable the settings listed for the IIS. |

### WebUX client (terminal)

You only need a HTML5-enabled Web browser such as Chrome, Firefox, Internet Explorer or Safari on a terminal that accesses the WebUX server.

### Installation of the WebUX server

You can install WinCC/WebUX together with WinCC.

When you install the server WebUX at a later time, proceed as follows:

1. Start the WinCC installation DVD.
2. Select the installation type "Custom Installation".
3. In the "WinCC" group of the "Program" dialog, select the entry "WinCC WebUX".
4. Transfer the WebUX license. You can find additional information under:
   - **WebUX licensing** (Page 431)

After the installation and restarting the PC, the WinCC WebUX Configurator opens.
You can find information about configuring WebUX under:

- Configuring the WebUX website (Page 436)

See also

- WebUX licensing (Page 431)
- Communication: SSL certificate for HTTPS connections (Page 433)
- Configuring the WebUX website (Page 436)

4.1.5 Configuring the WebUX website

Configure the WebUX website on the WebUX server and the connection via HTTPS to communicate with the WebUX clients.

WinCC WebUX Configurator

After WinCC and WinCC/WebUX are installed, the WinCC WebUX Configurator opens.

To make changes later, you can find the WinCC WebUX Configurator in the "Siemens Automation" program group.

You use the WebUX Configurator to set up the standard configuration for the use of WebUX.

- Configuration of the Microsoft Internet Information Service
- Settings of the Web server
- SSL certificate for HTTPS connections
- Virtual folder

Read the information about digital certificates at:

- Communication: SSL certificate for HTTPS connections (Page 433)

Creating virtual folders

During the course of initial configuration, you specify whether you wish to create a new default website or a new virtual directory.

If you would like to set up the website as a virtual directory, at least one website with activated SSL encryption must be present on the PC. The websites that meet this criterion are shown in the "Select the higher level website" selection list.

Procedure: Use virtual folders

1. Configuration
   Select a higher-level website.
   The WebUX Configurator takes the port number and the SSL settings from the IIS settings.

2. Access from the terminal (WebUX client):
   To access the website, add the name of the virtual directory to the URL in the browser.
Requirement

- Microsoft Internet Information Service (IIS) is installed.
- The WinCC basic system is installed.
- The “WinCC WebUX” program package is installed.
- The “WinCC WebUX” license is installed.

Procedure

After installing WinCC/WebUX and restarting the PC, the WinCC WebUX Configurator opens.

1. Click "Apply configuration".
   The standard configuration is set up.
   The "IIS configuration" dialog opens.
2. Enter a name for the website.
3. If you only operate the WebUX web page on the server, select the "Create a new website" option.
   If you work with virtual folders, proceed to step 6.
4. Enter the number of the port used for access in the "Port" field.
   The HTTPS standard port "443" is set by default.
   If you select a different port number, the address must be adapted on the WebUX client:
   When logging on to the terminal, this number is added into the browser address bar after
   the server name.
5. Select the settings for the digital certificate of the server.
6. If you set up the website as a virtual directory, select a higher level website.
   The WebUX Configurator takes the port number and the SSL settings from the IIS settings.
7. Confirm with "OK".
8. When the configuration has been set up, click "Exit".
9. Restart the computer.

Result

The WebUX server has been configured and the WebUX website set up.

The WinCC project must be activated in Runtime in order to access the WebUX server.

See also

Communication: SSL certificate for HTTPS connections (Page 433)
msdn.microsoft.com/de-de/library/ms751408(v=vs.110).aspx)
4.1.6 Functions supported in WebUX

4.1.6.1 Functions supported in WebUX

Restrictions compared to WinCC Runtime

The following restrictions apply as compared to the range of functions in WinCC:

- Touch operation is not optimized. You can, however, use all touch gestures supported by WinCC.
- Design settings are not supported. Note that the global design is activated by default in WinCC projects.
- Not all objects or properties are supported for graphic objects. (For details, see “Supported functions: Graphic objects (Page 438)"
- Only the SVG library as of "IndustryGraphicLibraryV2" is supported. The symbol library and the "IndustryGraphicLibraryV1" SVG library are not supported.
- Not all controls or functions are supported for WinCC ActiveX controls. (For details, see “Supported functions: WinCC Controls (Page 441)"
- Dynamization (for details, see “Supported functions: Dynamization (Page 445)"
  - Global script: ANSI-C is not supported.
  - Global script: VBScript is supported with restrictions.
  - Dynamics dialog: Restrictions for complex formulas or scripts.
  - Dynamization via the Dynamic Wizard is not supported.

All unsupported objects are hidden in WebUX.

You can find detailed information in the following sections.

See also

- Configuring a WinCC project for WebUX (Page 448)
- Supported functions: WinCC Controls (Page 441)
- Supported functions: Dynamization (Page 445)
- Supported functions: Graphic objects (Page 438)

4.1.6.2 Supported functions: Graphic objects

WebUX supports most of the graphic objects.

You can find additional information on limitations in the dynamization of object properties on the Customer Support pages on the Internet under entry ID=109481796:

Restrictions for all Graphics Designer objects

The following restrictions apply to all graphic objects in WebUX:

<table>
<thead>
<tr>
<th>Property</th>
<th>Restriction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print function</td>
<td>Not supported.</td>
</tr>
<tr>
<td>Global design</td>
<td>Not supported.</td>
</tr>
<tr>
<td>Grouped objects</td>
<td>The &quot;Tooltip Text&quot; object property is not supported.</td>
</tr>
<tr>
<td>Customized objects</td>
<td>Not supported.</td>
</tr>
<tr>
<td>Standard objects</td>
<td>The line ends do not flash.</td>
</tr>
<tr>
<td>Image / background image</td>
<td>The following graphic formats are not supported:</td>
</tr>
<tr>
<td></td>
<td>● EMF</td>
</tr>
<tr>
<td></td>
<td>● WMF</td>
</tr>
<tr>
<td>Preconfigured text lists and graphics lists</td>
<td>Not supported. Object properties that are connected with lists of the “Text and graphics lists” editor are not dynamized in WebUX Runtime.</td>
</tr>
<tr>
<td>Font</td>
<td>The selected character set must be available on the WebUX client.</td>
</tr>
<tr>
<td></td>
<td>This applies to all object properties with which a character set is selected.</td>
</tr>
<tr>
<td></td>
<td>Font / FontName / HeaderFont / NavigationPathFont / StatusbarFont</td>
</tr>
<tr>
<td></td>
<td>Exception:</td>
</tr>
<tr>
<td></td>
<td>The WebUX client always loads the &quot;FontAwesome&quot; and &quot;Siemens Sans&quot; fonts</td>
</tr>
<tr>
<td></td>
<td>from the WebUX server.</td>
</tr>
</tbody>
</table>

Object properties

The following object properties are generally not supported:

<table>
<thead>
<tr>
<th>Object property</th>
<th>OLE Automation Name</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configured languages</td>
<td>DataLanguage</td>
<td></td>
</tr>
<tr>
<td>Draw inside frame</td>
<td>DrawInsideFrame</td>
<td>The border lines are always drawn inside the frame.</td>
</tr>
<tr>
<td>Global color scheme</td>
<td>GlobalColorScheme</td>
<td></td>
</tr>
<tr>
<td>Global shadow</td>
<td>GlobalShadow</td>
<td>The shadow is not sketched.</td>
</tr>
<tr>
<td>LocalID property</td>
<td>LocaleID</td>
<td></td>
</tr>
<tr>
<td>Server name</td>
<td>ServerName</td>
<td></td>
</tr>
<tr>
<td>Time Base</td>
<td>TimeBase</td>
<td>The local time zone is always displayed, regardless of the project properties.</td>
</tr>
<tr>
<td>WinCC style</td>
<td>WinCCStyle</td>
<td>The object is shown according to the respective settings instead.</td>
</tr>
<tr>
<td>Windows style</td>
<td>WindowsStyle</td>
<td></td>
</tr>
</tbody>
</table>

Supported Graphics Designer objects

<table>
<thead>
<tr>
<th>Standard object</th>
<th>WebUX</th>
<th>Unsupported properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>All objects except for &quot;Connector&quot;</td>
<td>Yes</td>
<td>see &quot;Restrictions for all Graphics Designer objects&quot;</td>
</tr>
<tr>
<td>Connector</td>
<td>No</td>
<td>The connector is handled in the same way as the static object &quot;Line&quot;. The ends of a line can have a different design.</td>
</tr>
<tr>
<td>Smart object</td>
<td>WebUX</td>
<td>Unsupported properties</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------</td>
<td>------------------------</td>
</tr>
<tr>
<td>Application window</td>
<td>Yes</td>
<td>• Can only be used for script diagnostics. The &quot;Application&quot; property is not supported.</td>
</tr>
</tbody>
</table>
| Picture window            | Yes   | • Window mode (WindowPositionMode)  
|                           |       | • Monitor number (WindowMonitorNumber)  
|                           |       | • Independent window (IndependentWindow)  
|                           |       | • Menu/Toolbar configuration (MenuToolBarConfig) |
| Control                   | No    | -                      |
| OLE object                | No    | -                      |
| I/O field                 | Yes   | • Clear on New Input (Internet Explorer only)  
|                           |       | • Apply on Full Input  
|                           |       | • Clear on Invalid Input  
|                           |       | • Limited cursor movement (RestrictedCursorMovement) |
| Bar                       | Yes   | -                      |
| Graphic Object            | Yes   | • Picture referenced (PicReferenced) |
| Status display            | Yes   | • Basic picture transparent color (BasePicTransparentColor)  
|                           |       | • Basic picture referenced (BasePicReferenced)  
|                           |       | • Flash picture referenced (FlashPicReferenced) |
| Text list                 | Yes   | • Maximum of 512 entries  
|                           |       | • Text reference (LanguageSwitch): Disable the "Text reference" property. When switching languages, only the texts saved in the "Text list" object are displayed. Texts from the Text Library are not displayed. |
| Multiple row text         | Yes   | • No input possibility |
| Combo box                 | Yes   | • Maximum of 512 entries |
| List box                  | Yes   | • Maximum of 512 entries |
| Faceplate instance        | No    | -                      |
| .NET Control              | No    | -                      |
| WPF Control               | No    | -                      |
| 3D bar                    | No    | -                      |
| Group Display             | No    | -                      |
| SVG object                | Yes   | As of V2.0 of the "IndustryGraphicLibrary" SVG library, the dynamization of SVG library objects is supported. The symbol library and the "IndustryGraphicLibraryV1" SVG library are not supported. |
| Status display (extended) | No    | -                      |
| Analog display (extended) | No    | -                      |
| DataSet object            | No    | -                      |
### Windows object

<table>
<thead>
<tr>
<th>Windows object</th>
<th>WebUX</th>
<th>Unsupported properties ¹)</th>
</tr>
</thead>
<tbody>
<tr>
<td>All objects</td>
<td>Yes</td>
<td>see “Restrictions for all Graphics Designer objects”</td>
</tr>
</tbody>
</table>
| Button         | Yes   | ● Picture on referenced (PicDownReferenced)  
                             ● Picture off referenced (PicUpReferenced) |
| Round Button   | Yes   | ● Picture Deact. Referenced (PicDeactReferenced)  
                             ● Picture on referenced (PicDownReferenced)  
                             ● Picture off referenced (PicUpReferenced) |
| Slider object  | Yes   | ● Visualize tag status (ShowBadTagState)  
                             ● High limit color (HighLimitColor)  
                             ● Low limit color (LowLimitColor) |

### Tube object

<table>
<thead>
<tr>
<th>Tube object</th>
<th>WebUX</th>
<th>Unsupported properties ¹)</th>
</tr>
</thead>
<tbody>
<tr>
<td>All objects</td>
<td>Yes</td>
<td>see “Restrictions for all Graphics Designer objects”</td>
</tr>
</tbody>
</table>

¹) Restrictions for all Graphics Designer objects are not listed again.

### See also

- Functions supported in WebUX (Page 438)
- Supported functions: WinCC Controls (Page 441)
  

### 4.1.6.3 Supported functions: WinCC Controls

#### WinCC ActiveX Controls

Most ActiveX controls are executable as Web controls in WebUX.

Restrictions on individual controls are listed below.

<table>
<thead>
<tr>
<th>WinCC ActiveX Control</th>
<th>WebUX Control</th>
<th>Restriction ¹)</th>
</tr>
</thead>
<tbody>
<tr>
<td>WinCC AlarmControl</td>
<td>WinCC Alarm Web Control</td>
<td>Yes</td>
</tr>
<tr>
<td>WinCC OnlineTableControl</td>
<td>WinCC OnlineTable Web Control</td>
<td>Yes</td>
</tr>
<tr>
<td>WinCC OnlineTrendControl</td>
<td>WinCC OnlineTrend Web Control</td>
<td>Yes</td>
</tr>
<tr>
<td>WinCC FunctionTrendControl</td>
<td>WinCC FunctionTrend Web Control</td>
<td>Yes</td>
</tr>
<tr>
<td>WinCC RulerControl</td>
<td>WinCC Ruler Web Control</td>
<td>Yes</td>
</tr>
<tr>
<td>WinCC Slider Control</td>
<td>WinCC Slider Control</td>
<td>Yes</td>
</tr>
<tr>
<td>WinCC Digital/Analog Clock Control</td>
<td>WinCC Digital/Analog Clock Control</td>
<td>Yes</td>
</tr>
<tr>
<td>WinCC Gauge Control</td>
<td>WinCC Gauge Control</td>
<td>Yes</td>
</tr>
<tr>
<td>WebBrowser Control</td>
<td>WebBrowser Control</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Unsupported WinCC controls:
ActiveX controls in WebUX: Restrictions

The following limitations apply to Web controls.

You can find additional information on limitations of object properties on the Customer Support pages on the Internet under entry ID=109481796:


<table>
<thead>
<tr>
<th>Restriction applies to the following controls</th>
<th>Unsupported functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>All WinCC controls</td>
<td>• Object events</td>
</tr>
<tr>
<td>WinCC Alarm Web Control</td>
<td>• Exporting Runtime data</td>
</tr>
<tr>
<td>WinCC OnlineTable Web Control</td>
<td>• Online configuration in Runtime</td>
</tr>
<tr>
<td>WinCC OnlineTrend Web Control</td>
<td>• Operator authorization for the key functions in the toolbar</td>
</tr>
<tr>
<td>WinCC FunctionTrend Web Control</td>
<td>• Configuring the key functions of the toolbar in Runtime</td>
</tr>
<tr>
<td>WinCC Ruler Web Control</td>
<td>• Print function</td>
</tr>
<tr>
<td></td>
<td>• VBScript: No methods</td>
</tr>
<tr>
<td>WinCC OnlineTrend Web Control</td>
<td>• Trend selection</td>
</tr>
<tr>
<td>WinCC FunctionTrend Web Control</td>
<td>• User scaling</td>
</tr>
<tr>
<td></td>
<td>• Displaying trends:</td>
</tr>
<tr>
<td></td>
<td>– The trend type “Display values”</td>
</tr>
<tr>
<td></td>
<td>– Color coding of a value with uncertain status</td>
</tr>
<tr>
<td>WinCC FunctionTrend Web Control</td>
<td>• Data from user archives</td>
</tr>
</tbody>
</table>

1) Restrictions for all Graphics Designer objects are not listed again (see “[Supported functions: Graphic objects](Page 438)”).
<table>
<thead>
<tr>
<th>Restriction applies to the following controls</th>
<th>Unsupported functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>WinCC Alarm Web Control</td>
<td>• Message blocks</td>
</tr>
<tr>
<td></td>
<td>– Daylight saving/standard time</td>
</tr>
<tr>
<td></td>
<td>– Archiving</td>
</tr>
<tr>
<td></td>
<td>– Logging</td>
</tr>
<tr>
<td></td>
<td>– Class priority</td>
</tr>
<tr>
<td></td>
<td>– Frequency</td>
</tr>
<tr>
<td></td>
<td>– Sum +/-, Sum +/-1, Sum +/-2, Sum +/-</td>
</tr>
<tr>
<td></td>
<td>– Average +/-, Average +/-1, Average +/-2, Average +/-</td>
</tr>
<tr>
<td></td>
<td>– Apply project settings</td>
</tr>
<tr>
<td></td>
<td>• Acknowledging a central signaling device</td>
</tr>
<tr>
<td></td>
<td>• Configuration of the filter in Runtime</td>
</tr>
<tr>
<td></td>
<td>• Configuration of the lock list in Runtime</td>
</tr>
<tr>
<td></td>
<td>• User-defined sorting of the displayed messages</td>
</tr>
<tr>
<td></td>
<td>• Paging through long-term archive list</td>
</tr>
<tr>
<td></td>
<td>• The contents of each of the &quot;Class&quot;, &quot;Type&quot;, &quot;Date&quot; and &quot;Time&quot; columns are displayed in one common column.</td>
</tr>
<tr>
<td></td>
<td>• SQL statements for filtering messages in AlarmControl</td>
</tr>
<tr>
<td>WebBrowser Control</td>
<td>• Only HTTPS connections are possible. You can find additional information under &quot;Displaying files in the Web browser control&quot;.</td>
</tr>
<tr>
<td></td>
<td>• The browse dialog for locating the URL is not offered.</td>
</tr>
<tr>
<td></td>
<td>• Depending on the Web browser, unsupported buttons and functions are grayed out.</td>
</tr>
<tr>
<td>WinCC Slider Control</td>
<td>• Position font (FontPosition)</td>
</tr>
<tr>
<td>Restriction applies to the following controls</td>
<td>Unsupported functions</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-----------------------</td>
</tr>
</tbody>
</table>
| WinCC Digital/Analog Clock Control          | • Selection border (FocusRect)  
|                                             | • Foreground color (ForeColor)  |
| WinCC Gauge Control                         | • Maximum angle (AngleMax)  
|                                             | • Minimum angle (AngleMin)  
|                                             | • Background color (Back Color)  
|                                             | • Background graphic (BackgroundPicture)  
|                                             | • Background style (BackStyle)  
|                                             | • Inner frame (BevelInner)  
|                                             | • Outer frame (BevelOuter)  
|                                             | • Frame width (BevelWidth)  
|                                             | • Border width (BorderWidth)  
|                                             | • Scale center point size (CenterScale)  
|                                             | • Frame color (FrameColor)  
|                                             | • Frame picture (FramePicture)  
|                                             | • Frame scale (FrameScale)  
|                                             | • Decimal point (ShowDecimalPoint)  
|                                             | • Dial offset (TicOffset)  
|                                             | • Dial text offset (TicTextOffset)  
|                                             | • Dial width (TicWidth)  |

### Displaying files in the Web browser control

To display a file in the Web browser control, follow these steps:

1. Save the file in a subfolder in the following path
   - `C:\inetpub\wwwroot\siemens\WebRH\public\<folder>`
2. Use the following call in the Web browser control:
   - `https://<server name>/<folder>/<file name>`

**Example**

The PDF file "WinCC.pdf" is located in the subfolder "WebUXFiles":
- `C:\inetpub\wwwroot\siemens\WebRH\public\WebUXFiles`

Call using the following URL:
- `https://localhost/WebUXFiles/WinCC.pdf`
Note
No access restrictions for the "public" folder

Note that files in the "C:\inetpub\wwwroot\siemens\WebRH\public" folder can be accessed by all users.

The WinCC authorizations do not have an effect on the files in this folder.

See also

Functions supported in WebUX (Page 438)

4.1.6.4 Supported functions: Dynamization

Dynamization via scripts and the Dynamics dialog

WebUX supports graphics objects in which the following dynamics are configured:

- Trigger
- Tag connection
- Direct connection
- Dynamics dialog
  Dynamics via the Dynamics dialog are converted to VBScript.
- VBS action
Restrictions

The following restrictions apply to the dynamization:

- **VBScript:**
  - Scripts cannot open interactive applications, for example, MS Excel. The function is disabled by restrictions of the operating system.
  - WebUX Web controls do not support methods. Instead, address the elements of the controls through an assigned index.
  - The following methods are not supported:
    - "HMIRuntime.Stop" to end WinCC Runtime
    - "item.Activate" to activate a picture or picture element
  - Triggering the animation via the "Animation cycle" trigger type is not supported.
  - Calling message fields with the "MsgBox" function is suppressed. (Messagebox)
  - The VBS object "DataSet" must only include global variables with a scalar data type, e.g. "BOOL", "DOUBLE", "LONG INT".
  - OLE automation data types are not processed, e.g. "VARIANT" or an Excel table.
  - Some object properties cannot be made dynamic or use a different value format. You can find additional information on this on the Customer Support pages on the Internet under entry ID=109481796:

- **Dynamics dialog:**
  - Complex formulas and scripts are not supported.

- **Dynamic Wizard:**
  - Dynamization via the Dynamic Wizard is not supported.

- **ANSI-C:**
  - C actions are not supported.

- **The behavior of the "Focus Change" event is different to that in WinCC Runtime.**

**Note**

**Scripts always run on the WebUX server**

Scripts are not executed locally on a WebUX client. Scripts that run locally on a WinCC client are executed on the WebUX server in the case of access via WebUX.

This means that the following factors can affect the WebUX server performance:

- Number of running scripts
- Number of WebUX clients accessing the server

If necessary, reduce the scripts in the process pictures that are saved for WebUX.

**Dynamization via the Dynamics dialog**

The configuration of the Dynamics dialog is converted to VBScript for the display in the Web browser. The restrictions for complex formulas or scripts apply here ([Details (Page 451)]).
The conversion takes place automatically when you save the process picture.
If the configuration cannot be implemented, the object and the dynamic property are listed in
the output window.
You can jump from the message to the property and adapt the Dynamics dialog there.

---

**Note**

**Script adaptation overwrites dynamization**
If you adapt the dynamization in VBScript, the dynamization is overwritten in the Dynamics
dialog.
The modified process pictures can then be displayed in WinCC Runtime. This also applies to
the representation on WinCC clients and WinCC servers.

---

**Procedure**

1. Double-click on the object property listed in the output window of the Graphics Designer or
   select the object in the process picture.
2. Open the shortcut menu for the dynamic property listed in the message.
3. Select the entry "VBS action".
   A message indicates that the change is stored permanently for the dynamization of the
   property.
   After the message is confirmed, the "Edit VB action" editor opens.
   The script comments contain more information on the formulas that are not automatically
   converted.
4. Check the script and save the changes.
   When you close the editor without saving the script, the original dynamization is retained
   via the Dynamics dialog.

---

**See also**

[Functions supported in WebUX](Page 438)

4.1.7 Configuring a WinCC project for WebUX

Introduction

To use WinCC/WebUX on the terminal devices, the WinCC project must be configured accordingly:

- The WebUX users are set up.
- The process pictures are optimized for viewing on the Web.

Note

Windows 10: Limited number of WebUX clients

IIS on Windows 10 supports a maximum of ten connections or instances. WebUX requires more than one connection for a client. Therefore, a maximum of three WebUX clients can connect to the WebUX server.

If the limit is exceeded, you can no longer operate the instances already connected.

Use a server operating system for Web applications with multiple WebUX clients.

Setting up WebUX users

You can also set up and manage users and user groups via SIMATIC Logon.

However, you always configure the settings for accessing the WebUX server in the WinCC User Administrator.

You can find additional information in the WinCC Information System under:

- Structure of the User Administration > Administering users > Administering users for Web access

Automatic login

You can configure automatic login for the following users:

- Monitor user role
  Users with the authorization level 1002 "Web access - monitoring only"
- Operator user role
  Users who are authorized to control the WebUX project

When you first log into WinCC/WebUX, activate the setting that saves the login data.

The user name and password are automatically entered at the next login.

Adjust process pictures for WebUX

To configure the display in WebUX, select the "Web-enabled" object property for the process pictures.

The pictures are additionally saved in "*.rdf" format. In the WinCC Explorer, however, only the process pictures in the "*.pdf" format are displayed.
Checking the process picture

When a process picture is saved as web-enabled, the properties of the picture and the objects are checked.

The result is shown in the output window of the Graphics Designer. Make sure that the following option is activated: "Tools > Settings > Options > Display performance warnings".

The messages included a list of graphic objects that have not been saved web-enabled for each process picture. Double-click on the entry in the output window to edit the objects.

Only web-enabled objects are displayed in WebUX Runtime.

For this, refer to the information under:

- Functions supported in WebUX (Page 438)

Configuring the WinCC project for WebUX use

1. Configure the process pictures as executable for Web browsers in the Graphics Designer:
   - Select "Yes" for the "Web-enabled" object property in the "Miscellaneous" group.
   - Save the process picture.
   - If necessary, check the messages in the output window.

2. Configure the WebUX users in the WinCC User Administrator:
   - Activate the "WebUX" option in the properties.
   - Select the start picture from the list of process pictures that have been saved as "Web-enabled".
   - Select the Runtime language.
     The runtime language cannot be changed at the terminal.
   - If the user should be restricted to read-only access, select the authorization level 1002 "Web access - monitoring only".
   - If guaranteed access should be reserved for the user, activate the "Reserve license" option.

Configuring the dedicated WebUX server

With WinCC/WebUX, you can use a dedicated Web server for the central data supply of the WebUX clients.

Note the following requirements for this:

- WinCC/WebUX must be installed on the dedicated WebUX server.
- The WebUX start picture must be available locally on the dedicated WebUX server.
- Additional process pictures can only be called via a picture window in the start picture.

Configure the following object properties for the object "Picture Window":
   - "Picture Name (PictureName)"
     Configure the picture name without server prefix.
   - "Server Prefix (ServerPrefix)"
     Configure the server prefix for the dedicated WebUX server.
You can find additional information on using a dedicated Web server in the documentation for WinCC/WebNavigator:

- Possible applications of WinCC/WebNavigator > Dedicated Web Server

See also

Functions supported in WebUX (Page 438)

4.1.8 How to use WebUX

Introduction

To use WinCC/WebUX on the terminals, you only need a Web browser with access to the network of the WebUX server.

Note

Windows 10 on the WebUX server: Limited number of WebUX clients

IIS on Windows 10 supports a maximum of ten connections or instances. WebUX requires more than one connection for a client. Therefore, a maximum of three WebUX clients can connect to the WebUX server.

If the limit is exceeded, you can no longer operate the instances already connected.

Operation in Runtime

Note the following:

- Before you exit the browser, close the session to return an allocated license.
- Close the browser to reduce the power consumption and the transferred data volumes, particularly when using mobile devices.
  As long as a process picture is open in the browser, its display will be constantly updated.
- Avoid the following operator inputs because they would end the session:
  - Browser navigation (Back / Next)
  - Reload website (Refresh or <F5>)

Requirements

- The "WinCC WebUX" license installed on WebUX server.
- The WinCC project is configured for WebUX.
- The WinCC project is in Runtime.
Procedure

1. Go to the address bar of the browser and enter the address of the WebUX server.
   – https://<servername>
   If you do not use the default port, add the port number to the URL:
   – https://<servername>:<portnummer>
   If you are using a virtual folder instead of a website, add the name of the virtual Web folder:
   – https://<servername>/<directoryname>

2. Type in the user name and password.

Result

Depending on the user rights, you can observe or operate the WinCC project.

4.1.9 Appendix

4.1.9.1 Dynamics dialog Restrictions on expressions / formulas

When you save a process picture for WinCC/WebUX, the dynamization of the Dynamics dialog is converted to VBScript.

Complex expressions and formulas cannot be converted during the conversion. When you open the affected dynamization as VBScript, you can obtain detailed information in the Global Script Editor.

The following operators and formulas are not converted as a rule:

- Expressions with C function
- Assignment operators: ^= %= /= &= |= += -= ^=
- Bitwise operators: & | ^ ~
- Additional operators: << >> ? : ++ -- /
- Logical operators if the expression is in parentheses: (&& || !)
- Logical operators for the "Analog" data type: (&& || !)
- Logical operators for the "Direct" data type for properties that belong to the "BOOLEAN" data type: (&& || !)

========================================
## Index

| Domain | 19 |
| Domain-global user group | 31 |
| Domains | 19 |
| Driver |
  | Unsigned, 33 |

### E

| E-mail attachment |
| Report, 304, 422 |
| Energy-saving mode | 56 |
  | Network adapter, 56 |
| Error report |
  | (See support) |
| Event display | 44 |

### Example

| Access right to directories | 362 |
| Excel templates |
  | Publishing data, 302, 419 |
| Excel workbook, (See Excel workbooks) |
  | VBA functions, 418 |
| Excel Workbook Wizard, 280, 284, 288, 292, 296, 400, 404, 408, 417 |
| Excel workbooks, 279, 325 |
  | Access via an XML file, 279, 325 |
  | Alarm attributes, 417 |
  | Configuring the display of process data, 284, 288, 292, 400, 404, 408 |
  | Connection status, 299, 415 |
  | Displaying Process Data Online, 299, 415 |
  | Make available as report tool, 303, 420 |
  | Online access, 279, 325 |
| External application | 50 |
| External applications | 49 |

### F

| FAQ, (See corrective measure), (See support) |
| File |
  | Unsigned, 33 |
| File sharing | 27 |
| Firewall, 26, 56 |
  | Configuring, 251, 344 |
  | Windows 2008, 149, 198, 252, 346 |
  | Windows 7, 149, 198, 252, 346 |
| Folder, 27, (See: Folder) |
  | Released folders, 27 |
| Folder share, 28, (See: Folder share) |
| Function |
  | Opening the picture window, 241 |
  | Supported functions, 233 |
  | Supported MSBC functions, 233 |

### Supported ODK Functions | 233 |
### Supported User Archives functions, 233 |
### Unsupported functions | 243 |

### G

| Gadget | 185 |
| General information | 50 |
| Getting started, 146, 149, 159, 161 |
  | Changing the process picture, 159, 161 |
  | Configuring the WebNavigator Server, 149 |
| Global Script |
  | Use in WebNavigator, 207 |

### H

| Hardcopy | 223 |
| Hardware |
  | Requirement, 83, 96 |
| Hardware Requirement | 17 |
| Hit list of alarms | 393 |

### I

| IIS, (See Internet Information Service) |
| Image painting time | 77 |
| Installation, 9, 33, 36, 53, 79, 81 |
  | Adapting Security Policy, 33 |
  | Component, 36, 40 |
  | Connectivity Pack Client, 81 |
  | Connectivity Pack Server, 79 |
  | Domain, 19 |
  | Internet Information Service, 103 |
  | Multilanguage, 53 |
  | Notes on installed software, 36 |
  | PDF files, 9 |
  | Performing, 36, 47 |
  | Performing supplementary installation, 40, 41 |
  | Preparing the installation, 33 |
  | Removing, 44 |
  | Requirement, 83, 96, 101 |
  | Requirements, 16, 17, 19 |
  | Security settings, 110, 152 |
  | Supplementary installation of a language, 41 |
  | Upgrade, 105, 106 |
  | Upgrading an installation, 47 |
  | WebNavigator Client, 110, 152 |
  | WebNavigator Diagnostics Client, 113 |
  | WebNavigator server, 105 |
| Installation Guide | 9 |
| Installation Notes | 9 |
Installed software, 36
Internet Explorer, 19, 55, 94, 118, 213
  Display ActiveX controls, 55
  Security settings, 110, 152, 261, 348
Internet Information Service, 103, 192
  Checking the activated web page, 151, 200
  Starting a web page, 151, 200
IP address, 56
ISDN router, 56
Isolated solution, 165

L
Language
  Performing supplementary installation, 41
Language-dependent text, 210
Languages, 76
Layout
  Print barcode, 66
Layout template
  Create, 312, 374
  Delete, 384
License, 11, 99
  DataMonitor, 90
  Installation, 11
  Invalid, 91
  Reserved WebUX license, 121, 432
  WebNavigator diagnostics client, 99
License Agreement, 11
License type, 11
Load balancing, 200
  Configuring, 203
  Load distribution, (See Load Balancing)

M
Manual detachment, 56
Microsoft Message Queuing, 34, 78
  MSMQ Server, 34, 78
Microsoft SQL Server, 56
Microsoft SQL Server 2014, 11, 13, 44
Microsoft SQL Server, 24
Migration, 76
Mitsubishi Ethernet
  Information on communication, 71
MS Message Queuing, 34, 78
MSMQ Server, 34, 78
Multilanguage, 53
  Installation, 53

N
Netware, 53
  Novell Netware client, 53
Network adapter, 56
  Energy-saving mode, 56
Network client, 53
Network connection, 56
  Speed, 56
Network drive, 56
Network engineering, 56
  Access via RAS, 56
  DHCP server, 56
  IP address, 56
  ISDN router, 56
  Network adapter, 56
  Network client, 53
  Network server, 56
  Notebook, 56
  Novell client software, 53
  Supported network protocols, 56
  TCP/IP protocol, 56
  WinCC in multiple domains, 56
  WinCC within a domain, 56
Network protocol, 56
  Supported network protocols, 56
  TCP/IP, 56
Network server, 56
Notebook, 56
Notes, 50
  For operation, 50
  Novell Netware client, 53

O
Online help,
  Internet Explorer, 94
  Runtime,
Online support, (See support)
OPC, 68
  Historical Data Access, 69
  XML Data Access, 68
OPC A&E, 69
  OPC source, 69
OPC A&E server, 69
OPC channel, 166
OPC UA
  Information on communication, 71
  Raw data tag, 71
  OPC_E_MAXEXCEEDED, 69
Operating system, 19, 53
  Access rights, 27
  Prevent access, 25
Operation, 49
  Domain, 19

P
PDF file, 301, 326
PDF files, 9
PdlPad, 176, 254, 331
Persistence, 210
Picture Tree, 76
Plug-in Builder, 225
  Creating a plug-in and making it available for
download, 226
Port
  Setting, 194
  Preferred server, 56
    Connection interruption, 56
Process bus, 166
Process picture, 213
  Publishing, 173, 175, 176, 254, 328, 330, 331
Process value
  Display in diagram, 274, 387
  Displaying in a table, 272, 386
  Displaying Statistics Function, 395
Project
  Include in user group, 32
Project path, (See: Folder)
Proxy, 56
Publish plug-in, 226
Published reports
  Excel templates, 302, 419

R
RAS, 56
RDP, 73
Redundancy, 56
  Configuration of standard gateway, 75
  Redundant server, 56
Release
  Folder, 28
Release share, (See: Folder share)
Remote access, 25
Remote Desktop Protocol, 73
Remote publishing, 173, 175, 176, 254, 328, 330, 331
Removal, 44
  Performing, 44
Report, (See reports)
Report tool
  Make available, 303, 420
Report tools, 299, 415
Reports, 301, 304, 306, 308, 326, 422, 423, 426
  As e-mail, 304, 422
  Excel workbook, 306, 423
  PDF file, 301, 326
  PDF Report, 304, 422
  Print job, 308, 426
  Settings, 304, 422
  XLS file, 301, 326
Requirement, 16
  Hardware, 17, 83, 96
  Installation, 83, 96
  Operating system, 19, 83, 96
  Software, 19, 83, 96
Rights
  Access right to directories, 359, 362
  Access Rights in WinCC, 249, 338
  Access Rights in Windows, 247, 342, 343
  User Rights in WinCC, 249, 338
  User Rights in Windows, 247, 342, 343
Runtime, 56
  Displaying online help, 53
  Server failure, 56
S
S5 PROFIBUS DP
  Information on communication, 72
S7 Protocol Suite, 70
  Information on communication, 70
  Time change with AR_SEND, 70
S7DOS, 70
Safety, 25, 27
Scope of delivery, 9
Screen, 54
Screen resolution, 54
Screen savers, 50
Screenshot, (See Hardcopy)
Script
  Functions, 241
Security Controller, 36
Security policy, 33
Security settings
  Internet Explorer, 261, 348
Server
  Operating system, 19
  Server prefix, 56
  Share, 27, (See: Folder share)
Signature

- Electronic signature, 66

SIMATIC 505 TCPIP

- Information on communication, 72

SIMATIC HMI, 27, 31, 32

- User group, 27

SIMATIC Logon, 189

SIMATIC Manager

- User Rights, 27

SIMATIC Report Administrators, 247, 342, 356

SIMATIC Report Users, 247, 342, 356

SIMATIC Security Controller, 36

Slider control, 210

Software, 19

- Requirement, 19, 83, 96

SQL master database, 56

Standard web page, 194

Start menu, 36

Statistics function

- Displaying for process values, 395

Supplementary installation, 40, 41

- Languages, 41

- Performing, 40, 41

Support, 130, 133

Support request, 133

Swapped-out WinCC archive

- Changeable media, 365, 369

- connect to SQL server, 365, 369

System authorization, 189

System diagnostics, 133

System stability, 62

T

Table

- Displaying process values, 272, 386

Tags with @ prefix, 76

TCP/IP protocol, 56

Technical support, (See support)

Terminal bus

- Large amounts of data, 67

Terminal server, (See terminal services)

Terminal service, 101

Terminal services, 171

- activate, 229

- Communication, 228

- Set up, 228

- Setting up users, 230

- Start terminal services server, 230

Terminal services client, (See terminal services)

Terminal services server, (See terminal services)

Time synchronization, 63

Toolbar, 25

Trends and alarms, (See Trends and Alarms)

- Alarm Table,

- Analysis function,

- Column names of alarms,

- Display function,

- Display Messages,

- Hit list of alarms,

U

Uninterruptible power supply, 56

Unsigned driver, 33

Unsigned file, 33

Upgrade, 105, 106

Upgrade installation, 11, 47

- Performing, 47

UPS, 56

User

- create, 247, 343

User administration

- Web center, 356

User Administrator

User administration for WebNavigator, 189

- Web options, 189

User authorization, 77

User change, 154, 219, 265, 351

User group, 27, 356

- Automatically created groups, 247, 342

- Domain-global user group, 31

- Include project, 32

- Individual groups, 247, 342

- SIMATIC HMI, 27, 31, 32

V

VBA, 67

Virtual directory, 196

Virtualization, 18

Virus scanner, 50

Visual Basic Script

- Use in WebNavigator, 207

W

Web center, 310, 322

- Access right to directories, 359

- Layout template, 312, 374, 384

- Linking and disconnecting archives, 365

- Static process pictures, 372
WebPublishing Assistant, 340, 372

WebUX
  Configuring the WebUX web page, 125, 436, 448, 450
  Installation, 123, 434
  Licensing, 121, 123, 431, 434
  Overview, 429
  Reserve license, 121, 432
  Using WebUX, 125, 436, 448, 450

WinCC, 56, 61
  General information, 61
  Installation, 9, 16, 33
  Installation requirements, 17, 19
  Limit access, 27
  Notebook, 56
  Performing installation, 36
  Performing supplementary installation, 40, 41
  Preparing the installation, 33
  Remote access, 25
  Removing, 44
  Upgrade, 46
  Upgrading an installation, 47
  Use in multiple domains, 56
  Use within a domain, 56
  WinCC DVD, 9

WinCC Archive Connector, (See Archive Connector)
WinCC client
  Access via terminal services, 228
WinCC DataMonitor, (See DataMonitor)
WinCC DataMonitor client, (See DataMonitor client)
WinCC DataMonitor server, (See DataMonitor Server)
WinCC DVD, 9
WinCC project, (See web project)
  Include in user group, 32
WinCC server
  Configuration with WebNavigator Server, 165, 166
WinCC ServiceMode, 77
WinCC User Administrator, (See User Administrator)
WinCC V6.x, 46
WinCC WebNavigator, (See: WebNavigator)
WinCC/WebNavigator client, (See WebNavigator client)
WinCC/WebNavigator Diagnostics Client, (See WebNavigator Diagnostics Client)
WinCC/WebNavigator Diagnostics Server, (See WebNavigator Diagnostics Server)
WinCC/WebNavigator server, (See WebNavigator server)
WinCC-OPC-UA
  Information on communication, 71